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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials.
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. Ifan instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.
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ASAP 2050 Operator’'s Manual Organization of the Manual

1. GENERAL INFORMATION

This manual describes how to install and operate the ASAP 2050 Xtended Pressure
Adsorption Analyzer.

Organization of the Manual

The manual is divided into the following chapters:

Chapter 1 GENERAL INFORMATION
Provides a general description of the ASAP 2050 system as well as its
specifications.

Chapter 2 USER INTERFACE
Provides basic instrument and software interface.

Chapter 3 OPERATIONAL PROCEDURES
Provides step-by-step instructions for operating the ASAP 2050.

Chapter 4 SOFTWARE AND SETUP MODIFICATIONS
Provides instructions for using the 2050 Setup program.

Chapter 5 FILE MENU
Provides a description of the commands on the File menu.

Chapter 6 UNIT MENU
Provides a description of the commands on the Unit menu.

Chapter 7 REPORTS MENU
Provides a description of the commands on the Reports menu and
samples of reports.

Chapter 8 OPTIONS MENU
Provides a description of the commands on the Options menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE
Provides instructions for troubleshooting hardware problems and for
performing routine maintenance procedures.
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Organization of the Manual ASAP 2050 Operator’'s Manual

Chapter 10 ORDERING INFORMATION
Provides part numbers and descriptions of the ASAP 2050 System
components and accessories.

Appendix A A. ASAP SERIES SAMPLE DATA WORKSHEET
Contains a form to assist you in determining the sample mass.

Appendix B ERROR MESSAGES
Lists the error messages that may be displayed in the analysis
program; includes a cause and action for each.

Appendix C C. CALCULATIONS
Contains the calculations used by the system to produce reports.

Appendix D TESTING FOR LEAKS
Describes the procedure for testing each valve for leaks.

Appendix E CALCULATING FREE-SPACE VALUES
Provides instructions for obtaining free-space values to use in
analyses.

Appendix F DFT MODELS

Provides information on DFT models.

Index INDEX
Provides quick access to a subject matter.
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ASAP 2050 Operator’'s Manual Conventions

Conventions

This manual uses the symbols shown below to identify notes of importance, cautions, and
warnings.

Notes contain a tip or important information pertinent to the subject matter.

Warnings contain information to help you prevent actions which could cause personal
injury.

Cautions contain information to help you prevent actions which could damage the
instrument.
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Online Manual

For your convenience, the Operator’s Manual is available online. You can access the manual
by selecting Help, then Operator’s Manual from the analysis program main menu. The
manual appears in an Adobe® Acrobat® Reader®.

Following are some tips to help you quickly locate the information you need in the manual.

Refer to the Adobe Acrobat Help system (click the Help button on the Acrobat menu) for
more information on the Acrobat features you can use while viewing the manual.

Using Bookmarks

Click the Bookmarks tab to list and access the topics included in the manual.

B Adobe Acrobat - [ASAP2020 operatar manual.pdf] [_[5]

T Ele Edi Document Tock Wew Window Hel =18 x|

[Eecrsa@- BB B > e =

[ - @ | EEE[ -G8 T-8|E-F L -FE &

EE

i B @ B Bookmark > g
L1 WARRANTY =

D TABLE OF CONTENTS
E-{]1. GEMERAL INFORMATION
B-{ ]2, INSTALLATION
B D 3. USER INTERFACE
& 4. OPERATIONAL PROCEDURES
&5 FILE MENU
&L ] 8. UNIT MENU
B} D? REPORTS MENU
=-[18. OPTIONS MENU
5 19, TROUBLESHOOTING AND MAINTEMAN
B D 10. ORDERING INFORMATION

Bookmarks ——p

Topics

inatures | cofments { Thumbrals Y Bookmarks

Operator’s Manual

4 W[ T 1or4ss b M sxdiin O H M 4]

Navigation Pane Topic Pane

You can use the + and — buttons next to topics as they are used in Windows Explorer to
expand or collapse the topic list.
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To display a topic, click the topic name in the Bookmarks section. The related information
appears in the topic pane of the window as shown in the following example.

& Adobe Acrobat - [ASAP2020 operator manual.pdf] HE
'@ Fle Edt Document Tools Wiew iWindow Help & Iﬁ' 1!

EFEEE LY
|(§)1us% - @|D @m?'
HYUHET-

HRRICE L
[o& B85/ £ B4

able for certawn components on the instrument schematic when in manual mode, and Tor 4
@ B @ B Bookmarkw onsereen graphs and tbular reports. These menus are accessed by selecting the item for which a
o o wvou wish to display its menu and clicking the right mouse button. For example, right-click ina
E D WARRANTY = column of an onscreen report and the following menu is displaved
2 D TABLE OF CONTENTS
& | ={]1. GENERAL INFORMATION —
7 | B[ ]2 INSTALLATION - e
2| | B-[]3 USER INTERFACE e e =
é E}a Controls, Indicatars, and Cannectars ﬁ%@"::m m:"_" E
E L] Front Panel e S e
-] Side Panel o ey ¢
q T Ui Click bookmark o
T L] Lower to display topic. G cotmafant
£ - Rear Panel sy Uikt
8 - 1 Lsi he Soft = EAR .
1] Using the Software T Copyimtleasten ||
am -4 Shortcut Menus I
Bl | L IShotcliiEHE I v
,E 1] Dislog Boxes Shortcut Keys
9 ] S.e\ectmg e 2 Shoricut keys can be used 1o activate some meny commands. Shorteut kevs or key combina-
| ~{ ] File Name Conventions tions (if assigned) are listed (o the right of the menu item. Instead of opening the menu and
EH] henu Structure choosing the command, simply press the key combination. For example, (o open a sample
D Windows Menu information file, press F2; the Open Sample Information dialog is displaved.
D Help Menu You can also use shoricut keys (o access a menu or any function that containg an underlined
E- ]4. OPERATIONAL PROCEDURES letter by pressing Al plus the underlined letier in the command. For example, 1o access the
Ej 5 FILE MENU File meny, press Alt, then F
E‘j 6. UNIT MENU Table 31 provides 2 list of the keys available in the ASAP 2020 mnalysis program
E-[ 7. REPORTS MENU
E-{ 18, OPTIONS MENU
E_:] 9. TROUBLESHOOTING AND WMAINTENAN
#-[]10. ORDERING INFORMATION
[JASAP Series Sample Data Warksheet
®-{ 1B, ERROR MESSAGES
= May 08 37
E-{ ] CALCULATIONS
E}J D. TESTING FOR LEAKS
Mam mnmin e FAee omee e e T i
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Using the Table of Contents, Index, and other Links

Links provide direct access to selected information. All links appear in blue type. Links are
contained in:

« the table of contents

e index entries
e cross-references within the manual

Table of Contents

To display the table of contents, click Table of Contents in the Bookmarks section. When the
table of contents is displayed, you can click an entry to display its associated page. For
example, clicking Using the Software in the table of contents, displays the page containing
information about the software.

3. USER INTERFACE

Controls, Indicators, and Connectors
Front Panel
Side Panel )
Upper - - -
J_clgt\:’r Click topic name in

Rear Panel . : o table of contents to

I Using the Software . . . I— . . displ-ay tOpiC.

Shortcut Menus.

e R R T =L O S S

File Name Conventions
Menu Structure
Windows Menu
Help Menu ; -15

13
14

15

L L L L LD L L L LD L L LW

Using the Software <

The analysis program operates in the Windows environment and requires familiarity with
standard Windows operations such as using the mouse, menus, and dialog boxes. While this
manual provides brief instructions for such standard operations, you may have to refer to your
Windows documentation or to its online help system to clarify functions which are specific to
Windows

Shortcut Menus

Shorteut menus { sometimes referred to as context-sensitive Menus or POp-up Menus) are
available for certain components on the instrument schematic when in manual mode, and for
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Index

To use the index in the online manual, click the Bookmarks tab, scroll down to INDEX (the
last topic in Bookmarks), then click the + button to expand the index. The letters A through Z
are displayed. Click a letter to display its corresponding index entries as shown in the
following example.

B T [ Bookmark *
=L ] IMDEX =

Signatures % Commerts % Thumbnails % Bookmark:
B0 ]
@

)
5
=
QD
o
@
=
5]
=
[7)
=2
QD
<

After you display the entries, locate the item of interest and click on the page reference to
access the information.

Cross References

Cross-references work in the same manner. In the example below, clicking on the cross-
reference, FILE MENU (shown on the screen in blue type) will display the first page of the
chapter describing the commands found on the File menu.

FILE MENU

Provides a description of the commands available on the File menu.
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Using the Find Command

The Adobe Acrobat Find command provides another method of easily accessing specific
information. For example, suppose you want to know how the Save as command works. You
could select Edit > Find from the Adobe Acrobat menu, then enter Save as in the Find dialog.
The following example shows the results.

Find What: | Fave as Eind Again _I
[~ Match Whols Word Only Cancel |

[T Makch Case ny changes you have made to the file in the active window. The file
[ Find Backwards iame
Ignore Asian Character Width

Save As

Save As enables you to:

save a sample or parameter file in the active window under a different name. This option 1s
useful for making a duplicate copy of a file that you can modify as desired without chang-
ing the original one. The original file remains open when you use this function, so be sure
to open the new file before making any changes.

save a subset (parameter) of the sample file in the active window as a standalone parame-
ter file. For example, select Analysis Conditions from the Save As menu to create a stan-
dalone parameter file of the analysis conditions portion of the active sample file
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Printing

You can print the entire manual, a selected page, or range of pages. There are several options
for printing. You can:

» Select the printer icon ( € ) on the Adobe Acrobat toolbar.

A standard Print dialog is displayed. Select the page(s) to print, then click OK. When using
this option (or the next one), be sure to enter the page number(s) displayed in Adobe
Acrobat; do not use the page number(s) listed in the footer(s) of the manual.

Do not use
number in
Enter 11 4— footer of the
this manual.
number. ﬂl{ 4] TafdsE B H 85x11k |0 H & J
| A

e Select File > Print.

A standard Print dialog is displayed. Select the page(s) to print, then click OK.

» Click the Thumbnails tab.
Thumbnails of manual pages are displayed.
a. Click the pages you want to print.
b. Right-click to display a shortcut menu, then select Print Pages.

c. A standard Print dialog is displayed; click OK.

@ Thumbnail *
-
= o Report Example
—— —_—
|7 L. i
) g Report E
Thumbnails ——— é —
H 247 248 243
tab g It
—_— —_— == th
0 -
= — of
5 =
g -
- == | ==
8
| Insert Pages...
i Extract Pages...
250 251 252 Replace Pages...
Delete Pages...
= Crop Pages...

— Rotate Pages...

| Number Pages...

Print Pages...

Embed All Thumbnails
Remove Embedded Thumbnails

253 254

LA Small Thumbnails
T « Large Thumbnails

256 257
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Internet Access

Visit www.micromeritics.com to learn more about Micromeritics, our products, and applica-
tions. Our site is user-friendly, easy to navigate, and informative. Its content is summarized

below.

About Micromeritics A brief history of Micromeritics, office locations, awards/cer-
tifications, career opportunities, and a virtual tour of its
headquarters

Products Product information and printable brochures

Applications Application Notes, Product Bulletins, Tech Tips, Technical
Articles/papers, and important application links

Online Catalog Catalog of instruments and accessories, allowing you to place
your order online

News and Press Press releases, Events calendar, microReports, and latest
Micromeritics news updates

Lab Service Provides laboratory tips and access to the Micromeritics Ana-
Iytical Services web site

Customer Support Customer support contacts, product registration, instrument
training information, Material Safety Data Sheets, and account
registration

Grant Program Details of the Grant Program established for non-profit orga-
nizations and universities

Contact Us Contact information, office locations, maps and driving direc-

tions to the Micromeritics facility, and registration for the
microReport newsletter

Be sure to browse our site to see the many ways in which we can assist you.
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Equipment Description

that the sample tube is not under pressure when removing it from the instrument. Use

0 The ASAP 2050 can operate in a pressure range from 0 to 10 atm; therefore, ensure
caution appropriate for these types of devices.

The ASAP 2050 analyzer is equipped with two independent vacuum systems — one for
sample preparation and one for sample analysis. Having two separate systems, as well as
separate preparation ports, allows sample preparation and sample analysis to occur
concurrently without interruption. Inline cold traps are located between the vacuum pump and
the manifold in both the analysis and the degas systems. The sample saturation pressure (Psat)
tube is located next to the sample analysis port. Gas inlet ports and cable connections are
located conveniently on the side panel of the analyzer for easy access.

The ASAP 2050 is equipped with an elevator that raises and lowers the analysis bath fluid
Dewar automatically. A removable shield to enclose the Dewar is also included for safety
purposes.

The ASAP 2050 system includes Micromeritics’ patented Isothermal Jackets for the sample
tube. The Isothermal Jacket maintains a stable thermal profile along the full length of the
sample and Psat tubes.
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Gas Requirements

Compressed gases are required for analyses performed by the ASAP 2050 analyzer. Gas
bottles or an outlet from a central source should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are
required. Gas regulators are available from Micromeritics; refer to Ordering Information,
page 10-1.

Gases that be used with the ASAP 2050 include argon, carbon dioxide, nitrogen, hydrogen,
oxygen (with oxygen-compatible vacuum system), and other suitable gases

In order to use oxygen with the ASAP 2050, your 2050 analyzer must be equipped with

an oxygen-compatible vacuum pump that uses Fomblin® (or a suitable equivalent)
pump oil. Failure to use the proper vacuum system could result in hazardous
conditions including fire and personal injury.

Analysis Program

The ASAP 2050 analysis program is designed to operate in a Windows 2000 or Windows XP
Professional environment. The Windows environment provides a user-friendly interface for
performing analyses and generating reports.

The ASAP 2050 System software monitors and controls the analyzer. It enables you to
perform automatic analyses with just a few key strokes, and collects and reports analysis data.
You can choose from a variety of reports, which can be printed automatically after an analysis
and/or stored and printed later.

Report System

The ASAP 2050 software includes a report system which allows you to manipulate and
customize reports. You can zoom in on portions of the graphs or shift the axes to examine fine
details. Scalable graphs can be copied to the clipboard and pasted into other applications.
Reports can be customized with your choice of fonts and a company logo added to the report
header for an impressive presentation. Refer to “REPORTS MENU” on page 7-1 for the
options available for reports.
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Specifications

The ASAP 2050 system has been designed and tested to meet the specifications provided

below.
Characteristic Specification
UTILITY REQUIREMENTS
Electrical: 100/115/230 VAC; 50 or 60 Hz, 800 VA,
exclusive of vacuum pumps, which are
powered separately
Operating Environment
Temperature: 10 to 35 °C operating
- 10 to 55 °C storage or shipping
Humidity: Up to 90% (non-condensing) for instrument
20% to 80% for computer system
PRESSURE MEASUREMENT
Range: 0 to 10 atm
Resolution:
Analysis transducer 0.00015 psi
Accuracy (Analysis system only): 0.1% BFSL (Best Fit Straight Line)
Includes nonlinearity, hysteresis, and nonrepeatability. Transducer manufacturer’s
specifications.
VACUUM SYSTEM
Vacuum Pump: Mechanical, two-stage, ultimate vacuum 5 x
1073 mmHg; 2 pumps (one analysis and one
degas)
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Characteristic Specification

MANIFOLD TEMPERATURE TRANSDUCER

Type: Platinum resistance device (RTD)
Accuracy: +0.02 °C (by keyboard entry)
Stability: +0.1 °C per month
DEGAS SYSTEM
Temperature Range: Ambient to 450 °C
Selection: 1 °C increments
Accuracy: Deviation less than +10 °C of set point at

thermocouple

Backfill Gas: User-selectable, typically helium or nitrogen

SYSTEM CAPACITY

Sample Preparation: 2 degas ports, each with independently-
controlled heating mantle, using servo-
controlled restricted evacuation

Analysis: 1 sample port; 1 saturation pressure tube port

Total Operating Capacity: Up to two complete analysis units can be
controlled independently by one computer

CRYOGEN SYSTEM

Special Features: Patented Isothermal Jackets effectively
maintain cryogen level constant on sample
tube and Po tube during analysis while
evaporation of cryogen occurs

Capacity: 3-Liter Dewar, which provides at least 50
hours of unattended analysis.

Analysis Time: Unlimited. Dewars may be refilled without
affecting the accuracy of results.
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Characteristic

Specification

SAMPLE SIZE

1/2-inch straight-wall 316 stainless steel sample tubes.

Normal:

Height:
Width:
Depth:

Weight:

Minimum requirements:

GASES

Argon, carbon dioxide, nitrogen, hydrogen
oxygen, and other suitable gases

PHYSICAL
99 cm (39in.)
85cm (33.51in.)
61 cm (24 in.)

115 kg (250 Ibs)

COMPUTER

Pentium 333 MHz computer (or equivalent)
CD-ROM drive

128 megabytes of main memory

1-gigabyte hard drive

SVGA monitor (800 x 600 minimum
resolution)

RS232 port

Windows 2000 or Windows XP Professional
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2. USER INTERFACE

This chapter contains information to familiarize you with the hardware and software of the
ASAP 2050 system. It is recommended that you read this chapter before attempting to operate
the ASAP 2050 system.

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on the
front, side, and rear panels of the ASAP 2050 system.

Front Panel

L g

Power indicator light

Vacuum pump panel

Elevator

Green power indicator light  Illuminated when power is applied to the analyzer.

Vacuum pump panel Allows access to the vacuum pumps. Remove this panel
when you need to service the pumps.

It is not always necessary to remove the panel to inspect the
condition of the fluid or the fluid level. To accomplish either
of these tasks, remove (or fold over to the right) the protec-
tive rubber mat and lift off the metal cover; this exposes the
vacuum pump sight window.
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Drain  Vacuum pump

) sight window
Vacuum pump sight The vacuum pump sight windows enable you to inspect the
window oil levels in the degas and analysis pumps.
Vacuum pump drain Provides a convenient method of draining fluid from the

pump when service is required. (Pump must be removed from
analyzer in order to drain.)

Elevator Allows placement of the Dewar around the sample tube.
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The components listed here are located on the underside of the upper extension of the front

panel.
Heating
De%as mantle Cold traps
ports power
connector Not used

/

- [A@ micromenritics
ASAP 20_50 "

\/’ Fé |

Heating mantle Heating mantle Four hooks Po port Analysis port
breaker thermocouple connector provided for
safety shields

Degas ports Allow you to degas up to two samples. Each degas port has
connections for a heating mantle.

Heating mantle Allows connection of a heating mantle thermocouple (one for
thermocouple connector each degas port).

Heating mantle power Allows connection of the heating mantle power cord (one for
connector each heating mantle).

Heating mantle breaker Protects the circuitry for the heating mantle in the event of a

failure (one for each heating mantle). If the circuit breaker
trips (pops out), call your Micromeritics service
representative.

Cold Traps Two cold traps are provided; one for degassing and one for
analysis.
Analysis port For installing the sample tube containing the material you

wish to analyze.

Po port For installing a Po (saturation pressure) tube.
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Side Panel

Upper

Gas inlet ports Not used

Vapor gas port Degas backfill port

Freespace Helium port

Gas inlet ports Used to connect gas supplies to the analyzer.

Vapor gas port For attaching the water vapor option, or connecting a vapor
gas. Refer to Ordering Information on page 10-1 for the
part number of the water vapor option.

Degas Backfill port Allows connection of a gas to use for degassing the sample.
Freespace Helium port Allows connection of helium to use for measuring the free
space.
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Lower
@ @ ==
-~
4———RS 232 Port
&
valve circuit Power connector
breaker —». e
|
On/Off switch Voltage selector Switch
On/Off switch For turning the analyzer on and off. This switch also serves as

Power connector

RS232 port

Valve circuit breaker

Voltage selector switch

the main breaker for the analyzer; it switches off automati-
cally in the event of an electrical fault.

For connecting the analyzer to the electrical supply.

For connecting the analyzer to a computer.

Protects the circuitry for the valves in the event of a failure. If
the circuit breaker trips (pops out), call your Micromeritics
service representative.

For setting the analyzer to the correct incoming AC line
voltage.
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Rear Panel

Vacuum pump
location

Vacuum pump recess Provides for placement of the vacuum pumps. Vacuum
pumps can be serviced from the front of the instrument by
removing the vacuum pump panel located on the lower left
side of the front panel (see Front Panel described
previously).

Turning On the System

1. Place the ON/OFF switches for the computer and all peripheral devices in the ON
position.

2. Place the analyzer ON/OFF switch in the ON position; verify that the green power
indicator on the front panel is illuminated.

Turning Off the System

Always exit the ASAP 2050 program and/or Windows before turning off the computer.
@ Failure to do so could result in loss of data.

1. Select Close from the System Menu or Exit from the File menu.

2. If you exit the ASAP 2050 program with analyses in progress, you will be warned of the
operation. If desired, you can continue with exiting the application and the analyses will
proceed and continue to collect data. Reports that are queued under the Print Manager will
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print. If, however, a power failure occurs and an uninterruptible power supply (UPS) is not
attached to the computer, the data collected after exiting the ASAP 2050 System program
are lost.

3. Place the computer, monitor, and printer ON/OFF switches in the OFF position.

4. Place the analyzer Main Power switch in the OFF position.

Using the Software

The analysis program operates in the Window™ environment and requires familiarity with
standard Windows operations such as using the mouse, menus, and dialogs. While this manual
provides brief instructions for such standard operations, you may have to refer to your Win-
dows documentation or to its online help system to clarify functions which are specific to
Windows.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are avail-
able for certain components on the instrument schematic when in manual mode, and for
onscreen graphs and tabular reports. These menus are accessed by selecting the item for which
you wish to display its menu and clicking the right mouse button. For example, right-click in a
column of an onscreen report and the following menu is displayed.

Isother
Ahsolute
] Fressure
Resize column {
Rename column —

-

0.00  Move column no
0.00  align column Ho
goo———— 1
000 Hide column F 0z
H3
000 r———
pop  =olumn fant ki
.00 Header fonk ]
g'gg Edit title. . ;18
0.00 H3
0.00 A}
0.000001024 0.000758
0.0000010649 0.000791
0.000001113 0.000824

-

-

0.000  Show calumn

Copy table as text

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combina-
tions (if assigned) are listed to the right of the menu item. Instead of opening the menu and
choosing the command, simply press the key combination. For example, to open a sample
information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined
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letter by pressing Alt plus the underlined letter in the command. For example, to access the
File menu, press Alt, then F.

Table 2-1 provides a list of the keys available in the ASAP 2050 analysis program.

Table 2-1. Shortcut Keys

Key(s) Function
F1 Access online operator’s manual
F2 Open a sample information file
Clear the field of existing date (Select Dates dialog)
F3 Open an analysis conditions file
Insert the current date (Select Dates dialog)
Fa Open an adsorptive properties file
Display a calendar from which to choose a date (Select Dates dialog)
F5 Open a report options file
F6 Tile open windows
F7 Cascade open windows
F8 Start report
F9 Close all open reports
F10 Generate a Heat of Adsorption report
Alt + F4 Exit the ASAP 2050 program
Shift + F2 List sample information files
Shift + F3 List analysis conditions files
Shift + F4 List adsorptive properties files
Shift + F5 List report options files
Shift + F9 Access shortcut menu of (1) selected component on instrument

schematic, or (2) onscreen reports

2-8
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Dialog Boxes

Dialog boxes (referred to as dialogs) are displayed when a menu item followed by an ellipsis
(...) is selected. Subdialog boxes are displayed when certain push buttons are selected. Both
types of boxes may contain one or more of the items listed below.

i Free Space
Radio Button :
¥ Lower dewar for evacuation
Exacuation time: I 0.10 4¢ Data Entry Field
Check Box ——  Dutgas test
Outgas test duration: 180 (s
" Enter
Warm fiee space: I 16.0000 || cm®
i Grayed Item
Cold free space: I 450000 lem® = T (indicates unavailable)
" Calculate
Information Bar%|
_ Cancel | Push Button

The following describes elements that are often included in dialogs. If an element is shown in
gray instead of black, the element is currently unavailable.

Data Entry Fields A Data Entry field is used to enter text; either numeric (num-
bers only) or alphanumeric (numbers, letters, or printable
characters).

If an invalid entry is made, an error message is displayed, for
example, if you attempt to enter text in a numeric field or a
number outside of the range shown in the information bar.

Information Bar Some dialogs contain information pertinent to the selected
field in an information bar across the bottom of the dialog.
For example, a range is shown for fields in which numeric
entries are required.

Radio buttons Radio buttons are provided in groups of two or more and are
used to make a choice; only one radio button can be selected.
Simply click the desired option with your mouse pointer. A
black dot indicates the item is selected.

Check boxes Check boxes allow you to choose multiple options from a
group of options. Click the desired option(s) with your mouse
pointer. An X in the box indicates the item is selected,;
remove the X in the same manner.
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Push Buttons

Close

Save

Replace

Cancel

Drop-down list

A push button is used to display a subdialog box in which to
enter additional information about the subject matter, or to
invoke an action.

For example, if you click Date Range on the Open Sample
Information dialog, the Select Dates subdialog is displayed. If
you click Cancel on the Open Sample Information dialog,
you invoke the action of canceling and closing the dialog.

Closes the active dialog. If the dialog contains unsaved
changes, you will be prompted to save them before the dialog
closes.

Any information entered in subdialogs (refer to the next sec-
tion of this chapter), is discarded also.

Saves the information entered in the current session; the dia-
log remains open.

Allows you to replace the contents of the current file with
those from an existing file. For example, if you are creating
an analysis conditions file, you can save time by clicking and
choosing the file containing the values you wish to use. These
values are copied into the current file automatically. And
since the values are actually just copied into the file, you can
edit them in any way you wish. The file from which they
were copied remains intact and ready for the next use.

Discards everything you entered in the dialog and any subdi-
alogs, and closes the dialog. A warning message is displayed
before closing.

A drop-down list contains a list of options and is indicated by
a down arrow to the right of the field. If there are more items
than can fit in the box, a scroll bar is provided for navigating
through the list.

2-10
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Selecting Files

Sample information is stored in files and saved under file names. Certain dialogs contain a

Files list box which displays a list of files available for that particular operation. For example,
the Open Sample Information File dialog.

The Status drop-down | T -
list does not appear on [z nanc
the Open dialog for  Selection Ciiteria
parameter files. Stas: [l ~]
Date Range... |
Directories: .
Files: o\ Adata Displays the
13x_ar_smp 13X Reference Material [AR) a|ll--1 a
. . 13x_n2.smp 13X Reference Material [N2) —|I-a1 current
Displays all files of ———— |13xarex.smp 13 Reference [Ar] (example] Il directory.
B 13xco2ex.smp 13X Reference (CO2) [Example) [-d-] .
the type n the StatUS 13zn2ex.smp 13X Reference (N2) [example) [-a-1
field bl
. ol
1| | L'J =

A default string appears in the File name field. To select a file, simply move the mouse pointer
to the desired file in the list and double-click.

You can limit the list of files displayed by choosing one or more of the following options:

» Use wildcard characters in the path name entered in the File name field. Standard and
wildcard characters (such as * and ?) can be used to filter file names. For example, you

could limit the list of files shown in the dialog above to those beginning with 13x by enter-
ing 13x*.SMP in the file name field.

» Enter a range of dates. Click Date Range; the Select Dates dialog is displayed.

Il Select Dates

o o015 [8

Lancel |

Select Show Date Range to enable the From and To fields, then enter a beginning and
ending date. Or you can double-click in each field to display a calendar to select a date.

The range of dates remains the default until you change the dates or select Show All
Dates.
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For convenience, the following shortcut keys are available when the Select Dates dialog is
displayed:

F2 Clears the date
F3 Inserts the current date

F4 Displays a calendar from which you may select a date

e Select a file status from the Status drop-down list. For example, choose Complete from
the drop-down list and only files that have been used in an analysis are displayed. The
table shown below describes each file status.

\ files.

The Status drop-down list does not appear on the File > Open dialogs for parameter

Table 2-2. File Status and Description

Status Description

All All sample information files in the specified directory and within the
specified range of dates

Analyzing Sample information files that are currently being used with an analysis

Complete Sample information files that have been used with an analysis

Entered Sample information files that contain manually entered data

No analysis Sample information files that have not been used in a degassing operation or
an analysis

Prepared Sample information files that have been used in an automatic degassing
operation and are ready for analysis

Preparing Sample information files that are currently being used in an automatic
degassing operation

* Navigate to a different directory. The current directory is displayed just above the Directo-

ries list box. You can change directories by double-clicking a directory in the Directories
list box, double-clicking [..] to move up one level, or by entering the desired directory in
the File Name field. For example, enter C:\2050files\sample\*.smp to display sample files
in the 2050files\sample directory on your local drive.
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File Name Conventions

For sample information and parameter files, a wildcard character (*) and a default extension

display.

The following table shows the file name extensions for the ASAP 2050 program.

Table 2-3. Default File Name Extensions

Alpha-s curve

File Type Extension

Sample Information SMP
Sample Tube STB
Degas Conditions DEG
Analysis Conditions ANC
Report Options RPO
Adsorptive Properties ADP
Export to disk (ASCII) ISO
Report to disk RPT
List to disk LST
Thickness curve THK

ALS

The following types are available for reports saved from the Report window

Report REP
Spreadsheet XLS
ASCII TXT
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Menu Structure

All functions for the ASAP 2050 are located on menus which are accessed from the Menu bar.
Each menu contains commands, and in some cases a submenu. A submenu is indicated when
the command is followed by an arrow.

Menu Name Command

Menu Bar Ele Unit 1 Reports [ option:

1 Restricted

v Advanced
Units... —

Graph Grid Lines...

live Graph 3

Parameter Files Directory...
Service Test Mode

Submenu

Brief descriptions of each menu are provided below; refer to the chapter given in parentheses
for a detailed description of the commands contained on that menu.

File Enables you to maintain system files. (Chapter 5, FILE MENU)

Unit [n] Enables you to perform analyses and other instrument operations.
(Chapter 6, UNIT MENU)

Reports Enables you to generate, customize, and close reports. (Chapter 7,
REPORTS MENU)

Options Enables you to select data presentation formats, and enter system
default values. (Chapter 8, OPTIONS MENU)

Windows Enables you to arrange the windows and icons on your screen. It
also displays the names of all open files. (this chapter, page 2-15)

Help Displays Help information. (this chapter, page 2-15)
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Windows Menu

Windows
Tile F&
Zascade F7

Arrange Icons

v 1 CHDEMOZ0504000-002,5MP

Tile Resizes all open windows and arranges them side by side so
that the contents of all open windows are visible.

Cascade Resizes all open windows and arranges them in a stacked
fashion. The active window is positioned on top of the stack.
Each window’s title remains visible, making it easy to select
other windows.

Arrange Icons Arranges the symbols for all minimized windows in an
orderly manner.

Open file names Displays all open files; the active window is preceded with a
check mark.

Help Menu

Dperator's Manual,.. Fl1
About ASAP 2050,

Operator’s Manual Displays the operator’s manual in PDF format.
About ASAP 2050 Displays information about the ASAP 2050 analysis
program.
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3. OPERATIONAL PROCEDURES

This chapter contains brief step-by-step instructions on how to:

» specify sample file defaults, this page

* create sample information files, page 3-6

* define parameter files, page 3-9

* prepare the sample page, 3-16

» perform an analysis page, 3-37

 generate a list of information on a sample or parameter file, page 3-40
* print contents of a sample or parameter file, page 3-39

* export data in a sample information file to an ASCII file, page 3-41
 overlay graphs, page 3-42

This chapter does not contain detailed descriptions of the dialogs used to perform these

procedures. Refer to Chapters 5 through 8 for dialog descriptions. Use the index to assist you
in locating the appropriate dialog.

Sample Information Files

Sample information files contain information used to control the analysis. Therefore, an
analysis cannot proceed until it has been assigned a sample information file. A sample
information file consists of the following:

» sample identification

» sample tube criteria

+ analysis conditions

* adsorptive properties

* report options

« collected/entered data (after an analysis has been completed)

Portions of the sample information file can also exist as standalone parameter files. Having
these files exist independently allows you to use them as many times as you wish. For
example, if you typically use the same analysis conditions for many of your analyses, you can
create an analysis conditions file containing the desired conditions. Then when you create your
sample file, select that file for your analysis conditions; the values will be copied into the
current sample file. After it becomes part of the new sample file, you can edit it as desired. The
file from which the values were copied remains intact and ready for the next use.

Sample information files reside in a folder. The more files in a folder, the longer it may take to
access a file. Therefore, it is a good practice to limit the number of files in a folder to
approximately 200. You may create additional folders as needed.
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Sample information files can be created and presented in the Advanced, Basic, or Restricted
format.

« Advanced

Presents all parts of the sample information file in a tabbed dialog. Each tab opens its

associated dialog, allowing you to edit conditions. You can also switch to the Basic
format if desired.

* Basic
Presents all parts of the sample information file as a single dialog. This format allows

you to quickly create a sample information file using predefined parameter files. You
can also switch to the Advanced format if desired.

* Restricted

Identical to the Basic format except that you cannot switch to the Advanced format for
editing; certain functions are also disabled.

Specifying Sample File Defaults

You can specify sample defaults in the Basic or Advanced format. The defaults you specify are
the ones you see when you create a new sample file in the respective format. Therefore, it is
best to specify (or enter) parameters that you plan to use most frequently. For example; specify
defaults for your most commonly analyzed sample material. You can always edit parameters in
the sample file when it is created. The ASAP 2050 system automatically generates sample
information file names and uses the values you specify as the defaults.

Basic Format

Perform the following steps to define defaults for a sample information file in the Basic
format.

Select Option Presentation on the Options menu and ensure that Basic is selected as

\ the format.

1. Select Options > Sample Defaults; the default Basic Sample Information dialog is
displayed.
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[&]5ample Defaults H=
Sample Information
Sequence: ([[EM]
ISampIe: !3
Mass: 1.0000 g Density: | 1.000 cmilg
Sample Tube: |Sample Tube Lﬂ
Degas conditions: | Degas Conditions ;ﬂ
Analysis conditions: | Run Conditions ;j|
Adsorptive properties: |Nilmgen @ 77 35K _V_I|
Report options: | Report Options _v_I|
Replace All.. I
Save | Lloze | Advanced |

In the Sequence field, specify a default string. This is the number that is incrementally
sequenced and displays in the File name field when you select File > Open > Sample
information. You can use up to eight characters.

In the field on the right of the Sample line, enter a format for the sample identification. Be
sure to include the $ symbol if you want the sample file number included as part of the
identification. You can use up to 42 alphanumeric characters.

You also can edit the word Sample. For example, you may prefer to use Material or
Test. You can enter up to 15 characters in this field.

Enter a default value in the Mass field. An approximate weight is sufficient; a more
accurate weight can be entered later.

The sample density is used when free space is calculated; enter a default for your sample’s
density if you typically use a calculated free space. Otherwise, this value is ignored.

Select the down arrow to the right of the parameter fields to choose default parameter
files:

e Sample tube

» Degas conditions

« Analysis conditions
» Adsorptive properties
* Report options

Click Save, then Close.
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Advanced Format

The Advanced Sample Defaults dialog resembles a set of index cards. You can move from one
set of parameters to another by clicking the parameter tab or by using Next and Prev. The
values you specify in the parameter portions of the sample file (Analysis Conditions, Degas
Conditions, Adsorptive Properties, and Report Options) are saved as the defaults for newly
created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

 Select File > Open > Sample Information, Yes to create the file, and the defaults you
specify display for all parameters.

» Select File > Open > Analysis Conditions, enter a name, then Yes to create the file,
and the defaults you specify in the Analysis Conditions portion of the Advanced Sample
Defaults dialog display in the fields.

Select Option Presentation on the Options menu and ensure that Advanced is selected

\ as the format.

1. Select Options > Sample Defaults, the Advanced Sample Defaults dialog is displayed.

Sample Defaults =l
¢ Prew I Sample Sample Degaz Analyzis Adsorptive | Report Mext 2>
_l Information | Tube Conditions | Conditions | Properties Options I_l

Sequence l]l]l]-l]m
|Sample: %
Operator: [ DOmit
Submitter: I ™ Dmit

" Manually entered

Density: | 1.000 gfcm®

Comments:

TypeofData—
Mass: I
e 1.0000{8g { ' Automatically collected ‘

Add Log Entry I
Replace All.. |
|
Save | Lloze | Basic |

2. In the Sequence field, specify a default string for the sample file number; you can use up
to eight characters. This is the number that appears in the File name field when you select
File > Open > Sample information.
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3. Inthe right-side field of the Sample line, enter a format for the sample’s identification.
You can enter up to 42 characters. Be sure to include the $ symbol if you want the sample
file number (Sequence) included as part of the identification.

4. Edit the Operator and Submitter lines as desired. Or have them omitted entirely by
selecting Omit.

5. Enter a default value in the Mass field. An approximation in this field will suffice; a more
accurate value for the sample mass can be entered at the time of analysis.

6. If you plan to use a calculated free space, enter the sample’s density in the Density field.

7. Choose whether you wish to have data collected automatically or if you plan to enter the
data. This option can be changed (if desired) at the time of analysis.

8. Click the Sample Tube tab. Enter criteria for the sample tube you most commonly use,
then click Save.

You can click Save on each dialog as you specify parameters, or you can click Save
on any dialog after all parameters have been specified. All dialog defaults will be
saved.

9. Click the Degas Conditions tab. Specify degassing criteria, then click Save.

10. Click the Analysis Conditions tab. Choose the analysis conditions appropriate for your
most commonly analyzed material, then click Save.

11. Click the Adsorptive Properties tab. Specify gas characteristics, then click Save.

12. Click the Report Options tab. Choose desired reports, using Edit to specify details; then
click Save.

13. Click Close to close the dialog.
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3-5

Specifying Sample File Defaults




Creating Sample Information Files ASAP 2050 Operator’'s Manual

Creating Sample Information Files

A sample information file must be assigned to every sample that is analyzed. When you create
a sample file, you can accept the default values specified using Sample Defaults, or you can
edit them as desired. You can create a sample information file using the Advanced, Basic, or
Restricted format.

Advanced Format

The Advanced format allows you to customize the parameters of a sample information file.

Chapter 5 provides a description of the fields associated with creating sample information
files.

1. Select File > Open > Sample information; the Open Sample Information File dialog is
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed.

4¢ Prew I Sample Sample Degas Analyzis Adsorptive | Feport Mext 2>
_l Information | Tube Conditions I'Eonditions [Properties [Dptions i I_—I
Sample: |[LHIZITE
T'hese fl_elds do not | Operator
display if you selected <\ i
Omit when specifying Submitter: |
Sample defaults. - Type of Data
Mass: I
i 1.0000]89 {+ Automatically collected
Density: l 1.000 gicm® " Manually entered
Comments: Add Log Entiy |
Replace All.. I
Save | Lloze | B asic |

The defaults that appear in the fields are the ones specified in Sample Defaults.
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4. Accept the default identification in the Sample field or change it to an appropriate one.
The dialog above shows the sample file number because the dollar ($) symbol was used
when specifying sample defaults.

If a sample information file already exists containing the values you want to use in
this file, you can click Replace all to copy those values into this one. You can still
edit the values after they are loaded.

5. Edit the Operator and/or Submitter fields as needed. If these fields are not displayed,
they were selected to be omitted in Sample Defaults.

6. Enter the sample’s mass (if different from the default value) in the Mass field.

7. Choose whether you want data automatically collected by the system or whether you wish
to enter the data.

Use the Comments window to record specifics of the analysis or its conditions.
Anything you enter in this window is displayed in the report header.

8. Click Save to save the information you entered.

9. The steps for completing the remaining parameters of the sample information file are
explained in subsequent sections:

 Specifying Sample Tube Criteria
» Defining Degas Conditions

* Defining Analysis Conditions
Defining Adsorptive Properties
Defining Report Options

Simply click on the tabs to open the associated dialog.
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Basic and Restricted Formats

Sample information files are created in the Basic and Restricted formats using predefined
parameter files. Chapter 5 provides a description of the fields associated with creating sample
information files.

1. Select File > Open > Sample information; the Open Sample Information File dialog is
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed. The
defaults that appear in the fields are the ones specified in Sample Defaults.

Sample Information
5ample:
Mass: 1.0000 9 Density: 1.000 cm’/g
Sample Tube: |5amp|e Tube _'_||
Degas conditions: | Degas Conditions _'_]|
Analysi ditione |Run Conditi ;il
Adsorptive ies: [ Ni @77.35K =1
Heport options: |Hepull Options Li|
Replace All...
A
Save Clase l bdvanced | €——— Not dlsplayed on the
Restricted dialog.

Use this push button to copy parameters

4. Accept the default identification or change it to an appropriate one.
5. Enter the sample’s mass (if different from the default value) in the Mass field.

6. Using the down arrows to the right of each parameter field, select an appropriate file (or
accept the defaults). You can review or edit the contents of these files by switching to the
Advanced format if desired.

If you are using the Restricted format, you cannot switch to the Advanced format.

7. Click Save, then Close.
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Defining Parameter Files

The following file types can exist as part of the sample information file or as an individual
parameter file:

e Sample tube

» Degas conditions

» Analysis conditions
Adsorptive properties
Report options

Having these files exist independently allows you to use them over and over again.

Several predefined parameter files (located in the params directory) are included with the
ASAP 2050 analysis program. Although these files may come close to the needs of your
laboratory, you may wish to define additional ones. Or you can use a predefined file as a
starting point. This is easily accomplished by creating a new file and then selecting Replace.
A dialog is displayed so that you can select the existing file containing the values you wish to
use. After the values are copied into the current file, you can edit the values as desired; the
original file remains intact and ready for the next use.

If you wish to have parameter files display in the drop-down list on the Basic Sample
Information dialog, be sure to save them to the directory specified as the Parameter Files
Directory. (Refer Parameter Files Directory on page 8-12 for additional information.)

Sample Tube

1. Select File >Open > Sample Tube; the Sample tube dialog is displayed.
2. Enter a name in the File name field, then click OK.

3. Click Yes to create the file; the Sample Tube dialog is displayed

Sample Tube
Sample Tube Samle Tube] Replace |

Ambient free space ! 1.0000 cm@ [ Use isothermal jacket
I Use filler rod
Analyszis free space I 1.0000 cm? =

Yacuum zeal type:

' None

~ Seal Frit
Load From Sample File... I " Trans Seal
Save | Lloze |

4. Enter a description in the Sample Tube field. Be sure to use an intuitive description so that
you can recognize it easily.

5. Click Load from Sample File; the Open Sample Information File dialog is displayed.
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6. Select the file you used in the blank run with this sample tube, then click Open to copy the
ambient and analysis free space into the Sample Tube dialog.

7. If a vacuum seal of some type was used, select the appropriate option or leave the default
of None selected.

8. Click Save, then Close.

Degas Conditions

Degas Conditions files contain degassing information for preparing samples.

Perform the following steps to define a degas conditions file:

1. Select File > Open > Degas Conditions; the Degas Conditions dialog is displayed.
2. Enter a name in the File name field, then click OK.

3. Click Yes to create the file; the Degas Conditions dialog is displayed.

Degas Conditions

Description; I Replace... |
-E ion Phaze - Heating Phaze

Temperature ramp rate: 1.0 K/min Ramp rate: 1.0 K/min
Target temperature: 303 K Hold temp: 303 K

Ewacuation rate: l 5.0 mmHgfs Hold time: l 10 min
Unrestricted evac. from: I 5.0 mmHg

Yacuum setpoint: | 10 nmHg “E ion and Heating Phases
Evacuation time: I 0 min Hold pressure: I 100 mmHg

I+ Backfill sample tube

Save | Lloze |

4. Enter a description in the Description field. Be sure to use an intuitive description so that
you can recognize it easily.

5. Specify values for the evacuation and heating phases for degassing the sample

6. Click Save, then Close.
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Analysis Conditions

Analysis conditions specify the data used to guide an analysis. An analysis conditions file may
be assigned a unique name, and you can direct any sample to be analyzed according to the
conditions in any existing analysis conditions file. Chapter 5 provides a detailed description of
the fields on this dialog.

1.

Select File > Open > Analysis Conditions; the Open Analysis Conditions File dialog is
displayed.

Enter a name (up to eight characters) in the File name field, then click OK.

Click Yes to create the file; the Analysis Conditions dialog is displayed.

Analysis Conditions
Description; l Replace. .. |

Fielative Total |BET |Lang. =] Insert Range... |

Fressure Faore | Suf. | Surf.

[P4Fa) Wol.  |Area |Area | Freund) Temkin| t-Plot | Alpha-S f-Hat’—I Inzert Pledeﬁned...l

1 0.000000001
Ingert |
Delete |
Clear |

Ctrl+down-arrow
to append

[ Absolute pressure
dosing

¥ Use calculation
‘] I v r‘ assignments

Preparation... I Free Space... Poand T... Dosing.... | Eguilihlalion...l Backfill....

Lloze |

Enter a description (up to 42 characters) in the Description field. Use an intuitive
description, one that will help you identify the type of sample you plan to analyze using
these analysis conditions.

Specify points for your pressure table. Use the push buttons adjacent to the table to assist
you in creating your table.

Click Preparation to specify evacuation and leak test values.

Click Free Space to specify how the free space is to be measured.

Click Po and T to specify how the saturation pressure (Po) is to be measured, and the
analysis bath temperature. If you select Absolute pressure dosing, options 1 through 5
are disabled. The Po will be calculated using the analysis bath temperature; enter the

appropriate temperature in the field provided.

Click Dosing to specify dosing options.
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10. Click Equilibration to specify the equilibration interval and its delay time.

11. Click Backfill to specify backfill options.

12. If you wish to use absolute dosing, click the Absolute pressure dosing option.

13. Click Save, then Close.

Adsorptive Properties

Adsorptive properties specify the characteristics of the gases used in the ASAP 2050 System.
Chapter 5 provides a detailed description of the fields on this dialog.

1.

Select File > Open > Adsorptive properties; the Open Adsorptive Properties File dialog
is displayed.

Enter a name (up to eight characters) in the File name field, then click OK.

Click Yes to create the file; the Adsorptive Properties dialog is displayed.

Adsorptive Properties

Adszorplive: |Nilmgen

Mnemonic: I‘N_Z-_

[ Mo d dsorp
Mazi d p l 123.323 kPa
Density conversion factor: l 0.0015468

Therm. tran. hard-zphere diameter: I 3.860 A
Molecular crosz-zectional area: I 0.162 nm?

Compressibility Factor Table:

Replace... |
Psat ws T_.. |

Dosing Method
' Mormal
" From Psat tube

" Yapor source

Open... Save |
Save | Lloze |

Maximum manifold pressure
Density conversion factor

Enter the name of the adsorptive gas in the Adsorptive field, then enter its mnemonic.

Click Psat vs T to edit the Psat vs Temperature table. Edit any other field(s) on this dialog
as required, then click OK.

Select Non-condensing Adsorptive if the gas is hon-condensing.

Enter the appropriate information (or accept the defaults) in the following fields.
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Therm. tran. hard-sphere diameter
Molecular cross-sectional area

8. Click Open and select the compressibility factor table for gas to be used for analysis.

9. Choose your preferred dosing method; choose Normal for gases under pressure.

Report Options

Report options specify the types of reports to be generated from an analysis or manually
entered data. They also help you customize details of reports such as axis scale, axis range,
column headings, and components of thickness curve equations.

You can tailor report options files to accommodate the requirements of your analyses. For
example, you can generate a simple report that lets you determine the basic characteristics of
the sample. Then use that report to make choices about the variables you want to include in
lengthier, more sophisticated reports. You can specify for reports to be generated automatically
after each analysis, or you can generate reports at any time during or after an analysis.
However, a report generated during an analysis only includes data collected up to the time of
the report. Chapter 5 provides a detailed description of the fields on this dialog.

1. Select File > Open > Report Options; the Open Report Options File dialog is displayed.
2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Report Options dialog is displayed.

Report Options

Description: ! Replace... |
v Show report title !
v Show graphic !miclogo.em[ Browse... |

Heighl:l 0.250 in. Widlh:l 2.000 in.

Selected Reports:

Isotherm

Overlays... | Edit... I BET Surface Area
Langmuir Surface Area
Freundlich
Temkin
" Apply th It pirati Hi t-Plot

Inside diameter of sample tube: AIpha_-S Method
f-Ratio Method

I 9.53 'mm BJH Adsorption

BJH Desorption
Horvath-Kawazoe

DFT Pore Size

DFT Surface Energy b

Dubinin

MP-Method hd
Save | Lloze |

4. Enter a description (up to 42 characters) in the Description field. Enter an identifier that
gives a more intuitive description of the file’s contents. For example, BJH Adsorption
Report Options.
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5. Select Show report title and enter the title you wish to appear at the top of the report. Or
deselect this option if you prefer not to have a report title.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can
\ have it display in the report header by selecting Show graphic. Click Browse to
select the file; use the Height and Width fields to specify the size.

6. If you wish to compare the same type of graph from multiple files, click Overlays and
choose the files. Then be sure you edit the graph from the Selected Reports window and
choose Samples from the Overlay drop-down list.

7. Select Thermal transpiration correction if you want correction made for thermal
transpiration in the sample tube, then enter the inside diameter of the sample tube.

Thermal transpiration correction should be used for analyses where the sample
temperature is more than 100 °C below the manifold temperature.

8. The reports that may be generated are listed in the Selected Reports list. Select reports by
double-clicking on the desired report. Reports are deselected in the same manner. A report
is selected when it is preceded by a check mark.

9. You can edit some reports by highlighting the desired report and clicking Edit.

10. Click Save, then Close to save the information and close the dialog.

Using the Cold Trap

The cold trap helps remove oil vapors from the system. It can be used when preparing samples
on the degas ports or when analyzing samples on the analysis port. If should not, however, be
used with gases that could freeze in the cold trap, for example CO, at liquid nitrogen

temperatures.

1. Make sure the Dewar contains enough analysis bath fluid. (Refer to “Filling the Dewar”
on page 3-25.)

2. Hang the cold trap Dewar around the cold trap port as shown below.
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3. Place the cover over the Dewar opening.

Dewar
cover
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Preparing Samples

Care should be taken in conditioning and filling sample tubes. The following guidelines help
ensure accurate, reproducible results.

The weight of the isothermal jacket may vary slightly and cannot be considered as constant;
therefore, do not weigh it with the sample tube set.

The sample tube should be cleaned (using an ultrasonic cleaning unit) and adequately dried
before each analysis to prevent the cross-contamination of samples. The following materials
are recommended for cleaning sample tubes:

* Ultrasonic cleaning unit

 Suitable detergent

 Latex gloves or lint-free cloth

« Isopropyl alcohol (IPA) is preferred for cleaning; acetone or deionized water may be
used if IPA is unavailable

* Nitrogen or helium

e Sample tube brush

1. Ensure that the ultrasonic cleaning unit is clean.

2. Using a ratio of 5 grams of detergent per 500 mL of warm water, fill the bowl of the
ultrasonic unit with enough water to cover the entire sample tube.

3. Ensure that the detergent is dissolved before placing the sample tube into the water. If too
much detergent is used, it may be difficult to rinse from the sample tube.

4. Fill the sample tube with warm water and place it in the bow! of the ultrasonic cleaning
unit. Turn on the ultrasonic cleaning unit for approximately 15 minutes.

5. Using latex gloves or a lint-free cloth, remove the sample tube from the bowl.
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6. Clean the interior of the sample tube with the brush supplied in the accessories kit.

7.

If isopropyl alcohol is unavailable, acetone or deionized water may be used to rinse

\ the sample tube. Do not use any corrosive cleaning agents. They may reduce the
integrity of the stainless sample tube.

8. Using dry, compressed nitrogen or air, dry the interior of the sample tube. Use a tubing
extension long enough and small enough in diameter to fit inside the sample tube.

Wipe a stopper or seal frit with a lint-free cloth. Place the stopper or seal frit on the sample
tube.
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Determining the Mass of the Sample

N

A form to help you determine the sample’s mass is provided in Appendix A. Make
copies of this form and use it for your convenience.

mass of the empty sample tube.

~Na -,{ﬂ'-

2. Remove the sample tube from the balance.

3. Place a sample container onto the balance. Zero the balance and allow it to stabilize.

1. Place the sample tube (with stopper or seal frit) onto the balance. Record the value as the

4. Slowly add the sample to the container. This step enables you to control the size of the
sample before it is poured into the prepared sample tube. Do not record the sample mass at

this point.

3-18

Jul 07



ASAP 2050 Operator’'s Manual Preparing Samples

5. Remove the stopper from the tube. Carefully pour the sample from the container into the
sample tube. Use a pipe cleaner to clean the walls of the sample tube before weighing the
sample.

6. Replace the stopper or seal frit on the sample tube.

7. Place the sample tube onto the balance. Determine the mass of the sample tube (with
stopper) and sample. Record the value as the Sample plus sample tube mass if you are
using the Sample Mass form from Appendix A.
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Degassing Samples on Degas Ports

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere.
The sample must be clean when an analysis is performed. The sample is heated and placed
under vacuum to remove moisture and other contaminants. This process is referred to as
degassing the sample. You may degas up to two samples at one time using the degas ports.

1. Insert the heating mantle thermocouple plug into the thermocouple connector above the
degas port to be used. Insert the heating mantle power plug into power connector and twist
to lock securely.

Heating mantle thermocouple

— Heating mantle power plug

2. While holding the degas port plug, remove the connector nut and plug from the degas port
by turning the connector nut counterclockwise.

Connector nut

Port plug
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3. Place the connector nut, and, if used, seal frit, onto the sample tube. Make sure the O-ring
is in place on the sample tube as shown below.

—
-

— Seal frit

— O-ring

I — Connector nut

4. Attach the sample tube to the degas port. Be sure to push the sample tube in to a full stop.
Secure the sample tube in place by sliding the connector nut up to the degas port and

turning the connector nut clockwise. Tighten the nut securely by hand.
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5. Slide the heating mantle around the sample tube with the heating mantle hook toward the
back.

Heating mantle hook

6. Attach the elastic cord to the hook on the heating mantle and to the hook on the front panel
of the instrument; then secure the mantle with a heating mantle clip as shown below.

Front panel hook

Elastic cord

Heating mantle hook

Heating mantle clip
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7. Select Start Degas from the Unit menu; the Start Degas dialog is displayed.

Il Automatic Degas {Unit 1 - 5/N: demo)

1 Sample i Browse._. |
Degas conditions: | Degas Conditions j| Clear
2 Sample Browse. .
Degas conditions: | Degas Conditions L“ Clear
Start | Lancel |

8. Click Browse to the right of the Sample field to choose your degas file.
Repeat this step if you are degassing two samples.

9. Click Start to begin the degassing operation.

\ Observe the status bar of the degassing operation to determine when degassing is
complete.

10. After degassing has completed, allow the heating mantle and sample tube to cool.

Do not touch the sample tube or the heating mantle until they have reached room
temperature. Touching the sample tube or heating mantle could result in burns.

11. After the heating mantle has cooled, carefully remove the heating mantle and allow the
sample tube to cool to room temperature (approximately fifteen minutes).

12. When the sample tube has cooled, transfer it to the analysis port (refer to “Transferring a
Degassed Sample to the Analysis Port” on page 3-26).
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Filling the Analysis Dewar

Precautions

A

Always handle Dewars with care. Any product incorporating a vacuum is a potential
safety hazard and should be treated with caution.

We recommend the following be observed when handling Dewars containing liquefied gases:

Protect yourself by wearing 1) goggles (or a face shield), 2) an insulated or rubber
apron, and 3) insulated gloves.

When pouring liquefied gases from one container to another: 1) cool the receiving
container gradually to minimize thermal shock, 2) pour the liquefied gas slowly to
prevent splashing, and 3) vent the receiving container to the atmosphere.

Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases
(or other materials of extremely low temperature). Do not use a glass or metal stirring
rod unless it is coated with some form of protective coating.

Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover
over the Dewar’s opening. If an object of sufficient weight is accidentally dropped into
the Dewar, shattering may occur.

Always install the Dewar cover before performing an analysis. The cover reduces the
accumulation of ice. Accumulated ice could cause the Dewar to bond to the sample
tube.
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Filling the Dewar

1. Fill the analysis Dewar with the cryogen to about 5 cm (2 inches) from the top.

\ Incorrect fluid levels can lead to measurement errors. Do not overfill the Dewar.

2. Check the analysis bath fluid level with the dipstick as shown below.

Maximum Level
Indicator Mark

Analysis Dewar

Wetness or frozen
condensation indicates
bath liquid level.
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Transferring a Degassed Sample to the Analysis Port

The sample tube must be removed from the degas port, weighed and then installed onto the
analysis port for analysis.

If the sample tube is not mounted to the analysis port immediately, either leave it on

the degas port or remove it and insert the rubber stopper (unless you are using a
seal frit) into the sample tube opening.

1. Make sure the sample tube has cooled to room temperature.

2. While holding the sample tube, loosen the port connector nut and remove the sample tube
from the degas port. If you are not using a seal frit, insert a stopper immediately. Remove

the connector nut from sample tube stem.
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3. Weigh the sample tube set. Enter the weight on the Sample Data Worksheet as Mass of
sample tube plus sample (After Degas).

4. Subtract the Mass of empty sample tube (Before Degas) from the Mass of sample tube plus
sample (After Degas) to determine the mass of the sample. Record this value as the Mass
of sample (After Degas).

5. Remove the connector nut, and, if installed, the port plug, from the analysis port by
turning the connector nut counterclockwise.

Connector nut

Port plug
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6. Remove the stopper from the sample tube and immediately attach the sample tube to the
analysis port, pushing it fully up into the port. Secure it in place by screwing the connector
nut onto the analysis port connector; hand-tighten the connector nut.

\ You do not have to remove the seal frit (if one is used).

7. If you wish to degas the sample on the analysis port, proceed to “Degassing a Sample on
the Analysis Port” on page 3-31.

If you wish to perform an analysis, slide the isothermal jacket up over the sample tube.
Make sure the saturation pressure tube is close to the sample tube.
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8. Place the analysis Dewar on the elevator as shown in the following illustration.
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9. Place the Dewar cover over the sample tube stem just above the isothermal jacket as
shown below.

11. Begin the analysis. Refer to “Performing an Analysis” on page 3-37.
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Degassing a Sample on the Analysis Port

In addition to preparing a sample on a degas port, you may further evacuate the sample on the
analysis port prior to starting an analysis.

1. With the sample tube attached to the analysis port (refer to “Transferring a Degassed
Sample to the Analysis Port” on page 3-26), select Unit [n] > Show Analysis
Schematic, then select Unit [n] > Enable Manual Control. The Manual Control screen is
displayed.

2. Openvalves 7,9 and 2.

3. Wait until the value displayed for the transducer is below 10 mmHg.

4. Open valve 1.

ﬁilnstrument Schematic (Unit 1 - S/N: 101)

| Preliminary Analysis Termination
Sample
Stage Last Point P [mmHg] FP/Po B [mmol/g] Po [mmHg] Run Time

Idle
Details: |

5. Evacuate until the vacuum gauge reaches vacuum and no leaks are indicated on the gauge.
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6. Insert the heating mantle thermocouple plug into the thermocouple connector behind one
of the degas ports. Insert the heating mantle power plug into the associated power
connector and twist to lock securely.

Heating mantle thermocouple

Heating mantle power plug

7. Slide the heating mantle around the sample tube with the heating mantle hook toward the
back.

8. Attach the elastic cord to the hook on the heating mantle and to the hook on the front panel
of the instrument, then attach a heating mantle clip as shown below.

Instrument hook

Elastic cord

Heating mantle clip

9. Gently heat the sample:
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a. Select Unit [n] > Degas > Show Degas Schematic to display the Degas Schematic.

b. If the analyzer is not in manual control mode, select Unit [n] > Degas > Enable
Manual Control.

c. Right-click on the degas port to which the heating mantle power plug and thermocouple
are connected, then select Set.

i Deqas Schematic (Unit 1 - 5/N: 101)

D5

760 mmHg

¥,

D7
Backfill —(D_

D1

Cumrent = 25°C Current =

Sample: ST i = B
Status:  Idle Uzey | skip | Cailsel |
Sample: = ;

Status:  Idle CHEDE: | iy | Caeel |

d. The Heater Settings dialog is displayed. Enter 10 °C/min. for Ramp rate.
e. Enter 150 °C for Target temperature.

Il Port 2 Heater Settings

] 10.0 “C/min
Target temperature: I m e

|Enter a value between 20 and 450.

Hamp rate:

Lancel |

f. Click OK.

10. Allow the sample to degas for a minimum of one hour. (Additional time may be required
to fully degas the sample.)
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11. Right-click on the degas port sample tube, then select Disable.

i Deqas Schematic (Unit 1 - 5/N: 101)

D5 760 mmHg
v | |
D1

D7
BackFill —(D_ . X

Cumrent = 25°C Current =
Target =
Ramp = 9.0 *C/min

Sample: .
Status:  Idle Check | Skip | Cancel |
Sample: :
Status:  Idle Check | Skip | Cancel |

Do not touch the sample tube or the heating mantle until they have cooled.
Touching the sample tube, heating mantle, or heating mantle clip before they
have cooled could result in burns.

12. When the heating mantle is cool enough to handle, remove it from the sample tube.
13. Allow the sample to cool to room temperature.

14. Slide the isothermal jacket up over the sample tube. Make sure the saturation pressure tube
is close to the sample tube.
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15. Place the analysis Dewar onto the elevator as shown in the following illustration.

16. Place the Dewar cover over the sample tube stem just above the isothermal jacket as
shown below.
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17. Attach the safety shield to the two hooks above the port.

18. Begin the analysis. Refer to “Performing an Analysis” on page 3-37.
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Performing an Analysis

N

After the sample has been degassed and transferred to an analysis port, you may begin an

analysis.

Before beginning an analysis, make sure the tank pressure for the gas regulator is at
least 200 psig (1379 kPa). Pressures less than 200 psig (1379 kPa) may cause the
sample to be inadequately saturated, resulting in inaccurate data or termination of

analysis.

Ensure that the analysis gas and the Psat gas specified in the sample file match the system
configuration gases; if they do not, correct the sample information file or correct the unit

configuration gas.

Perform the following steps to begin an analysis:

1. Select Unit > Start Analysis; the Analysis dialog is displayed with the Start Analysis

dialog positioned on top.

2. Choose a file for your analysis and click OK; the Analysis dialog containing the

parameters of the selected file is displayed.

% analysis (Unit 1 - 5/N: 123)

View: | Operation _v_ﬂ

Browse |

Sample: ]uuu-um

Mass: I 1.0000 g Density: I 1.000 cm?ig
Sample Tube:
[sample Tube =l pt-| 101.3250 kPa
Analysis Conditions: Bath temperature: i 77.300 K
|F|un Conditions ;ﬂ Ambi o : 298.00 K
Adsorptive Properties:
|Nilmgen L" Ambient free space: i 16.0000 [cm?
Report Options: Analpzis free space: l 450000 cm?
|Hepoll Options _:!|
Report After Analysis__. |
e | §la" ............ | = | R |
Preliminary Analpsis | Termination
Sample 0o0-001
Stage Last Point p [kPa] pip* @ [mmol/g) p° [kPa] Run Time
Analysis 10 of 30 73.3273200 0.777000000 1.02614 101.3250 2:23
Details: |

3. Verify parameters and make any changes you feel necessary.
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4. To generate a report automatically after the analysis, click Report after Analysis and
choose report output options. You can generate reports to the screen (Preview) or directly

to a printer.

conditions can result.

Make sure the elevator is all the way down. If it is not all the way down, hazardous

5. Click Start to begin the analysis.

6. Until data collection begins, the following message is displayed on the screen.

Mo lzotherm D ata Available.

7. As data are collected, a graph will be drawn in the window.

& Analysis (Unit 1 - 5/N: 101) 10l =|

Yiew: LI Suszpend | Skip | Report I

Isotherm Plot
a H
= H
m \
=2 H
E :
= :
i) 1
= 1
5 :
= 1
< ol
= H
= '
o 1
B 1
< H
il 00 1,000 1,500 2,000 2,500 3,000 3,500 4,000 4,500 5,000
Absalute Pressure (mmHg)
<< Prev | Start I LCancel Cloze |
Preliminary Analpsis Termination |
Sample REDO-2
Stage Last Point P [mmHg] P/Po B [em*/g 5TF] Po [mmHg] Run Time
Termination 50 of 50 216834305 0.216834305 151376 1000.000 2:27
Details: [Walming zample. Waiting for less than 760 mmHg for 509 seconds. |

8.
the first view of the Analysis dialog is displayed.

If you wish to perform another analysis after the current analysis is completed, click Next;

damage to the elevator mechanism.

After the elevator rises, do not place any items under the elevator platform. Objects
under the platform will prevent the elevator from fully lowering, and could cause
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The ASAP 2050 can operate in a pressure range from 0 to 10 atm; therefore, ensure
that the sample tube is not under pressure when removing it from the instrument. Use

caution appropriate for these types of devices.

Printing File Contents

You can print the contents of one or more sample or parameter files.
1. Select File > Print; a drop-down list containing file types is displayed.

2. Choose the file type; a dialog similar to this one is displayed.

Il Print Analysis Conditions File

File name: IEIE—

- Sel Criteria Settings
Copies I 1 j
Destination | Printer ;]
Date Range... | File name |C:\DEMO2050\PARAM\*
. Directories:
Files: X
c:\___\param
13zarlar.anc 13X, argon, @ 87 29 K N [N] -
13xarin2.anc 13X, argon, & 77 .35 K “r-al
alumina.anc  Alumina, krypton, @ 77.35 K [-c-]
bjhads42 anc BJH Adsorption, 42 Point, using Nitrogen [-d-]
bjhdes43.anc BJH Desorption. 43 Point. using Nitrogen [-g-1
charcoal.anc Charcoal. CO2, @ 27315 K [-h-]
kblank.anc Krypton Blank ~All-g-1
kstdrd.anc Krypton Standard
nblank.anc Mitrogen Blank Tube Run
nstdrd_anc Mitrogen Standard
silalumf.anc  Silica Alumina, isotherm, N2 @& 77 K
zilalums ane Silica Alumina Surfare Area N2 @ 77 K _ILI
[ r | » =

Lancel |

3. From the Files list box, select the desired file. If you plan to print multiple files, hold down
Ctrl while clicking on the desired files.

You can use the Status drop-down list and/or the Date Range push button to limit the
\ files displayed in the Files list.

4. Choose whether you wish to print the contents to the screen (Preview) or to a printer

(Print). If you choose Print, the Copies field is enabled allowing you to print up to four
copies.

5. Click OK; the file is printed to the specified destination.
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Listing File Statistics

You can generate a list of the following information on a sample file or parameter file.

* File name

Date the file was created (or last edited)
Time the file was created (or last edited)
File identification

File status

1. Select File > List.

2. From the List drop-down menu, select the type of file on which you wish information. A
dialog similar to the one shown below is displayed:

Displays the type of file M List Sample Information File -
on which you requested
information; in this File name: [T
example, a sample - Selection Criteria Settings
information file Copi 1=
Status: | Complete Ll Shees =
Destinati < ;]
Date Range... | File name |C:\DEMO2050\DATANFIL
Files: Directories:
L c:h..\data
13x_ar.smp 13X Reference Material [AR] = [..1 a

13x_n2 smp 13X Reference Material [N2]
13xarex.smp 13X Reference [Ar] [example)
13xco2ex.smp 13X Ref [CO2) [E le]
13zn2ex.smp 13X Reference [N2] [example]

E-I-a -l -Sr iy

o
Lancel |

3. From the Files list box, choose the desired file(s). If you wish to include all files, leave all
files deselected.

4. Choose whether you wish to print statistics to the screen (Preview) or to a printer (Print).
If you choose Print, the Copies field is enabled allowing you to print up to four copies.

5. Click OK, a list for the requested file(s) is sent to the specified destination.
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Exporting Isotherm Data

The Export option on the File menu allows you to copy the isotherm data in the sample
information file and reformat it in ASCII text. If saved to a File, the data can be imported into
applications, such as spreadsheets. The output file consists of four columns containing the
absolute pressure, relative pressure, specific volume adsorbed, and the elapsed time.

1. Select File > Export; the Export Sample Information dialog is displayed.

Ml Export Sample File
File name: Im
i~ Selection Criteria - Settings
E T H
Status: | Complete = xport Type | Isotherm =l
Copies 1

Lo

Date Range... | Destination Screen

File name | |C:\DEMOZ2050\DATAN" |

. Directories:
Files: c:h.. Adata
13x_ar.smp 13X Reference Material [AR]
13x_n2 smp 13X Reference Material [N2]
13xarex.smp 13X Reference [Ar] [example)
13xco2ex.smp 13X Ref CO2) (E le]
13xnZex.smp 13X Reference [N2] [example]

b

| v

E-I-o - -Sr iy

Lancel |

2. From the Files list box, choose the file(s) you wish to export. You can select multiple files
by holding down Ctrl while clicking on the desired files.

You can use the Status drop-down list and/or the Date Range push button to limit the
\ files displayed in the Files list.

3. Choose an output destination. When you choose File as the destination, the File name
field is enabled so you may enter a name (or you can accept the default). If you have
selected multiple files, each file is exported as its file name with the extension .1SO.

4. Click OK; the file(s) is exported to the specified destination.
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Generating Graph Overlays

Use graph overlays when you wish to compare graphically results for multiple samples or
multiple graphs for one sample. Graphical lines are differentiated by the use of varying
symbols and reported in a legend on the report. If color output capability is available, different
colors are used instead of symbols.

Graph overlays can be implemented in two ways:

» Multiple Sample Overlays
Overlay results for up to eight samples on top of a previously selected sample.

» Multiple Graph Overlays
Overlay two different types of graphs from one sample. The multiple graph overlay
capability exists for:

BJH Adsorption/Desorption
DFT Pore Size/Surface Energy

You cannot overlay graphs if your sample file presentation is in the Basic format. You must
switch to the Advanced format before proceeding.

Multiple Samples Overlay

1. Select File > Open > Sample Information to display the Open Sample Information File
dialog.

2. Select a sample on which to overlay graphs of other samples, then click OK; the Sample
Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog.

(RN Tl Report Options Replace. .. |
¥ Show repot litle !
Graphi
¥ Show graphic !miclngn,emf Browse. .. |

Height: 0.250 in. Width: 2.000 in.

Selected Reports:
Summary -

> Isotherm
Overlays... I Edit... I BET Surface Area

Langmuir Surface Area
Freundlich

Temkin

" Apply thermal transpiration comection t-Plot

Inzide diameter of sample tube: AIpha_—S Method
f-Ratio Method

9.53 'mm BJH Adsorption
BJH Desorption
Horvath-Kawazoe
DFT Pore Size
DFT Surface Energy
Dubinin
MP-Method =

Save LCloze

3-42 Jul 07



ASAP 2050 Operator’'s Manual

Generating Graph Overlays

4. Make your report selections (or deselect any you do not wish to generate).

5. Choose the type of report for which you wish overlays; perform the steps indicated:

BET/Langmuir surface area
F-ratio

If overlaying this Then...

type of report...

Alpha-S Select the report for which you want an overlay, then click
Isotherm Edit. A report options dialog for that report is displayed.

Select Overlay Samples and do any other editing you wish.

Freundlich Click OK; the main Report Options dialog reappears.
Temkin

t-Plot

Dubinin Select Dubinin, then click Edit; a Report Options dialog for

Dubinin is displayed.

Select the desired graph, then click Edit. An options dialog
for that graph is displayed (for example, dV/dw Pore
\Volume).

Select Overlay Samples and do any other editing you wish.

Click OK; the options dialog for Dubinin reappears.

Click OK; the main Report Options dialog reappears.

BJH Adsorption
BJH Desorption
DFT Pore Size

DFT Surface Energy

Select the report for which you want an overlay, then click
Edit. A Report Options dialog for that report is displayed.

Select the desired report, then click Edit. An options dialog
for that graph is displayed.

Click on the down-arrow at the Overlay field and select
Samples; do any other editing you wish.

Click OK; do any other editing you wish.

Click OK; the main Report Options dialog reappears.
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6.

7.

10.

11.

Click Overlays; the Graph Overlay Samples dialog is displayed.

M Graph Overlay Samples
Sample 1 [C:\DEMO2050\DATAV13X_N2.SMP B,.,..,se___| Clear |
Sample 2 [C-\DEMO2050SDATANA-AL_N2.SMF [(Browse.|  Clear |
Sample 3 | Browse.. | Clear |
Sample 4 | Browse.. | Clear |
Sample 5 | Browse.. |  Clear |
Sample § | Browse.. | Clear |
Sample 7 | Browse.. | Clear |
Sample 8 | Browse.. | Clear |

**Heminder=  You must select which graphs are to be
overlaid by selecting the Overlay samples on each Selected
Report in the Report Options.

Lanicel |

Click Browse to the right of the Sample 1 field; the Plot Overlay Sample Selection dialog
is displayed.

Il Plot Overlay Sample Selection
File name: Im

- Selection Criteria

Status: |All _:J

Date Range... |
Directories:

Files: c:h_Adata

13x_ar.smp 13X Reference Material [AR)
13x_n2 smp 13X Reference Material [N2)
13xarex.smp 13X Reference [Ar] [example]

13xcoZex smp 13X Ref [CO2) [E le]

13xnZex.smp 13X Reference [N2] [example]

a-al_kr.smp Alumina Reference Material [Kr]

a-al n2.smp  Alumina Reference Material [N2)

a-alkrex.smp  Alumina [Kr) [example] e
d-4dcnZex.smp D-4 Carbon [example]

krmem102. smp MCMA41 102 K [Kr) [heat of adsorption)
kimecm110.smp MCMA41 110 K [Kr) [heat of adsorption)

klr\r:m1 2N =mn MCMA1 120 K (K5l Theat of adsorntinnl L'L'
4

Lancel |

| v

2788000

Choose a sample file, then click OK. You may choose up to eight files in this manner.

After selecting the desired number of sample files, click OK; the main Report Options
dialog reappears.

Click Save if you wish to save your Selected Reports list. Even if you don’t save, all of the
options you selected regarding overlays and other items are included in the report you
generate.

Select Reports > Start Report; the Start Report dialog is displayed with the name of your
primary file highlighted.
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Generating Graph Overlays

12. Click OK; the Select Reports dialog is displayed.

13. Ensure that the desired graph is selected (preceded with a check mark), then click OK.

Multiple Graphs Overlay

Multiple graph overlays can be produced only for:

» BJH Adsorption

* BJH Desorption

» DFT Pore Size

» DFT Surface Energy

1. Select File > Open > Sample Information to display the Open Sample Information File

dialog.

2. Select a sample for which you want to overlay two graphs; then select Edit; the Sample
Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog.

[\ DEMD2050" DATA!, 13X _N2.5MP

o=|

< Prev | Sample Sample
Informatior] Tube

Conditions

[Degas Analyziz
Conditions

Adsorptive] Report
Fropertiez | Options

Collected Mext 2>
e | e ]

DOxverlays... |

Iv Apply th

v Show report title

v Show graphic

Description: 13X Reference Material [N 2} Replace... |

itics Insh

t C

SGranhi

Imiclogo.em[

Heighl:l 0.250 in.

Widlh:l 2.000 | in

Browse. .. |

Edit... |

Ingide diameter of zample tube:

l 953 mm

Selected Reports:

+ lsotherm
BET Surface Area
Langmuir Surface Area
Freundlich
Temkin
t-Plot
Alpha-§ Method
f-Ratio Method
BJH Adsorption
BJH Desorption

+ Horvath-Kawazoe
DFT Pore Size
DFT Surface Energy
Dubinin
MP-Method

|

Save |

Lloze |

Basic |

4. Make your report selections (or deselect any you do not wish to generate).
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5. From the Selected Reports list, select the report for which you want multiple graph
overlays, then select Edit; a Report Options dialog for that report (or graph) is displayed
(this example shows BJH Adsorption).

ﬁ BJH Adsorption Report Oplions

[ VL s (e Minimum BJH width: | 17.000 A
" Reference
Maximum BJH width: I 3000.000 A

Fraction of pores open I—
i at both ends: 0.00
~ Harking and Jura

" Broekhoff-de Boer Adsorptive... |

" Carbon Black STS5A = =
[~ Smooth differentials

Edit._. |

~ BJH Correction

" Kruk-Jaroniec-5 ayari

Selected Reports:

+ BJH Tabular Report

" Standard + Cumulative Pore Yolume

" Kruk-Jaroniec-Sayari | |+ d¥/dw Pore Yolume

= + d¥¥/dlog[w) Pore ¥Yolume Edit

& Faas + Ci lative Pore Area ;I

+ dA/dw Pore Area

Pressure Range. .. | + dA/dlog[w) Pore Area

LCancel |

6. Select a report type, then click Edit; an options dialog for that specific item is displayed
(this example shows Cumulative Pore Volume).

X-Axis
" Linear (* Logarithmic
¥ Autoscale | 1.00) to 1000.00 | nm
Y-Axis
| — Wariable: |l'_‘ lative Pore Volume _L“
These two graphs <]
will be overlaid | Overlay: |d\l"fdw Pore Yolume _'J|
v Autoscale ! 0.0000 || to 9939.0000 | emétg
ol |

7. Click the down arrow at the Overlay field and select a graph type from the list. This
selection will be overlaid on the graph selected in the Variable field.

8. Select OK to return to the BJH Adsorption Report Options dialog; do any editing you
wish.

9. Click OK to return to the main Report Options dialog.
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10.

11.

12.

13.

Click Save if you wish to save your Selected Reports list. Even if you don’t save, all of the
options you selected regarding overlays and other items are included in the report you
generate.

Select Reports > Start Report; the Start Report screen is displayed with the name of your
primary file highlighted.

Click OK; the Select Reports dialog is displayed.

Ensure that the desired graph is selected (preceded with a check mark), then click OK.
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4. SOFTWARE AND SETUP MODIFICATIONS

This chapter provides instructions for:

* Installing the software
» Using the Setup Program for other functions

Installing the Analysis Program

Power option features must be properly set to enable communications between the analyzer
and the computer. Set these features as follows:

1. From the Windows Start menu, select Settings > Control Panel > Power Options.

2. Select Never from the drop-down lists for all Power Scheme options except the monitor.
You may select any setting you wish for the monitor.

Initial Installation

The ASAP 2050 System program is supplied on a CD. Perform the following steps to install
the program:

1. Turn on the analyzer.

2. Insert the CD into the CD-ROM drive.

Proceed to Step 4 if AutoPlay is enabled on your computer; Setup will start
\ automatically and display the New Installation dialog.

3. Select Start from the Status bar, then Run from the Start menu.
Enter the drive designator for the CD-ROM drive, followed by setup. For example:
e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select
setup.exe.

4. Click OK; the New Installation dialog is displayed.
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Displays the amount of current
disk space and the amount
required for installation of the
application. Also displays the
directory into which the
application will be installed.

New Installation

u
- - -
D'" micromeritics’
YWelcome to the Micromeritics application setup program. This program provides installation and configuration

operations for ASAP 2050 Yersian 1.00.

Setup will install this application in the following folder. To install into a different folder, click Browse. and select another
folder. You can choose to notinstall this application by clicking Exitto exit Setup,

 Destination Folder

cA\2050 Browse.. |

Disk space required: 13414 k
Digk space remaining 15257868 |k

Select this option to add the
ASAP 2050 icon to your desktop
for quick access to the application.

v Add the application icon to the Desktop so you can run the application from there

Select{ enter the name of the Start Menu Programs folder to which the application icon will be added

|M\crnmerilics :] ¥ Install this spplication for All Users

Exit |

You may cancel the installation at any time by selecting Exit. If you do so, you must

\ start the installation program from the beginning to install the analysis program.

The Destination Folder group box displays the amount of current disk space, the amount
of disk space required for the analysis program, and the directory into which the
application will be installed. If you wish to install the application into a different directory,
click Browse to choose the directory.

5. If you want to run the application from the desktop, select the check box just below the
Destination Folder group box to add an icon.

6. The ASAP 2050 icon is added to the Micromeritics folder by default. If you prefer a
different folder, enter or select one from the drop-down list.
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7. Click Next; the Analyzer Configuration dialog is displayed.

Analyzer Configuration
]
- - -
M] micromeritics’
FStepl ~Step 2

Selectthe number of Far each unit. enter the necessary information helow.

analyzers thaFW'” be The analyzer setial number is on the analyzer identification label, typically
attached to this PC. located near the power switch.

Sl e Enterthe communications port number only, for example, 1 for COR1

thatyou are doing
offline data reduction

an this PC or you are Unit Analyzer Communications
moving an anslyzer # Serial # Port#
from another PC o this iE =
PC 1 | [
Analyzers: ]

£

In the Step 1 group box, click the radio button for the number of analyzers to be attached to
this computer. If you are attaching two analyzers, make sure your computer has two serial
ports.

Choose 0 (zero) if you are installing this program for data reduction on a computer
other than the one controlling the analyzer.

8. Inthe Step 2 group box, enter the analyzer serial number and the communications port to
which it will be attached for each analyzer.

9. Click Next; the Calibration File Installation dialog is displayed. Read the information in
the dialog and proceed accordingly.

If you selected zero (0) as the number of instruments to install, the Calibration dialog
is not displayed.

10. After the calibration files are installed, the Installation Complete dialog containing the
Readme file is displayed.

11. Use the scroll bar if you want to read the contents of the file, then click Finish to close the
dialog.
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12. Remove the Setup CD and store in a safe place. The original Setup CD contains the
calibration files specific to your instrument. Upgrade CDs do not contain calibration files.
Therefore, it is important that you maintain your original Setup CD in a secure location in
the event calibration files need to be reinstalled.

Using the Setup Program for Other Functions

After initial installation of the ASAP 2050 analysis program, the application setup program
can be used to:

» Upgrade software

* Add an analyzer

» Move an analyzer from one computer to another computer
* Remove an analyzer from the computer

» Change the analyzer setup

* Reinstall calibration files

 Uninstall the analysis program

To start the application setup program:
1. Ensure that the analysis program is not operating.

2. Insert the CD into the CD-ROM drive.

Proceed to Step 4 if AutoPlay is enabled on your computer; Setup will start
\ automatically and display the New Installation dialog.

3. Select Start from the Status bar, then Run from the Start menu.
Enter the drive designator for the CD-ROM drive, followed by setup. For example:
e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select
setup.exe.

4. Click OK; the setup Welcome screen showing the options available is displayed.
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Using the Setup Program for Other Functions

Welcome

[M] micromeritics®

YWelcome to the Micromeritics application setup program. This program provides installation and configuration

operations for ASAF 2050 Version 1.00.

- Selectwhich operation you wish to do
& Re-install software version 1.00
 Add an analkyzer
 Mowve an analyzer from one FCto another FC
£ Bemave an anglyzer

7 sk setup

tian files farah analyzer
 Uninstall

€ Beset security o default

Startfile installation

Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any
status files that do not already exist on the computer. Existing analyzer status files are not
affected and default and data files are not overwritten. There are three types of subsequent
installation; the software version controlled by the setup program is:

* a later version than the version installed on the computer
« the same version as the version installed on the computer
« an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the
selection in the Setup dialog accordingly.

1. Start the Setup program. Choose the software option; remember, only the applicable
option will display; it will be one of the following:

» Upgrade software to version (number) from version (number)
 Reinstall software version (number)
» Downgrade software to version (number) from version (number)

2. Click Start File Installation; the application installs the software and redisplays the setup
Welcome dialog. If no other operations are desired using this dialog, click Exit to close the

dialog.

Jul 07



Using the Setup Program for Other Functions ASAP 2050 Operator’'s Manual

Adding an Analyzer

Add an analyzer to the existing application as follows:

1. Start the Setup program. Select Add an analyzer, then click Next; the Setup analyzer
dialog is displayed.

[M] micromeritics®

Forthe analvzer being added. enter the necessary information below. The anakyzer serial number
is on the analyzer identification label, typically located near the power switch

Unit Analyzer
# Serial #
2
“rou must enter a serial number,
< Back [alext > Cancel

2. Enter the serial number of the analyzer being added, then the communications port to
which it is to be connected.

3. Click Next; the Calibration Installation dialog is displayed.

4. Select the location of the calibration source files. If the calibration files are located in a
directory other than the one displayed, click Browse to select the directory. Click Finish;
a media change dialog is displayed.

5. Click OK to install the calibration files. A dialog containing the Readme file is displayed
after the calibration files are installed.

6. Click Exit to close the dialog.

Moving an Analyzer from one PC to another PC

You can move an analyzer, along with its status and calibration files, from one computer
(Source PC) to another computer (Destination PC).

This operation does not move sample or parameter files. To move these files, use a
\ file management program such as Explorer or a backup/restore utility.
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1. Install the application program on the destination computer. Refer to Installing the

Analysis Program on page 4-1.

If the analysis program is already installed on the destination computer, proceed to Step 2.

2. Start the application setup program on the source computer. Refer to Using the Setup

Program for Other Functions on page 4-4.

3. Inthe Setup dialog, select Move an analyzer from one PC to another PC, then click

Next; the Move analyzer operation dialog is displayed.

Mowe analyzer operation

u
- - -
mM] micromeritics’
The Move anabszer operation is done following these steps.

1. Install the analyzer software on the Destination PC if itis not already installed there. Ifthe Destination PC
already has the meximum number of analyzers a move cannot be done

2. Proceed with the Mowve operation on the Source PC - this will gather the necessarny information and files to be
moved 1o the Destination PC.

3. Run the setup program on the Destination PG and select the Move operation

4. Ifyouwant to copy or mowve sample or parameter files you will hawve to do that using & file management
program like Explorer ar a hackup / restore utiliby.

Is this the Source PC or the Destination PC?

" Destination PC

4. Select Source PC, then click Next; the following dialog is displayed.

Choose location for the files associated with the analyzer being moved

[M] micromeritics®

~Step 1
Selectwhich analyzeris to be moved from this PC:

Unit 1: S/ 101

~Step 2
Choose where the analyzer-being-moved files will be stored
To select a different drive { folder, click Browse, and make vour selection .

c Browse

It possible, selecta floppy drive of & network drive accessible by both the Source and Destination PCs.

[tthe files to-be-moved cannot fit on & floppy naris there & common network drive accessible by both the Source

—and Destination FCs, you must choose a local folder (which should hawve nothing in it). After the files are placed
there wou must use afolder transfer utility to copy this folder from the Source PC1a the Destination PC (a backup /
restore prograrm can do this operation). Then run this setup prograrm an the Destination PC and proceed with the
Mowe operation.

Jul 07
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In the Step 1 group box, select the analyzer that is to be moved.

Start the application setup program on the destination computer.

10. Select Destination PC, then click Next; the following dialog is displayed.

Move analyzer information to this PC

[M] micromeritics®

For the analyzer being moved to this PC. enter the necessary information below

~Step 1
The analyzer serial nurmber is on the analyzer identification label, typically near the power switch

Unit Serial #
+

3 l\—

You rust enter a setial number

—Step 2
Specify where the analyzer-being-moved files are located
To select a different drive / folder, click Browse, and make your selection

‘ ch Browse.. | ‘

In the Step 2 group box, choose a location in which the moved files will be stored. If
possible, choose a diskette drive or a shared network drive. If this is not possible, select a
local folder. After the files are placed there, use a folder transfer utility (for example,
Backup and Restore) to copy this folder from the Source PC to the Destination PC.

Click Finish; the files are moved and the setup Welcome screen is displayed.

In the Setup dialog, select Move an analyzer from one PC to another PC; the Move
analyzer operation dialog is displayed (shown on previous page).

13.Click Next; the files are moved and the setup Welcome dialog is displayed.

11. Inthe Step 1 group box, enter the serial number of the analyzer being moved.

12. In the Step 2 group box, click Browse and choose the location of the moved files.

4-8
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Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, the
status files are removed as well.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on
page 4-4.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an
analyzer dialog is displayed.

Remove an analyzer

u
- - -
M| micromeritics’
| [fyour objectve is to move an analyzer fram one PCto anotheryou should use the Mowve operation
tove |
Otherwise, to remove an anakyzet from this PC selectwhich analyzer to remove
Motes: The calibration and status files associated with this analyzer will ke removed

The Unit number assignments will be re-arrranged if the analyzer being removed does
not hawe the highest Unit number.

Unit 1: S/ 107

For example, if Unit#1 is remowved:
Before After
Unit1 = Serial # 1565 Unit1 = Serial # 210
Unit 2 = Serial # 210

3. From the drop-down list, choose the serial number of the analyzer you want to remove.
4. Click Remove; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the dialog.
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Changing an Analyzer Setup

Change the analyzer setup as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on

page 4-4.

2. From the Setup dialog, select Change analyzer setup, then click Next; the Change

analyzer setup dialog is displayed.

Change analyzer setup

[M] micromeritics®

Change any of these item(s) for: Unit 1: 5/ 256

Enter the communcations part numkber only, for example. 1 for COM1
Selectthe model of the analyzer.

Unit 1: S5/ 256

Communications hodel
Fort #
Current: 1
[N e |_ I vl

3. From the drop-down list, choose the analyzer you want to change.

4. Enter the new port number in the space provided.

5. Click Finish; the change is completed and the Welcome dialog is again displayed.

6. Click Exit to close the dialog.

4-10
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Reinstalling the Calibration Files

You can reinstall the files containing an analyzer’s factory calibration data as follows:

1. Start the Setup program. From the Setup dialog, select Re-install calibration files for an
analyzer, then click Next; the Re-install calibration files dialog is displayed.

Re-install calibration files E

[M] micromeritics®

~Step 1
Not shown if only To reminstall calibration files for an analyzer selectthe analyzer: Unit 1: S/ 105
one analyzer is
installed.

~Step 2

Please insert the calibration data medium (or specify the location) for this
analyzer.

Existing calibration files will be backed up

Calibration file source location
’7D:\callb Browse

2. Select the analyzer whose calibration files you wish to reinstall from the drop-down list. If
you have only one analyzer installed, a drop-down list is not included.

3. Insert the CD containing the calibration files; ensure that the CD drive is displayed as the
calibration file source location. If not, click Browse and choose the CD drive.

4. Click Finish; the calibration files are reinstalled and the Welcome dialog is again
displayed.

5. Click Exit to close the dialog.
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Uninstalling the Analysis Program

When you uninstall the ASAP 2050 analysis program, the application removes the analysis
program, status files, analyzer setup files, and resulting empty directories. It does not remove
data files. Perform the following steps to uninstall the program:

1. Start the Setup program. From the Setup dialog, select Uninstall, then click Next; the
Uninstall dialog is displayed.

Uninstall ASAP 2050

[M] micromeritics®

You hawe chosen the uninstall operation. This operation will remowve the ASAP 2050 application files as
well as the analyzer status and calibration files. twill not remowve any sample data or parameter files that

wou hawve created. If any folders become empty as a result of the file remowval the folder will also be
removed.

If wour intent is to mowve an analyzer from this PC to another PCyou should perform the Mowve operation

{press the Mowve button in this case).
Mowve |

Uninstall | LCancel |

2. Click Uninstall; the Select Uninstall Method dialog is displayed.

Select Uninstall Method

‘welcome to the Micromeritics Analyzer Setup uninstall program,

*f'ou can chooge to automatically uninstall this software or to
choose exactly which changes are made to your syzstem,

Select the Custom button to select which modifications are to
be made during the uninstall. Select the Automatic button for
the default uninztall options. Press the Mest button to continue.

i+ Automatic
" Custam

< Back

Cancel
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3. Choose one of the following:

Automatic: click Next; the system uninstalls the analysis program automatically and the
setup Welcome dialog redisplays.

Custom: click Next; a series of dialogs is displayed, allowing you to choose the files you
wish to uninstall. After all files are selected and uninstalled, the setup Welcome dialog
redisplays.

4. Click Exit to close the Welcome dialog.
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5. FILE MENU

The File menu contains commands which allow you to manage sample and parameter files.

Description
Listed below are brief descriptions of the File menu commands. Detailed descriptions follow
this section.
=
Cpen 3
Save
Save As (3
Save Al
Zlase
Elase &l
Prink k
List b
Export...
Exit AlE+F4
Open Opens an existing sample information or parameter file. Page
5-2.
Save Saves the file in the active window. Page 5-81.
Save As Saves the file in the active window as a different name. You
also can use this option to save a subset of the sample file as a
parameter file. Page 5-81.
Save All Saves all open files. Page 5-83.
Close Closes the file in the active window. Page 5-83.
Close All Closes all open files. Page 5-83.
Print Prints the contents of a sample or parameter file. Page 5-84.
List Generates a list of certain information for sample or

parameter files. Page 5-85.
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Export Copies the isotherm data in a sample information file and
exports it in ASCII format. Page 5-86.

Exit Exits the analysis program. Page 5-88.

Open
Open allows you to create a new file or edit an existing one. The following file types are
available:
» Sample information
» Sample tube criteria
 Degas conditions
* Analysis conditions
» Adsorptive properties
» Report options
Regardless of which file type you select, a dialog similar to the one shown here is displayed:
Il Open Sample Information File -
File name:
- Sel Criteria
Status: |All _:l
Date Range... |
Directories:
Files: c:h_Adata
13x_ar.smp 13X Reference Material [AR] N [N] -
13x_n2 smp 13X Reference Material [N2] “-al
13xarex.smp 13X Reference [Ar] [example) [-c-]
13xco2ex.smp 13X Ref [CO2) [E [-d-]
13xnZex.smp 13X Reference [N2] [example] [-g-]1
[-h-]
| [-a-]
< |L|_| .:j
File name For sample information files, this field contains the next
sequenced file name (as specified in sample defaults)
generated by the system. If this is a new file, you can use the
name displayed or enter a different one.
For parameter files, the file name displayed includes the wild
card (*) and a default extension as follows:
5-2
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Open

File name
(continued)

Date Range

Status

Directories

*.DEG for degas conditions
*STB for sample tube

*.ANC for analysis conditions
*.ADP for adsorptive properties
* RPO for report options

If you are creating a new file, enter a name in the File name
field. You can use up to 8 characters.

If you are opening an existing file, select the name from the
Files window, then click OK

Click this push button to display files created within a
specified range of dates; the Select Dates dialog is displayed.

Il Select Dates

" Show All Dates

rom:

E
o [01701706 [

Lancel |

Refer to Selecting Files, page 2-11 for an explanation of the
functions on this dialog.

Displays for sample information files only. This drop-down

list allows you to choose the types of sample files to display
in the Files window. All files of the type you choose, within
the range of dates, and in the current directory are displayed.
Refer to Table 2-2. File Status and Description, page 2-12
for a description of the status types.

Displays the current directory. You can navigate to a different
directory by clicking in the Directories list box or by
entering the desired directory in the File name field.

Jul 07
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Sample Information

Sample information files can be created and presented in the Advanced, Basic, or Restricted
format. (Refer to “Sample Information Files” on page 3-1.)

Advanced Format

The Advanced format displays all parts of the sample file in a tabbed dialog. This format
allows you to customize your sample file, moving easily among the parameters simply by
clicking on the tabs; alternatively, you can use Prev and Next. Refer to “Advanced Format”
on page 3-6 for step-by-step instructions for creating a sample information file using the

Advanced format.

4¢ Prew I Sample Sample Degas Analyzis Adsorptive | Feport Mext 2>
—l Information | Tube Conditions I'Eonditions [Properties [Dptions i I_—I
These fields can | ___— Semple: [000-002
be edited to Operatar:
display a different T Subitter |
label if desired.
i~ Type of Data
Mass: I
i 1.0000]89 {+ Automatically collected
Qensily:l 1.000 gicm® " Manually entered
Comments: Add Log Entiy |
Replace All.. I
Save | Lloze | B asic |

Sample

Contains the description of the current sample file.

If this is a new file, this field contains the file description
specified in Sample Defaults (refer to Advanced Format on
page 8-7). The above dialog shows the sample file number
because the dollar ($) symbol was included when sample
defaults were specified.

You can enter a new description or edit the existing one if
desired.

Maximum number of characters: 50

5-4

Jul 07



ASAP 2050 Operator’'s Manual

Open

Operator
Submitter

Mass

Displays the operator and submitter names of the current
sample file.

If this is a new file, these fields contain the names specified in
Sample Defaults.

You can enter a different name or edit the current one if
desired. You can use up to 40 characters.

Either (or both) of these fields can be prevented from
displaying on this dialog by selecting Omit in Sample
Defaults. The labels also can be edited in Sample Defaults.

Enter the value recorded for Mass of Sample, After Degas
from the Sample Data Worksheet.

The value in this field is used in report calculations;
therefore, it should be exact. To ensure accuracy, reweigh the
sample after analysis. Enter the post-analysis value if
different from the After Degas value before generating
reports.

If different gases are used, the sample mass after degas and after analysis will not be

x You should always use the same gas (typically nitrogen) for degassing and analysis.

equal. For example; if you use helium to backfill after degassing and nitrogen after
analysis, you can get as much as a 0.02-gram difference.

Density

Type of Data

Comments

If you plan to use a calculated free space, enter the sample’s
density in this field. A value in this field is ignored for
measured or entered free spaces.

Displays the type of data for the current sample file.

If this is a new file, choose whether you wish to have data
collected automatically or if you plan to enter data collected
from another source.

Allows you to enter pertinent information about the sample
or analysis. The information you enter in this window is
displayed in the report header. You may enter up to 500
characters in this window.

Jul 07
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Add Log Entry Displays the Add Log Entry dialog, enabling you to enter
comments to be included in the instrument log.

Il Add Log Entry

Add the entry to the log report

oK I LCancel
Replace All Use this push button to replace all parameters of the current

file with those from an existing one. You can edit the
parameters after they have been copied into the current file;
editing the current file does not affect the file from which
they were copied.

Save Saves all parameters of the current file; the dialog remains
open.
Close Closes the dialog. If the file contains unsaved changes, you

are prompted to save before the dialog closes.

Basic Switches the sample editor to the Basic format.

Basic Format

The Basic format displays all parts (parameters) of the file on a single dialog. With this format,
you can quickly create a sample information file using predefined parameter files. You can
also switch to the Advanced format if a specific parameter requires editing. Refer to “Basic
and Restricted Formats” on page 3-8 for step-by-step instructions for creating a sample
information file using the Basic format.
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Open

Sample

Mass

Sample Information

Sample: l]l]l]-l]l] 5

Mass: 1.0000 9

Density: | 1.000 cnifg

Sample Tube: |Sample Tube _'_||
Degas conditions: | Degas Conditions _'_j|
Analysis conditions: | Run Conditions ;i|
Adsorptive properties: |Nilmgen @ 7735 K ;“
Report options: | Report Options ;i|
Replace All.. |
Save | Lloze | Advanced |

Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced file
description based on the format specified in Sample Defaults.
The above dialog shows the sample file number because the
dollar ($) symbol was included when sample defaults were
specified.

You can enter a new description or edit the existing one if
desired.

Maximum number of characters: 50

Allows you to enter the sample mass. If you are using the
Sample Data worksheet, this is the value recorded for Mass of
Sample after Degas.
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Sample Tube

Degas Conditions
Analysis Conditions
Adsorptive Properties
Report Options

Replace All

Save

Close

Advanced

Restricted Format

Each parameter field contains the description of the current
parameter file.

If this is a new sample file, these fields contain the descrip-
tions of the files chosen as the defaults.

Click on the down arrow to the right of each field to choose a
different file. File parameters can be viewed or edited by
switching to the Advanced format.

Use this push button to replace all parameters of the current
file with those copied from an existing one. A dialog is
displayed allowing you to choose the desired file.

Saves all parameters of the current file; the dialog remains
open.

Closes the dialog.

Switches the sample editor to the Advanced format, allowing
you to view or edit parameters of the current file.

The Restricted format is used when analysis parameters must remain constant, for example, in
the pharmaceutical industry where consistency and accuracy are crucial. A password is
required to enter and exit this format. Refer to Restricted, page 8-3 for additional information

on the Restricted format.

When you open an existing sample information file or create a new one using the Restricted
format, all parts of the sample file are displayed in the same manner as the Basic format. Some
menu functions, however, are disabled and you cannot switch to the Advanced format to edit

file parameters.

5-8

Jul 07



ASAP 2050 Operator’'s Manual Open

Sample Information

Sample: 13X HReference Matenal [AR
Mass: 0.1100 g Density: I 1.000 cmilg
Sample Tube: |Sampie Tube :_“
Degas conditions: | 13X Reference Maternial [AR] Lﬂ
Analysiz conditions: | 13 Reference Material [AR] _"_i|
Adszorptive properties: |Argon @ 7735 K _"_i|
HReport options: |13X Reference Material [AR] Li|
HReplace All_ |

Save | Lloze |

Sample Tube

The fields on this dialog are used for storing sample tube information. Before creating a
sample tube file, you should perform a blank analysis (no sample) using the sample tube.

[]C:\ DEMD2050" PARAM},001-01.5TB

Sample Tube

Sample Tube Samle Tube] Replace |
Ambient free space ! 1.0000 cm@ [ Use isothermal jacket

I Use filler rod
Analyszis free space I 1.0000 cm? =

Yacuum zeal type:
' None
~ Seal Frit
Load From Sample File... | " Trans Seal

Save | Lloze |

Sample Tube Contains the description of the current file.
If this is a new file, this field contains the name (description)
you specified as the default. You can enter a new description
or add to the existing one if desired.

Maximum number of characters: 40
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Replace

Ambient free space

Analysis free space

Use isothermal jacket

Use filler rod

Vacuum seal type

Load From Sample File

Save

Close

Use this push button to replace the values of the current file
with those from an existing Sample Tube file. The Open
Sample Tube dialog is displayed, allowing you to choose a
file. After the values are copied into the current file, you can
edit them as desired.

Displays the ambient free space for the current file.

Displays the analysis free space for the current file.

Select this option if an isothermal jacket is to be used in the
analysis.

Not used.

If the sample is to be transferred under vacuum to the analy-
sis port, select the one to be used. If not, leave None selected.

Click this push button to choose the sample file that was used
in the blank analysis. The values for the Ambient and Analy-
sis free spaces will be copied into the sample tube file.

Saves all parameters of the current dialog.

Closes the dialog. If the file contains unsaved changes, you
are prompted to save before the dialog closes.

5-10
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Degas Conditions

The fields on this dialog are used for specifying degas conditions.

Degas Conditions

Description; I Replace... |
-E ion Phaze - Heating Phaze

Temperature ramp rate: 1.0 K/min Ramp rate: 1.0 K/min
Target temperature: 303 K Hold temp: 303 K

Ewacuation rate: l 5.0 mmHgfs Hold time: l 10 min
Unrestricted evac. from: I 5.0 mmHg

Yacuum setpoint: | 10 nmHg “E ion and Heating Phases
Evacuation time: ! 0 min Hold pressure: I 100 mmHg

I+ Backfill sample tube

Save | Lloze |
Description Contains the description of the current Degas Conditions file.

If this is a new file, this field contains the name (description)
you specified as the default. You can enter a new description
or add to the existing one if desired.

Maximum number of characters: 40

Replace Use this push button to replace the parameters of the current
file with those from an existing Degas Conditions file. The
Open Degas Conditions File dialog is displayed, allowing
you to choose a file. After the values are copied into the
current file, you can edit them as desired.

Evacuation Phase The options in this group box allow you to specify conditions
group box for the evacuation phase of the degassing operation.
Temperature Allows you to specify the rate at which the temperature is to
ramp rate change while advancing to the target temperature during
evacuation.
Target temperature Allows you to specify a temperature at which the sample will

be held for the remainder of the evacuation.
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Evacuation rate

Unrestricted evac.
from

Vacuum setpoint

Evacuation time

Heating Phase

group box

Ramp rate

Hold temp

Hold time

Evacuation and Heating

Phases

Hold Pressure

Backfill Sample Tube

Save

Close

Enables you to specify an evacuation rate for initial
evacuation.

Enables you to specify a pressure at which unrestricted
sample evacuation will begin.

Enables you to specify the vacuum level to be achieved
before evacuation begins.

Enables yo to specify how long the sample is to be evacuated
prior to the second stage of heating.

The options in this group box allow you to specify conditions
for the heating phase of the degassing operation.

Enables you to specify the rate at which the temperature will
change after evacuation while advancing to the hold
temperature.

Enables you to specify a temperature at which the sample is
to be held during degassing.

Enables you to specify how long the sample is to be held at
the specified temperature before beginning to cool down.

Enables you to specify the hold pressure.

If during the temperature ramp the pressure exceeds the value
you enter in this field, the ramp will be suspended until the
pressure returns to a safe level.

Select this option to have the sample tube backfilled.

Saves all parameters of the current dialog.

Closes the dialog. If the file contains unsaved changes, you
are prompted to save before the dialog closes.

5-12
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Analysis Conditions

The Analysis Conditions dialog allows you to specify the data used to guide the analysis. You
can create an Analysis Conditions file as an independent parameter file or include it as part of
the sample information file.

Refer to “Analysis Conditions” on page 3-11 for step-by-step instructions on creating an
analysis conditions file.

Analysis Conditions

Description; IRun Conditions Replace... |
Relative Total |BET |Lang. £ Inzert Range... |

Frezsure Fore | Suf. | Surf.
[p/p’] ol Area |Area | Freund) Temkin] t-Plat | Alpha-S{ f-Fat Insert Pledeﬁned...l

1 0.000000001

.Delele |
Clear |

Ctrl+down-armow
to append

[~ Absolute pressure
dosing

= ¥ Use calculation

‘I I i l—‘ aszignments

Preparation... ! Free Space... ptand T_.. Dosing.... | Eguilihlalion...l Backfill. ..
|
Lloze |
Description Contains the description of the current Analysis Conditions
file.

If this is a new file, this field contains the name you specified
as the default. You can enter a new description or add to the
existing one if desired.

Maximum number of characters: 40

Replace Use this push button to replace the parameters in the current
file with those from an existing Analysis Conditions file.
After you choose the file and the values are copied into the
current file, you can edit them in any way desired. Editing
the current file will not change anything in the file from
which they were copied.
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Pressure Table

A pressure table is a list of pressure points (with calculation
assignments) at which data are to be collected. The pressures
may span the entire range from the lowest relative value of
0.00000001 to the maximum value of 0.995 P/Po. In
addition, one saturation point may be entered with relative
pressure of 1.0.

Several analysis conditions files containing complete
pressure tables are included with the ASAP 2050 software
and can be found in the PARAMS subdirectory.

The pressure table for automatically collected data includes
the pressure points for data collection and identifies
calculations through which the data are processed.

Edit existing values by highlighting the field and entering the
desired values. Use Insert to add rows for additional values.
To append to the beginning or to the end of the table, use
Ctrl + Up Arrow and Ctrl + Down Arrow.

The pressure table must contain one sequence of strictly
ascending relative pressures, optionally followed by one
sequence of strictly descending relative pressures. You can
enter a maximum of one thousand pressure points.

To specify the calculations performed at a given relative
pressure, click in the field of the desired calculation type; an
X in the field indicates the calculation is selected.

Click OK to accept all entries in the pressure table and return
to the Analysis Conditions dialog.
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Insert Range

Linear

Geometric from low
pressure

Geometric from
saturation

Displays the Insert Pressure Range dialog.

Il Insert Pressure Range

Starting relative pressure: (00100000004 ¥
Ending relative pressure: i 0.900000000 pfp°
umber of points: I 10

P

& Linear
G tric from low p

i

e

oK I LCancel

Enter 3 value between 0.000000000 and 1.000000000.

This dialog allows you to specify the starting pressure, the
ending pressure, the number of points to insert within the
specified range, and whether you wish to have linear or
geometric progression.

Inserts evenly spaced points into your table.

Inserts geometrically spaced points from the low pressure
range. For example, to insert 5 points with a 0.01 starting
pressure and a 0.16 ending pressure, the following points are
inserted into the table:

0.01
0.02
0.04
0.08
0.16

Inserts geometrically spaced points from the saturation
pressure. For example, to insert 5 points with a 0.99 starting
pressure and a 0.84 ending pressure, the following points are
inserted into the table:

0.99
0.98
0.96
0.92
0.84
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Insert predefined

Insert

Delete

Clear

Absolute pressure
dosing

Displays the Insert Predefined Pressures dialog.

Surface area: M;‘
t-Plot micropore: | Mone LI|
BJH adsorption: |None _ﬂ|
BJH desorption: |None _L“

[+ Adsorption total pore yolume
[+ Desorption total pore volume

[ Saturation

Mote: The predefined pressures make sense
only if nitrogen iz used as the adsorplive.

1] % I LCancel

Choose predefined pressure points for surface area, t-Plot,
and/or BJH adsorption/desorption.

Click on the down arrow for each field to choose the desired
set of points. You can also specify Adsorption/ Desorption
total pore volume and Saturation.

Inserts a row into the table above the selected line.
Deletes the selected row.

Removes all but one required entry from the table. The rows
do not have to be selected. A warning message appears
requesting confirmation before the table is cleared.

Select this option to specify pressure targets in mmHg, mbar,
or kPa instead of relative pressure. This option is typically
selected when using adsorptives at analysis conditions above
the critical point of the gas; for example, H, adsorption on

carbon at liquid nitrogen temperature.
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Use calculation
assignments

Preparation

Fast evacuation

Unrestricted evac.

from

Vacuum setpoint

Evacuation time

Select this option to assign the points to be collected for each
type of report.

If this option is not selected, each report (with the exception
of Langmuir and BET) uses a range of pressures as selected
in the report options. The Langmuir and BET reports
interpolate to entered relative pressures on the report options.

The outlier points can be selected so that they will not be
reported.

Displays the Analysis Preparation dialog.

i Analysis Preparation

Unrestricted evac. [mm:I 5.0 mmHg

¥acuum setpoint: | 10 ymHg
Evacuation time: i 0.50 h

[~ Leak test

Leak test duration: I 120 (s

[~ Use TranSeal

LCancel |

Select this option for samples (such as pellets) that do not
fluidize or shed particles during evacuation.

Enabled when Fast evacuation is not desired. This field
allows you to enter the pressure at which unrestricted sample
evacuation is to begin.

Allows you to specify the vacuum level to be achieved before
evacuation begins.

Enables you to enter the length of time for preliminary
evacuation, which takes place prior to the free-space
measurement.
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Leak test

Leak test duration

Use TranSeal

Free Space

Enables the system to check for leaks or sample outgassing
before the analysis. The leak test allows sample pressure to
rise during the test. If the pressure rises more than 0.15
mmHg, the analysis does not proceed and you are notified.
While leak testing slightly increases analysis time, it prevents
the continuation of analysis and collection of erroneous data
if a leak exists.

Enables you to specify how long the pressure is to be
monitored.

Not used.

Allows you to specify free-space measurement conditions;
the Free Space dialog is displayed.

- Free Space E

¥ Lower dewar for evacuation

Exacuation time: I 010 h

[” Dutgas test
Dutgas test duration: I 180 =
" Enter

Ambient free space: | 16.0000 | cm®
Analyzsiz free space: I 45.0000 | cm®

" Calculate

Lancel |
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Measure

Enter

Select this option to have free space measured automatically
by the system.

Typically, it is best to measure the free space when analyzing
macro- and mesoporous samples, and for routine surface area
measurements.

Select Lower dewar for evacuation to lower the dewar
following free-space measurements.

Evacuation time enables you to specify how long evacuation
is to take place following the measured free space.

Select Outgas test to check for system leaks or sample
outgassing. After free space is measured, the Dewar is
lowered and the sample evacuated for 30 minutes. The leak
test is performed after evacuation. If a leak is found, the leak
test repeats nine times, with 30 minutes evacuation between
tests. If the 10th leak check fails, the analysis stops and you
are notified. While leak testing slightly increases analysis
time, it prevents the continuation of analysis and collection of
erroneous data if a leak occurs.

Outgas test duration indicates the number of seconds the
leak test is performed.

Select this option to enter values for the ambient and analysis
free spaces. You may need to use this option if the sample
retains helium and measurement of very low micron range
pressures are required.

\ If you change the entered free-space value after the preliminary analysis stage is 50%

complete, the change does not affect the analysis.

Ambient free space is the sample tube gas capacity measured
at room temperature.

Analysis free space is the sample tube gas capacity measured
with the Dewar raised.
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Calculate Select this option to have the free-space calculated using the
mass, density, and sample tube parameters entered in the
Sample Information and Sample Tube files. Calculated free
space measurement takes less time than measured free
space, so if you know the mass and density of the sample
and the sample tube parameters, you may wish to use this
choice of free space methods. If you do not know the
parameters, you may wish to use measured free space.

Poand T Displays the Po and Temperature Options dialog, allowing
you to enter the ambient temperature and choose saturation
pressure and analysis bath temperature.

ﬁ p*° and Temperature Options

Choose one of the six options.

f:'L Measure p* at intervals during lysis. Calcul the Analysiz Bath

(" 2. Measure p* at intervals during analpsis. Enter the Analypsis Bath
Temperature below.

i~ 3. Enter p* below. Calcul the Analysis Bath Temperat at the
time of analpsis.
i~ 4_ Enter p* below. Enter the Analysis Bath Temperat below.
" 5 Measure Psat of a gas. Calcul p* of the adsorptive from the
d Pzat. Calcul the Analysziz Bath Temperat usging the
Adsorptive Properties temperature data.
("~ . Calculate p* [using Ad P i data] at

the time of the analysis h;m the A n lysi Ball; T
entered below.

Ambient temperature: |298.00 K

Measurement interval: 120 min
orce |

This dialog provides six options for obtaining the saturation
pressure (Po) and analysis bath temperature. Clicking on each
option prompts you for the entry of related parameters in the
lower portion of the dialog.

Option Prompts for...

1 a measurement interval (how often during
analysis the Po is to be measured)

Recommended for N,, Ar
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Option

Prompts for...

a measurement interval and the analysis
bath temperature

a Po; the analysis bath temperature is
calculated at the time of analysis

Saves time; useful for BET with N,

a Po and analysis bath temperature

an analysis bath temperature only (when
Absolute pressure dosing is selected on
the Analysis conditions dialog)

Saves time; useful for BET with N,

a psat gas other than the adsorptive; the
temperature and pressure ranges for the
chosen gas are displayed. Click Psat vs.T to
edit the values if desired. Editing the values
in the current table do not affect the ones of
the original table.

May help save time.

an analysis bath temperature

May help save time.
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Dosing

First Pressure Fixed
Dose

Displays the Dosing Options dialog.

i Dosing Options

I~ First pressure fixed dose: I 0.00045 | mmol/g

[ Magimum volume increment: | 1.115369 | mmol/g

Absolute p tol ¢ 0.6666 kPa
Relative p tol 2 | 50 %

Lancel |

The most frequent use of this option is when you are
performing a standard nitrogen analysis of mesoporous
materials such as catalysts. If the first pressure table point is
low and you expect the gas uptake of the sample to be high,
this option can shorten the time required to reach the first
point on the pressure table.

The sample is dosed repeatedly at low pressures with a
specified amount of gas until the first pressure point is
reached. This initial dosing quickly meets the adsorptive
demand of the sample.

The first point on the pressure table is the threshold value,
triggering the transition from the Fixed Dose Mode to
Pressure Table Mode. When the first pressure table value is
reached, Fixed Dose Mode is disabled, and points are
equilibrated and recorded in accordance with the specified
pressure table.

In the field adjacent to this option, enter the amount of gas
that is to be added to the sample for each dose cycle.
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Maximum volume
increment

Absolute and Relative
pressure tolerance

Select this option to determine when additional data points
are collected between target pressures in regions of
adsorption. When the maximum increment has been adsorbed
since the last collected data point, another point is
equilibrated and collected.

During desorption, this field is treated as a maximum volume
“decrement” value.

The values entered in these fields are used to determine how
close the actual pressure must be to each target pressure from
the pressure table. At lower pressures the relative tolerance
value is smaller, and at higher pressures the absolute
tolerance value is smaller. The lesser (or more stringent) of
these two criteria are used to determine the tolerance.

For example, with relative tolerance = 5% and absolute
tolerance = 5 mmHg, the relative tolerance at 40 mmHg
target pressure is 5% of 40 mmHg, or 2 mmHg; 2 mmHg is
smaller than the absolute tolerance of 5 mmHg, so 2 mmHg is
used. At 200 mmHg target pressure, the relative tolerance is
5% of 200 mmHg, or 10 mmHg; in this case, the absolute
tolerance of 5 mmHg is smaller and is used.

In the above example, a minimum pressure of 40 - 2 = 38
mmHg must be attained to collect data for a target pressure of
40 mmHg. For a target of 200 mmHg, 200 - 5 = 195 mmHg
must be attained.

Normally, surface area measurement points are widely
spaced, and the resulting measurement is not very sensitive to
the precise location of points so wider tolerances may be
used. Unnecessarily tight tolerances lengthen the analysis.
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Equilibration

Equilibration
interval

Minimum
equilibration delay
at P/Po>=0.995

Backfill

Displays the Equilibration dialog.

i Equilibration

Relative =
Pressure E quilibration _| i -
[p/p] faerelE] G i
1| 1000000000 10 Does not
Delete | display when
& Absolute
dosing is
Ctrl+down-arow
ta Sbpand selected.
Minimum equilibration <
delay at p/p* >= 0.995:
| b | 600 s

LCancel |

The number of seconds between successive pressure readings
during equilibration. Long equilibration intervals tend to
lengthen analyses, however, they do improve data integrity.
Short equilibration intervals produce a faster analysis but
may reduce the accuracy of data.

The value entered in this field determines the minimum
number of seconds required before equilibration can occur
for a relative pressure greater than or equal to 0.995.

This field does not display if you select Absolute pressure
dosing on the analysis conditions dialog.

Displays the Sample Backfill Options dialog, allowing you to
select options for backfilling the sample tube at the start and
end of an analysis.

¥ Backfill sample at end of analysis

Backfill Gas: u

|
Qg I Lancel |

The options on this dialog are not available if the file status
displayed in the Open Sample Information File dialog is
Entered, Complete, or Analyzing.
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Backfill sample at
start of analysis

Backfill sample at
end of analysis

Backfills the sample tube at the beginning of the analysis
with the specified backfill gas.

Backfills the sample tube at the end of the analysis with the
specified backfill gas. If the sample mass is determined after
the analysis, it is best to use nitrogen as the backfill gas.

@ It is recommended that you backfill the sample tube at the start and at the end of

the analysis. If you deselect either backfill option, proceed with caution as damage
to the analyzer or sample tube may occur.

Backfill Gas

Lists the available backfill gases. The gases in this list are
the ones for which Adsorptive Properties files have been

created; helium is also included.

Adsorptive Properties

This dialog allows you to specify the characteristics of the gases used in the ASAP 2050
system. An Adsorptive Properties file can be created as an independent parameter file or

included as part of the sample information file.

Refer to “Adsorptive Properties” on page 3-12 for step-by-step instructions on creating

adsorptive properties files.

[\ DEMD2050" PARAM',001-01.4DP

Adsorptive Properties

Adszorplive: |Nilmgen

Mnemonic: I‘N_Z-_

M axi ifold p : l 123.323 kPa
Density conversion factor: l 0.0015468

Therm. tran. hard-zphere diameter: I 3.860 A
Molecular crosz-zectional area: I 0.162 nm?

Compressibility Factor Table:

Replace... |
Psat ws T_.. |

Dosing Method
' Mormal
" From Psat tube

" Yapor source

Open... Save |
Save | Lloze |
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Adsorptive

Replace

Mnemonic

Non-condensity
Adsorptive

Maximum manifold
pressure

Density conversion
factor

Therm. tran. hard-sphere
diameter

Molecular cross-sectional
area

Dosing Method

If this is a new file, this field contains either the name of the
default adsorptive gas or is blank. Enter the name of the
desired adsorptive gas.

Maximum number of characters: 40 alphanumeric

Click this push button to choose an Adsorptive Properties file
containing parameters you wish to copy and use in the
current file. After the values have been copied into the file,
you can edit them as desired. It does not affect the values of
the file from which they were copied.

The mnemonic for the adsorptive gas.

Maximum number of characters: 3 alphanumeric

Select this option if this file is for a non-condensing gas
(adsorptive). When you select this option, the Density
conversion factor field and the Psat vs. T push button
become disabled.

The maximum gas pressure allowed in the manifold.

This value is used to convert the gas volume at STP to liquid
volume for the adsorptive. It is the ratio of gas density at STP
to liquid density.

The thermal transpiration hard-sphere diameter.

The molecular cross-sectional area.

Select the manner in which the sample tube is dosed. Normal
applies to gases under pressure and is used for standard 2050
analyses.
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Compressibility Factor Table Compressibility factors compensate for the forces of attrac-
tion between molecules in a real gas. Each gas compatible
with the ASAP 2050 analyzer has a compressibility factor
table. To select the table, click Open. The Open Compress-
ibility Factor Table dialog is displayed.

Il Open Compressibility Factor Table

_
File name:
- Selection Criteria
Date Range... |
Directories:

Files: c:hdemo2050
spc_data.dat .1 a
zar.dat data]
zch4.dat hardware]
zco.dat models]
zco2. dat param]
zh2 _dat referenc]
zhe_dat service]
zkr.dat -a-]
zn2_dat -c-]
znZo.dat -d-]
zo2 dat -g-]

“||i-h
1 L|_| -q-] E

Click the file containing the mnemonic for the type of gas to
be used for analysis. For example, select zar.dat for Argon.

Then click OK to close the dialog.

If you would like to save the compressibility factor table con-
tained in a sample file, click the Save button located next to

the Open button.

Il Save Compressibility Factor Table
File name:
- Selection Criteria
Date Range... |
Directories:

Files: c:hdemo2050
spc_data.dat .1 a
zar.dat data]
zch4.dat hardware]
zco.dat models]
zcoZ dat param]
zh2 _dat referenc]
zhe_dat service]
zkr.dat -a-]
zn2.dat -C-
znZo.dat -d-]
zo2 dat -g-]

“||i-h
1 L|_| -q-] E

Enter a name in the File name field (make sure you use the

.DAT extension), the click OK.
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Psatvs. T Click to view or edit the Psat vs. Temperature table for the
adsorptive gas; this example shows Nitrogen.

- Psat ¥s Temperature Table for Argon @ 77.35K

Saturation
Freszure | Temperature]
g [K]
1 [EENEE 75,400
2 156.519 75.850
3 | traora 7eaE0 _tnset_|
4 186.101 76.900 Delete
5 153.784 77.150 _—|
{5 200117 77.350
7 206.620 77.580
g 216.700 77.850
_9_ 234.3% 78.350 Ctrl+down-armow

10 253,262 78.850 to append
Cores |

This table contains saturation pressures and their correspond-
ing temperatures. As many as 10 entries may be included; at
least two entries are required.

You can edit the table by clicking on the desired saturation
pressure or temperature and entering a different value.

Use Insert to insert a new row above the selected line; the
cursor moves to the new line. Use Delete to delete the
selected row.
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Report Options

This dialog allows you to specify report options. A report options file can be created as an
independent parameter file or included as part of the sample information file.

Refer to “Report Options” on page 3-13 for instructions on creating report options files.

Report Options

Description: I Replace... |
v Show report title !
v Show graphic !miclogo.em[ Browse... |

Heighl:l 0.250 in. Widlh:l 2.000 in.

Selected Reports:

= Isotherm
el | el I BET Surface Area
Langmuir Surface Area
Freundlich
Temkin
" Apply th It pirati Hi t-Plot

Inside diameter of sample tube: AIpha_-S Method
f-Ratio Method

I 9.53 'mm BJH Adsorption

BJH Desorption
Horvath-Kawazoe
DFT Pore Size

DFT Surface Energy

Dubinin
MP-Method hd
Save | Lloze |
Description Displays a description of the current Report Options file.

If this is a new file, this field contains the description you
specified as the default. You can enter a new description or
add to the existing one if desired.

Maximum number of characters: 40

Replace Click this push button to choose an existing Report Options
file containing parameters you wish to copy and use in the
current file. After the values have been copied into the file,
you can edit them as desired. It does not affect the values of
the file from which they were copied.
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Show report title

Show graphic

Overlays

This option allows you to enter a title for your report.

If this is a new file, the title you specified as the default is
displayed. Accept the default title or enter a different one.

Deselect this option to omit the report title.

Range: 40 characters

Select this option to have a graphic display above the report
title.

The graphic can be in a bitmap (bmp) or an enhanced
metafile (emf) format. For example, you may wish to display
your company logo.

Click Browse to choose the graphic, then use the height and
width fields to specify the size. The image can also be edited
from the report window.

Displays the Graph Overlay Samples dialog so that you can
choose the sample files containing the data you wish to
overlay onto a selected plot.

i Graph Dverlay Samples

Sample 1 [C:\DEMO2050\DATAVIZX_AR.SMP  Browse... |  Clear

Sample 2 IE:\DEMDZI]SI]\DATA“3XAF|EX.SM |;"ﬁ}'6i.'j'§'é'_"_"_"§| Clear

|

: |

Sample 3 | Browse.. | Clear |
Sample 4 | Browse.. | Clear |
Sample 5 | Browse.. |  Clear |
Sample § | Browse.. | Clear |
Sample 7 | Browse.. | Clear |
Sample 8 | Browse.. | Clear |

**Heminder=  You must select which graphs are to be
overlaid by selecting the Overlay samples on each Selected
Report in the Report Options.

Lanicel |

Click Browse to the right of the sample number field to
choose the desired file. Use Clear to clear a field of its entry.
You can select up to eight files.

After choosing the desired files, select the Overlay samples
option for each report type you plan to overlay.
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Edit

Apply thermal transpiration
correction

Inside diameter of
sample tube

Selected Reports

Allows you to edit parameters of the selected report. This
push button is disabled for the Options report.

Select this option to correct for the temperature-induced
pressure difference between the manifold and the chilled
sample tube. This option is most significant for pressures less
than approximately 1.0 mmHg.

Use this option when a cryogen liquid nitrogen or liquid
Argon is used to control the bath temperature.

Enabled when you select Apply Thermal transpiration
correction, so that you may enter the inside diameter of the
sample tube.

Contains a list of available reports. Choose reports by double-
clicking on the desired report(s). Alternatively, you can
highlight the desired report and press the Spacebar. A report
is selected when it is preceded with a check mark. You may
deselect reports in the same manner.

The following reports are available:

* Isotherm

* BET Surface Area

» Langmuir Surface Area
e Freundlich

e Temkin

* t-Plot

e Alpha-S Method

» f-Ratio Method

» BJH Adsorption

* BJH Desorption

» DFT Pore Size

e DFT Surface Energy

*  Dubinin

* Options

*  Summary

» Sample Log
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Isotherm Report Options

ﬁ Izotherm Report Options

— Select Heportz
[v Tabular report

¥ Linear plot Options__. |
¥ Logarithmic plat Options__. |
[ Linear Absolute plot Options.._. |
[ Logarithmic Abszolute plot Dptions... |

¥ Pressure Composition plot Options... |

— Tabular Options
[v Run time
[~ Time between points

[~ Weight %

— Plot Options
[ Plot adsorption

¥ Plot desorption

—Yolume Adsorbed

(* Per gram " Per BET Surface Area " Per other Surface Area

I 1.0000 | m*/g
—Weight
Adzorbate Molecular Weight: I EIE
Enter a value between 2.00 and 120.00.
o |

Select Reports

Lists the types of reports offered.

The isotherm report indicates adsorption (up to saturation pressure) and desorption (down
from saturation pressure) of a gas by a solid held at constant temperature.

Choices: Tabular Report, Linear plot, Logarithmic plot,
Linear Absolute plot, Logarithmic Absolute plot
Pressure Composition plot

When you select Pressure Composition plot, the Adsorbate
Molecular Weight field is enabled so that you can enter a

value for the adsorbate. This plot is useful for plotting

pressure as a function of Weight % adsorbed; for example, H,

adsorbed on carbon.
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Options

Tabular Options

Displays the related Plot Options dialog; this example shows
the dialog for the Linear plot.

i Linear Plot Dptions

I+ Plot points v Dverlay samples
From To
v Autoscale x-axis - I 0. 1] 1. pfp’
v Autoscale y-axis Y- I 0.0000 1000.0000 | emifg STP
Crce |

All plot dialogs contain the same options.
You can plot the graphs as a curve, points, or both.

Select Overlay samples to overlay data from the current plot
with data from other samples. The other sample files are
selected by clicking Overlays on the Report Options dialog.

Autoscale options enable you to have the X- and/or Y-axes
automatically scaled.

Linear X-axes begin at zero, and logarithmic X-axes begin at
an appropriate value. Y-axes begin at zero. The system uses
the highest values collected during analysis as the ending
points for axes ranges.

If you choose not to autoscale data, the From and To fields
are enabled, allowing you to specify a range. Data collected
outside these ranges are not included in the plot.

The value entered in the To field must be greater than the
value entered in the From field.

The X-axis fields show the relative pressure. The Y-axis
fields show the quantity of gas adsorbed

Enables you to have Run Time and/or Time Between Points
reported. Run time reports the time elapsed from the
beginning of the analysis to the finish. Time between points
reports the time relapsed between each point.

Also enables you to report Weight % when plotting pressure
composition.
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Plot Options

Volume Adsorbed

Weight

Enables you to choose the type of isotherm you wish to plot.
You can plot the adsorption and/or the desorption isotherm.

Enables you to choose the manner in which the volume
adsorbed is reported. These data are reported by default as

Per Gram (cm3/g). However, you can choose to report data
Per BET Surface Area (cm3/m?) or Per Other Surface

Area (mzlg). If the latter field is selected, a field is enabled
allowing you to enter a value.

The Adsorbate Molecular Weight field is enabled when you
choose Pressure Composition plot, allowing you to enter the
molecular weight of the adsorbate.

This weight appears on tabular reports.
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BET/Langmuir Surface Area Report Options

e The BET calculation obtains the sample surface area value by determining the monolayer
volume of adsorbed gas from the isotherm data.

» The Langmuir calculation determines the surface area of a sample by relating the surface
area to the volume of gas adsorbed as a monolayer.

Displays as Langmuir
Surface Area Report Options
if the Langmuir report is being
edited.

ﬁ BET Surface Area Report Options [ %]

|+ Tabular report
¥ BET transform plot

[ Dverlay samples
From To

[~ Autoscale z-axis - | (NN I 1.000000000

P/Po

v Autoscale y-axis - I 0.00000 I 2241.40998 | g/mmol
¥ BET Isotherm plot
[ Dverlay samples
From To
v Autoscale x-axis - | 0.000000000 I 1.000000000 | P/Po
[ Autoscale y-axis - I 0.00000 I 446.10312 | mmol/g
Pressures. |
|Enter a value between 0 and 1
Corc |

The Langmuir and BET Surface Area dialogs include the same fields; the operating

instructions for both are the same.

Tabular report

BET transform plot

BET Isotherm plot

Overlay samples

Select this option to have a tabular report of the plotted data.

Generates a traditional BET (Langmuir) surface area plot that
is used to determine monolayer volume and BET C constant.

Uses the BET (Langmuir) monolayer volume and constant to

calculate an isotherm.

Allows you to overlay data of the selected type from the

current plot with data from other samples. The other samples
are selected by clicking Overlays on the main Report Options

screen.
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Autoscale x-axis
Autoscale y-axis

From/To fields

Pressures

Select these options to have the X- and/or Y-axes scaled
automatically.

Both X- and Y-axes begin at zero; the system uses the highest
values collected during analysis as the ending points. If you
choose not to autoscale data, the From and To fields are
enabled, allowing you to enter the ranges.

Enabled when you choose not to autoscale data (deselect the
Autoscale option), allowing you to specify the beginning and
ending ranges of the X- and/or Y-axis. Data collected outside
these ranges are not included in the plot. The values entered
in the To field must be greater than the value entered in the
From field.

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.

Displays the Report Pressure Table dialog so that you may
edit or enter relative pressure points.

ﬁ Report Pressure Table [ %]
Relative |21  Enter the
Pressure pressures to be
[p/p’l used when
0.000000001 calculation

assignments are
0.125000001 not uged.

0.200000001
0275000001
0.350000001

Ingert Predefined... |

Delete |
Clear |

Ctrl+down-arrow to

<_|_|—7 Ll_'_ append

Lancel |

If Use calculation assignments is not selected on the
Collected/Entered dialog, the isotherm is interpolated to these
pressure points, and those interpolated values are used in the
BET calculations.

If Use calculation assignments is selected, the collected data
are used.
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Insert predefined

Insert

Delete

Clear

Displays the Surface Area Report Pressure Selection dialog,
allowing you to select predefined points.

Choices: 1 Point, 3 Point, 5 Point, 5 Point Low Pressure

Inserts a row into the table above the selected line.

Deletes the selected row.

Removes all but one entry from the table; one entry is
required. The rows do not have to be selected.

A warning message requesting confirmation is displayed
before the table is cleared.

Freundlich Isotherm

- Freundlich Report Dptions

[~ Specify monolayer capacilyj
1.0000 | emédg STP

Absolute pressure range when calculation assignments are not used:

| 0.000000 to | 1000.000000 mmHg

v Tabular report

¥ Transform plot

" Dverlay samples

From To
¥ Autoscale x-axis % | -5.00000 | 3.00000 logfp)
¥ Autoscale y-axis 7 | -4.0000 f 4.0000 Iog(B)
[ Freundlich Isotherm plot
I” Dverlay samples From To
I¥ Autoscale y-axis  X:||  0.000000|] 1000.000000 | mmHg
I¥ Autoscale y-axis = Y- | 0.0000)]  1000.0000 | cnd/g STP
ol |

The Freundlich isotherm is an empirical isotherm that is used to model low-pressure

adsorption data.

Specify monolayer
capacity

In this field, enter the monolayer capacity of the sample.
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Absolute pressure range

Tabular report

Transform plot

Isotherm plot

Overlay samples

Autoscale x-axis
Autoscale y-axis

From/To fields

Allows you to enter a pressure range when calculation
assignments are not requested.

Select this option to have a tabular report of the pressure
points generated.

Plots the log(p) vs log(Q) in a straight line.

Plots the absolute pressure vs quantity adsorbed. Shows best
fit line.

Choose this option to overlay Freundlich isotherm data from
the current file with the same type of data from other samples
(files). The desired files are chosen by clicking Overlays on
the Report Options dialog.

Select these options to have the X- and/or Y-axis scaled
automatically.

Both X- and Y-axes begin at zero; the system uses the highest
values collected during analysis as the ending points.

If you choose not to autoscale data, the From and To fields
are enabled, allowing you to enter the ranges.

The X-axis shows the log of absolute pressure and the Y-axis
shows the quantity of gas adsorbed.

Enabled when you choose not to autoscale data (deselect the
Autoscale option), allowing you to specify the beginning and
ending ranges of the X- and/or Y-axis. Data collected outside
these ranges are not included in the plot.
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Temkin Isotherm

- Temkin Report Options

" Specify I ity

I 1.0000 fendda STP

[ Specify diff ial heat of adsorption at zero g
1.000 Sk /mol

Absolute pressure range when calculation assignments are not used:

I 0.000000 to | 1000.000000 mmHg

[+ Tabular report
v Transform plot

[ Dverlay samples

From To
IV Autoscale x-axis - I -12.00000 I 7.00000 | In[p]
v Autoscale y-axis Y: I 0.0000 l 1000.0000 | cnéfg STP
" Temkin Isotherm plot
I” Dxerlay samples From To
¥ Autoscale x-axis b | 0.000000 l 1000.000000 | mmHg
I¥ Autoscale y-axis -1 0.0000)]  1000.0000| cmi/q STP
Corc |

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops
linearly with increasing coverage.

In this field, enter the monolayer capacity of the sample.

Specify monolayer
capacity

Specify differential
heat of adsorption at
zero surface coverage

Absolute pressure
range

Tabular report

Transform plot

Enter the differential heat of adsorption at zero surface
coverage. This allows inclusion of all of Temkin constants.

Allows you to enter a pressure range when calculation
assignments are not requested.

Select this option to have a tabular report of the pressure
points generated

Plots a linear form of the Temkin isotherm.
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Temkin Isotherm plot

Overlay samples

Autoscale x-axis
Autoscale y-axis

From/To fields

Overlays the Temkin isotherm with the analysis data.

Choose this option to overlay Temkin isotherm data from the
current file with the same type of data from other samples
(files). The desired files are chosen by selecting Overlays on
the Report Options dialog.

Select these options to have the X- and/or Y-axis scaled
automatically.

Both X- and Y-axes begin at zero; the system uses the highest
values collected during analysis as the ending points.

The X-axis shows the natural log of absolute pressure and the
Y-axis shows the quantity of gas adsorbed.

If you choose not to autoscale data, the From and To fields
are enabled, allowing you to enter the ranges.

Enabled when you choose not to autoscale data (deselect the
Autoscale option), allowing you to specify the beginning and
ending ranges of the X- and/or Y-axis. Data collected outside
these ranges are not included in the plot.
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t-Plot Report Options

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area, the area external to micropores, is directly determined and often
proves to be a valuable way of characterizing complex mixed materials.

- t-Plot Report Options

- Thickness Curve Surface Area Fitted thickness
" Reference = BET el
" Kruk-Jaroniec-5 ayari  Langmuir I 0.35000 nm
o " Entered | 0.50000 ' nm
a
& I 1.0000 [m/g
" Broekhoff-de Boer

Surf. area
" Carbon Black 5T5A correction factor:

Pressure Range... | l 1.000
Edit... |

|+ Tabular report

[+ t-Plot
[ Dverlay samples From To
IV Autoscale x-axis - 0.00000 100.00000 | nm
¥ Autoscale y-axis 1 0.0000 10000.0000 | 'em’fg STP
|
Lancel |
Thickness Curve Presents the type of thickness curves available.

» Reference

*  Kruk-Jaroniec-Sayari
e Halsey

e Harkins and Jura

e Broekhoff-de Boer

e Carbon Black STSA

You can also apply the Frenkel-Halsey-Hill thickness curve
using the Halsey option, and entering the appropriate values
in the equation. Use Edit to edit the values in the equation.

Edit Displays the equation for the type of thickness curve selected
so that you may view or edit the values.
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Reference

Displays the Entered t-Curve dialog allowing you to define a
t-curve by entering the relative pressure and thickness values.

ﬁ Entered t-Curve [X]
Name: IUserDeﬁned
Relative Pressure| Thickness | _| Insert

{P/Po] ) —l
1 1.0000 —lge'e'e
_ Cear|

Clear

Ctrl+down-arrow
to append

Open... |
Save As... |
-
| Erter strictly increasing relative pressures up to a maxirurn of 1.0
]

This table can also be created in another application if desired
and imported into this dialog using Open. When creating the
table in another application, the file must be saved as ASCI|I
text with a . THK extension. Use a two-column format with
the relative pressures in the first column and the thickness
values in the second column. Columns must be separated by a
space (or a tab).

Insert

Inserts a row above the selected row. A row cannot be
inserted if the value in the selected row is at its lowest value;
values must be strictly increasing. For example, in the table
shown above the default value is 0.000000001. Therefore,
you must use Ctrl + Down Arrow to insert rows.

Delete
Deletes the selected row.

Clear
Clears the table of all but one entry; one entry is required.

Open
Enables you to import the values from an existing t-curve.

Save As
Enables you to save the current table of values under a
different name.
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Kruk-Jaroniec-Sayari

Halsey

Harkins and Jura

Displays the Kruk-Jaroniec-Sayari Thickness Equation
dialog.

i Kruk-Jaroniec-Sayari Thickness Equation

l 0.3968
I 60.6500

t=1 1

I [HIEH] - log [p/p°)

|Enter a value between 0.00001 and 9999.00000.

Lancel |

You can edit the values for the numerator, the first element of
the denominator, and the exponent. The range for a selected
field is shown in the information bar at the bottom of the
dialog.

Refer to Appendix C, Calculations, for more information.

Displays the Halsey Thickness Equation dialog.

ﬁ Halsey Thickness Equation

I 0.333

-5.000

t= [ EED (

In [p/p*]

|Enter a value between -1.000 and 99999.000.

Lancel |

You can edit the values for the multiplier, numerator, and
exponent. The range for a selected field is shown in the
information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Displays the Harkins and Jura Thickness Equation dialog.

ﬁ Harkinz and Jura Thickness Equation

[ 139900 [ 0.500
1
| [ET - log (p/p*)

t=1

|Enter a value between 0.0001 and 9999.0000.

Lancel |

You can edit the values for the numerator, first element of the
denominator, and exponent. The range for a selected field is
shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.
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Broekhoff-de Boer Displays the Broekhoff-de Boer Thickness Equation dialog.

ﬁ Broekhoff-De Boer Thickness Equation

I 161100 I -0.1137 ¢
e I + I 0.1682 e

log [p/p*) =

Enter a value between -9999.9999 and -0.0001.

Lancel |

You can edit the values for the multiplier, numerator, and
exponent. The range for a selected field is shown in the
information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Carbon Black STSA Displays the STSA Thickness Equation dialog.

i Carbon Black STSA Thickness Equation

t= [ EEEND + [ 64500 (b/p7) + [ 0.8800 (p/p°F

|Enter a value between 0.0001 and 9999.9999.

Lancel |

All coefficients can be edited. The range for a selected field is
shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Surface Area group box Allows you to choose the surface area value used for
thickness calculations. You can use BET (most commonly
used), Langmuir, or enter one of preference.
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Pressure Range

Surface area correction
factor

Fitted Thickness Range

Tabular report

t-Plot

Overlay samples

Displays the Report Relative Pressure Range dialog so that
you may specify minimum and maximum relative pressures
to use with this report.

Il Report Relative Pressure Range

Enter the pressure range to be used when
calculation assignments are not used.

Minimum relative pressure: (0_010000000
Maximum relative pressure: | 0900000000
1] % I LCancel I

|Enter 3 value between 0.000000000 and 1.000000000.

» If Use calculation assignments is not selected on the
Collected/Entered dialog, all of the nonoutlier points of
the collected data within the specified range are used for
calculating the data for this report.

» If Use calculation assignments is selected, collected
data points which are assigned to this report type are
used.

This value corrects for surface areas that are not smooth and
brings the values for BET surface area into accordance. For
most samples, the default value of 1.000 is adequate

Provides two fields, allowing you to enter the minimum and
maximum thicknesses you wish to include in the thickness
curve.

Select this option to generate a table of collected data.

Select this option to generate a graphical representation of the
collected data.

Allows you to overlay data from the current sample file with
data from other sample file(s). The other sample file(s) are
chosen by clicking Overlays on the main Report Options
screen.
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Autoscale x-axis
Autoscale y-axis

From/To fields

Alpha-S Plot

Select these options to have the X- and/or Y-axes scaled
automatically.

Both X- and Y-axes begin at zero; the system uses the highest

values collected during analysis as the ending points.

If you choose not to autoscale data, the From and To fields

are enabled, allowing you to enter the ranges.

Enabled when you choose not to autoscale data (deselect the
Autoscale option), allowing you to specify the beginning and

ending ranges of the X- and/or Y-axis.

Data collected outside these ranges are not included in the

plot.

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.

i Alpha-5 Method

Relative
Pressure

4

Insert

|
Delete | l 0.0000

Clear | 1000.0000

d

Ctrl+down-arrow
to append

Open...

f

Save As...

Relative pressure range when calculation
assignments are not used:

| 0.000000000 to | 1.000000000 p/p°

Fitted Alpha-5 range:

v Tabular report
[+ Alpha-5 plot
[ Dverlay samples

v Autoscale z-axis

v Autoscale y-axis

From To

'5<I

0.0000 I 1000.0000

Y.‘l

0.0000 l 1000.0000 | cmi/fg STP

LCancel |

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm
using the quantity adsorbed at a relative pressure of 0.4.
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Table

Insert

Delete

Clear

Open

Save As

Fitted Alpha-S range

Relative pressure range

Tabular report

Provides two columns for entering the relative pressure (first
column) and the alpha-s values (second column).

This table can also be created in another application if desired
and imported into this dialog using Open. When creating the
table in another application, the file must be saved as ASCII
text with an ALS extension. Use a two-column format with
the relative pressures in the first column and the alpha-s
values in the second column. Columns must be separated by a
space (or a tab).

Inserts a row above the selected row. A row cannot be
inserted if the value in the selected row is at its lowest value;
values must be strictly increasing. For example, in the table
shown above, the default value is 0.000000001. Therefore
you must use Ctrl + Down Arrow to insert rows.

Deletes the selected row.

Clears the table of all but one entry; one entry is required.

Allows you to import the values from an existing alpha-s
curve (ALS) into the table. One predefined curve is shipped
with the analysis program. After the values are copied into
the table, you may edit them if desired. Editing these values
will not affect the file from which they were copied.

Enables you to save the current table of values under a file
name.

Provides two fields for entering the minimum and maximum
relative pressures from which the fit will be determined.

Provides two fields for entering a pressure range when
calculation assignments are not used.

Select this option to generate collected data in a tabular
manner.
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Alpha-S plot

Overlay samples

Autoscale x-axis
Autoscale y-axis

From/To fields

Select this option to generate collected data graphically.

Allows you to overlay data from the current sample file with
data from other sample file(s). The other sample file(s) are
chosen by clicking Overlays on the main Report Options
screen.

Select these options to have the X- and/or Y-axes scaled
automatically.

Both X- and Y-axes begin at zero; the system uses the highest
values collected during analysis as the ending points.

If you choose not to autoscale data, the From and To fields
are enabled, allowing you to enter the ranges.

Enabled when you choose not to autoscale data (deselect the
Autoscale option), allowing you to specify the beginning and
ending ranges of the X- and/or Y-axis.

Data collected outside these ranges are not included in the
plot.

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.
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f-Ratio Plot

8 [-Ratio Method

Reference isotherm:

Relative pressure range when calculation assignments are not uzed:

l 0.000000000 to | 1.000000000 p/p*

[+ Tabular report
I F-Plot

[ Dverlay samples
From To

¥ Autoscale x-axis l 0.000000000 I 1.000000000  "p/fp*
v Autoscale y-axis - l 0.0000 l 1000.0000

LCancel |

The f-Ratio report allows you to take the measured isotherm and normalize it using a reference
isotherm.

Reference Isotherm Displays the sample file you choose as a reference. You
should always choose a file containing an isotherm measured
from a non-porous sample of the same material as the current
sample.

Browse Click to choose the sample file you wish to use as a reference
for the isotherm.

Relative pressure range Allows you to enter a pressure range when calculations
assignments are not used.

Tabular report Choose this option to have a tabular report generated The
tabular report contains four columns: relative pressure,
guantity adsorbed for the isotherm of interest, quantity
adsorbed for the reference isotherm, and the ratio of the
guantities adsorbed.

f-Plot Choose this option to have the data plotted as a graph.
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Overlay samples

Autoscale x-axis
Autoscale y-axis

From/To fields

Allows you to overlay data from the current sample file with
data from other sample file(s). The other sample file(s) are
chosen by clicking Overlays on the main Report Options
screen.

Select these options to have the X- and/or Y-axes scaled
automatically.

Both X- and Y-axes begin at zero; the system uses the highest
values collected during analysis as the ending points.

If you choose not to autoscale data, the From and To fields
are enabled, allowing you to enter the ranges.

Enabled when you choose not to autoscale data (deselect the
Autoscale option), allowing you to specify the beginning and
ending ranges of the X- and/or Y-axis. Data collected outside

these ranges are not included in the plot.

BJH Adsorption/Desorption Report Options

i BIH Adsorption Report Dptions

- Thickness Curve
" Reference

" Kruk-Jaroniec-5ayari

~ Harkins and Jura
" Broekhoff-de Boer
" Carbon Black 5TSA

Edit._. |

~BJH Correction -
" Standard

" Kruk-Jaroniec-5ayari
¥ Faas

Minimum BJH width: | 1.7000 nm

Maximum BJH width: | 3000000 nm

Fraction of pores open [ oo | This field does not display on the
at both ends: =

Adsorplive. . |

[~ Smooth differentials

Selected Reports:

BJH Tabular Report
Cumulative Pore Yolume

d¥/dw Pore Yolume

dv¥/dlog(w] Pore Yolume

C ive Pore Area

Pressure Range. . |

dA/dw Pore Area
dA/dlog(w] Pore Area

Edit._. |

Lancel |

BJH Desorption dialog

The BJH Adsorption and Desorption dialogs include the same fields; the operating

instructions for both are the same.
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The BJH calculation determines the mesopore volume/area distribution which accounts for
both the change in adsorbate layer thickness and the liquid condensed in pore cores. You can
generate BJH reports from adsorption and desorption data.

Thickness Curve Type Presents the type of thickness curves available.

» Reference

*  Kruk-Jaroniec-Sayari

e Halsey

e Harkins-Jura

»  Broekhoff-de Boer

» Carbon Black STSA (ASTM D-6556-01A)

You can also apply the Frenkel-Halsey-Hill thickness curve
using the Halsey option, and entering the appropriate values
in the equation. Use Edit to edit the values in the equation.
Halsey is the default thickness curve and typically is used for
BJH calculations.

If you select a thickness curve which is not a good match for the sample being
\ analyzed, an incomplete pore distribution may be generated.

Edit Displays the equation for the type of thickness curve
selected.

Refer to t-Plot Report Options, page 5-41 for information
on the equations for thickness curves.

Minimum/Maximum BJH Provides fields for entering the minimum and maximum
size pore to be included in BJH reports.

The size can be reported in width (default), radius, or
diameter. Select Options > Units to specify the desired unit.

Fraction of pores open During calculations, the software assumes that all pores are

at both ends closed at one end. Sometimes a percentage of pores may be
open at both ends, causing disagreement in the adsorption

(not displayed on desorption  and desorption data or in the values for total volume and

dialog) total BJH pore volume. Enter a value in this field to
compensate for this error.

This field does not display on the BJH Desorption Report
Options dialog.

Jul 07 5-51



Open

ASAP 2050 Operator’'s Manual

Due to normal hysteresis, data may disagree even after applying this corrective factor.

Adsorptive Displays the BJH Adsorptive Options dialog, allowing you
to specify up to ten adsorptive/adsorbate property factor
combinations.

i BIH Adsorptive Dptions

Adsorbate
Adszorptive Property Factor
[nm)
1 [ - [ 095300
2 Jar = 1.04400
& =l | o.ooo000
4 =] | o.ooo000
a: =l | o.ooo000
6: =] | o.oo000
7 =] | o.oo000
8 =l | o.ooo000
ol |

The recommended adsorptives and their values are shown.
You may specify up to six additional adsorptive/adsorbate
property factor combinations.

The adsorbate property factor is the combination of con-
stants in the numerator of the BJH equation which is
specific to the type of gas used. Adsorbate property factors
may be specified in angstroms or nanometers. Select
Options > Data Presentation > Units to specify desired
units.

Smooth differentials Smooths all of the differential calculations, eliminating
variations in the differential computation caused by noise in
the input data.

5-52

Jul 07



ASAP 2050 Operator’'s Manual

Open

Pressure Range

BJH Correction

Standard

Kruk-Jaroniec-Sayari

Faas

Selected Reports

Edit

Displays the Report Relative Pressure Range dialog so that
you may specify minimum and maximum relative pressures
to use with this report.

» If Use calculation assignments is not selected on the
Collected/Entered dialog, all of the nonoutlier points of
the collected data within the specified range are used for
calculating the data for this report.

» If Use calculation assignments is selected, collected
data points which are assigned to this report type are
used.

Enables you to choose the type of correction to apply to
calculations. The type you choose will be displayed in the
report header.

Uses original BJH models.

Good for reference thickness curves.

Good for statistical thickness curves.

Lists the available BJH reports.

» Tabular Report

e Cumulative Pore Volume
e dVv/d* Pore Volume

e dVv/dlog(*) Pore Volume
e Cumulative Pore Area

e dA/d* Pore Area

* dA/dlog(*) Pore Area

* = width, radius, or diameter

Choose a report by double-clicking on the report name or
click the report name and press Spacebar. A report is
selected when it is preceded with a check mark.

Displays an associated dialog for the selected report.
Editing options for available reports are shown in
subsequent sections.
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You can measure pore width (W), pore radius (R), or pore diameter (D) for BJH reports.
\ Select Options > Units to specify desired measurement.

Tabular Report

The BJH Adsorption/Desorption tabular report allows you to specify the method of data

reduction.
- BIH Adsorption Tabular Report Options
Tabular data defined by Columns... |
" Fized pore size table
Table... |
o |

You can measure pore width, diameter, or radius; pore size can be expressed in
\ angstroms or nanometers. Select Options > Units to specify desired units.

Fixed pore size table Select this option to specify exact pore sizes for which
volume or area data are reported. Only the pore sizes within
the specified range appear on the report. Click Table to enter
(or edit) a fixed pore size table.

Collected points Select this option to include the values collected by the
system in the report calculations.
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Columns Displays the BJH Adsorption (or Desorption) Tabular Report
column Options dialog, allowing you to select up to six
columns of data for the tabular report.

i BJH Adsorption Tabular Report Column Options

Column 1: | JT Tt - |
Column 2: [ ayerage Width =
Column 3: [}ncremental Pore Yolume [
Column 4: |l'_‘ lative Pore Yolume LH
Column 5: | Incremental Pore Area LH
Column &: | & Pore Area L’|
|
Cancel |

The default column title appears next to the column number.
Each column includes a pull-down list of the data types to
include in the report; the pore width, radius, or diameter can
be measured (select Options > Units to choose the desired
unit).

Table Enabled when Fixed pore size table is selected for tabular
data. Displays the BJH Adsorption (or Desorption) Fixed
Pore Size Table dialog, allowing you to enter or edit a fixed
pore size table.

i BJH Adsorption Fixed Pore Size Table

[
1
Insert
2 0.5000 —J
Delete |
Clear |
Ctrl+down-arrow
to append
Coea |

The table must contain a minimum of two points and may
include as many as one thousand. Points must be strictly
decreasing.
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Insert
Inserts a row into the pressure table. The row is inserted
above the selected row and the cursor moves to the new row.

Delete
Deletes the selected row from the pressure table.

Clear

Removes all entries (except the two required ones) from the
table. A warning message requests confirmation before the
table is cleared.

Plot Options

Selecting a BJH plot option from the BJH Adsorption or Desorption Report Options dialog
enables you to specify the plotting method used for your report and to customize the plot.

You can measure pore width, diameter, or radius; pore size can be expressed in
angstroms or nanometers. Select Options > Units to specify desired units.

When you edit a BJH Adsorption or Desorption plot, a dialog similar to the following is
displayed.

i BJH Adsorption Cumulative Pore ¥olume Options

I+ Plot points
X-Axis
" Linear (* Logarithmic
¥ Autoscale | 1.00] to 1000.00 |{ nm
Y-Axis
Variable: |Cumulalive Pore Yolume _L“
DOverlay: |None _'J|
v Autoscale ! 0.0000 | to 9939.0000 | cmétg
Lancel |
Plot Options Allows you to have data plotted as a curve, points, or both.
X-Axis Lists the scale options for the x-axis
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Linear/Logarithmic

Autoscale

Y-axis

Variable

Overlay

Autoscale

Choose whether you wish to have the X-axis on a logarithmic
or linear scale. Unless you are performing micropore analy-
ses, use the logarithmic option.

Choose this option to have the x-axis scaled automatically.
Linear X-axes begin at zero, and logarithmic X-axes begin at
an appropriate value. The system uses the highest values col-
lected during analysis as the ending points.

If you deselect this option, the corresponding fields are
enabled so that you may enter a beginning and ending value.
Data collected outside the specified ranges are not included in
the plot.

X-axis range fields show pore radius or diameter in ang-
stroms or nanometers.

Data ranges are displayed in the information bar across the
bottom of the dialog when the cursor is in a numerical data
entry field.

Lists the options for the Y-axis.

Click on the down-arrow to choose a variable for the Y-axis.

Displays a list of overlay choices. You can choose a different
type of plot to overlay with the current plot. Or, you can
choose Samples to overlay the current type of plot with the
same type from other sample files. If you choose Samples,
you select the other files using Overlays on the Report
Options dialog.

Choose this option to have the y-axis scaled automatically. Y-
axes begin at zero. The system uses the highest values
collected during analysis as the ending points.

If you deselect this option, the corresponding fields are
enabled so that you may enter a beginning and ending value.
Data collected outside the specified ranges are not included in
the plot.

Y-axis range fields show the quantity of gas adsorbed.
Data ranges are displayed in the information bar across the
bottom of the dialog when the cursor is in a numerical data
entry field.
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Horvath-Kawazoe Report Options

Pore Geometry

Apply Cheng/Yang
correction

Smooth differentials

Pressure Range

i Horvath-Kawazoe Report Options

" Cylinder [Saito-Foley)
" Sphere

" Apply Cheng-Yang cormrection
[~ Smooth differentials

Pressure Range... |

Selected Reports:
+ H-K Tabular Report

+ d¥/dw Pore Yolume

P
F

" Computed
1.29e-43 ergcm”™4

' Entered

! 3.19e-43 erg-cm™4
FProperties. .. |

+ Cumulative Pore Yolume Edit... |

Lancel |

Select the option in this group box which best represents the
physical geometry of the micropores in the sample material.
Refer to Appendix C for additional information on
calculations used for these parameters.

Allows you to apply the Cheng/Yang correction to the pore
size analysis. This correction substitutes the Langmuir

equation of state for Henry’s Law in the Horvath-Kawazoe
derivation (see Appendix C).

Smooths the differential calculations, eliminating variations
in the differential computation caused by noise in the input

data.

Displays the Report Relative Pressure Range dialog so that
you may specify minimum and maximum relative pressures
to use with this report.

» If Use calculation assignments is not selected on the
Collected/Entered dialog, all of the nonoutlier points of
the collected data within the specified range are used for
calculating the data for this report.

» If Use calculation assignments is selected, collected
data points which are assigned to this report type are

used.
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Interaction Parameter

Computed

Entered

Properties

Select one of the options in this group box to determine
which interaction parameter is used during report generation.

The interaction parameter is calculated using the parameters
on the Horvath-Kawazoe Physical Properties dialog. You can
click Properties to view or edit these parameters. Each time
you change one of the parameters, the interaction parameter
is recalculated. The formula for computing the interaction
parameter is given in

Appendix C.

The value you enter in the adjacent field will be used.

Use this push button to view or edit the constants (used
during report generation) describing the physical properties
of the adsorbent and adsorptive; the Horvath-Kawazoe
Physical Properties dialog is displayed.

Il Horvath-Kawazoe Physical Properties -
Description: [T - |
Diameter IW nm
Diameter at zero energy: IW nm
Polarizability: Il.l]l.l[ie-Ztl cm
Magnetic susceptibility: lm o
Density: II.Sl}Be+15 molecule/cn®

A d

Mnemonic: |Ar

|

Diameter:

Polarnizability:

Magnetic susceptibility:

Diameter at zero energy: I 0.2530 nm

I 0.2950 nm
I1 -630e-24 em?

3.220e-29 | cm®

Density: 7.608e+14 imolecule/cn?
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Adsorbent Group Box

Adsorptive Group Box

Contains the parameters for the sample. If you select
Computed for the interaction parameter, all fields are
enabled and can be edited if desired. If you select Entered,
only the values in the Diameter and Diameter at zero
energy fields may be edited.

Description
The name of the adsorbent used in the analysis.

Click on the down arrow to make a new selection. Each time
you change the selection, the values for that adsorbent are
displayed in the appropriate fields.

Diameter
The diameter of the sample atom.

Diameter at zero energy
The diameter of an atom at zero interaction energy,

(2/5)16 x diameter.

Polarizability
The polarizability of the adsorbent.

Magnetic susceptibility
The magnetic susceptibility of the adsorbent.

Density
The density per unit area of the adsorbent.

Contains the parameters for the adsorptives (provided with
the software and/or user-defined). If you select Computed
for the interaction parameter, all fields are enabled and can be
edited if desired. If you select Entered, only the values in the
Diameter and Diameter at zero energy fields may be
edited.

Mnemonic
The mnemonic name of the adsorptive gas in use.

Click on the down arrow to make a new selection. Each time
you change the selection, the values for that adsorptive
display in the appropriate fields. If no parameters have been
defined, the default values are displayed.

Diameter
The diameter of the adsorptive atom.
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Adsorptive Group Box
(continued)

Selected Reports

Edit

Tabular Report Options

Diameter at zero energy
The diameter of an atom at zero interaction energy;,

(2/5)Y6 x diameter.

Polarizability
The polarizability of the adsorptive.

Magnetic susceptibility
The magnetic susceptibility of the adsorptive.

Density
The density per unit area of the adsorptive.

Lists the available Horvath-Kawazoe reports. Choose a report
by double-clicking on the report name or highlight the report
name and press the Spacebar. A report is selected when it is
preceded with a check mark.

The following reports are available:

e Tabular Report

e Cumulative Pore Volume
e dV/dw Pore Volume

Allows you to edit the selected report.

Displays the Horvath-Kawazoe Tabular Report Column Options dialog so that you can select
the type of data to display in each column.

i Horvath-Kawazoe Tabular Report Column Dptions

Column 1 | R -

Column 2: |Relalive Pressure L“

Calumn 3: | Quantity Adsorbed [

Column 4: | pore width 7]

Column 5: | cumulative Pore Volume =

Column &: | d¥/dw Pore Yolume .v..||
|

The default column title displays next to the column number. Each column includes a drop-
down list of the types of data to include in the report.
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Plot Options
i Horvath-Kawazoe Cumulative Pore ¥Yolume Options
I+ Plot points

X-Axis
[V Autoscale 0.00 | to 2.00| nm

Y-Axis
Variable: | Cumulative Pore Volume ;_“
Dverlay: | Mone ;_“
v Autoscale I 0.0000 to 99990000 | cm/g

e |

Selecting a Horvath-Kawazoe plot option from the Horvath-Kawazoe Report Options dialog
enables you to specify the plotting method used for your report and to customize the plot. Plots
for Cumulative Pore Volume and dV/dw Pore Volume are available.

When you select either of these plots from the Horvath-Kawazoe Report Options dialog, a
dialog like the following is displayed.

Plot Options Lists the data presentation styles available; you must choose
to plot a curve, points, or both.

X-axis options Choose Autoscale to have the x-axis scaled automatically.
The X-axis begins at zero and the system uses the highest
value collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so
that you may enter a beginning and ending value. Data
collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in
angstroms or nanometers.

Data ranges are displayed in the information bar across the
bottom of the dialog when the cursor is in a numerical data
entry field.
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Y-axis options Click on the down-arrow at the Variable field to choose a
variable for the Y-axis.

Click on the down-arrow at the Overlay field to overlay the
plot with data from other samples.

Choose Autoscale to have the y-axis scaled automatically. Y-
axes begin at zero. The system uses the highest value
collected during analysis as the ending point.

If you deselect Autoscale, the corresponding fields are
enabled so that you may enter a beginning and ending value.
Data collected outside these ranges are not included in the
plot.

Y-axis range fields show the quantity of gas adsorbed

Data ranges are displayed in the information bar across the
bottom of the dialog when the cursor is in a numerical data
entry field.
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DFT Pore Size

i DFT Pore Size Report Options

Type: ST ~ | Pressure Range... |
Geometry: Slit _Ll
Models:

N2 - DFT Model

Regularization Reports to Generate

* Hone + Tabular Report

" Low +# lzotherm Table
 Medi + Cumulative Area Graph =
_e _— + Incremental Area Graph Edie. |
" High + Differential Area Graph
" Entered + Cumulative Yolume Graph

l 0.01000) + Incremental Yolume Graph  ~

LCancel |

Type

Geometry

Models

Drop-down list containing the types of models available;
DFT or Classical.

DFT models are based on the density functional theory.
Classical models are based on the Kelvin equation and
thickness for determining the pore size distribution. Refer to
Appendix F for a discussion on models.

Drop-down list containing pore shapes available; Slit or
Cylinder.

Lists the models that meet the criteria specified and which
match the adsorbate and temperature of the sample data.

The models display in alphabetical order with the first one
automatically selected; you may select any one desired.

If the list is empty, there were no models that meet the
selected criteria.

5-64

Jul 07



ASAP 2050 Operator’'s Manual

Open

Pressure Range

Regularization

Reports to Generate

Displays the Report Relative Pressure Range dialog so that
you may specify minimum and maximum relative pressures
to use with this report.

* If Use calculation assignments is not selected on the Col-
lected/Entered dialog, all of the nonoutlier points of the
collected data within the specified range are used for calcu-
lating the data for this report.

 |f Use calculation assignments is selected, collected data
points which are assigned to this report type are used.

These choices enable you to choose the extent of smoothing
you wish to have applied to your data, or your can choose
None.

If you choose Entered, its field is enabled allowing you to
enter a number giving a relative weight for the smoothing
during deconvolution. Larger values produce more
smoothing.

Displays the types of reports available.

* Pore Size table

* Isotherm table

» Cumulative area graph

* Incremental area graph

+ Differential area graph

» Log goodness of fit graph
» Goodness of fit graph

Graph details can be edited by selecting the Edit push button.
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Edit

Plot Type

Autoscale Options

Overlay

Axis Range

Use this push button to edit details of a selected graph; a
dialog like the following is displayed.

Displays the type of————— [ 1
graph you are 7
editing. - Plot Type Autoscale Options ——
v Autoscale x-axis
v Aut le y-axis
DOverlay | Samples Lﬂ
— Axiz Hange
From To
| 0.001] 1000.000] nm
el | 0.000 | 2000.000] nt/g
gl |

This push button is disabled for tables and Goodness of Fit
graphs.

Enables you to choose the manner in which you wish to
display plotted data.

Select these options to have the axes scaled automatically.

If you deselect one or both of these options, you must enter a
range in the related Axis Range fields which become enabled
automatically.

This drop-down list contains the type of overlays available
for the current graph.

Choose Samples to overlay the same type of graph as the
current one from other data reductions. Then select Overlays
on the Report Options dialog to choose your files (explained
on page 5-29).

The fields in this group box become enabled when you dese-
lect Autoscale, allowing you to specify beginning and ending
values for the X- and/or Y-axis. Data collected outside these
ranges are not included in the plot.

Valid ranges for a selected field are displayed in the informa-
tion bar across the lower portion of the dialog.

The X-axis displays the energy and the Y-axis displays the
area.
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Surface Energy

- DFT Surface Energy Report Options

Type: CTGI—— - | Pressure Range... |
Models: AR - Modified Density Functional

M2 - Modified Density Functional

Regulanization Reports to Generate
* None -+ Tabular Report
" Low + |sotherm Table
 Medi + Cumulative Area Graph .
- _e = +# Incremental Area Graph i‘
High < Differential Area Graph
" Entered + Log Goodness of Fit Graph
l 0.01000 4 of Fit Graph e,
|

The fields on the Surface Energy dialog are identical to those on the DFT Pore Size dialog
with the following exceptions:

Geometry drop-down list Is not applicable to the Surface Energy report and, therefore,
does not display on its dialog.

Reports to Generate Displays the types of reports available.

 Surface energy table

* Isotherm table

e Cumulative area graph

* Incremental area graph

« Differential area graph

* Log goodness of fit graph
» Goodness of fit graph

Graph details can be edited by selecting the Edit push button.

Refer to the previous section for the DFT Pore Size report beginning on page 5-64 for
information on the fields contained on this dialog.
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Dubinin Report Options

_- Dubinin Report Options

Report Type Fitted relative
VR pressure range:

v Astakhoy I 0.000000
|+ Dptimize exponent I 1.000000
Exponent: I 2.0000

Fressure Range. .. |

Selected Reports:

Adsorplive. .. |

+ Dubinin Tabular Report

Transformed lzotherm Edit.... |

d¥/dw Pore Yolume

Lancel |
Report Type Allows you to specify the type of report you want. At least

one type of report must be selected.
Select Radushkevich to generate the Radushkevich report.

Select Astakhov to generate the Astakhov report. With this
choice, you may select Optimize Astakhov exponent. If you

do not select this option, the Exponent value field is enabled
so that you can enter a value.

Refer to Appendix C for more information.

Fitted relative Allows you to specify minimum and maximum limits on
pressure range relative pressures included in the line fit. Data collected
outside these limits are not included.
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Adsorptive Displays the Dubinin Adsorptive Options dialog allowing
you to specify up to 8 Adsorptive/Affinity Coefficient (beta)
combinations.

i Dubinin Adsorptive Options

Affinity
Adsorptive Coefficient
[beta)
1 [CEA— - [ 01797
2a =] [ ozemn
¥ |coz2 =] [ 019300
4 =l | o.oo000
LS =] | o.oo000
& = | o.oo0000
Z =l | o.oo000
8 =] | o.oo000
|
LCancel |
Pressure Range Displays the Report Relative Pressure Range dialog so that

you may specify minimum and maximum relative pressures
to use with this report.

» If Use calculation assignments is not selected on the
Collected/Entered dialog, all of the nonoutlier points of
the collected data within the specified range are used for
calculating the data for this report.

» If Use calculation assignments is selected, collected
data points which are assigned to this report type are
used.

Selected Reports Lists the available Dubinin reports. Choose a report by
double-clicking on the report name or highlight the report
name and press the Spacebar. A report is selected when it is
preceded with a check mark.

The following reports are available:
» Tabular Report

e Transformed Isotherm
» dV/dw Pore Volume (Astakhov only)
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Tabular Report

The Tabular report enables you to customize your report with one to six columns of data for
Astakhov reports and one to five columns of data for Radushkevich reports. The Dubinin
Tabular Report Column Options dialog is displayed.

i Dubinin Tabular Report Column Options

Calumn 1: | R o - |
Column 2: | Relative Pressure L“
Column 3: | Quantity Adsorbed ;!|
Column 4: |Log Quantity Adsorbed _'__I|
Column 5: {1 og (p*/p)°n =
Column 6: | d¥/dw Pore Yolume _'__I|
|
LCancel |

The default column title appears next to the column number. Each column includes a drop-
down list of the data types to include in the report.

Transformed Isotherm

The Transformed Isotherm report allows you to restrict the line fit to a portion of the isotherm.
The Dubinin Transformed Isotherm Plot Options dialog is displayed.

i Dubinin Transformed Isotherm Plot Dptions

v Autoscale x-axis l 0.000000 | to l 1000.000000 | ) ag ";'}p]ﬂ
v Autoscale y-axis I 0.00000 | to I 3.00000 'Log [B]
Lancel |
Overlay Samples Select this option to overlay the current plot with data from

other samples. Then click Overlays on the Report Options
dialog to choose the sample files.

Autoscale x-axis Select these options to have the X- and/or Y-axes

Autoscale y-axis automatically scaled. Both X- and Y-axes begin at zero, and
the system uses the highest values collected during analysis
as the ending points for axes ranges.

5-70 Jul 07



ASAP 2050 Operator’'s Manual

Open

Autoscale x-axis
Autoscale y-axis
(continued)

Pore Volume

If you choose not to autoscale data for either (or both) axis,
the adjacent fields are enabled so that you may enter a
beginning and ending value. Data collected outside these
ranges are not included in the plot.

The X-Axis Range fields show the quantity of gas adsorbed
at standard temperature and pressure.

The Y-Axis Range fields show the log of relative pressure.
Data ranges are displayed in the information bar across the

bottom of the dialog when the cursor is in a numerical data
entry field.

When you select the dV/dw Pore Volume plot from the Dubinin Report Options dialog, the
Dubinin dV/dw Pore Volume Options dialog is displayed.

\ report.

The Pore Volume report is unavailable if you choose Radushkevich as the type of

Plot options

Overlay Samples

i Dubinin d¥/dw Pore ¥Yolume Dptions

v Plot points [” Dverlay samples
v Autoscale x-axis I 0.00{ ta I 2.00 | nm
v Autoscale y-axis l 0.000| to ! 500.000 | e /g-nm
Cone |

You can plot data with a curve, points, or both.

Select this option to overlay data from other samples. Then
click Overlays on the Report Options dialog to choose the
files.
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Autoscale x-axis Select these options to have the X- and/or Y-axes

Autoscale y-axis automatically scaled. Both X- and Y-axes begin at zero, and
the system uses the highest values collected during analysis
as the ending points for axes ranges.

If you choose not to autoscale data for either (or both) axis,
the adjacent fields are enabled so that you may enter a
beginning and ending value. Data collected outside these
ranges are not included in the plot.

The X-axis Range fields show pore width, radius, or
diameter in angstroms or nanometers.

The Y-axis Range fields show the quantity of gas adsorbed.
Data ranges are displayed in the information bar across the

bottom of the dialog when the cursor is in a numerical data
entry field.

MP-Method Report Options

i MP-Method Report Options

Thickness Curve — | Selected Reports:

{* ; MP Tabular Report
 Halsey Cumulative Pore Yolume

d¥/dw Pore Yolume Edit... |
~ Cumulative Pore Area =
Equation... | dA/Zdw Pore Area

Pressure Range... |
|
Lancel |

Thickness Curve group box  Select the type of thickness curve from this group box.
You must choose either the Halsey equation or the
Harkins and Jura equation. Use Equation to edit the
values in the equation.

Equation Displays the equation for the type of thickness curve
selected
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Harkins and Jura Displays the Harkins and Jura Thickness Equation
dialog.

- Harkins and Jura Thickness Equation

l 0.500
l 13.9300

t=1 1

I [ET - log (p/p*)

|Enter a value between 0.0001 and 9999.0000.

Lancel |

You can edit the values for the numerator, first element of
the denominator, and exponent. The range for a selected

field is shown in the information bar at the bottom of the
dialog.

Refer to Appendix C for more information.

Halsey Displays the Halsey Thickness Equation dialog.

- Halsey Thickness Equation

I 0.333

-5.000

- [ BT (

In [p/p°)

|Enter a value between -1.000 and 99999.000.

Lancel |

You can edit the values for the multiplier, numerator, and
exponent. The range for a selected field is shown in the
information bar at the bottom of the dialog.

Refer to Appendix C for more information.
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Pressure Range

Selected Reports

Displays the Report Relative Pressure Range dialog so
that you may specify minimum and maximum relative
pressures to use with this report.

» If Use calculation assignments is not selected on
the Collected/Entered dialog, all of the nonoutlier
points of the collected data within the specified range
are used for calculating the data for this report.

» If Use calculation assignments is selected, col-
lected data points which are assigned to this report
type are used.

Lists the available MP-Method reports. Choose a report
by double-clicking on the report name or highlight the
report name and press the Spacebar. A report is selected
when it is preceded with a check mark.

The following reports are available:

e Tabular Report

e Cumulative Pore Volume
e dV/dw Pore Volume

e Cumulative Pore Area

* dA/dw Pore Area
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Tabular Report

The Tabular report enables you to customize your report with one to six columns of data. (The
data types in the first and second columns cannot be changed.) The MP-Method Tabular
Report Column Options dialog is displayed.

i MP-Method Tabular Report Column Options

Column 1: Pore Hydraulic Radius Interval
Column 2: Average Pore Hydraulic Radius
LA fIncremental bore Volume  Jad|
Column 4: | Cumulative Pore Yolume _'__I|
Column 5: | d¥/dw Pore Yolume :_“
Column §: | Incremental Pore Area _'__I|
|
Lancel |

The default column title appears next to the column number for columns three through six.
Each of these columns includes a drop-down list of the data types to include in the report.
Columns 1 and 2 are fixed and cannot be edited.

The MP-Method reports hydraulic radius only. If you select Pore size in diameter from
\ the Units dialog, the MP-Method still reports pore size in radius.

Pore Volume/Pore Area Plot

MP-Method plot options enable you to specify the plotting method used for your report and to
customize the plot. A dialog like the following is displayed. The fields on all dialogs are the
same.

i MP-Method Cumulative Pore Area Options

I+ Plot points

X-Axis

v Autoscale 0.0 to 200 F&
Y-Axis

Variable: |l'_‘ lative Pore Area _'_j|

Dverlay: |None ;_“

v Autoscale I 0.0000  to 99990000 fm*/g

Corce |
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Plot options

X-axis options

Y-axis options

Variable

Overlay

Autoscale

You can plot data with a curve, points, or both.

Choose Autoscale to have the x-axis scaled automatically.
The X-axis begins at zero and the system uses the highest
value collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so
that you may enter a beginning and ending value. Data
collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in
angstroms or nanometers.

Data ranges are displayed in the information bar across the
bottom of the dialog when the cursor is in a numerical data
entry field.

Allows you to choose Y-axis options.

Click on the down-arrow to choose a variable for the Y-axis.

You can use the choices in this drop-down list to overlay
plots. You can choose a different type of plot for the current
sample to overlay with the listed Variable, or you can choose
Samples to overlay the Variable plot with the same type of
plot from other samples.

Choose this option to have the y-axis scaled automatically. Y-
axes begin at zero. The system uses the highest value
collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so
that you may enter a beginning and ending value. Data
collected outside these ranges are not included in the plot.

Y-axis range fields show the quantity of gas adsorbed
Data ranges are displayed in the information bar across the

bottom of the dialog when the cursor is in a numerical data
entry field.
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Options Report

The Options report is a subset of the contents report; it provides pertinent information for the

following:

» Degas conditions

»  Adsorptive properties
* Analysis conditions

e Sample tube criteria
» Free space

* Poand temperature

» Equilibration

* Isotherm collection

Summary Report

The Summary report provides a condensed listing of analysis statistics and data results. The
Summary Report Options dialog allows you to choose the type of information to include in the

report.

- Summary Report Options =

- Surface Area
|+ Single-point BET

[V Multi-point BET

v Langmuir

¥ t-Plot micropore

¥ t-Plot external

[ BJH cum. adsorption
" BJH cum. desorption

Pore Yolume
|+ Adsorption total

p/p": I 0.010000000

¥ Desorption total

pip*: l 0.900000000

[+ t-Plot micropore
[~ BJH cum. adsorption

[ BJH cum. desorption

Deselect All |

i~ Pore Size

¥ Average pore width

[” BJH adsorption avag.
pore width [4¥/A)

I~ BJH desorption avg.
pore width [4¥/A)

Micropore Reports
- Dubinin-Astakhoy -

¥ Micropore surface area
IV Limiting micropore volume

- MP-Method

I Freundlich

I~ Temkin

[ Alpha-5

[~ DFT Pore Size

I DFT Surface Energy

v Cumulative surface area
v Cumulative pore volume

v Average pore hydraulic radius

~ Dubinin-Radushkevich

v Micropore surface area

¥ Monolayer capacity

~Horvath-K

¥ Magimum pore volume
v Median pore width

Lancel |
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Sample Log Report

The Sample Log report displays the following:
» Manual control operations performed during analysis

» Information entered using Add Log Entry on the sample file editor
*  Warnings and/or errors which occurred during analysis

Collected/Entered Data

If you choose Manually entered as the type of data in the Sample Information dialog, an
Entered tab is added allowing you to enter the data.

If you choose Automatically collected as the type of data in the Sample Information dialog, a
Collected Data tab is added when analysis is complete. The Collected Data dialog will
contain the data points collected during analysis and the specified calculation assignments.

This example shows the Collected Data dialog from a completed sample information file; the
Entered dialog is identical except the data is entered and the tab displays as Entered Data.

[]c:,2050"DATA}000-039.5MP

¢ Prew | TSampIe_ Sample [Dega_s_ [Analy_s_is [Adsorpt_ive Heport [ Collected I Mext 2> I
Information| Tube Conditions | Conditions | Properties | Options [rata
Absolute Fielative Guantity | Tatal [BET  |[Lang. 2
Frezsure Frezzure Adsorbed  [Pore | Suwif. | Suilf _J
[rarnHg] [p/p’] [cmédg STP | Yal Area  |Area | Freund| Te
1 8262543 0.011208635 291517
"2 |  z4sm23: oozeazas 3smAnd % | =
= 47.639595  (L.0B4621980 40.8712 # bl
4| susEESis 0080824470 42,6927 b b e |
5 | 74070023 0100488801 446237 % e Delete |
B 89188774 0120973120 46.3725 # bad
7 | 104439330 0141736723 4A0163 % | ® Ciear |
8 | 118801463 01B1131477 49.5271 # bid
9 | 133921768 0181635083 51.0043 # bl
70| 143140045 0200314345 524281 # bl
11| 183680267 0249003864 EE7614
(12| 2zasmayes Oo0A0A00ES.  BO57EE
- 2 JENERIAGT 0353347370 £ 20410 Llﬂ
¥ Uze calculation assignments prand T... Free Space... |
Save | Lloze | Basic |
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Pressure table

Insert

Delete

Clear

Use calculation
assignments

For collected data, columns for the following are displayed:
» absolute pressure

» relative pressure

e (uantity adsorbed

« outliers (if Use calculation assignments is not selected)

» calculation assignments for each requested report option
(if Use calculation assignments is selected)

For entered data, columns for the following are displayed:

» absolute or relative pressure (depending on the selection
in the Pressures group box)

e (uantity adsorbed

Enabled for entered data; inserts a row into the pressure
table.

Enabled for entered data; deletes the selected row.

Enabled for entered data; clears the entire table of all entries
except one (one is required).

If selected, allows you to assign the points to be collected for
each report type.

If deselected, each report (with the exception of Langmuir
and BET) uses a range of pressures as selected in Report
Options. The Langmuir and BET reports interpolate to
entered relative pressures on Report Options.

The outlier points can be selected so that they will not be
reported.
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Poand T Displays the Po and T dialog, allowing you to edit the
saturation pressure and temperature. Only the applicable
options are enabled.

Free Space Displays the Free Space dialog, allowing you to edit the
ambient and analysis free spaces. This dialog also includes
the plotted isotherm. The isotherm is redrawn each time you
edit the values in either field.

Also available for the isotherm is a shortcut menu containing
options allowing you to edit the curve and axes. You also can
zoom in for finer detail. Refer to Onscreen Reports, page 7-
16 for the options available.

+ Measured
Ambient: 19.2307
Analpsis:  19.0128

Isotherm Linear Plot

" Entered

i

(" Calculate

Guantity Adsorbed {crig STP)

IK:oun S G S s S
a 1 2 3 4 5 =] 7 g g 10
Relative Pressure (pip™

Lancel
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Save

Save As

Save enables you to save any changes you have made to the file in the active window. The file
is saved under its current name.

Save As enables you to:

save a sample or parameter file in the active window under a different name. This option is
useful for making a duplicate copy of a file that you can modify as desired without chang-
ing the original one. The original file remains open when you use this function, so be sure
to open the new file before making any changes.

save a subset (parameter) of the sample file in the active window as a standalone parame-
ter file. For example, select Analysis Conditions from the Save As menu to create a stan-
dalone parameter file of the analysis conditions portion of the active sample file.

save as an ASCII file the relative pressures and corresponding thicknesses (t-Curve) from
the collected data. These data are derived by dividing the condensed volume of adsorptive
by the selected surface area. The density conversion factor in the adsorptive properties file
is used to convert quantity adsorbed to volume of condensed adsorptive.

save as an ASCII file the relative pressures and resulting quantities adsorbed (Alpha-S)
from the collected data. These data are derived by taking the isotherm and dividing it by
the quantity adsorbed at 0.4 relative pressure.
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Sample and Parameter Files

A dialog similar to the one shown below is displayed when you select Sample Information,

Sample Tube, Degas Conditions, Analysis Conditions, Adsorptive Properties, or Report
Options.

Indicates the type (o] I |l Save as Degas Conditions File

file being saved . III’-E—

_Cal,

bl

Criteria

Date Range... |
Directories:
Files: c:h__\param
13x.deg 13¥ Degas Conditions “ a
alpha-al.deg  Alpha-Alumina Degas Conditions
d-4.deg D-4 Carbon Degas Conditions
zi-al.deg Silica-Alumina Degas Conditions

F7eagaL

Lancel |

Enter a file name (up to eight characters) in the File name field; the appropriate extension is
appended automatically when you click OK. The new file is saved as specified, but does not

remain in the active window. Be sure to open the new file before making any changes to the
file.

t-Curve and Alpha-S Files

The same type of dialog shown above is also displayed when you select t-Curve or Alpha-S.
However, before you receive this dialog for t-Curve, the Save As t-Curve dialog is displayed.
This dialog allows you to choose the surface area for the sample.

Surface Area
i+ BET 6463049 n2/g
” Langmuir 714.2159 mi/g

" Entered I 1.0000 | nfg

LCancel |
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Save All
Save All enables you to save all open files under their current names. This option provides a
faster way to save all open files at one time and avoids having to perform a Save operation on
each individual file.
A dialog prompting for a reason for the current change version of each file is displayed.
Close
Close enables you to close the file in the active window. If the file contains changes that have
not been saved, the following message is displayed:
(file name) has been changed. Save changes before closing?
Yes No Cancel
Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.
Close All

Close All enables you to close all open files under their current names. The following message
displays for every file containing changes that have not been saved:

(file name) has been changed. Save changes before closing?
Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.
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Print
Print enables you to print the contents of one or more files to the screen, a printer, or a file. For
example, if you choose Analysis Conditions, you will receive the parameters used for all
analysis conditions associated with the file(s). The print dialog is common to all file types.
Select the desired file type from the drop-down menu; a dialog similar to the following is
displayed:
Indicates the type — [T
g:lrnetlpn(;rt youare File name: IEIE—
- Selection Criteria Settings
Copies i 1 é%[
Destination | Printer ;]
Date Range... | File name I‘.Z: \DEMOZ2050\PARAMY
R
13zarlar.anc 13X, argon, @ 87 29 K N [N] -
13xarin2.anc 13X, argon, & 77 .35 K “r-al
alumina.anc  Alumina, krypton, @ 77.35 K [-c-]
bjhads42 anc BJH Adsorption, 42 Point, using Nitrogen [-d-]
bjhdes43.anc BJH Desorption. 43 Point. using Nitrogen [-g-1
charcoal.anc Charcoal, CO2, @ 273.15 K {-h-}
_Al-a-
R | _>l_| =
File name The name of the file you choose to print is copied to this
field. If you choose multiple files, the name of the last one
selected is displayed.
Copies Enabled when Printer is selected as the print destination.
You may print up to four copies
Destination Select the destination. You may print to a printer, the screen,
or afile.
5-84
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File name Enabled when you select File as the destination. A default
file name (the same name as the sample file) appears if you

choose only one file; you can use the default name or enter
another one.

If you select multiple files, the default displays as *.RPT;
each file will be exported as its original file name with the
RPT extension.

Refer to “Selecting Files” on page 2-11 for a description of the other fields on this dialog and
the Date Range push button.

List

List enables you to generate a listing of the following information on a selected sample or
parameter file.

File name

Date the file was created or last edited
Time the file was created or last edited
File identification

File status

Regardless of the type of file you choose, the dialogs are similar; the options presented in the
header vary slightly. The types of dialogs displayed are identical to the ones displayed for the

Print function; you simply obtain different types of information. This example shows a dialog
for sample files.

Indicates the type Ml List Sample Information File

of file on which you File name: [BE

have requested a

. .- - Select iteri i
list of statistics Crletis Eung !
Copi =
Status: | Complete Ll Shees =
Destinati Ty ;]
Date Range... | File name |C:\DEMO2050\DATANFIL
Files: Directories:
L c:h..\data
13x_ar.smp 13X Reference Material [AR] N [N] -
13x_n2 smp 13X Reference Material [N2] “r-al
13xarex.smp 13X Reference [Ar] [example) [-c-]
13xco2ex.smp 13X Ref CO2) (E le] [-d-]
13xznZex.smp 13X Reference [N2] [example] [-g-1
[-h-]
[-a-]

Lancel |

Refer to Print, page 5-84 for an explanation of the fields on this dialog.

You may request a list of multiple files by holding down Ctrl while selecting files. If no files
are selected, a list is generated for all files.
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Export

Export copies the isotherm data in the sample information file and reformats it in a text format
acceptable to other programs, such as spreadsheets. The output file consists of 4 columns
containing the absolute pressure, relative pressure, specific quantity adsorbed, and the elapsed

time.

File name

Settings

Destination

Il Export Sample File

File name: |E..‘..E

i~ Sel Criteria

- Settings

Status: | Complete _j

Date Range... |

Copies

Export Type

Files:

Directories:
c:h.. Adata

13x_ar.smp 13X Reference Material [AR]
13x_n2 smp 13X Reference Material [N2]
13xarex.smp 13X Reference [Ar] [example)
13xco2ex.smp 13X Ref [CO2) [E
13xznZex.smp 13X Reference [N2] [example]

|1

o oo

E-]

o[

Lancel |

The name of the file you choose to export is copied to this
field. If you choose multiple files, the name of the last one

selected is displayed.

This group box enables you choose print options.

Select Destination to export files to a printer, the screen, or
to a file. The Copies field is enabled if you choose printer,
allowing you to print up to four copies.

The File name field is enabled if you select File for export
destination. For the name, you can:

» Accept the default value where all selected files you
choose to export will have the same name as those in the
sample information file with an .1ISO extension.

For example, if you select the following files to export,
names will be assigned as indicated:
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Export

Selected Files

Export Names

C:\DATAI\SAMP1.SMP | C:\DATA1\SAMP1.1SO
C:\DATAL\SAMP2.SMP | C:\DATA1\SAMP2.1SO
C:\DATAI\SAMP3.SMP | C:\DATA1\SAMP3.1SO

Enter a name for the file (full path name). The extension
does not have to be .ISO. If exporting more than one file,
a wildcard character should be entered.

For example, if you use a .TXT extension, enter
C:\DATA2\*.TXT in the File name field.

Selected Files Export Names
C:\DATAL\SAMP1.SMP C:\DATA2\SAMP1.TXT
C:\DATAL\SAMP2.SMP C:\DATA2\SAMP2.TXT
C:\DATAL\SAMP3.SMP C:\DATA2\SAMP3.TXT
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Exit

Exit enables you to exit (close) the ASAP 2050 program.

» Ifan analysis is in progress, the following message is displayed:

CAUTION: Sample analysis is in progress. If you exit
the program analysis will continue to completion, but
the data are not saved to disk until the program is
restarted. Do you want to exit the program?

Yes No

Click Yes to close the ASAP 2050 program. The analysis continues and data are collected.
Click No to allow the program to remain active.

they are not saved in the file until the program is restarted. At that time the data are
saved automatically. If a power failure occurs in the interim and you do not have an
Uninterruptible Power Supply (UPS) attached, loss of data will result.

@ Although data are stored in the analyzer when you exit the program during analysis,

o Ifareportis in progress, you are cautioned that reports are being generated, and given the
opportunity to either cancel the print job or allow the reports to print before exiting.

\ Observe the Status area of the instrument schematic; it indicates when an analysis is
complete.
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6. UNIT MENU

N

The Unit menu contains the options for the operations that can be performed with the ASAP
2050 analyzer. The main menu will contain a Unit menu for each attached analyzer. For
example, if you have two attached analyzers, the main menu contains two Unit menus. The
appropriate unit number and serial number display in the title bar of the operational windows.
The status windows also display in different colors. This feature is especially useful when you
have more than one analyzer attached to the same computer.

The Unit menu does not display on the menu bar if the analysis program is being
used for offline data manipulation on a computer other than the one controlling the
analyzer.

Description

| Unit 1
Sample Analysis., .,
Stark Degas...

Enable Manual Control
Show Instrument Schematic
Show Status

Show Instrument Log

IInit Configuration. ..

Zalibration 4
Degas k
Service Tesk k

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found
in subsequent sections.

Sample Analysis Starts an analysis. This option is disabled if analyses are in
progress. Page 6-3.

Start Degas Allows you to start the degassing operation on one or two
samples. Page 6-7.

Enable Manual Control Allows you to control the system manually. Page 6-8.
Show Instrument Displays a schematic of the analyzer components. Page 6-11.
Schematic
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Description

Show Status

Show Instrument Log

Unit Configuration

Calibration

Degas

Service Test

Shows the status window of the operation in progress.
Page 6-12.

Displays a log of recent analyses, calibrations, and error mes-
sages. Page 6-13.

Displays the configuration of the analyzer. Page 6-15.

Enables you to calibrate certain components of the analyzer.
Page 6-17.

Allows you to perform sample degassing operations.
Page 6-22.

Enables you to perform certain troubleshooting procedures.
This option is enabled only with the direction of a Micromer-
itics service representative. Page 6-27.
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Sample Analysis

When you select this option from the Unit menu, the Sample Analysis dialog is displayed
with all fields disabled (grayed) and the Start Analysis dialog positioned on top. This allows
you to select a sample file for your analysis or to create a new one.

After a sample file has been designated, the Analysis dialog is displayed. The fields now con-
tain the values for the selected file or, if creating a new file, the specified defaults.

% analysis (Unit 1 - 5/N: 123)

Yiew: | Operation

.v_“ Browse |

Sample: ]uuu-um

Mass: I 1.0000 g Density: I 1.000 cm?ig
Sample Tube:
|Sample Tube _:_|| p*: 1_151_335 kPa
Analysis Conditions: Bath temperature: [W K
|F|un Conditions Lﬂ Archiant b 2 298.00 K

Adsorptive Properties:

| Mitrogen

L" Ambient free space: i 16.0000 | cm®

Report Options:

Analpzis free space: l 450000 cm?

| Report Options

Report After Analysis__. |

T §la" ............ |

LCancel | Cloze |

View

Browse

Sample

Mass

Density

Allows you to view one of the following in the current win-
dow:

« the current operation
* the instrument schematic
* the instrument log

Refer to Show Instrument Schematic on page 6-11 and
Show Instrument Log on page 6-13.

Displays the Start Analysis dialog allowing you to choose a
different sample file for the current analysis.

Displays an identification of the sample file.

Enables you to enter the sample’s mass.

Enables you to enter the density of the sample.
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Sample Analysis

Sample Tube

Analysis Conditions

Adsorptive Properties

Displays the name of the Sample Tube file for the current
sample file.

If this is a new file, this field contains the file you specified as
the default.

The drop-down list contains a list of predefined parameter
files that were saved to the Parameter Files Directory (refer to
Parameter Files Directory on page 8-11), as well as those
included with the analysis program. You may choose a dif-
ferent file from this list if desired.

Displays the name of the Analysis Conditions file for the cur-
rent sample file.

If this is a new file, this field contains the file you specified as
the default.

The drop-down list contains a list of predefined parameter
files that were saved to the Parameter Files Directory (refer to
Parameter Files Directory on page 8-11), as well as those
included with the analysis program. You may choose a dif-
ferent file from this list if desired.

Displays the name of the Adsorptive Properties file for the
current sample file.

If this is a new file, this field contains the file you specified as
the default.

The drop-down list contains a list of predefined parameter
files that were saved to the Parameter Files Directory (refer to
Parameter Files Directory on page 8-11), as well as those
shipped with the analysis program. You may choose a differ-
ent file from this list if desired.
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Report Options

Po

Bath temperature

Ambient Temperature
Ambient and Analysis Free

space

Report After Analysis

Start

Displays the name of the Report Options file for the current
sample file.

If this is a new file, this field contains the file you specified as
the default.

The drop-down list contains a list of predefined parameter
files that were saved to the Parameter Files Directory (refer to
Parameter Files Directory on page 8-11), as well as those
shipped with the analysis program. You may choose a differ-
ent file from this list if desired.

Enabled if you have chosen to enter the Po measurement.
Enter (or confirm) the saturation pressure of the adsorptive,
or edit the current one if desired.

Enabled if you have chosen to enter the bath temperature (Po
and T option on the Analysis Conditions dialog). Enter (or
confirm) the temperature for the analysis bath.

Enter the ambient temperature.

Enabled if you have chosen to enter the free space values
(Free Space option on the Analysis Conditions dialog). Enter
(or confirm) the appropriate values.

Displays the Report Settings dialog so that you may specify
report output options. If you choose Screen, reports have
many options for being customized and manipulated. (Refer
to Onscreen Reports on page 7-16 for details about
onscreen reports.)

Il Report Settings

¥ Report after analysis

Copies: I !F£1
—___ &
File name: IC:\DEMUZU5U\’.HPT

I aml Ganeil |

Begins the analysis; after data start to collect, an analyzing
view of the Analysis dialog is displayed.
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Sample Analysis

Yiew:

& Analysis (Unit 1 - 5/N: 101)

-0l x|
Dperztion B4 suspend | skip | [ Repon |

Isotherm Plot

Guantity Adsorbed {crig STP

1,000 1,500 2,000 2,500 3,000 3,500 4,000 4,500 5,000
Absalute Pressure (mmHg)
<< Prev | Start I LCancel Cloze |
Preliminary Analpsis Termination |
Sample REDO-2
Stage Last Point P [mmHg] P/Po B [em*/g 5TF] Po [mmHg] Run Time
Termination 50 of 50 216834305 0.216834305 151376 1000.000 2:27
Details: [Walming zample. Waiting for less than 760 mmHg for 509 seconds. |

Suspend

Skip

Suspends the analysis.

Skips the current step of the analysis.

task. Skipping

Use the Skip command with caution; the ASAP performs multiple steps for a given

personal injury.

certain steps may cause corruption of data, instrument damage, or

Resume

Cancel

Start

Next

Close

Resumes a suspended analysis.
Cancels the analysis.

On this view of the analysis dialog, this push button changes
to Next when the analysis is finished.

Enabled at the completion of the analysis. Returns you to the
first view of the Analysis dialog so that you may schedule
another analysis.

Enabled at the completion of analysis. Closes the dialog.
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Start Degas

This option allows you to choose the file and start degas operations on one or two samples;
the Automatic Degas dialog is displayed.

Il Automatic Degas {Unit 1 - 5/N: demo)
T S amale e
Degas conditions: | Degas Conditions _:]| Clear
2 Sample Browse. .
Degas conditions: | Degas Conditions L“ Clear
Start | Lancel |
Sample Click Browse to the right of this field to select a sample file

that will be used with the current sample.

Degas Conditions Displays the Degas Conditions file designated as the default.
After you choose a sample file, this field displays the file
associated with the sample file.

You can choose a different Degas Conditions file from the
drop-down list if desired. If you choose a different file, the

values in the current file will be overwritten with the values
of the new one.

Clear Clears the sample file from the port assignment. Click
Browse to choose a different file.

Start Starts the degassing operation

Cancel Closes the dialog, cancelling the degassing operation.

Jul 07 6-7



ASAP 2050 Operator’'s Manual Enable Manual Control

Enable Manual Control

Select this option to control certain components of your system manually. If the instrument
schematic is not displayed, select Instrument Schematic from the View drop-down list or
from the Unit menu.

ﬁilnstrument Schematic (Unit 1 - S/N: 103)

| Preliminary Analysis Termination |
Sample
Stage Last Point p [mmHg] pip* Q [em*/g 5TF] p° [mmHg) Run Time

Idle
Details: | |

When manual control is enabled, the valve symbols change color on the monitor screen to
indicate their status.

Green = open
Yellow = closed

Use the mouse pointer to select a component. A component is selected when it is surrounded
by a thin line. Each component has a shortcut menu displaying the operations available for
that particular component. These menus may be accessed by right-clicking on the desired
component, or by using the shortcut keys Shift + F9.

You can open and close valves, and raise or lower the elevator by using one of the following
methods:

» right-click on the valve or elevator symbol to access the shortcut menu and select the
appropriate action

» double-click on the valve or elevator symbol

« select the valve or elevator symbol and press the Spacebar
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Valves System valves and their functions are listed in Table 6-1.
’ $ Actions:  Open, Close, Pulse
Open  Closed Pulse briefly opens and closes (or vice versa) the valve.

Table 6-1. System Valves

Valve Description
1 Unrestricted vacuum

2 Restricted vacuum

3 Free-space measurement gas (helium)
4 Restricted analysis gas

5 Unrestricted analysis gas

7 Lower manifold isolation

8

9

Vapor
Sample port
10 Restricted Psat tube port
11 Unrestricted Psat tube port
P1 through P6 | Gas inlet port valves
PS Supply valve for physisorption gases
PV Vacuum valve for physisorption gases
Dewar positions The Dewar can be raised, lowered, or stopped.
ﬂ ﬁ Indicates the Dewar is being raised; note the position of the
I‘_ | |I‘ arrow in the center of the Dewar symbol.
!
‘ Jl ﬁ | Indicates the Dewar is being lowered; note the position of the

I__i_ I‘ arrow in the center of the Dewar symbol.
m ﬂ ﬂ [I‘ Indicates the Dewar is stopped in the raised position.
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Indicates the Dewar is stopped in the lowered position.

The remainder of the components are displayed for informational purposes only; they cannot
be controlled manually.

IL Represents the sample tube.

ﬂ Represents the Psat tube.

This group of rectangles on the left side of the schematic dis-
Temperature .
plays the temperature, the transducer, and the vacuum gauge

Transducer 0.47 mmHg == pressure.
Vacuum Gauge 22 umHg
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Show Instrument Schematic

Select this option to display a schematic of the ASAP 2050 analyzer. The schematic is a
graphical representation of the plumbing system including system valves, the analysis station,
and the Dewar position. The valves and Dewar can be controlled from the schematic when
Manual control is enabled. Refer to Enable Manual control on page 6-8 for an explanation
of the components displayed on the instrument schematic.

ﬁilnstrument Schematic (Unit 1 - S/N: 103)

0.47 mmHg j 8 9 10 1
Vapor

| Preliminary Analysis Termination |
Sample
Stage Last Point p [mmHg] pip* Q [em*/g 5TF] p° [mmHg) Run Time
Idle
Details: | |

The state of the valves can be determined quickly by color representation even when manual
control is not enabled:

» Green = open
* White = closed

If you wish to change the state of a valve, you must enable manual control.
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Show Status

A status window is shown across the bottom of all operational dialogs as well as the instru-
ment schematic. The Show Status option enables you to show only the status window. This
frees up your computer screen allowing you to perform other tasks (such as creating or edit-
ing sample files), while still monitoring the progress of your analysis.

If you have multiple instruments attached to your computer, the status bar for each instrument
is displayed in a different color.

Sample
Stage Last Point p [mmHg] pip* Q [cm*/g 5TF] p* [mmHg) Run Time
Analysis 10 of 30 550000000 0. 777000000 23.0000 F60.000 2:23
Details: | |
Analysis status bar Shows the progression of the analysis. This bar contains three
stages:

* Preliminary: ambient and analysis free spaces are deter-
mined; displays green during progression

» Analysis: data are collected; displays blue during progres-
sion

» Termination: the Dewar lowers, and the sample tube is
warmed and backfilled; displays gray during progression

All stages are displayed in red if the analysis has been

suspended.
Analysis details The following analysis details are displayed:
Sample: Sample file number
Stage: Stage of the analysis (as in status bar)
Last Point: Last point and number of points requested
P: Absolute pressure of last point
P/Po: Relative pressure of last point
V(cm3/g): Volume adsorbed
Po: Absolute pressure of last measured or
calculated saturation pressure (Po)
Run Time: Elapsed time since the start of analysis
Step details Provides details of the current step of the analysis.
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Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages.

‘f-'f“lnstrument Log {Unit 1 - 5/N: 101)

¥ Calibration

v Message

4f212007 8:13:00AM  Message:
4f212007 8:12:55AM  Message:
4§212007 8:12:36AM  Message:
3/30{2007 3:23:46PM Message:

Instrument Unit 1
Instrument Unit 1
Instrument Unit 1
Instrument Unit 1

- 5/N: 101 connection initialized.

- 5{N: 101 connection initialized. -
- 5{N: 101 connection closed.
- 5{N: 101 connection closed. =

Add Log Entry. | Report... |

By default, this information is logged for a 60-day period for analyses and messages, and a

90-day period for calibrations. You may change the time for which this information is

retained in the Unit section of the WIN2050.INI file. Simply replace the default value with

the desired number.

Analysis These options allow you to choose which entries are dis-
Calibration played in the window. For example, select the Calibration
Messages check box to display only calibration information.

Add Log Entry Enables you to make an entry in the instrument log that can-

not be recorded automatically through the application

software. For example, you may change the port filter. The
field adjacent to the push button allows you to enter the
operation; the push button is enabled when you make an
entry in the field, allowing you to add the entry.
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Show Instrument Log

Report

Displays the Log Report Settings dialog allowing you to
generate the log contents to a specified destination.

Il Log Report Settings
Start Date:  [03/01 J'l]? BT 115
Destination: | File L’
File name: [C:\DEMD2050%=F
1] % l Lancel |

Use the Start Date field to specify the date at which to start
the printout. This date does not limit the entries that display
in the window, it is only pertinent to the entries that will be
printed on the report.

You can specify a date using one of the following methods:

» Highlight the field (or press F2 to clear the field) and type
in the desired date.

» Double-click in the field (or press F4) to display a calendar
to choose a date.

» Press F3 to insert the current date.

Enter the number of copies desired in the Copies field; you
may print up to 4. This field is disabled if you are printing to
a File or to the Screen.

Choose the report destination from the drop-down list in the
Destination field. If you choose File, the File name field is
enabled, allowing you to enter a name for the printed file (or
you may accept the default).
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Unit Configuration

Select this option to view the current calibration settings, the date on which calibration was
performed, and the software and hardware configuration of your system.

[ Unit Configuration {Unit 1 - 5/N: 103)
~WYolume Calibration ~ Sof Yersi
System Lower Reference Boot: Boot Block ¥1.05 Jun 21
h8. 4284 28.8741 408.2100 Controller: 2050 MASS ¥1.00
Calibrated:  6/5/2007 10:26:46AM Application: ~ ASAP 2050 V1.00
—AfD Calibration ~ Smart¥ac Sof Yersi
Manifold Boot: ¥1.00 Apr 07 1998
temperature: /172007 11:09:20AM Application:  Smart¥ac ¥1.04 Jun 20 2007
Transducer
offsets: 6/22/2007 8:06:25AM Features:
Transducer  104.18 % of nominal Smart¥ac
scale: 642272007 8:08:-41AM
Yacuum: 53172007 3:30:18PM
— Conf g
Hardware: E
Comm port:  COM1 Board ID... | oK |
Senal #: 103
Volume Calibration Displays the system, lower, and reference volumes from the
most recent calibration. It also displays the date and time the
calibration was completed.
A/D Calibration Displays the following:
» The date and time the manifold temperature was last cali-
brated.
» The date and time the transducer offsets were last cali-
brated.
» The percent of nominal transducer scale in use, and the
date and time the transducer scale was last calibrated.
» The date and time the vacuum gauge was calibrated.
Configuration Displays the following:

» The hardware code specifying the hardware components
present in your analyzer. This code is provided so the Ser-
vice Department may quickly identify your hardware con-
figuration and provide prompt assistance.
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Unit Configuration

Configuration
(continued)

Software Versions

SmartVacSoftware
\Versions

Features

Gas

Board ID

» The identification number of the port being used to control
the analyzer.

» The serial number of the attached analyzer (active unit).

The software versions of the MIC BIOS, Controller, and
ASAP 2050 System software.

The software versions of the MIC BIOS and degas system
software.

The options currently enabled on your system.

Displays the Gas Configuration dialog.

Gas Configuration {(Unit 1 - 5/N: 101)

P1: [N2 =] Pza =] Pp3[co2 =

P4: [T -] PS5 | =] Pe| -l
Lancel |

This dialog allows you to choose the gases attached to each
port of the analyzer.

Displays the Board ID dialog so that you can view the sta-
tistics of the board contained in the requested slot of the card
cage in the instrument.

CETrEEE———
Board: | FRASEOS— - |
Yersion: 1]
Date: 063801
Part #: 202177017011
Revision: B
Model #: 2020
Seral #: 1
App info:
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Calibration

This option allows you to calibrate the vacuum gauge, pressure gauge, pressure scale, mani-

fold temperature, and system volume of the analysis system. You can also save the current
calibrations to a file or load a different calibration file.

Vacuum Gauge

Displays the Calibration Vacuum Gauge dialog containing the current vacuum level.

Il Calibrate ¥acuum Gauge {Unit 1 - 5/N: 101}

Cumrent yacuum level:

l il pmHg

Warning: Changing the calihl_alion information will

affect the perf of the inst; t. 0
qualified zervice personnel should do this.

oK | LCancel |

Enter 3 value between 1 and 30,

This dialog also allows you to enter a new value (if necessary) after calibration using an
external reference gauge.

Pressure Gauge

Displays the Calibrate Pressure Offset dialog.

- Calibrate Pressure Offset {Unit 1 - 5, N: 101} =] ]

Warning: Changing the calibration information will
affect the perf of the inst t. Only
qualified service personnel should do this.

Press the start button to evacuate the system and
then zero the pressure transducers.

Cancel |

This dialog allows you to evacuate the manifold and zero all pressure transducers in the
system.
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Pressure Scale

Use this option to adjust the scale of the transducer to match a reference standard; the Cali-
brate Pressure Scale dialog is displayed.

Il Calibrate Pressure Scale (Master) {Unit 1 - 5/N: 123)

" Reset to nominal

* Match to entered pressure

Actual manifold pressure: l IR mmHg

Warning: Changing the calihl_alion information will

affect the perf of the t. 0
qualified service personnel should do this.
oK I Lancel

Enter a value between 500.00 and 7500.00.

Reset to nominal Restores factory calibration settings for the transducer.

Match to entered pressure  Select this option to enter a value obtained using a reference
pressure gauge to determine the actual manifold pressure.

Temperature

Use this option to adjust the offset of the manifold temperature sensor to agree with a value
obtained using a calibration device. The Calibrate Manifold Temperature dialog is displayed

so that you may enter the measured value.

Il Calibrate Manifold Temperature {Unit 1 - 5/N: 101)

Current temperature:
[ EEEE K

Warning: Changing the calibration information will
affect the perf of the inst; t. Only
qualified zervice personnel should do this.

OK Lancel |

Enter 3 value between 273.15 and 1273.15.
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Volume

Use this option to enter a predetermined system volume in the event of data loss.

.4“-‘ Calibrate System Yolume {Unit 1 - 5/N: 101)

System Lower
i 60.0000 450000 cm?®

" Entered | 60.0000) | 45.0000) cn®

" Measured
Displays as Next if
you choose Warning: Changing the calibration information will

affect the perf of the inst; t. Only

Measured. qualified zervice personnel should do this.

—_———i Done | LCancel |

The system volume typically is calibrated after servicing valves, transducers, or any part of
the analysis plumbing. The ASAP 2050 must be idle to calibrate system volume. Before sys-
tem volume is calibrated, the manifold temperature sensor and the master pressure gauge
must be calibrated.

Previous Retains the values currently in use.
Entered Allows you to enter values to use.
Measured This field is used by authorized service personnel when mea-

suring the system and lower manifold volumes. A special
Service Kit is required to perform these procedures.

Done Closes the dialog (displays for the Previous and Entered
selections).
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Calibration

Next

Reference Volume

Reference Volume Temp.

Perform measurement

Start

Appears only when Measured was selected; displays a dia-
log that enables service personnel to enter measured volumes.

.4“-‘ Calibrate System Yolume {Unit 1 - S/N: 101)

Reference volume:

Ref, lume ¢

Perform measurement | 3|3 times

Reference volume and valve must be attached
to the instrument.

l 25,0000 cm?®
p 4 ! 27315 K

LCancel |

Enter the number of cubic centimeters for the reference vol-

ume you are using in this calibration.

Enter the temperature of the reference volume. Since the ref-
erence volume should be submerged in an ice bath, this value

should remain at 0.0°C for best accuracy.

Choose the number of measurements you wish to perform;

you may choose up to 9.

Begins the calibration; a status view is displayed. After the
calibration has finished, a confirmation view of the Calibrate

System Volume dialog is displayed.

.4“-‘ Calibrate System Yolume {Unit 1 - S/N: 101)

System Lower
" Previous k00000 45.0000° cm®
(Entered | 60.0000] | 450000 cn®
+ Measured 27.0000 145000 cm®
" Average 26.0000 13.5000 cm?
Last measurements
Std. dey. 08165 0.8165 cm®

LCancel |

This dialog allows you to choose the volume you wish to use.
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Save to File

Previous
The system volume and lower manifold volume in use before
this measurement.

Entered
An entered measurement.

Measured

The last measured system and lower manifold volumes; for
example if you choose 3 measurements, this value is that of
the last (third) measurement.

Average

The average of the series of measurements; for example if
you choose 3 measurements, this value is the average of the
three measurements.

Click Done to close the dialog.

Use this option to save the current calibration settings to a file; the Select Calibration File dia-

log is displayed

Load from File

Il Select Calibration File

File name: |1u1 -001.CAL

Directories:
ch.Shardware

R [ i

376239

+f] g

LCancel |

File name

Defaults to the next sequence number for calibration
files. The sequence number consists of: xxx-
yyy.CAL, where xxx = serial number of unit and
yyy = sequence number. For example, the number
listed in the above dialog represents the first calibra-
tion file for unit serial number 101.

Displays the Select Calibration File dialog (shown above) so that you can load a previously

saved calibration file.
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Degas

This option allows you to select options for the degas system.
Unit L

Sample Analysis...
Skart Degas. ..

Enable Manual Control
Show Instrument Schematic
Show Status

Show Instrurnent Log

Unit Configuration. ..

Calibration 3

Degas 4 + Enable Manual Control

Service Test 3 Show Degas Schematic
Show Skatus

Calibrate Pressure Zero, ..
Calibrate Pressure Scale. ..
Calibrate Macuum Gauge. .,
Calibrate Servo...

Enable Manual Control

Select this option to control manually certain components of the degas operation. If the degas
schematic is not displayed, select Show Instrument Schematic from the Degas menu.

i Degas Schematic (Unit 1 - 5/N: 101) 1 -1ol x|
i
Vacuum I
D1 D2
D7
Servo Back[.u—(l)—
valve | | | |
Current = 496 *C Current = 122 *C
Target = 120 *C
Ramp = 10.0 *C/min
Sample: .
Status:  Idle Check | Skip | Cancel |
Sample: .
Status:  Idle Check | Skip | Cancel |

Valves D1, D2, D5, D6, D7 Degas valves and their functions are listed in Table 6-2.

Actions: Open, Close
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Table 6-2. Degasser Valves

Valve Description
D1 and D2 Sample port valves
D5 Vacuum valve
D6 Servo isolation valve
D7 Gas inlet port valve
Servo Valve Actions: Set, Close

Set displays the Servo Value Settings dialog so that you can
enter a target pressure for sample evacuation. This feature
enables you to use the software to bring down the sample
pressure slowly and incrementally.

Close closes the servo valve.

Heaters Actions: Set, Disable
Set displays the Port [n] Heater Settings dialog so that you
can specify a ramp rate and target temperature. After you
click and close the dialog, the settings are displayed directly
below the heater symbol.

Disable cancels the settings.

Status window Displays the status of the current degassing operation(s).

Show Instrument Schematic

Displays the schematic (shown in the previous section) for the Degas system.
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Show Status

This option allows you to monitor the degassing operation.

5 Degas Status (Unit 1 - 5/N: 101) I (=1
g:a“ll::::: Idle Check | Skip | Cancel |
gy Check | Skip | Cancel |
Sample Displays the sample file being used with the degassing oper-

ation for each port.

Status Displays the current stage of the degassing operation for
each port.
Check Allows you to check the outgassing rate of the sample on the

related port; the following actions occur:

* current degassing step is suspended (on both ports).
Degassing can be checked after the vacuum setpoint has
been attained, or during a temperature ramp and hold. If
you choose this option during any other step, a message
indicating the degas system is not in a valid state is dis-
played.

e vacuum valves are closed and the vacuum level moni-
tored.

« the Status window will indicate that the degassing opera-
tion is being checked and will display the outgassing rate
as it becomes available.

During the degas check, this push button changes to Con-

tinue. When Continue is clicked, the valves open, the tem-
perature ramp or hold continues, and the degassing operation
resumes. If your outgassing rate indicated that the sample

has been rid of contaminants (minimal pressure increases),
you can click Skip to advance to the next state of the degas-
sing operation. For example, if you check degassing after the
setpoint is attained, Skip advances you to the ramping stage.

Skip Skips the current stage of the degassing operation for the
port associated with this push button.
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Cancel Cancels the degassing operation for the port associated with
this push button.

Calibrate Pressure Zero

Use this option to evacuate the manifold and zero the transducer

.4“-‘ Calibrate Degas Pressure Offset {Unit 1 - 5/N: 101)

Warning: Changing the calibration information will
affect the perf of the inst t

.0
qualified service personnel should do this.

Press the start button to evacuate the degas system
and then zero the pressure lransducer.

Cancel |

Start Begins the calibration.

Status messages are displayed during this procedure, then
the dialog closes automatically.

Calibrate Pressure Scale

Use this option to adjust the scale of the pressure transducer.

Il Calibrate Pressure Scale {(Unit 1 - §/N: 123)

Current pressure: l m mmHg

Warning: Changing the calibration information will

affect the perf of the inst; t. Only
qualified service personnel should do this.
1] % Lancel |

Enter 3 value between 500 and 1000,

Current Pressure Enter the current pressure of the degas manifold.
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Calibrate Vacuum Gauge

Displays the Calibrate Vacuum Gauge dialog containing the current vacuum level.

Il Calibrate ¥acuum Gauge {Unit 1 - 5/N: 101}

Cumrent vacuum level: l 0 umHg

Warning: Changing the calibration information will
affect the perf of the inst; t. Only
qualified zervice personnel should do this.

1] % LCancel

Enter 3 value between 1 and 30,

This dialog also allows you to enter a new calibration value (if necessary) obtained using an
external reference gauge.

Calibrate Servo

Use this option to calibrate the servo valve to the manifold pressure transducer. The servo
valve should always be recalibrated after a pressure calibration has been performed. The Cal-
ibrate Degas Servo dialog is displayed.

.4“-‘ Calibrate Degas Servo (Unit 1 - 5/N: 101}

Warning: Changing the calibration information will
affect the perf of the inst; t. Only
qualified service personnel should do this.

Press the start button to calibrate the servo to the
main transducer.

Cancel |

Start Begins the calibration. The servo valve is used to evacuate
and equilibrate the manifold. The pressure transducer read-
ings are used to calibrate the servo set point. Status messages
are displayed during this procedure, then the dialog closes
automatically.
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Service Test

Various service tests are included in the ASAP 2050 operating program. These tests can be
enabled and performed only with the assistance of a trained Micromeritics service represen-
tative. These tests are designed to provide your service representative with instrument
readouts, as well as to assist him in troubleshooting potential problems and, perhaps, elimi-
nating unnecessary repair services. This service strategy allows you to conduct expert tests in
less time than it would take to be trained in servicing the instrument properly.
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Description

/. REPORTS MENU

This chapter describes the commands on the Reports menu.

Reports can be generated for data:

» collected on a sample that has completed analysis

» collected on a sample that is currently being analyzed (includes only the information col-
lected up to the time of the report)

» that is manually entered

Description

fﬁepurg
Skart Repart... Fa
Close Reports Fa

Cpen Report...

SPC Report Opkions., ..
Regression Report. ..
Control Chart...

Heat of Adsorption.., Fi0
Ruate of Adsarption,,,  FL1

Listed below are brief descriptions of the commands contained on the Reports menu. Detailed
descriptions follow this section.

Start Report

Close Reports

Open Report

SPC Report Options

Regression Report

Allows you to generate a report on a completed sample
analysis or on the data collected thus far for an analysis in
progress. Page 7-2.

Closes all open report windows. Page 7-4.

Enables you to open a report that was saved from the report
window. Page 7-4.

Allows you to specify the sample data to be included in SPC
reports. Page 7-5.

Allows you to generate a regression report. Page 7-6.
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Control Chart

Heat of Adsorption

Rate of Adsorption

Start Report

Allows you to generate a control chart report. Page 7-10.

Allows you to generate a Heat of Adsorption report.
Page 7-13.

Not used.

Select this option to generate a report on a sample analysis. Select Start report from the
Reports menu to display the Start Report dialog.

Il Start Report
File name: |*.SMP
- Selection Criteria Settings
Copi 11
Status: | All Ll Shees =
Destination | File ;j
Date Range... | File name |C:A\DEMOZ2050MDATAN- A
Files: Directories:
L c:h..\data
13xarex.smp 13X Reference [Ar] [example) N [N] -
13xco2ex.smp 13X Ref [CO2) [E le] “r-al
13xnZex.smp 13X Reference [N2] [example) [-c-]
a-alkrex.smp  Alumina [Kr] [example) [-d-]
d-4cnZex.smp D-4 Carbon [examplel [-9-]
[-h-]
[-a]
L _>l_I [

File name

Status

Status
(continued)

The name you select from the Files list box is copied to this
field. If you select multiple files, only the last one selected is
displayed. If you have a sample file open when you select this
option, its name is displayed.

This drop-down list determines what type of sample files are
displayed in the Files list window in the specified directory
for all dates, or within the specified range of dates (using
push button).

Choices:All, Analyzing, Complete, Entered

Refer to “Table 2-2. File Status and Description” on
page 2-12 for a description of the status types.
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Start Report

Date Range

Copies

Destination

File name

Files list box

Directories

Displays the Select Dates dialog so that you may specify a
range of dates. Refer to “Selecting Files” on page 2-11 for a
description of this push button.

Enabled when the Printer destination is chosen. This option
allows you to print up to four copies of the selected report(s).

Displays a drop-down list of output destinations.
Choices:File, Printer, Screen

If you select Printer, requested reports are printed to the
selected printer.

If you select Screen, many options are available for
manipulating and customizing reports. Refer to Printed
reports on page 7-16.

If you select File, the tabular reports of the requested file are
converted to a text file which can be viewed with a text editor
or other text file manipulation tool. Graphical data cannot be
generated to a File.

Enabled when you select File as the destination. Allows you
to enter a name, or you may accept the default.

Displays a list of the available sample files for the choice
shown in the Status field and within the range of dates
specified in the Dates dialog.

Displays a list of available drives and directories. The drive
and directory last accessed is displayed immediately above
the Directories list box.

If you choose a single sample file, the Reports to Generate
dialog is displayed. The reports selected are the ones you
specified in the sample file. This dialog allows you to
deselect reports or select additional ones.
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Il Select Reports
4 Summary -

BET Surface Area
Langmuir Surface Area
Freundlich

Temkin

t-Plot

Alpha-5 Method
f-Ratio Method

BJH Adsorption

BJH Desorption
Horvath-Kawazoe

DFT Pore Size

DFT Surface Energy e

Dubinin

MP-Method hd
1] 4 I Lancel |

Double-click on the report(s) you wish to select (or deselect);
alternatively, you can highlight the report and press Space-
bar. A check mark is placed before each selected report.
After you make your report selection and click OK, the
requested reports are sent to the specified destination.

If you choose more than one file, this dialog is not displayed.
The reports specified in each sample file will be generated.

Close Reports

This option enables you to close all open report windows at one time. This avoids having to
select close on each report window.

Open Report

Enables you to open a report that you saved from the report window.
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SPC Report Options

SPC Report Options

When you select SPC Report Options, the SPC Report Options dialog is displayed.

Il SPC Report Options

—curf

iz Options

" Equilibration interval
™ Evacuation time

I Analysis temp

[~ Saturation pressure
[~ Ambient free space

™ Analysis free space

Area

" Single-point BET
[~ Multi-point BET
" Langmuir

™ t-Plot micropore
[~ t-Plot external
[ BJH adsorption
™ BJH desorption

— Pore ¥olume
™ Adsorption total
" Desorption total
[~ t-Plot micropore

[ BJH lative d

[ BJH cumulative adsorption

— Pore Size

[ BJH ads. avg. pore width 478
[~ BJH des. avg. pore width 4¥/4

LCancel

More. ..

The SPC Report Options dialog lists the variables that are most frequently used for SPC
reporting. You can check as many as desired. All variables selected are computed for each

sample file used in an SPC report.

Click More for additional SPC calculations for the detailed reports.

Il SPC Calculations

[~ Monolayer volume

™ Comrelation coefficient

~BET——

- Dubinin-Astakhoy

]

" Micropore surface area

[ Limiting micropore volume

- Alpha-5
" Slope
™ ¥-Intercept

— Dubinin-Radushkevich
[~ Micropore surface area

[~ Monolayer capacity

- DFT Pore Size

" Total pore area

[~ Total pore volume

" B value
" Monolayer volume

™ Comrelation coefficient

- MP-Method
[” Cumulative surface area
[” Cumulative pore volume

[~ Average pore width

- DFT Surface Area

" Total surface area

- Horvath-Kawazoe

[~ Magimum pore volume

[ Median pore width

LCancel |
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Regression Report

Select this option to generate a regression report. The regression report is used to determine
the interdependency between two variables. Up to three dependent variables (Y-axis) may be
plotted against a single independent variable (X-axis). The degree of correlation between the
variables also is reported. The graphs for the regression report are scaled so that all three fit
on a single page. If you choose less than three, the graphs are scaled to fill most of the page.

Il Regression Report

vV Show report title !HEQIESSiDN Report

v Show graphic |mklogo.em[ _Eﬂﬁe-;l

Height: [ 0250 in  Width: [ 2.000 in
= Axis Range Auto-

il From To scale
K-auis: [Nane =1 0.0000(| 1.000.0000] )
First graph =
Y-atis: [Nane =1 0.0000|| 1.000.0000 [}
Second graph
Y-axis: [None =1 0.0000 ] 1,000.0000 [
Third graph =
¥-axis: [Nane =1 0.0000|| 1.000.0000 | §

[~ Tabular report
" Label data

Samples... |
Save as Default |

[” Recalculate archived SPC results

- Report Settings
Copies: 18

Destination: | File LIJ

File iC:\DEMDZI]SI]\DATA\’.HPT

Report I LCancel |

Show report title

Show graphic

Select this option to have a title display on your report.
Accept the default or enter a new title. You can enter up to 40
alphanumeric characters.

Deselect this option to omit the report title.

Select this option to have a graphic display above your report
title. For example, you may wish to display your company
logo. The graphic must be a bitmap (bmp) or enhanced
metafile (emf).

Click Browse to choose the file, then use the Height and
Width fields to specify a size. This image can be edited in the
report window (when printed to the screen), or removed if
desired.
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Regression Report

X-and Y-Axes
Variable fields

Axis Range

Autoscale

Recalculate archived
SPC results

Tabular report

Label data

Samples

Allows you to designate the X- and Y-axes variables. Click
on the down arrow to display a list of variables. The variables
in this list are the ones you specified in the SPC report
options.

With this option, you can plot the regression of up to three Y-
axis variables against the X-axis variable. The X-axis
specifies the independent variable for the regression, while
the Y-axes provide the dependent variables.

Enables you to specify the beginning and ending values for
the X- and Y-axis ranges. Data collected outside these ranges
are not included in the plot. These fields are disabled if you
choose Autoscale.

Allows you to have the X- and/or Y-axes scaled
automatically. When scaled automatically, both axes begin at
zero. The analysis program uses the highest values collected
during analysis as the ending points.

Select this option to have archived SPC values recalculated.
This ensures that any changes made to the SPC Report
Options are included in the new report; however, it does
lengthen the time required to generate the report.

Enables you to generate tabular, as well as graphical, data of
the included samples. A tabular report contains the numeric
values contributed by each sample.

Allows you to label the points on the plot to correspond with
the values in the sample files.

Displays the Regression Report Sample Selection dialog,
allowing you to choose the sample files you wish to have
reported.
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Il Regression Report Sample Selection

File name: |*.SMP

Directories:  c:\demo2050\data

- Selection Criteria

I Use all files [T 7|
Status: |All Li in this -a-]
directory c-]
| d-]
Date Range... a1 L
h.1

Axailable Files:

Selected Files

13x_ar.smp
13x_n2 smp
13xarex smp
13xco2ex smp
13znZex.smp
a-al_kr.smp
a-al_n2.smp
a-alkrex_smp
d-4dcnZex. smp

13X Reference Material [AR] « 55
13X Reference Material [N2] |
13X Reference [Ar] [example
13X Reference [CO2) [Examg
13X Reference [N2] [example
Alumina Reference Material [
Alumina Reference Matenal [
Alumina [Kr] [example] b
D-4 Carbon [example]

Date Range

Use all files in

this directory

Add

Directories

o o o
LCancel |
File name Use this field to limit the files displayed in the Available Files
pane. For example; enter g*.smp to display only the files
beginning with an g.
Status This drop-down list determines the type of sample files that

display in the Available Files pane in the selected directory
for all dates, or within the specified range of dates (using
Date Range push button). Refer to “Table 2-2. File Status
and Description” on page 2-12 for an explanation of the
Status types.

Displays the Select Dates dialog so that you can specify a
range of dates. Refer to “Selecting Files” on page 2-11 for
an explanation of this dialog.

Select this option to include all files from the selected
directory in the report.

Lists the current directory. Use the directory window to
navigate to a different directory.

Moves the selected file in the Available Files pane to the
Selected Files pane. Alternatively, you can simply double-
click on the desired file(s). You can select multiple files by
holding down Ctrl while making your selections. You can
include up to 200 sample files.
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Regression Report

Remove

Save As Default

Report Settings

Report

Removes the selected file from the Selected Files pane and
places it back into the Available Files pane.

Saves the current definition of the report as the default.

The options in this group box enable you to choose output
criteria.

The Copies field is enabled when you choose Printer as the

destination, enabling you to print up to four copies of the
report.

Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a

statistic.

Show report title

Il Control Chart
¥ Show report title Conlml Charl
v Show graphic lmlclogo.em[ m‘
Height: [ 0.250 in width: [ 2.000 in
% Axiz Order By |
‘ @ Time ( Filename ( Date  Minutes ( Days ‘
Y Axis Label
Graph 1... | Hone
Graph 2... | Mone
Graph 3... | Mone
" Tabular report " Recalculate archived SPC results
- Report Settings
Copies: | 1=
Samples... |
Destination: |St:leen _L“
‘ File name: li;:\DIZMGZIJSB\DAiA\'.HPT
Save as Default | Cancel |

Select this option to have a title display on your report.

Show graphic

X-axis Order By

Accept the default or enter a new title. You can enter up to 40
alphanumeric characters.

Deselect this option to omit the report title.

Select this option to have a graphic display above your report
title. For example, you may wish to display your company
logo. The graphic must be a bitmap (bmp) or enhanced
metafile (emf).

Click Browse to choose the file, then use the Height and
Width fields to specify a size. This image can be edited in the
report window (when printed to the screen), or removed if
desired.

Enables you to choose the order in which X-axis statistics are
placed. You can have them placed by Time, File name, Date,
Minutes, or Days.
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Control Chart

Graph [n]

Statistic

Autoscale

Center Line

Limit Lines

Tabular report

Recalculate archived
SPC results

Displays the Control Chart Graph [n] Options dialog,
allowing you to define the Y-axis of each graph.

Il Control Chart Graph 1 Options _
=Y Axis
Statistc: (TR - |
v Autoscale
From: [10,000.0000 Te: | 10.000.0000
~Center Line—————— |- Limit Lines
+ None ¥ None
i~ Mean "+ and - W"
" Entered i Entered
Center line at: lm. Hiatelintt I 2.0u00
Low limit' [ 0.0000]
|

This drop-down list displays the SPC variables selected on
the SPC Report Options dialog. The variable you choose will
be plotted against time.

Allows you to have the Y-axis scaled automatically. If you
wish to specify a range, deselect this option and enter a range
in the From and To fields.

Displays placement options for the variable’s optional value.
Choose Entered to specify placement of the line.

Displays the options available for limiting lines. You can
have the lines placed at some multiple of the standard
deviation or at specified positions (Entered).

When you select Entered, the High limit and Low limit
fields are enabled, allowing you to enter appropriate values.

Allows you to generate tabular, as well as graphical, data of
the included samples. A tabular report contains the numeric
values contributed by each sample.

Select this option to have archived SPC values recalculated.
This ensures that any changes made to the SPC Report
Options are included in the new report. It also lengthens the
time required to generate the report.
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Samples

Save as Default

Report Settings

Report

Displays the Control Chart Sample Selection dialog, allowing
you to choose the sample files on which you wish to report.

E—_———————————————————
Il Control Chart Sample Selection

File name: l’.SMP

_ talach

Directories: c:\demo2050\data

[~ Use all files [T] 7 |
Status: |All Li in this

directory
Date Range... |

Available Files: Selected File

13x_ar.smp 13X Reference Material [AR] & 8
13x_n2.smp 13X Reference Material (N2) ™|
13xarex.smp 13X Reference [Ar] [example
13xcoZex.emp 13X Reference [CO2) (Examg
13¥nZex.smp 13X Reference [M2] [example
a-al_kr.smp Alumina Reference Maternial [
a-al_n2.smp  Alumina Reference Material [

Criteria

Fe s

| | i) K L|l|
Add Bemove |
LCancel |

This dialog functions in the same manner as the Regression
Report Sample Selection Dialog explained on page 7-7.

Saves the current definition of the report as the default.

The options in this group box enable you to choose output
criteria.

The Copies field is enabled when you choose Printer as the

destination, enabling you to print up to four copies of the
report.

Generates the report.
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Heat of Adsorption

Heat of Adsorption

The isosteric heat of adsorption is an important parameter for characterizing the surface
heterogeneity, providing information about the adsorbent and the adsorption capacity. Multiple
adsorption isotherms are obtained on the same sample using the same adsorptive but at
different temperatures to obtain the heat of adsorption.

This option allows you to choose the sample files, define the quantities, and generate a Heat of
Adsorption report; the Heat of Adsorption dialog is displayed.

Il Heat of Adsorption =
Quantities Adsorbed [mmol/g]
Temp, j
Sarmple ['C]_| 0.0000
o | o[
~ Report Settings
¥ Show report title IHeal of Adsorption
e e | ¥ Show graphic Imiclogo.em[ Browse. .. |
ClBar S smalgs | Height: l 0.250  in Widlh:l 2.000  in
v Tabular report Copies: 1 g
. — |+ Isostere plot Destination: _'_I|
Edit Quantities. .. | - = =
¥ Heat of adsorption plot File name: |C:ADEMO2050\DATAN RPT
Open... | Save. .. | Heport | Cloze |
Table Contains the files you choose; also lists the quantity
adsorbed.
Add Samples Displays the Select Samples dialog so that you can choose

Remove Samples

Clear Samples

desired files.

Removes the selected sample from the list. If no samples are
selected, the last one is removed.

Removes all samples from the list.
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Edit Quantities

Quantity Adsorbed
table

Insert Range

Save Table

Load Table

Insert

Displays the Edit Quantities Adsorbed dialog so that you can
specify the range of surface coverage to include in the heat of

adsorption report.

fr—

Ml Edit Quantities Adsorbed B3

Quantity
Adsorbed
ol
1 0.00001

)

Insert I

Delete |
Clear |

Ctrl+down-arrow
to append

Load Table... |
Save Table... |

Apply

Cloze

Allows you to enter the points.

Displays the Insert Quantity Range dialog.
This dialog allows you to specify the starting and ending
guantities adsorbed, as well as the number of points to insert

within the specified range.

Starting quantity adsorbed:
Ending quantity adsorbed:

Humber of points:

Il Insert Quantity Range

EETHEE mmol/g
17.84591 mmol/g
I 10

LCancel |

Enter 3 value between 0.00000 and 44.61477.

Allows you to save the current table as a file (QNT

extension).

Allows you to import a previo

usly saved table.

Inserts a row above the selected row.
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Heat of Adsorption

Delete

Clear

Report Settings

Show report title

Show graphic

Copies

Destination

File name

Report

Tabular report

Isostere plot

Heat of adsorption plot

Deletes the selected row.

Clears the entire table of all entries except one; one is
required.

The options in this group box allow you to choose report
criteria.

Choose this option to have a title display in the header of
your report, then use the adjacent field to enter the title.

This option allows you to have a graphic appear in your title;
for example, you may wish to show your company logo. You
can use a bitmap or an enhanced metafile.

Use the Height and Width fields to define a size.

Enabled when you choose Printer as the destination, allowing
you to print up to four copies of your report(s).

Enabled when you choose Printer as the destination, allowing
your to print up to four copies of your report(s).

Enabled when you choose File as the destination, allowing
you to enter a name (or you can accept the default).

Generates the report.

Select this option to have data generated in a tabular format.

Select this option to generate a graph showing quantities of
gas adsorbed vs. the temperature.

Select this option to generate the Heat of Adsorption data in a
graphical format.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file
statistics.

e Tabular and graphical reports contain sample and instrument statistics such as when the
file was created and by whom, date and time of analysis, analysis conditions, and so forth.

The headers for these reports also contain notes of any changes to the sample file that
occur after analysis.

e Summary report headers contain the same type of information displayed in tabular and
graphical reports with the exception of notes.

Onscreen Reports

The report window containing onscreen reports provides many options for customizing and
manipulating reports:

 atool bar
 shortcut menus
e zoom feature
* axis cross-hairs

When reports are printed to the screen, they are printed in a window like the one shown below.
Each requested report is listed in the Reports window on the tool bar; they are also indicated
by selectable tabs across the top of the report header. To view a specific report, select its tab or
select the report in the Reports window and click Show.
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Tabs display for each type of report
Header you wish to generate.

i Reports - C:DEMO2Z020%DATA" 13XAREX.SMP

Summéry Report | |sothem Tabular Hepartl Isatherm Lingar Plat : [sotherm LogF‘Iotl BET Tabular Hepmtl BET Transform PIDII ot
it tiee” 2| summary Report
[Mi micromeritics
MICROMERITICS INSTRUMENT CORPORATION Isotherm Linear Flat
w ||| Isatherm Log Plot .
| = FEI R G St | 7 _’l_l BET Tabular Report List of reports
BET Transtorm Plat
requested
Isotherm Log Plot
—#—I 13¥% Reference (Ar) (example)-‘Adsurption : _']
i Shiw Delete |
§ ‘ Hide
= } e
£ |
£ 1
T : Save |[ Saveds
E "
2 3 Default Style
E 3 Cloze Options on
£ Tool Bar
= ;
10 1 10 102
Relative Pressure (P/Po)
Displays graphical
(or tabular) data
Tool Bar
| Reports
Surnmary Repoart
|zotherm Tabular Repo
|zatherm Linear Plat
|zotherm Log Plot
BET Tabular Report
BET Transfarm Plot
B
Show Delete |
Hide
Default Style I
Cloze I
Reports Contains a list of all requested reports.
Show Shows the selected report in the report window. If the report

has been hidden, it and its associated tab will become visible.
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Delete

Hide

Open

Print

Print

Deletes the selected report. A deletion confirmation dialog is
displayed since this function cannot be undone. The deleted
report(s) will have to be regenerated if deleted in error.

Hides (removes) the selected report from the report window.
The report’s associated tab is also removed.

Allows you to open a previously saved report file.

Displays a print dialog so that you can choose an appropriate
printer for report output. A list of available reports is
displayed in the window on the right side of the dialog.

— Prirter
Mame; hhseh Techiwditing Properties |
Status: Fieady

Type: HF Lazerlet 4k
‘Where:  Micromenitics-T ech ‘Writing-HPLJ 44

 Selection

Comment:  Micromeritics-Tech ‘Writing-HFLI 4k ™ Fiint ta file
r— Frint range — Copie:
o | Mumber of copies: I‘I 3‘

) Fages f.'o;n'I rn'l — —t Current All
) ) Bﬂ’—il Bﬂ—il ¥ Callate _—| —

Shown | Clear |

Qg I Lancel I

For convenience in selecting which reports to print, push
buttons are provided beneath the report window. Or, you can
make your selection by clicking on the desired reports.

Current selects the report displayed in the report window.
Shown selects only the shown reports; any non-highlighted
reports indicate they are hidden. You can still select hidden

reports from this window to print.

All selects all reports, including those that may have been
hidden.

Clear clears all selections.
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Printed Reports

Save

Save As

Default Style

Fonts

Curve

Saves all reports of the currently open file in a report format
using the same name as the sample file, only with an rep
extension. If you wish to specify a name and/or specific
reports to save, use the Save As push button.

Saves all or specified reports from the currently open file.
The push buttons displayed on this dialog perform in the
same manner as the print dialog (explained above).

Reports can be saved in three different formats:
Report system (*.rep): Saved in a format which allows you to
reopen the file using the push button on the Report window

tool bar.

Spreadsheet (*.xls): Saved in a format which can be imported
into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be imported
into programs accepting this type of file.

Displays the Default Style dialog so that you can specify
default parameters for report fonts and curve properties.

Default Style
—Fant — Curve
Edit | Thickness:
o e —
Table title d
Table header
Table column Histogram Fill Style:
Graph title
Graph axiz title lHorizontaI LI

Graph axiz scale
Graph curve label
Graph legend

Graph border line thickness: I‘I

Load Save LCloze |

Contains a list of report elements for which the font can be
edited. Simply highlight the desired element and click Edit; a
font dialog is displayed so that you can specify the desired
font and attributes.

The items in this group box enable you to specify a thickness
for report curves and, when using histograms, the type of fill

to apply.
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Graph border line
thickness

Load

Save

Close

Close

Enables you to specify a thickness for the border of the graph.

Loads the last saved defaults.

Saves the changes as the defaults. If you do not click Save,
the changes will apply to the current report set only. The next
reports will revert to the defaults.

Closes the dialog and applies the changes. If you clicked
Save, the changes become the defaults. If you did not click
Save, the changes apply to the current report only.

Closes the report window.
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Printed Reports

Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a

report.

Tabular Reports

Resize column

Rename column

Move column

Align column

Hide column

Show column

Column font

Resize column
Renanme column

Move column 3
Align column 4
Hide column r
Sty caliammn ¥
Colurmn Fonk

Header Fonk

Edit kitle. ..

Zopy table as text

Displays a dialog so that you can specify the width of the
selected column (in inches).

Displays a dialog so that you can edit the name of the
selected column. Use Ctrl + Enter to insert line feeds.

Allows you to move the location of the selected column to
the left or to the right.

Enables you to right-align, left-align, or center the data in the
selected column.

Displays a list of the columns that have not been hidden,
enabling you to select the one you wish to hide.

Displays a list of all hidden columns, enabling you to select
the one you wish to have shown again.

Displays a Font dialog, allowing you to change font attributes
for the tabular data in the current report.
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Header font

Edit title

Copy table as text

Graphs

Autoscale

Redraw

Show curve

Hide curve

Displays a Font dialog, allowing you to change font attributes
for column headers in the current report.

Allows you to edit the table title and font.

Enables you to copy the entire table (column headers and
data) and then insert it into another program. Columns are
tab-delimited, allowing easy alignment

Aukoscale
Fedraim

S EUEE

Hide curve r
Edit curve L
Edit axis 3
Edit legend

Edit title

Zopy as metafile
Copy as bexk

Autoscales all axes of the graph. This function is useful for
returning to a full view after having zoomed in.

Sets axis boundaries to its original view. You can also use this
function to remove cross-hairs.

Shows any curve(s) that has been hidden. This option is
disabled (grayed) if no curves have been hidden.

Hides (removes from view) any unwanted curve(s).
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Printed Reports

Edit curve

Title

Style

Curve group box

Histogram group box

Displays the Curve Properties dialog, allowing you to edit
curve properties.

Curve Properties

Title:
Shyle: IPoints ;]

— Curve
| rterpalation; l»‘\.l'ima Spline :J Calor... |
Foint style: IF"US j V' Use default thickness
Pt Sl Ifjc.lici L' Thickress: | 1

— Histogram
¥ Lze default fil sty
Fill Style | EETE #l Calor... |
[Label: IL'Ienter Ll

(1] I LCancel |

Displays the title of the curve you are editing. You can edit
the title if desired.

This drop-down list contains the styles in which collected
data can be displayed.

Choices:Curve, Histogram, Points, Curve and Points

Contains options for curves and points. You can edit the
curve interpolation, the style of curve and/or points, as well
as the pen color. You can also select to use the default curve
thickness or specify a different thickness.

The options in this group box are disabled if Histogram is
chosen in the Style drop-down list.

The options in this group box are enabled when you choose
Histogram as the style for collected data. The choices in the
drop-down list allow you to choose the type of fill for the
Histogram, then you can click Color to select the fill color.
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Edit axis Displays the Axis Properties dialog, allowing you to edit axis
properties.
Axis Properties
Title font... |
—Scale
& Linear [ Inyert Scale ml
" Logarithmic
[ Autoscale minimum ID
V' Autoscale magimum Igf”[]El5
Gridlines: M ajor: IDotted _v_l
Minar: INUNE L!
(1] I Lancel |
Edit legend Displays the Legend Properties dialog, allowing you to edit
the placement of the legend. You can also edit the font if
desired.
Legend Properties
" Do not show
" Wertical above . Fort... |
 Left .
" Right
" Bottom
ag I Lancel
Edit title Displays the Title Properties dialog, allowing you to edit the
current graph’s title and font.
Title Properties
Title: BET Surface Area Plol
Qg I Lancel |
Copy as metafile Copies the graph and places it on the clipboard, allowing you
to paste it into other applications accepting Windows
metafiles.
Copy as text Copies the data used to generate the graph as a series of tab-

delimited columns of text.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine
details. To use this feature, simply hold down the left mouse button and drag the mouse cursor
(drawing a box) across the area you wish to view; then release the button. The enlarged area
immediately fills the graph area. Right-click in the graph area and choose Autoscale from the
shortcut menu to return to the normal view

AXxis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature,
simply left-click in the desired area of the graph.

BET Surface Area Plot
+  D-4 Carbon {example)

1]

(PP -

X-axis
position

et mefe od hoe e d wew e d waw wd o
.00 0.0s 0.1 I 015 020 0.25 0.30
Relative Pressure (FiPo)

Point of Coordination
Y-axis position

Right-click in the graph area and choose Autoscale or Redraw from the shortcut menu to
remove cross-hair lines and return to the normal view. Alternatively, you can click outside of
the graph area.
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Sample Reports

The remainder of this chapter contains samples of some of the reports that can be generated by
the ASAP 2050 program. Most of the reports can be varied through entries on the report
options screens.
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Summary Report

[Mi micromeritics

2050 'V X.XX Unit 1 Serial #: 102 Page 1

Sample: Silica alumina reference material
Operator: JCH
Submitter: Unit 102
File: Y:\..\HANKH\SIAL_01.SMP

Started: 7/30/2007 4:10:03PM Analysis Adsorptive: N2
Completed: 7/31/2007 1:04:49AM Analysis Bath Temp.: 77.300 K
Report Time: 8/27/2007 2:30:39PM Thermal Correction: No
Sample Mass: 0.2235 g Ambient Free Space: 16.3383 cm® Measured
Analysis Free Space: 49.4051 cm?® Equilibration Interval: 5s
Ambient Temperature: 295.15 K Automatic Degas: Yes

Comments: Silica Alumina STD

Summary Report

Surface Area
Single point surface area at p/p°® = 0.298614971: 205.4358 m?/g

BET Surface Area: 209.9056 m?/g

BJH Adsorption cumulative surface area of pores
between 17.000 A and 3000.000 A width: 247.929 ma/g

BJH Desorption cumulative surface area of pores
between 17.000 A and 3000.000 A width: 323.1344 mz/g

Pore Volume

Single point adsorption total pore volume of pores
less than 4530.409 A width at p/p°® = 0.995803560: 0.600783 cme/g

BJH Adsorption cumulative volume of pores
between 17.000 A and 3000.000 A width: 0.650128 cm?3/g

BJH Desorption cumulative volume of pores
between 17.000 A and 3000.000 A width: 0.603143 cme/g
Pore Size
Adsorption average pore width (4V/A by BET): 114.4863 A
BJH Adsorption average pore width (4V/A): 104.889 A
BJH Desorption average pore width (4V/A): 74.662 A
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BJH Adsorption Cumulative Pore Volume

[Mi micromeritics*

2050 V X.XX Unit 1 Serial #: 102

Sample: Silica alumina reference material
Operator: JCH
Submitter: Unit 102
File: Y:\..\HANKH\SIAL_01.SMP

Started: 7/30/2007 4:10:03PM
‘Completed: 7/31/2007 1:04:49AM
Report Time: 8/27/2007 2:30:39PM
Sample Mass: 0.2235
Analysis Free Space: 49.4051 cm?
Ambient Temperature: 295.15 K

Analysis Adsorptive: N2
Analysis Bath Temp.: 77.300 K
Thermal Correction: No

Equilibration Interval: 5s
Automatic Degas: Yes

Comments: Silica Alumina STD

BJH Adsorption Cumulative Pore Volume

User-Defined : Standard
—t— Silica alumina reference material
~©~ BJH Adsorption dV/qu_Jg(w) Pore Volume

Page 9

Ambient Free Space: 16.3383 cm? Measured
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Isotherm Pressure Composition

micromeritics

i

Page 6

Serial #: 102

Unit 1

12050 V X.XX

Sample: LaNi5 First Run (2.5g)

Operator: JE

Submitter: JK

File: Y:\24ZEH5~2\DATA\LANISF.SMP

el
14
=1
n
o
(]
=
[/]
x §
8 3
S B
0 !
AR O 9o
I8=%0nz2
2a58s 8
EES QSO
8600200
%TmsnD
£68_-8
2TSL5E
B|Fﬁm
®0 T ®
DLACESS
285885
IFg285«
<ckFETDT
< <uW

Started: 7/10/2007 2:20:01PM
Completed: 7/11/2007 6:56:42PM

Report Time: 8/27/2007 2:28:46PM

Sample Mass: 2.5013 g
Analysis Free Space: 19.2126 cm?
Ambient Temperature: 295.15 K

Isotherm Pressure Composition

—&— LaNi5 Second Run

—+— LaNi5 First Run

(BHww) ainssaid ainjosqy
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Isotherm Linear Absolute Plot

[Mi micromeritics®

2050 'V X.XX Unit 1 Serial #: 102

Sample: Li- X N2
Operator: JCH
Submitter: Unit 102
File: Y:\..\DATA\13X_N201.SMP

Comments: Water bath used

Isotherm Linear Absolute Plot
~—+— 13X_N201 : Li- X N2

Started: 8/7/2007 8:18:38AM Analysis Adsorptive: N2
Completed: 8/7/2007 3:39:53PM Analysis Bath Temp.: 298.000 K
Report Time: 8/27/2007 2:16:43PM Thermal Correction: No
Sample Mass: 0.5991g Ambient Free Space: 19.1665 cm® Measured
Analysis Free Space: 19.3325 cm?® Equilibration Interval: 10 s
Ambient Temperature: 295.15 K Automatic Degas: No

Page 3

Absolute Pressure (mmHg)
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Isotherm Linear Absolute Plot

Isotherm Linear Absolute Plot

«

-
L] L] L] ®
[Mj micromeritics
Demo 2050 V1.00 E Unit 1 Serial #: 102 Page 5
Sample: Silica alumina reference material
Operator: JCH
Submitter: Unit 102
File: Y:\..\HANKH\SIAL_01.SMP
Started: 7/30/2007 4:10:03PM Analysis Adsorptive: N2
Completed: 7/31/2007 1:04:49AM Analysis Bath Temp.: 77.300 K
Report Time: 8/27/2007 2:30:39PM Thermal Correction: No
Sample Mass: 0.2235 g Ambient Free Space: 16.3383 cm?® Measured
Analysis Free Space: 49.4051 cm?® Equilibration Interval: 5 s

Ambient Temperature: 295.15 K Automatic Degas: Yes

Comments: Silica Alumina STD

—t+— Silica alumina reference material - Adsorption
—&— Silica alumina reference material - Desorption

Isotherm Linear Absolute Plot

400 : : : T :
R oo e s femnees R R B
e oonneeeee booonooeos o dromoneees R AR G T

= ! ! | : :

= 1 ! ! : ! :

(D -1 1 | | ] ]

O 250+----------  EEEETt SRR

[y) . ¥ ' ] ] ] ]

£ 1 ! ! ! ! : !

3 4 ] Il | | | ]

3 1 ! ! ! ! ! !

8 2004--------- - LS oo R L A A .

S : : : ! ! : !

(/7] 4 I | | | | ]

© } | ] | | ]

< ] : : : | : :

£ 1501 -mmmeaoos s S b e A R

c 1 ! ! ! ! . ! !

m = 1 1 1 b 1 1 ]

: 1 1 1 ] 1 1

C 1 : ! : : ! ! !
100t -~ dememeeee fmmmeee bomeees } . b
501 --- ¢ R AR s EEEEEE TR SRR S EEEEE DEEE

: i a | | s i s
S 5 O S
0 100 200 300 400 500 600 700

Absolute Pressure (mmHg)

Jul 07

7-31



Isotherm Linear Absolute Plot ASAP 2050 Operator’s Manual

7-32 Jul 07



ASAP 2050 Operator’'s Manual

Description

8. OPTIONS MENU

The commands on the Options menu enable you to configure the system to your laboratory’s
requirements and establish sample defaults.

Description

Oipkion Presentation 4
Sample Defaults. ..

Linits. ..
araph Grid Lines.. .
Live Graph ¥

Option Presentation

Sample Defaults

Units

Graph Grid Lines

Live Graph

Parameter Files Directory

Service Test Mode

Parameter Files Directory, .,
Service Test Mode

Allows you to display the sample file dialog in Advanced,
Basic, or Restricted mode. Page 8-2.

Enables you to specify default values for sample and
parameter files. Page 8-4.

Enables you to choose the way in which data are presented
on the screen and in printed reports. Page 8-10.

Enables you to choose the type(s) of grid lines to show on
your report. Page 8-10.

Enables you to choose the variable for the X-axis during
data collection. Page 8-11.

Allows you to specify a location for the parameter files used
in the Basic sample file editor. Page 8-11.

Enables you to perform certain troubleshooting procedures.
This option is available only under the direction of a
Micromeritics service representative. Page 8-12.
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Option Presentation

The sample editing dialogs for the ASAP 2050 analysis program may be presented in three
modes: Restricted, Basic, and Advanced. Each format displays sample information dialogs
differently.

» Advanced: displays all parts of the sample information file in a tabbed dialog as in an
index card file. You just click on the tab of the desired parameter. This format also allows
you to switch to the Basic mode.

» Basic: displays all parts of the sample file as a single dialog. in which you select from pre-
defined parameter files. This format also allows you to switch to the Advanced mode if
editing of parameters is desired.

* Restricted: displays in the same manner as the Basic format. Certain menu options, how-
ever, become disabled and you cannot switch to the Advanced mode. You also must enter
a password to access and exit this format.

Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each
tab opens its associated dialog. For example, if you are using the Advanced format and you
open or create a sample information file, the following dialog is displayed.

[ C: DEMD20504,DATA!,000-001.5MP

¢ Prew | Sample Sample [egas Analyziz Adsorptive | Report Collected Mext 2> I
Information |Tube Conditions | Conditions | Properties | Options [rata
Sample: |[IIIEIY]

Dpetalol:l
Suhmillet:l
Typeof Data—————
Mass: i
S 1.0000 €0 & Automatically collected
Qensily:i 1.000 gfcm® " Manually entered
Comments: Add Log Entry |
Heplace Al I
Save | Lloze | Basic |

The Advanced format can be used to edit sample parameters and customize files.
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Basic

The Basic format presents the sample information file and its parameter files as a single
dialog. You also have access to all menu options. For example, if you are using the Basic
format and open or create a sample information file, the dialog is displayed in this manner.

[]C:\ DEMD 20504 DATA!,000-001.5MP

Sample Information
Sample: l]l]l]-l]l]1
Mass: [ 10000 @ Density: | 1.000 cm/g

Sample Tube: |§amp§e Tube :}

Degas conditions: |[}eges Conditions ;“ Predefined parameter
Analysiz conditions: |ﬂun Conditions __"_i| files are selected from
Adsorptive properties: |Mi£;ogen :_i| drop-down lists

Report options: |Hepoll Options 'I

Heplace All._. |
Save | Lloze | deancedl

The Basic format is used to quickly create sample information files using previously defined
parameter files. You also can switch easily to the Advanced format to view or edit details of
parameter files.

Restricted

The Restricted format is identical to the Basic format, except that certain options are disabled.
You also cannot switch to the Advanced format. This format is password-protected and
typically is used in laboratories where analysis conditions must remain constant, for example,
in the pharmaceutical industry.

When you select Restricted, a dialog requesting a password is displayed.

|l Option Presentation Password
Pleaze zet a new password.
i LCancel |

You can enter any password (up to 31 characters) to enable the Restricted mode. You must
enter the same password to exit the Restricted mode. For example, if you enter “password” to
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enable the Restricted format, then you must enter “password” to exit. If you forget the
password, open the application INI file and navigate to the Private section. The current
password is shown immediately following “OptionPresentationPassword.” Make a note of the
password, exit the INI file, and enter the password where requested. Deleting the password
from the INI file will not disable the Restricted mode; you must enter the password using the
Password dialog to exit the Restricted format.

Sample Defaults

Sample defaults are the values you see in the sample information editors when you create a
new sample file. This option allows you to specify the default values. This feature makes it
easy for you to apply the same conditions to many samples.

For efficiency, it is best to specify defaults for materials you most commonly analyze. You can
always edit the values in the sample file when it is created. Sample defaults can be specified
using the Basic or Advanced format.

The analysis program contains one complete default sample information file. When you select
Open, Sample information from the Main Menu, a new file with these default values is
generated. Default files for degas conditions, analysis conditions, adsorptive properties, and
report options also are included. Appendix F, Default Files and System Files lists details on
system default files.

Sample defaults can be specified using the Advanced or Basic format. The Advanced or Basic
format is chosen by selecting Options > Option presentation from the main menu.

Basic Format

When you select Sample Defaults using the Basic format, the Basic Sample Defaults dialog is
displayed.

Sample Defaults =l
Sample Information
Sequence: l]l]l]-l]m
ISampIe: !3
Mass: 1.0000 g Density: I 1.000 cmilg
Sample Tube: |Sample Tube Lﬂ
Degas conditions: | Degas Conditions ;ﬂ
Analysis conditions: | Run Conditions ;j|
Adsorptive properties: |Nilmgen @ 77 35K _V_I|
Report options: | Report Options _'_I|
Replace All... I
Save | Lloze | Advanced |
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Sequence Allows you to specify a default sequence for the sample file
name. The number you specify is incrementally sequenced
each time you create a sample file. It is the number that
appears in the File name field when you select File > Open
> Sample information.

Use numbers, letters, or other printable characters, such as
dashes. At least three numbers must be included.

» Use up to eight characters.
« Do not use characters such as * or ?.

Sample Allows you to enter an additional identification that provides
more information than the sample file name itself.

The field on the left allows you to specify a name for the
identification label. For example, you may prefer to use Test
or Material.

The field on the right allows you to specify a format for the
sample identification.

Use numbers, letters, or other printable characters, such as
dashes.

» Use up to 20 characters for the prompt.
e Use up to 43 characters (including the $ symbol).

* Include the automatically generated file name as part of
the identification by using the $ symbol where you want
the sequence number to appear.

For example, if the sequence number is 000-001, enter
the identification as follows:

Lab #25-$

The resulting sample identification for the first sample
information file would be:

Lab #25 - 000-001
for the second file:

Lab #25 - 000-002, and so on.
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Mass Enter a value that represents the approximate mass of your
most commonly analyzed material. You can enter a more
accurate value in the sample file when the analysis is
completed.

Density The sample density is used when using a calculated free
space. The default value is appropriate unless you typically
use a calculated free space. This field can always be edited
in the sample file.

Sample TUb? _ Each parameter has a drop-down list containing files
Degas Conditions included with the software, as well as any you may have

Analysis Conditions created and saved to the Parameter Files Directory.
Adsorptive Properties

Report Options . . .
P P Choose from the list provided for each parameter the file you

wish to use as the default.

Replace All Use this push button to replace the current default values
with those from an existing sample file.

Save Saves the current definition as the defaults

Close Closes the dialog.

Advanced Switches the sample editor to the Advanced format.

8-6 Jul 07



ASAP 2050 Operator’'s Manual Sample Defaults

Advanced Format

When you select Sample Defaults while using the Advanced format, the Advanced Sample
Defaults dialog is displayed.

The defaults you specify for the parameters in the Advanced format display as the
\ defaults for newly created standalone parameter files

Sample Defaults =l
¢ Prew I Sample Sample Degaz Analyzis Adsorptive | Report Mext 2>
_l Information | Tube Conditions | Conditions | Properties Options I_l

Sequence l]l]l]-l]m
|Sample: %
Operator: [ DOmit
Submitter: I ™ Dmit

" Manually entered

TypeofData—
Mass: I 1.0000 g { ‘

' Automatically collected
Degsily:l 1.000 gfcm*

Comments:
Add Log Entry I
Replace All.. |
|
Save | Lloze | Basic |
Sequence Allows you to specify a default sequence for the sample file

name. The number you specify is incrementally sequenced
each time you create a sample file. It is the number that
appears in the File name field when you select File > Open
> Sample information.

» Use numbers, letters, or other printable characters, such
as dashes. At least three numbers must be included.

e Use up to eight characters.

e Do not use characters such as * or ?.
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Sample

Allows you to enter an additional identification that provides
more information than the sample file name itself.

The field on the left allows you to specify a name for the
identification label. For example, you may prefer to use Test
or Material.

The field on the right allows you to specify a format for the
sample identification.

Use numbers, letters, or other printable characters, such
as dashes.

Use up to 20 characters for the prompt.
Use up to 43 characters (including the $ symbol).

Include the automatically generated file name as part of
the identification by using the $ symbol where you want
the sequence number to appear.

For example, if the sequence number is 000-001, enter
the identification as follows:

Lab #25-$

The resulting sample identification for the first sample
information file would be:

Lab #25 - 000-001
for the second file:

Lab #25 - 000-002, and so on.

8-8
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Sample Defaults

Operator
Submitter

Mass

Type of Data

Comments

Replace All

Save

Close

Basic

These fields contain the name (or other identification) of the
operator and submitter.

The fields on the left can be edited to display a different label
if desired.

The fields on the right allow you to specify default names or
titles.

» Include the automatically generated file number as part
of the identification by using the symbol $ where you
want the sequence number to appear. Refer to the exam-
ple in the previous section.

e Use up to 20 characters for the prompt.
e Use up to 43 characters (including the $ symbol).
e Omit either (or both) item entirely from the sample infor-

mation file by selecting Omit.

Enter a value that represents the approximate mass of your
most commonly analyzed material. You can enter a more
accurate value in the sample file when the analysis is
completed.

Choose whether you wish to enter data or have it collected
automatically by the system.

Use this window to enter sample characteristics, analysis
conditions, etc. Anything you type in this window is printed
in the report header.

Use this push button to replace the current default values with
those from an existing sample file.

Saves the current definition as the defaults
Closes the dialog.

Switches the sample editor to the Basic format.
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uUnits

This menu command displays the Unit Selections dialog which allows you to choose the
manner in which to display data on the dialogs and reports.

Graph Grid Lines

Il Unit Selections

Quantity Adzorbed

Length Unit " nm
BJH Pore Dimension  {* width
Pressure Unit " kPa
Pressure Symbol Cpp
Temperature Unit L 4

Analpzsiz Temperature K

" cmtg 5TP
A

" diameter ” radius
" mbar * mmHg
* P, Po

L0l

LG

Lancel

Graph Grid Lines enables you to choose the type(s) of grid lines to show on your reports; the
Graph Grid Lines dialog is displayed.

X-AXis
Y-AXis

Grid Line Style

X-Axis
Linear Scale:
Logarithmic Scale:
Y-Axis
Linear Scale:

Logarithmic Scale:

Grid Line Styles

Maijor: " Solid
Minor: " Solid
0K

Ml Graph Grid Lines

[~ Minor

v Maiol; [~ Minor

v Major
v Major

[~ Minor
[~ Minor

* Dotted
&+ Dotted

LCancel

x|

Enables you to choose Major and/or Minor lines to
display in printed reports for the Logarithmic and Linear

scales.

If you deselect these items (remove the check marks),
your report will not display grid lines.

Allows you to choose the type of grid line to display if
grid lines are being shown.
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Live Graph

Cpkions
Cipkion Presentation 4
Sample Defaults. ..

Linits. ..
araph Grid Lines. ..

Live Graph Absolute Pressure
v Relative Pressure

Parameter Files Directory, ..

Service Test Mode v Thermal Transpiration

This option enables you to choose the variable for the x-axis during data collection. You can

also choose to correct for thermal transpiration (refer to page 5-31 for additional information
on thermal transpiration).

Parameter Files Directory

This option allows you to specify a location for the predefined Analysis conditions, Degas
conditions, Adsorptive properties, and Report options files displayed in the drop-down lists on

the Basic Sample Information dialog. The current directory is displayed above the drives/
directory window.

Il Parameter File Directory Selection
[ Specify the location of the parameter files shown in the
‘Basic-Mode’ Sample p ( P ter files includ
Analpsiz Conditions and Report Options.
P ter file directory: c:\demo2050
i | ia
data] =
hardware]
models]
param]
referenc]
service]
-a-]
]
-d] |
-a-]
] 5

The default directory is params and includes several parameter files supplied with the analysis
program. If you specify a different directory, these files will not be included in the drop-down
lists unless you copy (or move) them to the new directory.

If you wish to continue using the params directory for parameter files, be sure to save any files
you create to this directory(s).
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Service Test Mode

Various service tests are included in the ASAP 2050 operating program. These tests can be
performed only with the assistance of a trained Micromeritics service representative. When
you select Service Test Mode from the Options menu, a dialog prompting you to enter a
password is displayed. This password is coded to change on a regular basis and is known only
by your service representative. You will not be able to perform these tests without his
guidance.

8-12
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Troubleshooting

9. TROUBLESHOOTING AND MAINTENANCE

The ASAP 2050 system has been designed to provide efficient and continuous service.
However, to get the best results over the longest period of time, certain maintenance
procedures must be followed. This chapter includes troubleshooting information,
recommended preventive maintenance procedures, and routine maintenance procedures.

Troubleshooting

Most operational problems are caused by the following:

e Leaks (commonly around the sample tube O-ring at the analysis port)

»  Sample weighing errors

» Use of too much analysis bath fluid in the Dewar at the start of an analysis
» Entry of incorrect system volume for analysis

Always check these first when expected analysis results are not obtained. Some common
operational problems, which are not indicated on the computer screen, and their respective
causes and solutions are provided in the following table.

What Happened Why What To Do
Analysis Dewar cannot | Elevator that moves Dewar Check for possible obstruction
be raised (or lowered). | stuck in up position, down to elevator movement.

position, or somewhere in
between.

Vacuum pump system | Sample tube connector nut is Turn the connector nut
makes loud noise loose. clockwise to tighten.
continuously.
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What Happened

Why

What To Do

Vacuum pump system
makes loud noise
continuously.
(continued)

Sample tube fitting is loose.

Tighten the fitting securely with
a wrench.

Sample tube O-ring is worn or
cracked.

Replace the sample tube O-ring.
Refer to “Replacing a Sample
Tube O-ring” on page 9-8.

No sample tube is loaded on a
selected port.

Make sure the port valve is
closed. Install a plug or empty
sample tube on the port.

A gas inlet valve is open while
the vacuum valve is open.

Enable manual control, then use
the instrument schematic to
close the gas inlet valve. Refer
to “Enable Manual Control”
on page 6-24.

Vacuum gauge shows
reading above 20
umHg, even after
extended pumping
through unrestricted
valve with analysis or
degas ports closed.

Vacuum pump oil is low,
causing ineffective evacuation.

Add or change vacuum pump
oil. Be sure to add oil to proper
level according to indicator
window on the pump. Refer to
“Inspecting and Changing
Vacuum Pump Fluid” on
page 9-9.

No power to the vacuum pump.

Check the pump power plug,
power switch, and line circuit
breaker.

Filter in the port being used is
dirty.

Replace the port filter. Refer to
“Replacing the Port Filters”
on page 9-5.

Alumina in the oil vapor trap is
holding moisture because it was
not sufficiently dried before

being added to the alumina trap.

Replace or dry the alumina.
Refer to “Replacing the
Alumina in the Oil Vapor
Traps” on page 9-15.

9-2
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Troubleshooting

What Happened

Why

What To Do

Analysis valves cannot
be operated.

Circuit was opened by the circuit
breaker.

Push in the breaker button,
located on the side of the
instrument near the power
entrance. If it will not stay in,
contact appropriate service
personnel.

Breaker button

Cable from the computer to the
analyzer is loose.

Make sure the cable is connected
properly to the computer and the
analyzer.
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Preventive Maintenance

The table below lists the preventive maintenance procedures you should complete to keep

your analyzer operating at peak performance. Instructions for each procedure follow the table.

Micromeritics also recommends that you have preventive maintenance procedures and
calibration performed by one of our service representatives every 12 months.

Replace sample tube O-ring, page 9-8

Inspect and change vacuum pump fluid, page 9-9
Replace alumina in oil vapor traps, page 9-15

Clean cold trap glass tube, page -21

Lubricate elevator screw, page 9-24

Check outgassing rate and test for leaks, Appendix D

Replace vacuum pump exhaust filter, page 9-25

Zero transducer pressure gauge, page 9-27

Calibrate transducer pressure scale, page 9-28

Calibrate manifold temperature sensor, page 9-29

Calibrate system volume, page 6-19

Maintenance Required Frequency
Check and clean analysis port Dewars, page 9-5 Weekly
Replace port filters, page 9-5 Every 30 days
Clean the outside of the analyzer, page 9-8 As required

As required or every 3 months
As required or every 3 months
As required or every 3 months
As required or every 3 months
As required or every 6 months
As required or every 6 months

As required or every 12
months

As required or every 12
months

As required; should be
performed by qualified service
personnel

As required; should be
performed by qualified service
personnel

As required; should be
performed by qualified service
personnel

9-4
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Checking and Cleaning the Analysis Port Dewars

A

@

When handling Dewars, be sure to observe the Dewar precautions described on
page 3-24.

Ice and suspended frost particles may accumulate in the bottom of an analysis port Dewar.
Particles or deposits exceeding 1/4 in. (0.64 cm) in depth may jam between the bottom of the
sample tube and the bottom of the Dewar, causing the Dewar not to raise fully. Accumulations
of fine particles impede liguid nitrogen circulation around the bottom of the sample tube. This
causes the sample temperature to be slightly higher which, in turn, can cause pore volume
measurement errors in those samples exhibiting high isotherm slope above 0.97 relative
pressure.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use.
Clean Dewars on a weekly basis as follows:

1. Remove the Dewar and pour the liquid nitrogen from the Dewar into an appropriate
cryogenic container.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes
to burst.

2. Rinse the Dewar with warm water to melt any ice accumulation which may remain in the
Dewar, then dry thoroughly.

Replacing the Port Filters

A porous metal filter is located in each analysis and degas port. If a degas port is not plugged
with either a sample tube or a port plug then the filter will absorb atmospheric gases, resulting
in extended degassing time for samples on that port.

Using a contaminated filter on an analysis port may extend the time required to achieve a

vacuum at that port. More importantly, the contaminant may adsorb or desorb during analysis,
affecting the analysis results. A contaminated filter on an analysis port may cause a leak test to
fail (if the contaminant outgasses) or cause a free-space reading to be much lower than normal.
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Analysis Ports

Before removing and installing a port filter, ensure that the port valve is closed.
\ Observe the analysis system schematic to verify valve status.

1. Using a wrench, remove the analysis port fitting from the analyzer.

Analysis port
fitting

2. Remove the filter and O-ring.

O-ring

Filter

3. Using latex gloves, replace with a new filter and O-ring.

To avoid analysis problems, the new filter and O-ring must be clean. Do not

\ touch them with bare hands.
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4. Reinstall the analysis port fitting; securely tighten with a wrench to prevent leaks during
evacuation.

Degas Ports

Before removing and installing a port filter, ensure that the port valve is closed.
\ Observe the degas system schematic to verify valve status.

1. Using a wrench, remove the degas port fitting.

| Degas port fitting

2. Remove the O-ring and filter.

O< O-ring

& <« Filter

3. Replace the filter and the O-ring.

To avoid analysis problems, the new filter and O-ring must be clean. Do not
\ touch them with bare hands.

4. Reinstall the degas port fitting; securely tighten with a wrench to prevent leaks during
evacuation.
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Cleaning the Analyzer

The ASAP 2050 should be cleaned as required.

Clean the outside casing of the analyzer (including the shields) with a clean cloth dampened
with isopropyl alcohol (IPA), a mild detergent in water, or a 3% hydrogen peroxide solution. It
is not necessary to remove any switches or screws to clean the outside casing.

Use a mild detergent in water or isopropyl alcohol to clean the shields. Avoid using
@ acetone because it will damage the surface of the shields.

Replacing a Sample Tube O-ring

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an
O-ring becomes worn or cracked, it does not provide a good seal and will need to be replaced.

1. Remove the O-ring from the top of the sample tube.

O-ring

2. Slide a new O-ring over the sample tube.

9-8
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Inspecting and Changing Vacuum Pump Fluid

A

The fluid in the vacuum pump should be changed every three months or when the efficiency of
the vacuum pump declines (requiring increased time to reach vacuum levels). The fluid can
first be inspected to determine if a change is necessary.

Use oil supplied by Micromeritics, or refer to the vacuum pump manual for other acceptable
oils.

In order to use oxygen with the ASAP 2050, your 2050 analyzer must be equipped with
an oxygen-compatible vacuum pump that uses Fomblin® (or a suitable equivalent)
pump fluid. Failure to use the proper vacuum system could result in hazardous
conditions including fire and personal injury.

Inspecting Fluid

Make sure the pump is running when inspecting fluid.

1. Choose one of the following to view the vacuum pump sight window.

a. Remove the four screws located along the sides of the vacuum pump panel, then
remove the panel.

b. Remove (or fold over to the right) the protective rubber mat on the lower front panel,
then lift off the metal cover; this exposes the vacuum pump sight window.

2. View the vacuum pump fluid through the sight window. Fluid in good condition is clean,
clear or light in color, and transparent. If the color of the fluid is darkened, the fluid should
be changed.
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If the fluid is just above the lower level indicator mark, fluid should be added.

"\‘ d _Jq——
N ] T EDWARDS
- @
-_" wEANTRE 1 [

BERAL Ny THOVITESY

3 BT |

- Fumpziannn Oil-level window
. €
- [AA o)

4 Level indicator mark
|

S -

Adding Fluid

1. If the front panel has not been removed, remove the four screws located along the sides of
the vacuum pump panel, then remove the panel.

2. Remove the oil-fill plug from the vacuum pump.

Oil-fill port

Adding fluid above the midway position on the fluid level mark may cause fluid to
@ splash into the vacuum hoses and leak from the vacuum pump.
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3. Add fresh fluid to the oil-fill port until the level is midway between the indicator marks in
the pump sight window.

A EDWARDS

RIS n

WAL W T4 OTEN -

LR BT
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FANWANG S — Level indicator marks
===

e U

4. Check the washer or O-ring used at the oil-fill port; replace if necessary.

5. Replace the oil-fill plug.

Changing Fluid

Always drain the vacuum pump while the pump is warm and disconnected from

\ the power source.

1. Place the analyzer ON/OFF switch in the OFF position.

2. If the vacuum pump panel is not already removed, remove the four screws located along
the sides of the panel, then remove the panel.

3. Disconnect the vacuum pump from the power source.
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4. Loosen the wing nut on the clamp at the top of the oil vapor trap. Swing the clamp open
and remove the trap from the hose.

! l F20, =1
i Iﬂ l_ Disconnect hose

Clamp wing-nut

.T * '.E.":-: o

Oil-vapor trap

5. Grasp the handle on top of the vacuum pump and lift it out of the analyzer; place the
vacuum pump on a work table.
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6. Drain the used oil:

a. Place a waste container under the drain spout.

b. Remove the plug from the drain spout.

[

menmar .
cooe W 15 AR AR L)
REINTEG n

NERAL Wy ENTTTEER
LR

. FRELEERANNE
N AW S
i

‘ \—!—’-’ Drain plug
——

c. Allow the oil to drain into the waste container.

d. Replace the drain plug.

7. Remove the oil-fill plug.

Oil-fill port

Adding fluid above the midway position on the fluid level indicator marks may cause
@ fluid to splash into the vacuum hoses and leak from the vacuum pump.

Add fresh fluid to the oil-fill port until the level until the level is midway between the two
indicator marks in the pump sight window.

9. Check the washer or O-ring used at the oil-fill port; replace if necessary.

10. Replace the oil-fill plug.

Jul 07 9-13



Preventive Maintenance ASAP 2050 Operator’'s Manual

11.

12.

13.

14.

15.

16.

17.

If the fluid was badly contaminated (dark brown color), flush the pump with fresh fluid as
follows:

a. Cover the top of the oil vapor trap.

b. Plug the pump power cord into a power source and run for about 2 minutes.
c. Unplug the power cord.

d. Remove the plug from the drain spout.

e. Allow the oil to drain into the waste container.

f. Reinstall the drain plug.

g. Add fresh fluid to the oil-fill port until the level is midway between the two indicator
marks.

h. Reinstall the oil-fill plug.
i. Repeat steps a through h if necessary.

Check the alumina in the oil vapor trap and replace if necessary (refer to “Replacing the
Alumina in the Oil Vapor Traps” on page 9-15).

Place the vacuum pump back onto the drip tray in the analyzer.
Reconnect the vacuum pump hose.

Reconnect the power cord to the power source.

Reinstall the front analyzer panel.

The pump must run a few hours (or overnight) to eliminate air and moisture from the fresh
fluid and to produce efficient vacuum operations.
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Replacing the Alumina in the Oil Vapor Traps

The activated alumina in the oil vapor traps becomes saturated during use. The alumina should
be replaced if either of the following conditions exist:

e The alumina has been used for a three-month period.
» Most of the alumina pellets are no longer white.

o
'i; < Oil vapor trap

Alumina

y A

Do not perform the following procedure on used alumina. The resultant oil
‘. vapors may cause a fire or an explosion.

1. Prepare fresh alumina as follows:
a. Heat an oven between 250 °C and 350 °C.

b. Pour about 180 grams of alumina into a glass or metal container for each trap
(approximately 250 mL if a graduated beaker is used). Place the container in an oven.

c. Bake the alumina for two hours; turn off the oven.

d. Allow the alumina to cool in the oven before pouring it into the traps.
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2. Select Unit [n] > Enable Manual Control. If the analysis schematic is not displayed,
select Unit [n] Show Instrument Schematic to display the schematic in manual mode.

0.47 mmHg _¢ 8 9 10 1
Vapor

3. Open the analysis vacuum valve: Valve 1. Make sure all other valves are closed.

4. Select Unit [n] > Degas > Enable Manual Control. If the degas schematic is not
displayed, select Unit [n] > Degas > Show Instrument Schematic to display the
schematic in manual mode.

760 mmHg
Vacuun |
D1 D2
D7
Backﬁll—(D_
Cumrent = 25°C Cumrent = 25°C

5. Open the degas vacuum valve: D5.
6. When the pressure stabilizes around atmospheric pressure, close all valves.

7. If the vacuum pump panel is not already removed, remove the four screws located along
the sides of the panel, then remove the panel.

8. Unplug the pump power cord.
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9. Loosen the wing nut on the clamp at the top of the oil vapor trap. Swing the clamp open
and remove the trap from the hose.

Disconnect hose

Clamp wing-nut

Oil-vapor trap

10. Remove the pump from the analyzer for easier access, if you wish.

11. Loosen the wing nut on the clamp at the bottom of the oil vapor trap. Swing the clamp
open and remove it.

Oil vapor trap

End fitting

Wing nut

12. Remove one end fitting from the trap body.

13. Remove the used alumina from the trap body and dispose of it in an appropriate manner.
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14. If the trap body interior appears oily or dirty, wash it with isopropyl alcohol or ethyl
alcohol and dry it thoroughly.

Exposure of the trap body to oil vapor may cause small cracks on the inside surface
\ of the trap body. Under normal circumstances, these cracks will not cause problems
or leaks.

Ensure adequate ventilation when using solvents for cleaning purposes.

15. Pour the new activated alumina pellets into the trap until they are level with the top of the
trap body.

End fitting

—}@ . «4——— Centering ring
‘ !: O-ring

16. Insert the O-ring into the end fitting, screw the end fitting back onto the trap, then tighten
securely by hand.

17. Make sure the centering ring is in place on the intake port.
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18. Place the trap on the centering ring.

Oil vapor trap |

Centering ring

Intake port

19. Open the clamp and place it around the flange of the intake port and the flange of the trap.
Swing the clamp fastening screw toward the intake port until it fits into the slot in the
other half of the clamp. Tighten the wing nut securely by hand.

20. If you removed the pump from the analyzer, place it onto the drip tray in the analyzer.
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21. Reconnect the hose from the analyzer to the oil vapor trap using the clamp and wing nut.

Tighten clamp to attach
trap to hose

22. Plug the pump power cord into the power source.

23. Reinstall the front panel on the analyzer.
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Cleaning the Cold Trap Tubes

Oil vapor from the vacuum pumps accumulates in the cold traps. The tubes on the cold trap
ports should be cleaned as follows:

1. Remove the vacuum pump panel.
2. Disconnect both vacuum pump power cords from their power sources.

3. Select Unit [n] > Instrument Schematic; then select Unit [n] > Enable Manual
Control.

0.47 mmHg _¢ 8 9 10 1
Vapor

4. Open analysis valves in the following order: P1, PS, 5, 7, and 1. Allow the pressure to
stabilize until around atmospheric. Then, close the valves in the same order as they were
opened. This step fills the analysis vacuum section before disconnecting.

5. Select Unit [n] > Degas > Degas Schematic; then select Unit [n] > Degas > Enable
Manual Control.

760 mmHg
Vacuun |
D1 D2
D7
Backﬁll—._
Cumrent = 25°C Cumrent = 25°C

6. Open degas valves in the following order: D5 and D7. Allow the pressure to stabilize until
around atmospheric. Then, close valve D7 and D5. This step fills the degas vacuum
section before disconnecting.
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7.  While holding the tube, remove the connector nut from the degas cold trap port.

8. Carefully slide the glass tube down over the metal tube and remove the glass tube.

The connector nuts must be reinstalled on the port from which they were removed.

\ They are not interchangeable.

9. Remove the connector nut from the other cold trap port and remove the metal tube.

10. Inspect the O-rings. If an O-ring is cracked or worn, it should be replaced.

11. Rinse the tubes with acetone; then dry them.
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12. Slide the O-rings over the top of the tubes.

O-ring &=—— Oring
d D

Connector nut ____ Connector nut

‘\\——//\_/

13. Reinstall the cold trap tubes and tighten the connector nuts. Make sure you use the correct
connector nut on each port.

14. Reconnect the vacuum pump power cords.

15. Replace the vacuum pump access panel.
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Lubricating the Elevator Screw

1. Remove the analyzer’s back panel by loosening, then removing the retaining screws.

2. Apply alight coat of lithium grease to the elevator screw.

Elevator screw

3. Replace the back panel.

Checking Outgassing Rate and Testing the Analyzer for Leaks

Refer to Appendix D TESTING THE ANALYZER FOR LEAKS for instructions on
checking ASAP 2050 outgassing rates and testing for leaks.
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Replacing the Vacuum Pump Exhaust Filter

A

The gases used by the ASAP 2050 are exhausted by vacuum pumps. An exhaust filter is
installed on the exhaust port of each vacuum pump. The filter minimizes the release of oil
vapor and should be replaced when it becomes so saturated with oil that it is ineffective.

Exhaust filters are used on the vacuum pump to minimize the release of oil vapors.
The gases used are diluted substantially upon being released from the vacuum
pumps. However, it may be desirable in some locations to provide a fume hood for
added protection from hazardous gases and vapors released into the work area.

1. Remove the four screws located along the sides of the vacuum pump panel, then remove
the panel.

2. If you wish to remove the vacuum pump from the analyzer, refer to steps 1 through 5
under “Adding Fluid” on page 9-10.

I Vacuum pump
exhaust filter

Jul 07

9-25



Preventive Maintenance ASAP 2050 Operator’'s Manual

3.

4.

Loosen the wing nut of the clamp at the vacuum pump exhaust port. Swing the clamp
away from the exhaust port and remove it.

Filter

Clamp

_ Wing Nut

Exhaust Port

Discard the oil filter.

Retain the centering ring, clamp, and wing nut.

Remove the dust cover from the new filter.

Make sure the centering ring is on the exhaust port.

Place the new filter on the centering ring.

Open the clamp and place it around the flange of the exhaust port and the flange of the

exhaust filter. Swing the clamp fastening screw toward the exhaust port until it fits into the
slot in the other half of the clamp. Tighten the wing nut securely by hand.

10. If you removed the vacuum pump from the analyzer, place it back onto the drip tray in the

analyzer, reconnect the hose, then reinstall the vacuum pump panel.
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Calibrating the Pressure Gauge

When operating the system in manual mode Calibration, pressure gauge enables you to
evacuate the manifold and zero the transducer.

The system automatically zeros the transducer before an analysis begins. Therefore, you do
not need to use this feature unless you are operating the system in manual mode.
Perform the following steps to calibrate the pressure gauge:

1. Select Unit > Calibration > Pressure gauge; the Calibrate Pressure Offset dialog is
displayed.

¥ Calibrate Pressure Dffset (Unit 1 - S/ :101) =] ]

Warning: Changing the calibration information will
affect the perf of the inst t

.0
qualified service personnel should do this.

Press the start button to evacuate the system and
then zero the pressure transducers.

Cancel |

2. Click Start to evacuate the manifold and zero the pressure gauge(s).

3. When the calibration is complete, click OK to close the dialog.

You may cancel a calibration at any time by selecting Cancel. If you cancel a
\ calibration, no new calibration data are saved.
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Calibrating the Pressure Scale

Calibration, Pressure scale allows the software to adjust the gain of the selected transducer to
match a reference standard.

1. Attach a reference pressure gauge to the sample port of the analyzer.
2. With manual control enabled:
a. Dose the manifold with helium or nitrogen to 5200 to 7500 mmHg.

b. Open the sample port to expose the reference pressure gauge to the same pressure as
the analyzer’s transducer.

3. Select Unit > Calibration > Pressure scale; the Calibrate Pressure Scale dialog is
displayed.

Il Calibrate Pressure Scale (Master) {Unit 1 - 5/N: 123)

" Reset to nominal

* Match to entered pressure

Actual manifold pressure: l IR mmHg

Warning: Changing the calihl_alion information will

affect the perf of the inst; t. Only
qualified service personnel should do this.
oK I Lancel

Enter a value between 500.00 and 7500.00.

4. Select Match to entered pressure.
5. Enter the pressure reported by the reference pressure gauge, then click OK.
6. Close the sample port and evacuate the manifold.

7. Remove the reference pressure gauge.
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Calibrating the Manifold Temperature Sensor

You should calibrate the manifold temperature on an annual basis. This allows you to correct
for any changes in the manifold temperature sensor that occur with time.

You will need a small diameter probe, such as a 1/16-in. (1.5-mm) thermocouple to calibrate
the manifold temperature sensor.

1. Insert the thermocouple probe into the opening located to the left of the analysis port.

Analysis port

o

A

Manifold Probe Hole (to the left of the analysis port)

2. Move the thermocouple back and forth until you locate the small opening on the underside
of the manifold. Push the thermocouple into the opening until the thermocouple stops.

3. Allow the temperature gauge reading to stabilize.

4. Select Unit > Calibration > Temperature; the Calibrate Manifold Temperature dialog is
displayed.

Current temperature:

[ EEE «

warning: Ch ing the il ion inf ion will
affect the perf of the i 5
qualified service personnel should do this.

(1] 4 LCancel |

Enter a valus hetween 27315 and 127315

5. Enter the manifold temperature indicated on the reference temperature gauge. Click OK to
store the new value.

6. Remove the thermocouple probe.
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Routine Maintenance

The procedures in this section are performed as needed.

Changing Gases

Guidelines for Connecting Gases to the Analyzer

Use these guidelines when installing regulators and gas lines:

» Ensure that all gases needed are available and near the instrument. If the gas bottles are not
located near the instrument, you will have to use gas line extenders, which may degrade
gas quality and reduce pressure.

Retaining strap

» Use a retaining strap (or other appropriate tether) to secure the gas bottle.

» Carefully route the gas lines from the bottle to the analyzer, avoiding overlapping or
entangling gas lines. This will ensure the correct gas pressure and make maintenance
easier.

» Label both ends of the gas lines before connecting for ease in identification and
maintenance.

» Ensure that all gas bottles are closed before connecting them to the analyzer.
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A

N
A

The instructions below describe a typical installation. Some configurations require additional
components, such as regulator expansion kits, when one gas source will be used for several
operations or when the gas bottle cannot be located close to the analyzer.

In order to use oxygen with the ASAP 2050, your 2050 analyzer must be equipped with
an oxygen-compatible vacuum pump that uses Fomblin® (or a suitable equivalent)
pump fluid. Failure to use the proper vacuum system could result in hazardous

conditions including fire and personal injury.

Connecting a Gas Regulator to the Gas Supply

Dual-stage regulators must be used for all gas supplies.

These instructions apply to connecting inert gases only. When connecting hazardous
gases, follow the safety procedures used by your lab.

1. Disconnect the gas bottle you are replacing:

a. Turn the gas bottle Shut-Off valve clockwise to close.
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b. Disconnect the gas line from the regulator and allow the regulator line to purge. You
will hear gas vent.

It is not necessary to disconnect the gas line from the instrument.

2. Turn the regulator Shut-Off valve counterclockwise to open (more gas will vent).

3. Turn the Pressure Control knob clockwise to open and vent any remaining gas; both
gauges should then read approximately zero.
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4. Close the Pressure Control knob.

5. Use an appropriate wrench to loosen the nut at the regulator connection, then remove the
regulator from the gas bottle.

6. Replace the protective cap, disconnect the retaining strap, and move the gas bottle to an
appropriate location.

Depleted Bottle

n Use caution when transporting gas bottles.
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7. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
bottle.

Place the protective cap in a secure location. You will need it to recap the gas bottle when
it is depleted and replaced.

New Bottle

8. Attach the gas regulator to the connector on the gas bottle. Hand-tighten the nut. Use an
appropriate wrench to tighten it an additional 3/4 turn.

@ Do not overtighten the fittings. Doing so could cause a leak.
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9. Check for leaks in the high-pressure side of the regulator and in the connector.

a. Turn the regulator control knob fully counterclockwise.
b. Slowly open the gas bottle valve, then quickly close it.
c. Observe the pressure on the high-pressure gauge for approximately one minute.
If the pressure decreases, tighten the regulator connector nut until it becomes stable.

If the pressure does not remain stable, remove the regulator and clean all contacts at the
regulator connection. Then reinstall the regulator.

10. Perform the following steps to purge air from the lines:
a. Open the gas bottle valve to pressurize the regulator, then close the valve.

b. Adjust the Pressure Control knob to approximately 5 psi (34 kPa).
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c. Turn the regulator shut-off valve counterclockwise to open.
d. Allow gas to flow until both gauges read approximately zero.

e. Close the regulator shut-off valve to stop gas flow.

11. Reconnect the gas line to the regulator.

12. Use two 7/16-in (11-mm) wrenches to tighten the gas line connection; one to hold the
fitting steady and one to tighten the connector nut.
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13. Set the instrument pressure:

a. Turn the regulator control knob clockwise until the low-pressure gauge indicates 150
psig (1034 kPag)

Low-Pressure gauge

b. Open the regulator shut-off valve.
c. Open the gas bottle valve and flow gas for 10 to 30 seconds.
d. Close the regulator shut-off valve.

e. Close the gas bottle valve.

14. If you disconnected the gas line from the instrument, proceed to Connecting the Gas
Delivery Tubing to the Analyzer in the next section.

15. If you changed to a different type of gas, you must specify the change in the analysis
program; refer to Specifying Gas Ports.
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Connecting the Gas Delivery Tubing to the Analyzer

The gas inlet ports are located on the right side panel of the analyzer. The ports are labeled
Physi 1 through 6, Degas Backfill and Freespace Helium.

Gas inlet ports Not used

Vapor gas port > 5 Degas backfill port

Freespace Helium port

To change the gas attached to one of the ports:

1. Make sure the port valve is closed (refer to “Enable Manual Control” on page 6-24).

2. Detach the gas line from the desired port.
3. Attach the new gas line to the port.
4. Make sure any unused gas inlet ports are plugged.

5. Record the gas installed in the port in the analysis program as described in the following
section.

Specifying Gas Ports

When you change the gas attached to a port on the analyzer, you must enter the change in the
analysis program as follows.

1. Select Unit 1 > Unit Configuration from the main menu. The Unit Configuration dialog
is displayed.

2. Click Gas. The Gas Configuration dialog is displayed.

| Gas Configuration {(Unit 1 - 5/N: 101)

P1: [N2 =] Pza =] Pp3[co2 =

P4: [T -] PS5 | =] Pe| -l
Lancel |
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3. Click on the down-arrow at the port to which you attached a gas line and choose the
appropriate gas.

4. Click OK to close the dialog, and then click OK again to close the Unit Configuration
dialog.

Performing a Reference Material Analysis

When you have doubts about the integrity of analysis data or when you would just like to
ensure the highest quality data, perform a reference analysis. Reference Material Kits are
available from Micromeritics (refer to Chapter 10, ORDERING INFORMATION). Each kit
contains reference material and an instruction booklet. Follow the instructions in the booklet to
perform the analysis and review the results.
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10. ORDERING INFORMATION

The ASAP 2050 system components and accessories can be ordered using one of the
following methods:

e Call our Customer Service Department at (770) 662-3636
» Access our web site at www.micromeritics.com
» Contact your local sales representative

When ordering, please use the information provided in this chapter to place your order:

Analysis System Components and Accessories

Part Number Item and Description

Peripheral Accessories

060-00030-00 FlowPrep 060, degasses up to six samples at up to 400 °C with
flowing gas.
061-00030-00 VacPrep 061, degasses up to six samples at up to 400 °C with either

flowing gas or by evacuation (evacuation requires a vacuum pump).

021-00000-00 Model 021 LN, transfer system, for easy filling of sample Dewars;

includes 47-L Dewar, mobile platform, and pump with 100-cm
discharge line.

202-33050-00 Water vapor option; allows water vapor adsorption studies.

System Components

202-25849-00 Dewar, 3 liter, cold trap

202-25850-00 Dewar, 3 liter, analysis

200-25928-00 Dewar, 1 liter, analysis (wide mouth)

202-33053-00 Stainless Steel Dewar Kit, 4 liter, wide mouth, includes analysis
Dewar, cold trap Dewar, and elevator adapter

240-25901-00 Dewar depth gauge

202-31708-00 Dewar cover, cold trap

202-31707-00 Dewar cover, analysis

200-25929-00 Dewar stopper, sample port, 1-liter Dewar

004-25103-00 Ferrule, front, Teflon 1/4 in.

May 2010
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Part Number

Item and Description

004-25104-00

290-25846-00
290-25846-01

004-25549-00

004-62230-35

004-62230-54
004-62230-326

004-62230-705

004-62230-58
004-62230-32
004-62250-320
004-62250-350
004-62250-540
004-62250-580
004-33601-00

004-33602-00

003-26046-00

230-25808-00
205-42801-00
004-25006-00
004-16843-00
004-16821-00
004-54609-00
240-25853-00
240-14855-00

Ferrule, rear, Nylon 1/4 in.
Copper tube, for gas inlet, 1/8-in. diameter, 6 ft (1.8 m) long.
Same as 290-25846-00, but uses 16-ft. (5m) tubing

Reducer, 1/8-in. tube x 1/4-in. tube, accepts 1/8-in. tube, connects to
1/4-in. swage fittings

Gas pressure regulator, CGA 350 fitting (CO, H,), 30 psig
Gas pressure regulator, CGA 540 fitting (O,), 30 psig

Gas pressure regulator, CGA 326 fitting (N,0), 30 psig

Gas pressure regulator, CGA 705 fitting (NH3), 30 psig

Gas pressure regulator, CGA 580 fitting (He, N, Ar), 30 psig
Gas pressure regulator, CGA 320 fitting (CO,), 30 psig

Gas pressure regulator, CGA 320 fitting (CO,), 250 psig

Gas pressure regulator, CGA 350 fitting (CO, H,), 250 psig
Gas pressure regulator, CGA 540 fitting (O,), 250 psig

Gas pressure regulator, CGA 580 fitting (He, N,, Ar), 250 psig

Expansion Kit; adds an additional outlet to the gas regulator, includes
fittings and instructions

Pressure Relief Kit, 35 psig, prevents excessive gas pressure in the event
of regulator failure (not to be used with noxious gases or with 150 psig gas
lines)

Heating mantle with type K thermocouple, 450 °C maximum, 24 V, with
elastic hanger.

Heating mantle clip

Operator’s manual

O-ring, size 006, Buna-N, for Po tube

Reference material, 13x molecular sieve

Reference material, Surface Area ~215 mzlg, PV ~0.6cc/g
Sample tube brush

Sample tube funnel

Sample tube rack
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Analysis System Components and Accessories

Part Number

Item and Description

004-54618-00
200-25840-00
250-25608-00
004-25459-00
250-25602-00

062-00001-11

062-00001-23

004-16003-01
062-33002-00
062-00002-11
062-00002-23
004-16009-00

200-25879-00
004-27040-00
004-16830-00
004-25652-00

202-33025-00

205-33001-00

Tool, for removing sample tube O-ring

Saturation pressure tube, includes isothermal jacket
Valve gasket, Kel-F, for analysis manifold

Valve plunger, Kalrez seal, for analysis manifold
Valve spring, for Kalrez plunger, for analysis manifold

Vacuum System Components

Vacuum pump, oil-sealed, with built-in anti-suckback valve, 110/120
VAC,; includes hose kit and alumina oil vapor trap

Vacuum pump, oil-sealed, with built-in anti-suckback valve, 220/240
VAC; includes hose kit and alumina oil vapor trap

Vacuum pump oil, 1 liter (not for use with oxygen-compatible pump)
Activated alumina oil vapor trap, for one vacuum pump
Vacuum pump, Inert fluid for oxygen use, 110/120 VAC
Vacuum pump, Inert fluid for oxygen use, 220/240 VAC

Fomblin® YL-VAC 14/6 inert fluid for vacum pumps that are
pre-conditioned for oxygen use

Vacuum pump oil funnel

Vacuum pump exhaust filter

Activated alumina, 500 grams, for oil vapor trap
O-ring, size 217, for oil vapor trap

Software

Isotherm Cycling; allows you perform up to 500 adsorption/
desorption cycles over a user-defined range. Includes software and
operating instructions.

Software package, ASAP 2050; includes current version of software
and operator’s manual.

May 2010
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Sample Tubes and Components

U g
-8

O -

0

Part Number

Item and Description

205-25802-01
004-25474-00
205-25807-00
300-25824-00
240-32000-00
205-25815-00

mT m O O W >

Sample Tubes and Components
Seal Frit with built-in check valve for air-sensitive samples
O-ring, size 013, Kalrez for sample tube
Sample tube
Nut, sample tube
Stopper, for sample tube

Isothermal jacket, for sample tube

10-4

May 2010



ASAP 2050 Operator’'s Manual

Cold Trap Tubes and Components

Cold Trap Tubes and Components

TR

B . C

D__| E
AN

Part Number

Item and Description

Cold Trap Tube and Components

004-25469-00
004-25979-00
205-25808-00
004-61063-00
205-25806-00

m g O @ >

O-ring, Buna-N, size 014, for glass or stainless-steel cold trap
Nut, for glass cold trap

Nut, for stainless-steel cold trap

Tube, 1/2-in. OD stem, cold trap, glass

Tube, 1/2-in. OD stem, cold trap, stainless-steel

May 2010
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[M] micromeritics®

A. ASAP SERIES SAMPLE DATA WORKSHEET

This form is provided to assist you in obtaining an accurate sample mass for report calculations.
You may use the After Degas value (Step 5) or the After Analysis value (Step 7), provided they
are close to the same.

Sample tube: Sample:

Before Degas:

1. Mass of empty sample tube I (*),
2. Mass of sample tube plus sample I (*),
3. Mass of sample (Step 2) — (Step 1) I (*),
After Degas:

4. Mass of sample tube plus sample I (*),
5. Mass of sample (Step 4) — (Step 1) I (*),
After Analysis:

6. Mass of sample tube plus sample (g) I (*),
7. Mass of sample (Step 6) — (Step 1) I (*),

Compare the sample mass obtained after analysis (Step 7) with the sample mass after degas (Step
5). These two values should be close in range. If a significant difference is noted, analysis
problems may exist or the sample may have been improperly degassed.
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B. ERROR MESSAGES

Error messages are listed numerically. If the Action response instructs you to contact your
service representative, record the error message and make backup copies of any files involved
in the operation.

included in this appendix. These errors should not occur during normal operation.
If you receive a 1000 series error message or an error message not listed in this
appendix: record the error message, make backup copies of any files involved,
then contact your service representative.

\ The 1000-series error messages (used primarily for software testing) are not

2200 and 2400 Series

2201- Cannot execute report subsystem.

Cause: Start Report failed to execute the report subsystem (which is a separate
process).
Action: Restart the computer. If the problem persists, reinstall the application

(this will not affect any of your sample files). If the problem continues,
contact a Micromeritics service representative.

2401- FATAL ERROR: (error message).

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your service representative if you continue to receive this error
message.

2430- Error accessing file (file name), error code = (number).

Cause A: A computer or network problem occurred.

Action A: Check the performance of your computer devices or network.
Cause B: A software error occurred when the file was accessed.
Action B: Contact your service representative.
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2431- Error writing file (file name), error code = (number).

Cause: The hard disk does not have enough space left to perform the opera-
tion.
Action: Copy files not used regularly from the hard disk to a diskette, CD, or

network directory, delete them from the hard disk, and then try the
operation again.

2432- Invalid response from MMI ‘FILE_READ’ request.

Cause: An internal processing and/or hardware error has occurred.
Action; Contact your service representative if you continue to receive this error
message.

2433- New entries have been found in this directory. Refresh the directory
information?

Cause: Several ASAP 2050 files (sample information, analysis conditions,
adsorptive properties, or report options) have been added to this direc-
tory by some function other than the ASAP 2050 program.

Action; Select Yes to update the directory information with data from each new
file. This operation may take a minute.

Select No if you do not want to spend the time updating the directory
information. This option may be feasible if a large number of files have
been copied into the directory and you know the name of the file you
wish to access.

2434- File (file name) — Subset # (humber) wrote wrong amount of data.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your service representative if you continue to receive this error
message.
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2436- Path specification (path name) is invalid.

Cause: You entered an invalid path name and/or extension.
Action: Type a valid path name (including the proper extension) and press
Enter.

2437- File (file name) does not exist.

Cause: You entered a file specification that does not exist.
Action: Enter an existing file specification or select a file name from the list
box.

2438- Disk drive (letter): is inaccessible.

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the disk is not write-protected.

2439- Could not register file.

2440- Subset not found.

2441- Seek within file failed.

2442- Bad header in subset file.

2443- Subset owner denied access.

2444- Not a valid file format.

2445- Subset wrote the wrong amount of data.
2446- Error reading data.

2447- Error writing data.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

2448- File directory (path name) is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid. The directory
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a
file, use the Directories: list to move to the correct directory.
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2449- This field does not contain a valid file specification.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your DOS or Win-
dows manual and re-enter the name.

2450- Sample Defaults may not be edited while this operation is in progress. Do you
wish to save and close the Sample Defaults edit session?

Cause: You are in the process of initiating an automatic analysis (an analysis in
which sample files are created using the defaults) while editing the
defaults.

Action; Finish your edit session of the defaults and close the dialog. Then

restart the automatic analysis.

2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number)
selections will be processed. Please reselect the remainder.

Cause: You selected too many files for this operation.

Action; Select only the number of files specified in the message.

2456- Insufficient file handles available. Application cannot continue.

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for
open files to 50 or greater.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.
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2458- An instrument is performing a critical operation. Wait a few moments before
exiting the application.

Cause: You attempted to exit the application while the analyzer is performing
a critical operation. This operation must be completed before the appli-
cation can be stopped.

Action: Wait a few minutes before attempting to exit the application again.

2459- Aninstrument is busy. A delay in restarting this application could result in loss
of new data. Continue with program Exit?

Cause: You attempted to exit the application while the analyzer was perform-
ing an operation.

Action; Rather than exiting the application you may choose to minimize it.

2460- Fatal Communications error on (unit nn).

Cause: Repeated attempts to maintain communication with the analyzer have
failed.

Action: Check the communications cable connecting the analyzer to the com-
puter. Confirm that the analyzer is turned on and that the status light is
not blinking.

If these checks are okay, exit the analysis program and then restart the
application. If this error persists, contact your service representative.

2461- No instruments are in operation. This application will unconditionally

terminate.

Cause: At least one analyzer must be active for the application to operate. The
initialization of the analyzers configured with the Setup program has
failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason
for the analyzer’s failure to initialize. See the instructions for that mes-
sage.
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Action B: Check the cable connection between the analyzer and the computer.
Verify that the analyzer has the power switch in the ON position and
that the light on the front panel is illuminated. If the application con-
tinues to fail in its attempts to initialize the analyzer, contact your ser-
vice representative.

2471- Unit (number) - S/IN; (number) has an invalid communications port specified. It
cannot be initialized.

Cause: The communications port specified for this analyzer during installation
(or configuration) is invalid.

Action: Use the setup program to change the analyzer configuration.

2474- Unit (number) Communications port COM (port number) specified in the pro-
gram control files is already in use. Unit cannot initialize.

Cause: The communications port assigned to the indicated unit is in use by
another program.

Action: End the program using the busy port or use the Setup program to
change the communications port assigned to this program.

2475- Unit (number) Communications port COM (port number) specified in the pro-
gram control files cannot be accessed. Unit cannot initialize.

Cause: The operating system has prevented the application from accessing the
communications port.

Action: Review the hardware configuration of the computer, ensure that no
other application is using the port. Contact your service representative
if you continue to receive this error message.

2476- Unit startup failed. Cannot initialize the communications port.

Cause: The communications port specified during installation is invalid.

Action: Use the setup program to change the analyzer configuration. Contact
your service representative if you continue to receive this error mes-
sage.
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2477- Unit (number); Serial (number) did not properly initialize.

Cause: The software was unable to initialize the analyzer.

Action A: Run the Setup program and ensure that a valid port is specified; if not,
specify a valid one when prompted.

Action B: Reinstall the software, then restart application.

Action C: Contact your Micromeritics service representative if you continue to
get this message.

2478- Error copying sequential data segment.

Cause: An internal processing and/or hardware error occurred while accessing
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for
example, you may wish to use a utility such as ScanDisk. Contact your
service representative if you continue to receive this error message.

2479- Unit (number); Serial (number) The instrument is busy performing an operation
of which this application is unaware. Do you want to cancel? (Yes, No)

Cause: During initialization of the application, the status of the analyzer was
found to be in a different state than expected.

Action: Click Yes to cancel the operation in process, allowing the analyzer to
reset and continue with initialization.

Click No to cancel the initialization process.

If you continue to get this message, verify that files in the application
directory structure are not being changed or removed.

2480- File (file name) cannot be analyzed. It is currently being edited.

Cause: You attempted an analysis using a sample file that is being edited.

Action: Save the changes and close the dialog box.
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2481- Error accessing the sample information file (file name).

Cause A: You attempted to open a file that is already open, possibly minimized.
Action A: View the minimized icons, locate and maximize the file.

Cause B: A computer or network problem occurred.

Action B: Check the performance of your computer devices or network.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

2482- File cannot be opened for writing. It is already in use.

Cause: You are attempting to open a file that is currently being used (either by
this application or another).

Action: Locate the application using the file (in the Micromeritics application,
use the Windows menu item to get a list of all windows, one of which
may contain this file).

2483- An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

Cause: You attempted to use a sample file containing errors that is currently
open.
Action: Go to the window containing the file, correct the errors, and save it.

2484- The edit session for (file name) must be saved before the analysis. Save
changes and continue with the analysis.

Cause: You attempted an analysis using a sample file that contains unsaved
changes.
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Action: Select Yes to save the changes and continue with the analysis.

Select No to abort the analysis and return to the sample file.

2485- The service test file has an invalid status and cannot be used for this analysis.

Cause: The selected service test file has a status other than No Analysis.

Action; Select a different service test file or create a new one and use Replace
All to copy parameters from the file you originally selected.

2486- Cannot construct (name) report type. Program will terminate.
2487- Cannot start report generator. Error code (number). Program will terminate.

Cause A: You may not have full rights to the application’s folders and files.

Action A: Contact your system administrator and have him grant you full rights.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error
message.

2488- File (file name) cannot be opened for editing. It is already in use.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.

2490- No “.INI' file present. Application will terminate.

Cause: The ASCII (.INI) file containing initialization and system options
information cannot be found. The .INI file may have become cor-
rupted. The application cannot operate without this file.
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Use the Setup CD to uninstall the ASAP 2050 application. When you
uninstall the application, only the application files are deleted; data
files remain intact.

Action:

After the uninstall operation is complete, reinstall the ASAP 2050
application.

2491- Highlighted fields contain errors. Please correct the errors before closing dia-

log box.
Cause: The highlighted fields contain invalid entries. You will not be able to
close the dialog box until you correct the errors.
Action: Check the entries, correct the errors, and close the dialog box

2492- This field’s entry is invalid.

Cause: The highlighted field contains an invalid entry.

Action; Check the entry and correct the error.

2493- An entry is required for this field.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.

2494- Value is out of the valid range.
2495- Value is out of the valid range. Enter a value between (value) and (value).

Cause: The value you entered in the highlighted field is outside the valid range
of values.
Action: Check the entry and enter or select an appropriate value.

2496- Invalid number.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.
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2497- This field contains an invalid character.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

2498- The requested change to the Sample’s status is invalid at this time.

Cause: A request to change the file’s status (for example, from automatically
collected to manually entered) could not be done.

Action: Contact your service representative if you continue to receive this error
message. Record the name of the sample file in which the problem
occurred.

2499- Sequence number must contain at least 3 digits.

Cause: You tried to enter a sequence number that did not contain at least three
digits.
Action: Enter a sequence number that contains at least three digits.
2500 Series

2500- All sample file names that can be created using the sequence number pattern
already exist. You may want to modify the next sequence number.

Cause: No more sample information files can be created using the currently
entered file name sequence number.

Action: Select Options > Sample Defaults from the Main Menu and enter a
new sequence number.

2501- System resources have reached a dangerously low level. Please close some
windows to avoid the loss of data.

Cause: A large number of windows are open and consuming the system
resources available to all applications.
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Action: Close one or more windows on the screen. Contact your service rep-
resentative if you continue to receive this error message.

2502- Error writing to file (name) during print. Error code: (number).

Cause: An error occurred in the file being written to during a print operation.

Action; Ensure that there is sufficient space on the drive containing the file.

2503- Error converting file (file name). Could not create DIO intermediate file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed
in the directory specified by the TEMP environment variable.

Action A: Determine if there is sufficient space on the drive where the TEMP
directory is located.

Cause B: An internal processing and/or hardware error has occurred.
Action B: Contact your service representative if you continue to receive this error
message.

2504- Cannot create output file for sample (sample name).

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this error message.

2505- Error Logger cannot be initialized! Error code (number). Program will exit.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.
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2506- (sample file) Output device (name) is not installed. Printing cannot be
accomplished.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device in the System Configuration dialog
box. Install the device using the Control Panel, Printers operation.

2508- (sample file) Overlay file (name) was not found. It will not be included in the

reports.
Cause: The specified overlay file could not be found.
Action: Ensure that the file specified as an overlay does exist.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

Cause: An error occurred while the program was opening a file necessary to
the report operation.

Action: Use the name given in the error message to investigate. Contact your
service representative if you continue to receive this error message.

2510- (sample file) Error parsing reports from file (name). Reports cannot be

produced.

Cause A: One or more data entry fields in the sample file may contain an invalid
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.
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Cause C: An internal processing error occurred.

Action C: Contact your service representative.

2511- Print job (name) has been cancelled due to insufficient disk space. Delete
unnecessary files and restart the report.

Cause: The disk drive does not have enough space for the temporary file

required by the Windows Print Manager. Therefore, printing of the
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five
megabytes of free space for normal operation.

2512- Print job (name) has been cancelled.
Cause: The requested print job was canceled at your request.

Action: None required.

2513- Unable to read the calibration file (file name).

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the calibration file has no problems.

2514- Unable to write the calibration file (file name).

Cause: An attempt to Save calibration data has failed due to possible media
problems.

Action A: Be sure the media you want to Save the file to has no problems.

Action B: Choose an alternate media to Save the calibration data.
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2515- Warning: Changing the calibration information will affect the performance of
the instrument. Only qualified service personnel should do this. Do you wish to

proceed?
Cause: You have started the process of performing a calibration operation.
Action: Calibration operations should only be done by or under the direction of

qualified service personnel.

2516- Warning: Keeping a backup copy of the calibration data is recommended by
Micromeritics. Would you like to do so now?

Cause: You have performed a calibration operation; a backup copy is recom-
mended.
Action: Perform a calibration Save operation.

2517- Canceling this dialog will reset the calibration state to what it was when this
dialog was first opened. Are you sure you want to cancel?

Cause: You have not accepted the calibration you performed.

Action: If the calibration operation was successful, press Accept.

2521- Unable to program controller.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

2522- Invalid controller application file.

Cause: The application’s control file has been corrupted or deleted.

Action; Reinstall the ASAP 2050 analysis program.

2523- Programming the controller failed.

2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.
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2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

Cause: An internal processing and/or hardware error has occurred.
Action; Contact your service representative if you continue to receive this error
message.

2532- The instrument contains a different software version. Do you want to reset it?

Cause: The application has discovered a different version of software operat-
ing in the analyzer.

Action: If there are no analyzers other than the ASAP 2050 connected to the
computer, select Yes and allow the updated software to load.

2533- Analyzer initialization failed.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your service representative if you continue to receive this error
message.

2534- Error opening file (name) for printing. Error code: (number).

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
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4000 Series

4000- Memory Allocation Error.

Cause: An internal processing and/or hardware error occurred during report
generation.

Action: Contact your service representative if you continue to receive this error
message.

4002- Thermal Transpiration correction had no effect.

Cause: The Thermal transpiration correction option was selected on the Report
Options dialog box. However, the correction did not change any pres-
sure by more than one percent.

Action: De-select this option to disable this message. This correction is only
meaningful for very low pressures.

4003- Error Converting Pressures.
4004- Error Computing Volume Adsorbed.

Cause: An internal processing and/or hardware error occurred during report
generation.

Action: Contact your service representative if you continue to receive this error
message.

4005- Pressures were not smoothed. Not enough pressures below 0.10 P/Po.
Cause: The Smooth pressures below 0.10 P/Po option was selected on the

Report Options dialog. There must be at least 10 pressures within this
range for smoothing to occur.

Action: Deselect this option to disable this message.
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4006- Report Type Not Found.
4007- Error Processing Report.

Cause: An internal processing and/or hardware error occurred during report
generation.

Action; Contact your service representative if you continue to receive this error
message.

4008- Report requested on sample file with no data points.

Cause: You selected a file for reporting which contains no collected data.

Action: Select another file which contains collected data and restart the report.

4009- Error, No Reports Selected.

Cause: You attempted to generate reports for a sample that has no reports
selected in its report options.

Action: Select the desired reports in the sample’s report options and save the
sample file.

4010- Summary Report was not included in the Selected Reports.

Cause: You did not select a plot or a table for any of the Selected Reports in
the Report Options dialog; you selected the reports only to generate an
entry in the summary. However, the Summary was not included in the
Selected Reports.

Action: Select a plot or table in one or more of the Selected Reports, and/or add
the Summary to the Selected Reports.

4011- Analysis gas in sample file does not match analysis gas in unit.

Cause: You attempted to start an analysis using a sample information file in
which the analysis gas specified does not match the analysis gas
entered in the unit configuration.
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Action: If necessary, attach the appropriate gas bottle, then enter the gas in the
Unit Configuration dialog box.

4012- Psat gas in sample file does not match Psat gas in unit.

Cause: You attempted to start an analysis using a sample information file in
which the Psat gas does not match the Psat gas entered in the unit con-
figuration.

Action: If necessary, attach the appropriate gas bottle, then enter the gas in the

Unit Configuration dialog box.

4015- Error creating export file for sample <sample file name>.

Cause: A file error occurred during creation of an export output file.

Action: The output file name may be invalid. Ensure that the target directory
exists. Ensure that the target diskette is not full or write protected. The
target disk drive may be damaged or inoperative. Verify that other files
may be created on the same drive. Contact your service representative
if you continue to receive this error message.

4016- Sample (file name) has no data for export.

Cause: The file selected for export has a status of No Analysis. No export file
will be created.

Action: Select a file which contains analysis data.

4017- Damage to the instrument will result if the sample has not been manually evac-
uated. Have you evacuated the sample?

Cause: You did not select Backfill sample at start of analysis on the Sample
Backfill Options dialog box. The sample tube is normally at atmo-
spheric pressure when an analysis is started, and it must be backfilled
before the analysis begins to prevent sample material from being
drawn into the manifold.
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Action: If you have manually evacuated the sample tube, select Yes. If you
have not, select No and then either perform a manual evacuation or go
to the Sample Backfill Options dialog box and select Backfill sample
at start of analysis.

4020- Disabling this option may damage the instrument. Are you sure that the sample
should not be backfilled?

Cause: You did not select Backfill sample at start of analysis on the Sample
Backfill Options dialog. The sample tube is normally at atmospheric
pressure when an analysis is started; it must be backfilled before the
analysis begins to prevent sample material from being drawn into the
manifold.

Action; If you want to manually evacuate the sample prior to the start of the
analysis, select Yes. Otherwise, select No, go to the Sample Backfill
Options dialog, and select Backfill sample at start of analysis.

4021- The entered Po value (Po and Temperature Options of the Analysis Conditions)
is outside the range of the pressures listed in the Psat vs. Temperature Table (Adsorp-
tive Properties).

Cause: The temperature that corresponds to the entered Po cannot be found
because the entered Po is outside of the range of values in the Psatvs. T
table.

Action A: Enter a Po that is within the range of the table.

Action B: Use a different Psat vs. T table.

4022- The entered bath temperature value (Po and Temperature Options of the Anal-
ysis Conditions) is outside the range of the temperatures listed in the Psat vs.
Temperature Table (Adsorptive Properties).

Cause: The Po that corresponds to the entered temperature cannot be found
because the entered temperature is outside of the range of values in the
Psat vs. T table.

Action A: Enter a temperature that is within the range of the table.

Action B: Use a different Psat vs. T table.
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4023- The file (sample file) cannot be prepared for analysis. It is open for editing and
contains errors.

Cause: You attempted an analysis using a sample file that is being edited and
has invalid values in one or more of its fields.

Action: Enter valid values into the fields that have errors, save the changes, and
close the dialog box.

4024- Backfill gas in sample file does not match any gas in unit.

Cause: You selected a backfill gas that is not included in the gas configuration.

Action: Make sure that gas selections match the gases that are attached to the
instrument. Choose one of the gases as the backfill gas, or edit the sam-
ple file and choose one of the existing gases as the backfill gas.

4025- There is no Helium attached to the unit.

Cause: A measured free space has been requested but Helium does not appear
to be available.

Action: Make sure the helium cylinder is attached to the unit at its designated
port.

4026- Cannot calculate Dubinin-Astkahov: bad least squares data.

Cause: Less than two selected data points are within the fitted pressure range.

Action: Edit the calculation assignments on the Collected Data dialog, or
change the fitted pressure range on the Dubinin report options dialog.

4027- Fewer than two sample files have data suitable for heat of adsorption reports.

Cause: Less than two of the sample files you selected for heat of adsorption
reports contain appropriate data.

Action; Edit the Quantity Adsorbed table, or select other sample files.

Jul 07 B-21



ASAP 2050 Operator’'s Manual Appendix B

4028- Dubinin calculations cannot be performed because the affinity coefficient of
the analysis gas is zero.

Cause: Dubinin values could not be calculated because the affinity coefficient
of the analysis gas is zero.

Action: Access the Dubinin Report Adsorptive options in the sample file and
enter an appropriate value for the analysis gas.

4029- At least two fitted data points are needed for Alpha-S calculations.

Cause: Fewer than two data points fall within the selected Alpha-s range.

Action; Edit the calculation assignments or the fitted Alpha-s range, or use a
different reference curve.

4030- Preparations failed in primary data.

Cause: Appropriate data were not available to generate the report.

Action: This message was preceded by a different error message; refer to the
cause/action of the preceding message.

4031- Not enough points with a relative pressure in the range (n,n)

Cause: Fewer than two data points selected for the Dubinin report falls within
the selected relative pressure range.

Action; Edit the calculation assignments or the fitted relative pressure range.

4033- Not enough points to generate Dubinin Tabular Report.

Cause: There are fewer than two valid data points available for the Dubinin
tabular reports.

Action: Examine the calculation assignments in the Collected Data dialog of
the sample file. You must have at least two micropore pressures
selected for inclusion in the Dubinin report.
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4034- Fewer than 2 points available for Dubinin calculations.

Cause: There are fewer than two valid data points available for Dubinin
reports in one of the sample files selected for overlaying.

Action: Examine the calculation assignments in the Collected Data dialog of
the sample file. You must have at least two micropore pressures
selected for inclusion in the Dubinin report.

4035- Cannot calculate optimized Astakhov exponent: Not enough points with a rel-
ative pressure in the range [(pressure), (pressure)].

Cause: There are fewer than two valid data points in the relative pressure
range specified. Astakhov reports will not be produced.

Action: Examine the calculation assignments in the Collected Data dialog for
the sample file. You must have at least two pressures in the given range
selected for inclusion in the Dubinin report.

4036- Fewer than 2 points available for Horvath-Kawazoe calculations.

Cause: You must select at least two data points for inclusion in the Horvath-
Kawazoe analysis on the Collected Data dialog. No report will be pro-
duced.

Action: From the Collected Data dialog, select the data points to be analyzed.

4037- Computations failed while processing the primary data set. No reports will be

produced.

Cause: The preparation of data for reporting could not be successfully com-
pleted. No Horvath-Kawazoe reports will be produced. This message
will always be preceded with another one containing additional infor-
mation.

Action: Refer to the number of the error message which preceded this one for

an explanation.

Jul 07 B-23



ASAP 2050 Operator’'s Manual Appendix B

4038- Fewer than 2 points available for the Langmuir Qm computation. Cheng/Yang
correction will not be applied.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires
the value of the monolayer volume as calculated from the Langmuir
equation. The isotherm must include at least two points above 0.02 rel-
ative pressure for the Langmuir equation to be applied.

Action: The analysis will be performed without the Cheng/Yang correction.
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe
Report Options dialog to prevent this message from appearing on
future reports.

4039- The isotherm does not meet the constraints of the Cheng/Yang assumption.
Cheng/Yang correction will not be applied.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires
the value of the monolayer volume as calculated from the Langmuir
equation. The isotherm does not correlate to the Langmuir assumption
with a coefficient of 0.98 or more. The correction is not applicable to
this isotherm or to the range of the data points selected.

Action A: The analysis will be performed without the Cheng/Yang correction.
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe
Report Options dialog to prevent this message from appearing on
future reports.

Action B: Generate the Langmuir report for the same data points selected for the
Horvath-Kawazoe report. If the Langmuir correlation coefficient can
be brought above 0.98 by removing some points at high relative pres-
sure, remove them and reproduce the Horvath-Kawazoe reports.

4040- The value of Qm computed from the Langmuir equation is too low. The pore
size will not be computed for all data points.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires
the value of the monolayer volume as calculated from the Langmuir
equation. The computed value is less than the volume adsorbed at the
largest relative pressure included in the analysis. The correction is not
applicable to this isotherm or to the range of the data points selected.
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Action: The analysis will be performed and the Cheng/Yang correction will be
applied to all points with a volume adsorbed less than the value of Vm.
The pore size will not be calculated for data points with an invalid vol-
ume adsorbed. Deselect Apply Cheng/Yang correction on the Horvath-
Kawazoe Report Options dialog to clear this message.

4041- Cheng/Yang correction is inappropriate for some P/Po.

Cause: The Cheng/Yang correction is usually inappropriate for any P/Po above
the isotherm knee. In some instances, the computed pore sizes may
decrease above the knee. While it is possible to include these relative
pressures (usually above 0.1 P/Po) in the analysis, the computed pore
sizes for these pressures are usually meaningless.

Action; Change the data points selected for the Horvath-Kawazoe report to
include only relative pressures at or below the knee of the isotherm, or
change the Horvath-Kawazoe report options so that the Cheng/Yang
correction is not applied.

4042- 0.0 cannot be a starting or ending pressure for a geometric progression from
low pressure.

Cause: You selected to generate a pressure table from a geometrically pro-
gressing range.

Action: Change the 0.0 entered value.

4043- 1.0 cannot be a starting or ending pressure for a geometric progression toward

saturation.
Cause: You selected to generate a pressure table from a geometrically pro-
gressing range.
Action: Change the 1.0 entered value.

4044- Points in the Langmuir report pressure table lie outside the collected data.

Cause: Calculation assignments are not being used and more than one of the
report pressure table points is above the range of the collected data, and
more than one is below.
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Action: Change the report pressure table to be more consistent with the col-
lected data.

4045- Points in the report pressure table lie outside the collected data.

Cause: Calculation assignments are not being used and more than one of the
report pressure table points is above the range of the collected data, and
more than one is below.

Action: Change the report pressure table to be more consistent with the col-
lected data.

4046- (file name) could not be opened for reading.

Cause: A thickness curve file could not be opened.
Action: If the problem persists, restart your computer and optionally perform a

media integrity check (using ScanDisk).

4047- Warning: An error occurred while reading (file name).

Cause: An error happened during a read operation of a thickness curve file.
Action: If the problem persists, restart your computer and optionally perform a

media integrity check (using ScanDisk).

4048- Warning: An error occurred while restoring the heat of adsorption report editor.

Cause: The state of the heat of adsorption report editor could not be restored.
Default settings will be used.

Action: No action.
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4049- The sample (file name) does not have enough data. A minimum of two adsorp-
tion points is required.

Cause: A sample file has been included in the Heat of Adsorption report that
does not have enough data.

Action: Remove the file from the selected file list.

4050- None of the requested quantities adsorbed is within the range of the collected
data of more than one sample file.

Cause: The Heat of Adsorption report failed because the specified quantities
are not within the range of the collected data.

Action A: Edit the quantities adsorbed so that they are within the range of the col-
lected data, or select other sample files.

4051- The sample (file name) does not have any data in the range of the requested
guantities adsorbed.

Cause: The sample’s data cannot be interpolated to any of the quantities
adsorbed.

Action: Edit the quantities adsorbed so that they are within the range of the col-
lected data.

4052- Fewer than two points are selected for this report.

Cause: At least two points are required for the BET calculations.

Action: Edit the calculation assignments for the BET report.

4053- At least two data points must be selected for t-Plot calculations.

Cause: At least two points are required for the t-Plot calculations.

Action: Edit the calculation assignments for the t-Plot report.
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4054- Fewer than two data points are inside the fitted thickness range.

Cause: At least two points must be within the fitted thickness range for the t-
Plot calculations.

Action A: Edit the calculation assignments for the t-Plot report.

Action B: Edit the fitted thickness range in the t-Plot report editor.

4055- The BET surface area could not be calculated.

Cause: Fewer than two points were assigned to the requested surface area cal-
culation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.

4056- The Langmuir surface area could not be calculated.

Cause: Fewer than two points were assigned to the requested surface area cal-
culation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.

4057- At least two data points are needed for Freundlich calculations.

Cause: Less than two data points have been selected for the Freundlich report;
at least two are required.

Action: Select Freundlich points on the Collected Data dialog. If calculation
assignments are not being used, edit the Freundlich Report options,
Absolute pressure range in the sample file.
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4058- At least two data points are needed for Temkin calculations.

Cause: Less than two data points have been selected for the Temkin report; at
least two are required.

Action; Select Temkin points on the Collected Data dialog. If calculation
assignments are not being used, edit the Temkin Report options,
Absolute pressure range in the sample file.

Cause: You have selected at least one point with a negative pressure value to
include in the Temkin report.

Action; Negative pressure points void Temkin calculations. Open the sample
file and click the Collected Data tab. Locate the negative value(s) in
the Temkin column and deselect it (them).

4059- Fewer than 2 points available for MP-Method calculations.
Cause: At least two points are required for the MP-Method calculations.

Action; Edit the calculation assignments for the MP-Method report.

4060- Sample (file name) contains no data points.

Action: An attempt was made to save a sample without collected data as a t-
curve or alpha-S curve.

Cause: Repeat the save as t-curve or save as alpha-S operation after opening a
sample that has collected data.

4061- The t-curve must contain at least 2 points.

Cause: At least two points are required in a thickness curve definition.

Action: Edit the thickness curve.

4062- Error during report generation.

Cause: An internal processing error has occurred.

Action: Contact your Micromeritics service representative.
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4063- The data requested on this report are not available.
Cause: There is no information in the sample log to report.
Action: You selected a sample file for which no instrument operations have

been used. Select a sample file with a status of Prepared, Preparing,
Analyzing, or Complete to obtain a valid sample log report.

4067- No data points are within the range of pressures in the reference isotherm.

Cause: There are no collected data points within the range of pressures in the
reference isotherm.

Action; Select data points that are in the range of the reference isotherm, or
select a more appropriate reference isotherm.

4068- No points were selected for the f-Ratio report.

Cause: The collected data column for the f-Ratio report does not have any
points selected.

Action: Edit the collected data dialog and select points for the f-Ratio report.

4069- Dosing method choice is invalid. The Analysis Conditions choice of Absolute
pressure dosing requires that the Adsorptive Properties (Dosing Method) is set to

Normal.

Cause: There is an incompatibility between the analysis conditions choice of
Absolute pressure dosing and the adsorptive properties dosing
method.

Action: Edit one of the choices.

4070- Unable to load deconvolution model (name).

Cause: For some reason, the list of available models was corrupted, therefore,
the model selected could not be loaded for the deconvolution.

Action; Exit the program and reinstall the software, then try again.
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4071- The selected pressures points do not form a valid set for deconvolution.

Cause: The data points selected for analysis do not contain enough informa-
tion to allow a DFT data reduction.

Action A: Edit data points in the table of the Collected Data dialog, or select
another sample file. At least two points with strictly increasing pres-
sures and volumes adsorbed are required for a DFT Plus data reduc-
tion.

Action B: Edit the pressure range on the DFT report options dialog.

4072- The range of pressures selected is too small to deconvolute using this model.

Cause: A null result was found using the selected model.

Action: Edit data points in the table of the Collected Data dialog, or select
another sample file. At least two points with strictly increasing pres-
sures and volumes adsorbed are required for a DFT data reduction.

4073- The analysis gas (name) does not match the model gas (name).

Cause: The model assumes a specific gas and the sample file uses a different
one.
Action: Select a model that assumes the same gas.

4076- Invalid sample file - Adsorptive Properties “Non-condensing adsorptive” can-
not be used unless Analysis Conditions “Absolute pressure dosing” is selected.

Cause: You selected a sample file that has Non-condensing adsorptive
selected in the Adsorptive Properties but does not have Absolute pres-
sure dosing selected in Analysis Conditions.

Action A: If you plan to use a non-condensing adsorptive, select Absolute pres-
sure dosing on the Analysis Conditions dialog.

Action B: If you are not using a non-condensing adsorptive, deselect the Non-
condensing adsorptive option on the Adsorptive Properties dialog, or
choose an adsorptive that you are sure in not non-condensing.
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4077- Cannot get surface area for: (file name)

Cause: The Isotherm report for the named overlay file has Per gram selected
for the Volume Adsorbed, and the Isotherm report for the primary file
has a surface area option selected for the Volume Adsorbed.

Action A: Edit the Isotherm report for the named overlay file and select a surface
area option for Volume Adsorbed.

Action B: Click Overlays on the Report options dialog of the primary file and
remove the named overlay file from the list.

4078- Slope and Y-Intercept cannot be determined from the selected points.

Cause: The Langmuir report cannot be generated from the selected points.
Action: Edit the calculation assignments in the Langmuir column on the

Collected Data dialog.

4079- Points found with negative pressure values will not appear on the graph.

Cause: Collected data contains negative pressure values.

Action; Negative pressure points are automatically removed from isotherm
graphs. If you wish to have negative pressure values appear on the
graph: Open the sample file and click the Collected Data tab.
Deselect Use calculation assignments and then select the points with
negative pressures as Outliers.

4080- The compressibility factor table has (hnumber) pressure entries. Only (number)

are allowed.
Cause: The compressibility factor table in the adsorptive properties has too
many pressure values for analysis.
Action: Edit the table to remove unneeded pressure entries.
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4081- In the compressibility factor table, the 4 temperatures below (temperature) and 7
temperatures above must span at least 10 K.

Cause: The compressibility factor table in the adsorptive properties has too
many entries for temperatures near ambient.

Action: Edit the table to remove unneeded temperature entries.
4082- Compressibility factors must be greater than zero for temperatures near ambi-
ent and pressures up to the maximum manifold pressure.

Cause: The compressibility factor table in the adsorptive properties contains
zeros or negative values for the temperatures and pressures expected
during analysis.

Action; Edit the table to add missing compressibility factors.

4083- All rows of (file name) do not have the same number of entries. Some rows will
be filled or truncated.

Cause: This is a warning that all rows in the compressibility factor table do not
have the same number of enties.

Action: Edit the table to make all rows the same length.

4084- The temperatures of (file name) are not strictly ascending.

Cause: The temperature values in the compressibility factor table are not in
ascending order.

Action: Edit the table to put the temperature columns in ascending order.

4085- The pressures of (file name) are not strictly ascending.

Cause: The pressure values in the compressibility factor table are not in
ascending order.

Action: Edit the table to put the pressure rows in ascending order.
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4086- Error reading (file name)

Cause A:

Action A:

Cause B:

Action B:

An error ocurred while reading the compressibility factor table.
Check the performance of your computer devices or network.
A software error occurred when the file was accessed.

Contact your service representative.

4087- Error writing (file name)

Cause:

Action:

An error ocurred while writing the compressibility factor table.

The hard disk does not have enough space left to perform the opera-
tion. Copy files not used regularly from the hard disk to a diskette, CD,
or network directory, delete them from the hard disk, and then try the
operation again.

4088- Can not open (file name) for reading

Cause A:

Action A:

Cause B:

Action B:

The specified compressibility factor table could not be read.
Check the performance of your computer devices or network.
A software error occurred when the file was accessed.

Contact your service representative.

4089- Can not open (file name) for writing

Cause:

Action:

The specified compressibility factor table could not be written.

The hard disk does not have enough space left to perform the opera-
tion. Copy files not used regularly from the hard disk to a diskette, CD,
or network directory, delete them from the hard disk, and then try the
operation again.
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4090- The compressibility factor table is empty.

Cause: The compressibility factor table in the adsorptive properties does not
have any data.

Action: Load an appropriate compressibility factor table.

6200 Series

6201- ‘GetOpenFile()’ reports error code (number). File selection cannot be made.

Cause: You specified a file name which does not exist.

Action: Confirm that the file name used is valid and that the file exists.

6202- Invalid communications port (port name) specified in the application’s config-
uration settings. Unit cannot initialize.

Cause A: The communications port assigned to the ASAP 2050 cannot be made
available for proper communications.

Action A: Run the ASAP 2050 Setup program, select Change analyzer setup, and
enter the correct port information. If the message continues, contact
your service representative.

Cause B: The ASAP 2050 control file was manually modified and an invalid
communications port was specified.

Action B: Use the ASAP 2050 Setup program to change the communications port
assigned to the ASAP 2050.

6203- No serial number available. Unit cannot initialize.

Cause: The ASAP 2050 control file does not contain a serial number for the
unit.
Action: Run the ASAP 2050 Setup program, select Change analyzer setup, and

define the serial number for the instrument.
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6204- The disk does not have enough room for the ROA data. The space required is
(number) megabytes.

Cause: The computer’s disk is almost out of disk space.

Action: Delete unwanted files.

6209- Analysis startup failed. (Secondary message number and text.)

Cause: The ASAP 2050 Program was unable to start an analysis with the indi-
cated unit.
Action: Refer to the specified error number and text for instructions.

6212- Calibrating. This action must be completed before the application exits.

Cause: The unit is calibrating.

Action; Do not exit the application until the calibration is complete.

6216- Instrument could not initialize. Reason: (reason).

Cause: An internal processing and/or hardware error has occurred.

Action: The specific reason given may identify a possible corrective action.
Contact your service representative if you continue to receive this error
message.

6235- (Unit [number]) Analysis canceled: Time limit exceeded while dosing Psat tube

to 925 mmHg.
Cause A: A pressure of 925 mmHg was not attained within the allowed time. The
Psat gas regulator may be set too low or turned off.
Action A: Set the Psat gas regulator to 10 psig (0.7 bar). Then restart the analysis.
Cause B: The Psat gas bottle is empty.
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Action B: Connect a new Psat gas bottle. Then restart the analysis.
Cause C: The Psat tube fitting is loose.
Action C: Check the Psat tube fittings and ensure that the tube is attached

securely to the port. Then restart the analysis.

6237- Unit (number) Analysis canceled: Time limit exceeded while evacuating Psat

tube.
Cause: The maximum time for evacuating the Psat tube was exceeded before
the vacuum set point was achieved.
Action; Check the Psat tube fittings. Tighten the connector nut if necessary;

then restart the analysis.

6240- Leak test failed.

Cause: With the sample port valve closed, the sample pressure increased by
0.15 mmHg before the leak test duration was completed.

Action: Check sample tube fitting and ensure that it is securely attached to the
port. Then restart the analysis.

6241- Unit (number) Analysis canceled: Maximum time exceeded before the elevator
reached the UP (or DOWN) position.

Cause A: The maximum time for the analysis was exceeded before the elevator

reached the UP (or DOWN) position. Ice may be present in the bottom
or the neck of the Dewar.

Action A: Check the Dewar and remove ice if necessary. Refer to Checking the
Analysis Port Dewar in Chapter 8. Then restart the analysis.

Cause B: The Psat tube is interfering with elevator movement.

Action B: Make sure the Psat tube is close to the sample tube and the Dewar
cover is over both the sample and Psat tubes. Then restart the analysis.
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6500 Series

6500- Failed to evacuate manifold to VAC SET in (number of) seconds. Calibration

canceled.

Cause A: The vacuum set point is set too low.

Action A: Ensure that the vacuum set point is at 5.0 mmHg. If the set point is
already at 5.0 mmHg or above, the vacuum gauge may need servicing.

Cause B: Leak in manifold.

Action B: Locate the leak and repair it. Refer to Chapter 9, Troubleshooting and
Maintenance. Restart calibration.

Cause C: Valve failure.

Action C: Identify the leaking valve. Contact your service representative.

6501- The Master transducer offset exceeds recommended limits: (number)

Cause: The Pressure Gauge Calibration operation showed the transducer offset
exceeds the recommended limit.

Action; Repeat the Pressure Gauge Calibration operation, if this message
occurs again contact a Micromeritics service representative.

6504- Unable to write the calibration file (name).

Cause: A Save to File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file
and that the media is not corrupted (run ScanDisk). If the problem per-
sists contact a Micromeritics service representative.
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6505- Unable to read the calibration file (name).

Cause: A Load from File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file
and that the media is not corrupted (run ScanDisk). If the problem per-
sists contact a Micromeritics service representative.

6506- Calibration file for (file name) is invalid.

Cause: A Load From File operation failed due to invalid information in the
file.
Action: Confirm there is sufficient free space on the media receiving the file

and that the media is not corrupted (run ScanDisk). If the problem per-
sists contact a Micromeritics service representative.

6509- The sample has an invalid status and cannot be used for degassing.

Cause: A file selected for degassing has a status other then No Analysis or Pre-
pared.
Action: Select a different file.

6510- Error evacuating.

Cause: An evacuation error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.

6511- Error dosing.

Cause: A dosing error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.
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6512- Error calibrating the servo.
Cause: An error occurred while calibrating the servo valve.
Action: If the problem persists, contact a Micromeritics service representative.
6513- Error waiting for pressure to drop.
Cause: A pressure error occurred during a degas operation.
Action: If the problem persists, contact a Micromeritics service representative.

6514- Problem encountered dosing to target [PR2] [PR-U], last pressure = [PR4] [PR-
U], elapsed time = [0]:[0].

Cause: Dosing during an analysis did not come within the allowed range of the
target.
Action: Check that the outlet stage of the gas regulator is within specification.

If the problem occurs frequently contact a Micromeritics service rep-
resentative.

6516- Unit (number) Analysis canceled: Sample pressure greater than (pressure)
mmHg is not allowed.

Cause: An absolute pressure greater than (pressure) mmHg was attained dur-
ing Low pressure dosing (either fixed dose mode or incremental dose
mode).

Action: The analysis was canceled. All previously collected data were stored.

6517- Unit (number) Analysis canceled: Total volume dosed greater than (volume)
cm3 is not allowed.

Cause A: More than (volume) cm? has been dosed onto the sample, possibly due
to leaks in the system.

Action A: Perform leak checks on the system. Refer to Appendix E, Testing for
Leaks.
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Cause B:

Action B:

Cause C:

Action C;:

The value for the Po may be too low, causing the instrument to mistake
condensation for actual adsorption.

Change the analysis variables to directly measure the value of Po dur-
ing the experiment.

The amount of sample you used may be too large. Multiply the max-
imum value from the Volume Adsorbed column of the Isotherm Report
by the sample weight. If the result exceeds (volume) cm3, the amount
of sample is too large.

Reduce the amount of sample.

6518- Unit (number) Analysis canceled: Pressure of (pressure point) mmHg exceeds
the maximum manifold pressure of (pressure point) mmHg.

Cause:

Action:

An absolute pressure greater than (pressure) mmHg was attained that
exceeded the specified maximum manifold pressure.

The analysis was canceled. All previously collected data were stored.
Change the maximum manifold pressure value in the Adsorptive Prop-
erties file.

6519- Unit (number) Analysis canceled: Psat gas is not condensing.

Cause A:

Action A:

Cause B:

Action B:

Cause C:

Action C:

The working Dewar does not contain enough bath liquid.

Retry the operation after filling the Dewar.

The Psat gas is contaminated.

Replace the Psat gas supply.

The Psat tubing from the regulator to the instrument is contaminated.

Pump out the tubing.
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6520- Power failure detected.

Cause A: Main power failed but UPS (if attached) is working.
Action A: Restore power to the analyzer.
Cause B: The value for the Po may be too low, causing the instrument to mistake

condensation for actual adsorption.

Action B: Change the analysis variables to directly measure the value of Po dur-
ing the experiment.

Cause C: The amount of sample you used may be too large. Multiply the max-
imum value from the Volume Adsorbed column of the Isotherm Report
by the sample weight. If the result exceeds (volume) cm3, the amount
of sample is too large.

Action C: Reduce the amount of sample.

6522- Unit (number) Analysis canceled: Time limit exceeded while evacuating

manifold.

Cause A: Maximum manifold evacuation time was exceeded before the vacuum
set point was achieved. Vacuum pump may be turned off.

Action A: Turn on vacuum pump switch. Then restart the analysis.

Cause B: The vacuum pump oil level is low.

Action B: Check the vacuum pump oil level and add more oil if necessary. Then
restart the analysis.

Cause C: The manifold is contaminated or leaking.

Action C: Correct the problem. Refer to Appendix D, Testing for Leaks. Then

restart the analysis.
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6523- Unit (number) Analysis canceled: Time limit exceeded while evacuating sample
(unrestricted).

Cause: The maximum time for evacuating the sample through the unrestricted
valve was exceeded. Possible causes are a leak in the sample tube fit-
ting or a crack in the sample tube.

Action: Check the sample tube and the sample tube fitting; ensure that the tube
is securely attached to the port. Then restart the analysis.

6524- Unit (hnumber) Analysis canceled: Time limit exceeded while evacuating sample
(restricted).

Cause: The maximum time for evacuating the sample through the restricted

valve was exceeded. Possible causes are a leak in the sample tube fit-
ting, a crack in the sample tube, or a poorly degassed sample.

Action: Check the sample tube and the sample tube fitting; ensure that the tube
is securely attached to the port. Verify that the sample is properly
degassed; then restart the analysis

6525- Power failure lasted too long.

Cause: A power failure on an analyzer which has an Uninteruptible Power
Supply attached has lasted for an hour or more; therefore, the analysis
has been canceled.

Action: Determine the cause of the power failure and correct it.

6526- Time limit exceeded while backfilling manifold to [PR4] [PR-U] with [G].

Cause A: The maximum time was exceeded before the target pressure point was
reached. The gas regulator may be set too low or turned off.

Action A: Set the gas regulator to 150 psig. Then resume the analysis.
Cause B: The gas bottle is empty.
Action B: Connect a new gas bottle. Then resume the analysis.
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6527 - Unit (number) Analysis suspended: Time limit exceeded while dosing manifold
to (target pressure point) mmHg with (gas name).

Cause A: The maximum time was exceeded before the target pressure point was
reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to 150 psig. Then resume the analysis.
Cause B: The analysis gas bottle is empty.
Action B: Connect a new analysis gas bottle. Then resume the analysis.

6529- Master pressure gauge offset is too high - [PR1] [PR-U].

Cause: A check of the Master gauge’s offset during an automatic operation
indicated it was too high.

Action: If this message occurs repeatedly, contact a Micromeritics service rep-
resentative

6530- Volume calibration canceled due to failure (code [0]).

Cause: A problem occurred during volume calibration.

Action: Contact a Micromeritics service representative.
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6531- The gas configuration file for (unit number) is invalid.

Cause: The contents of the gas configuration file are not valid.

Action A: Exit the application, navigate to the application hardware directory,
and delete the <S/N>.SST file. Then restart the application and reas-
sign gasses.

Action B: Confirm there is sufficient free space on the media receiving the file

and that the media is not corrupted (run ScanDisk). If the problem per-
sists, contact a Micromeritics service representative.

6532- The instrument is currently running the Physi software. Do you want to reset
it?

Cause: The analyzer is under the control of the 2050 Physisorption software.

Action: Selecting Yes will reset the analyzer and download the 2050 Chemi-
sorption control software.

6534- Instrument (unit number) is not calibrated.

Cause: Calibration information for various analyzer components are missing.

Action; Run the application setup program and reinstall calibration information
for the specified unit.

6535- Problem encountered evacuating.

Cause: Evacuation during the manifold dosing operation did not come within
the allowed range of the target.

Action: Check that the outlet stage of the gas regulator is within specification.
If the problem occurs frequently, contact a Micromeritics service rep-
resentative.
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6536- There is no Nitrogen attached to the unit.

Cause: A volume calibration has been requested but N2 is not one of the gases
selected in the unit/gas configuration.

Action: Make sure the nitrogen cylinder is attached to the unit and edit unit
configuration to match the gases that are present.

6537- Error reading SmartVac ADC.

Cause: There was a problem reading one of the signals on the Smart\ac board.

Action; Exit the application, turn off the power switch on the analyzer, then
turn the power back on. Restart the application and the degas opera-
tion. If the problem persists, contact your service representative.

6538- Power failure detected. The sample is in an unknown condition. A run termina-
tion will be performed for safety.

Cause: A total power failure occurred (a UPS was not connected) while an
analysis was in progress.

Action: Allow the analysis to terminate.

6539- Error overheating Current = (no.), Target = (no.), Limit = (no.)

Cause A: The heating mantle is reporting a higher temperature than expected.

Action A: Ensure that the heating mantle and thermocouple cables are plugged in
fully on the port(s).

Cause B: An internal failure of the degas system may have occurred.

Action B: Unplug the heating mantle power connector; do not unplug the ther-
mocouple. Allow the heating mantle to cool down (approximately 15-
30 minutes). Then exit the analysis program and turn off the analyzer.
Wait a couple of minutes, then turn the instrument on and restart the
program. If the problem recurs, contact your Micromeritics service
representative.
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C. CALCULATIONS

Saturation Pressure (Po)

Po method is selected by the user on the Po and Temperature Options dialog box. It may be
entered, measured, or calculated from temperature.

If entered, Po = user entered value
If measured, Po = equilibrated pressure reading after saturating Po tube
If calculated from temperature, interpolate Po from the Psat vs Temperature table on the Po

and Temperature Options dialog box, given the analysis bath temperature

Relative Pressure

If Po was measured:

For points taken before the previous Po measurement,

(Po,-Po,) x(T,-To,)
(To,-Toy)

Po, = Po; +

For points taken after the previous Po, use the previous Po:
Po, = Po;
If Po was entered, use the entered Po:
Po, = Pog
If Po was calculated, use the calculated Po:
Po, = Poc

Calculate relative pressure for the I data point:
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where
Po, = saturation pressure for the I data point (mmHg)
Po, = most previous measured saturation pressure before I data
point (mmHg)
Po, = first measured saturation pressure after the I data point (mmHg)
Po. = calculated Po
Poz = entered saturation pressure (mmHg)
T, = time when the I data point was taken (minutes)
To, = time when Po; was measured (minutes)
To, = time when Po, was measured (minutes)
Prel, = relative pressure for the I™" data point (mmHg)
P, = absolute pressure for the 1™ data point, taken at equilibrium (mmHg)
Free Space

Free-space volumes are calculated using the following equations:

Vew = ——

\Y P
Vee = =2 x [_1 —q x Tso

T, P,
Vygr = Vec T:/BFTW
1-
TRM
where:\
P, = system manifold pressure before dosing helium onto sample (mmHg)
P, = system manifold pressure after dosing helium onto sample (mmHg)
Ps = sample pressure after raising Dewar and equilibrating with helium (mmHg)
Terp = standard temperature (273.13 K)
Tem = approximate room temperature (298 K)
T, = system manifold temperature before dosing helium onto sample (K)
T, = system manifold temperature after raising Dewar and equilibrating with
helium (K)

Viow = lower manifold volume (cm?3)
Ve = volume of free space, cold (cm? at standard temperature)
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Vew
VagT

TABT

Volume Adsorbed

volume of free space, warm (cm? at standard temperature)
portion of cold free space at analysis bath temperature: (cm3 at standard
temperature)

= analysis bath temperature (K), from the Po and Temperature Options dialog

box

For the 1™ dose:

Ngas, = Ngasl—l+VLOWX|:

Psysl, Psysz,} y Tso

Tsysl, Tsys2,l Psmp

Psam;Vagr |, Vea
Nads, = Ngas, _E(Z_FC + Z—FA)
v, = Nads,
Wsam
where:
Ngas, total amount of gas dosed into sample tube after 1™ dose (cm3 STP)
Nads, = amount of gas adsorbed after equilibrating 1™ dose (cm3 STP)
Psrp = standard pressure (760 mmHQ)
Psysl1, system manifold pressure before 1™ dose of gas onto sample (mmHg)
Psys2, system manifold pressure after 1™ dose of gas onto sample (mmHg)
Psam, sample pressure after equilibrating 1™ dose of gas onto sample (mmHg)
Tsysl, system manifold temperature before 1! dose of gas onto sample (K)
Tsys2, = system manifold temperature after 1™ dose of gas onto sample (K)
Wsam = weight of sample (g)
V, = amount of gas adsorbed per gram of sample (cm3/g STP)
Z.. = compressibility factor for the analysis gas at Psam, and the analysis
temperature
Zea compressibility factor for the analysis gas at Psam, and the ambient
temperature
Vea volume of the sample tube at ambient temperature Vec — Vagt

Jul 07
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Equilibration

a4

Equilibration is reached when the pressure change per equilibration time interval (first
derivative) is less than 0.01% of the average pressure during the interval. Both the first
derivative and average pressure are calculated using the Savitzky-Golay! convolution method
for polynomial functions. The equations below are those used to compute weighted average
and first derivative, respectively, for the 6th point of an 11-point window.

P _ =36(Py +Py) +9(Pyo + Py) +44(Py + P3) + 69(Pg + Py) + 84(P; + Ps) + 89(Py)
AVG —
429

P _ 5(Py; =Py) +4(Pyy—P;) + 3(Pg—P3) + 2(Pg - P,) + (P; = Ps)
CHG = 110

where the numerical constants are from the Savitzky-Golay convolution arrays, and

Pave average pressure (mmHQ)
Pcug = change in pressure (mmHg)
P, It pressure reading taken at equilibrium intervals (mmHg)

After equilibration has been reached, if the user-entered minimum equilibration time from the
Low Pressure Options dialog box has not elapsed, the equilibration continues until the entered
time has elapsed.

If the user entered a non-zero maximum equilibration time from the Low Pressure Options
dialog box, and this time period has elapsed before equilibration has been reached, the
equilibration ends as if equilibration had been reached, and the point is collected.

If a non-zero value that is too small is entered for the maximum equilibration time,
the points are collected before equilibration is reached.

If Payg is greater than 0.995 times the current Po, equilibration will not take place
until the Minimum equilibration delay for P/Po 0.995 has expired, in addition to the
standard equilibration criteria.
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Thermal Transpiration Correction

During data reduction, thermal transpiration correction is applied to the data if the user
selected Thermal transpiration correction from the Report Options dialog box. Starting
with the first collected pressure, the following calculations are performed until the pressure
ratio (PC/P) is greater than or equal to 0.99.

_ PxSDxMD? . 3
Y=gt <10
— 1+GxY
R PRV
F = L

(axY2)+(B><Y)+u

where:

P = equilibrated collected pressure measured by gauge at temp
Trm (MMHQ)

SD = inside diameter of sample tube (mm), from the Report Options
dialog box

MD = thermal transpiration hard sphere diameter of gas (A), from
the Adsorptive Properties dialog box

T = average temperature [Tagr + Trml / 2 (K)

o = Weber’s coefficient, 0.033

B = Weber’s coefficient, 0.245

G = Weber’s coefficient, 2.5

H = Weber’s coefficient, 2

Tagr = analysis bath temperature (K), from the Po and Temperature Options dialog
box

Tem = room temperature (298 K)

PC = corrected equilibrated pressure at temperature Tygr (MMHQ)

FY,u = intermediate values for subsequent calculations
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BET Surface Area

For each point designated for surface area calculations, the BET? transformation is calculated

as follows:

B, = I:’rell
1 =
(1'0 - I:)rell) X Nads1

where B, is in units of g/cm3 STP.

A least-squares fit is performed on the (P, ,B,) designated pairs where P, is the
independent variable and B, is the dependent variable. The following are calculated:

a. Slope (S g/cm3 STP)

b. Y-intercept (Y, g/cm3 STP)

c. Error of the slope (Sggrg 9/cm® STP)

d. Error of the y-intercept (Ylggg g/cm? STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated:

BET Surface Area (m2/g):

CSA x (6.023 x 10%)
(22414 cm® STP) x (10" nm?/m?%) x (S + Y,7)

SAger =

where
CSA = analysis gas molecular cross-sectional area (nm?), user-entered on the
Adsorptive Properties dialog box
BET C value:
C S+ Ying
YINT

Volume of the Monolayer (cm3/g STP):

1 1

S CxYipr  SHYi

Vi
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Error of the BET Surface Area (m?/g):

05
BET... = SAger X (Serr * + Ylerr *)
= Yint +S

Langmuir Surface Area

For each point designated for surface area calculations, the Langmuir® transformation is cal-
culated as follows:

Ll — IDreh

=z

ads,

where L, is in units of g/cm® STP

A least-squares fit is performed on the (P ,L,) designated pairs where P is the inde-
pendent variable and L, is the dependent variable. The following are calculated:

a. Slope (S g/cm3 STP)
b. Y-intercept (Y, 9/cm3 STP)
c. Error of the slope (Sggrg 9/cm® STP)
d. Error of the y-intercept (Ylggg 9/cm® STP)
e. Correlation coefficient (Cc)
Using the results of the above calculations, the following can be calculated:

Langmuir Surface Area (m?/g):

CSA x (6.023 x 10%)

SAian = 3 18 2,2
(22414 cm” STP) x (10© nm“/m“) x S

where

CSA = analysis gas molecular cross-sectional area (nm?), user-entered on the
Adsorptive Properties dialog box
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Volume of the Monolayer (cm?3/g STP):

Vy =

nikF

Langmuir b Value:
b= (Yine)( Vi)
Error of the Langmuir Surface Area (m?/g):

_ SALan X Sgrr

LANggrr = 3
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t-Plot

For each point designated for t-Plot* calculations, the following calculations are done:

Thickness for the I point (A):

t, = HP1 x Ln'?gjh)rps (Halsey®)
or

t, = [HJPZliJIEgl(Preh)TJPS (Harkins and Jura®)
where:

t, thickness for 1™ point

HP1 = Halsey parameter #1

HP2 = Halsey parameter #2

HP3 = Halsey parameter #3

HJP1 = Harkins and Jura parameter #1

HJP2 = Harkins and Jura parameter #2

HJP3 = Harkins and Jura parameter #3

Pen = relative pressure for the Ith point (mmHQ)

A least-squares analysis fit is performed on the (t;, N,q,) data pairs where t; is the indepen-
dent variable and Nads, is the dependent variable. Only the values of t, between t,,,, and
tyax, the minimum and maximum thickness, are used. The following are calculated:

a. Slope (S cm3/g-A STP)

b. Y-intercept (Y, cm3/g STP)

c. Error of the slope (Sgrg cm3/g-A STP)

d. Error of the Y-intercept (Ylggg cm3/g STP)

e. Correlation coefficient (Cc)
Using the results of the above calculations, the following can be calculated:
External Surface Area (m?/g):

_ (Scm’/g—A STP) x (10" A/m) x (D cm® liquid/cm® STP)
.=

SA
= F x (10° cm®/m®)

Jul 07
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where
F = surface area correction factor, user-entered on the t-Plot Report Options dialog
box
D = density conversion factor, user-entered on the Adsorptive Properties dialog
box

Micropore Surface Area (m2/g):
SAup = SAror + SAgxt

where SAq;qr is the BET surface area if the user enabled the BET report exclusively, or Lang-

muir surface area if the user enabled the Langmuir report exclusively. If neither report has
been selected, SA;q7 is the BET surface area value calculated using a set of default
parameters.

Micropore Volume (cm? liquid/g):

Ve = (Yyr cm®/g STP) x (D cm® liquid/cm® STP)
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BJH Pore Volume and Area Distribution

For adsorption data, the relative pressure and volume adsorbed data point pairs collected dur-
ing an analysis must be arranged in reverse order from which the points were collected during
analysis. All calculations are performed based on a desorption model, regardless of whether
adsorption or desorption data are being used.

The data used in these calculations must be in order of strictly decreasing numerical value.
Points which do not meet this criterion are omitted. The remaining data set is composed of
relative pressure (Pr), volume adsorbed (Va) pairs from (Pr,, Va,) to (Pry, Vay) where (Pry =
0, Vay = 0) is assumed as a final point. Each data pair represents an interval boundary (or des-
orption step boundary) for intervals i=1 to i=N-1 where N = total number of (Pr, Va) pairs.

Generally, the desorption branch of an isotherm is used to relate the amount of adsorbate lost
in a desorption step to the average size of pores emptied in the step. A pore loses its con-
densed liquid adsorbate, known as the core of the pore, at a particular relative pressure related
to the core radius by the Kelvin” equation. After the core has evaporated, a layer of adsorbate
remains on the wall of the pore. The thickness of this layer is calculated for a particular rel-
ative pressure from the thickness equation. This layer becomes thinner with successive
decreases in pressure, so that the measured quantity of gas desorbed in a step is composed of
a quantity equivalent to the liquid cores evaporated in that step plus the quantity desorbed
from the pore walls of pores whose cores have been evaporated in that and previous steps.
Barrett, Joyner, and Halenda® developed the method (known as the BJH method) which incor-
porates these ideas. The algorithm used on the ASAP 2020 is an implementation of the BJH
method.

Explanation of Terms

A pore filled with condensed liquid nitrogen has three zones:

a. The core - evaporates all at once when the critical pressure for that radius is reached,;
the relationship between the core radius and the critical pressure is defined by the
Kelvin equation.

b. The adsorbed layer - composed of adsorbed gas that is stripped off a bit at a time
with each pressure step; the relationship between the thickness of the layer and the
relative pressure is defined by the thickness equation.
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c. The walls of the cylindrical pore - the diameter of the empty pore is required to
determine the pore volume and pore area. End area is neglected.

14 ———=—- pore ————-—-7= i
,a |
1 1
o d '
1 L3
1 5 13
I ]
1 O 1
1 L}
Por ¢ '
;b 0 H i wall
€ r . '
1 - 1
o d e . I
I " 1
i H i
P ; '.
poa : !
A - D A T I !
Insignificant Loe :
compared to A .
1 L]
core length . .
I [

Calculations

The volumes adsorbed (Va) are converted to the liquid equivalent volumes (V1, cm3/g):
VI = (Va)(D)

where D is the Density Conversion Factor from the Adsorptive Properties dialog box.

The relative pressure (Pr,) is assumed to be close to unity so that substantially all the pores in
the sample are filled.

The corresponding Kelvin core radius is calculated. Only pores smaller than this size will be
included:

Rc, = A
(1+F)[In(Pr)]

where
A = adsorbate property factor (the BJH Adsorptive Options dialog box)
F = fraction of pores open at both ends (from the BJH Adsorption Report Options

dialog box or the BJH Desorption Report Options dialog box); assumed to be
zero for desorption

This radius will be adjusted for the thickness of the adsorbed layer during subsequent calcu-
lation steps.
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The thickness of the remaining adsorbed layer at this relative pressure is calculated:

HP3
Tw, = le[ HP2 }

In(Pry)

where

HP1, HP2, and HP3 are Halsey Parameters 1, 2, and 3 (respectively) from the Halsey Thick-
ness Equation dialog box.

These calculations illustrate the use of the Halsey thickness equation. If the Harkins/Jura
equation was selected, substitute the following wherever the thickness equation appears:

Tw. = [ HJ1 T“
17 LHJ2-log(Pr,)

where

HJ1, HJ2, and HJ3 are Harkins-Jura Parameters 1, 2, and 3 (respectively) from the Harkins-
Jura Thickness Equation dialog box.

The following calculations (a-c) are made for each relative pressure interval based on the
increment of volume desorbed during that interval. The variable I refers to the interval num-
ber, that is 1=1 for the first interval from Pr; to Pr,, and so on. J refers to each previous

interval during which new pores were found. K refers to the total number of intervals in
which new pores have been found. K is also the number of lines reported on the BJH table for
collected data.

a. The thickness of the adsorbed layer at the end of the interval is calculated as follows:

HP3
Tw,,, = le[ HP2 }

In(Pr, 1)

(For the last pressure interval from the lowest Pr, to zero relative pressure, Tw,,; =0.)

For the first pressure interval, there are no previously opened pores so the volume
desorbed from walls of previously opened pores is zero (Vd; = 0), and the remainder

of Step a is skipped.

The change in thickness of the wall layer due to desorption from preivously opened
pores is calculated:

ATW = TWl_ TW|+1

Jul 07
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The annular cross-sectional area of the wall layer desorbed is calculated for all pre-
viously opened pores:

CSA, = n[(Rc;+ ATw)’ —Rc; °](107° cm?/A?)

The total volume of gas desorbed from walls of previously opened pores is
calculated:

Vd, = Z(ij)(CSAaJ) for all previously opened pores

where LP; = length of previously opened pores as calculated in Step b(2).

The physical processes occurring for this pressure interval are determined as follows:

)

(2)

If VVd, is greater than the current increment of volume desorbed (VI, - VI,,,),
desorption from walls only is occurring. Total surface of walls exposed thus far
(cm?/g) is calculated as follows:

SAy = Zn(LPJ)(Da\,gJ)(lo‘8 cm/A) for all previously opened pores

where

D = weighted average pore diameter calculated below in Step b(2).

avgJ

A new layer thickness (ATw) that will not overcompensate for the actual volume
desorbed in this interval is calculated:

W= (V1,-V1,,,)(10° Alcm)
SAw,

AT

Since no cores are evaporated in this pressure interval, no new pores are revealed.
Thus no ending Kelvin radius and average pore diameter are calculated for this
interval. Note that this means the report may have fewer tabulated intervals on
the collected data report than experimental pressure intervals.

If Vd, is less than the volume increment desorbed during this interval
(VI,=VI,, ), the remaining volume is due to new pores with core evaporation

taking place in this interval. K, the number of intervals with new pores exposed,
is increased by 1. (For the interval from the lowest Pr; to zero relative pressure,

no new pore volume is calculated and the rest of Step b is skipped.)

The volume desorbed from newly opened pores in this interval is calculated as
follows:
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Ve, = (VI =VI,,) - Vd,

The Kelvin radius for the end of the interval is calculated as follows:

A

Roc1 = TP ]

All new pores opened in this interval are represented by one pore having a
length-weighted average pore diameter and a corresponding length sufficient to
account for the required volume of adsorbate. The weighted average pore diam-
eter is calculated as follows:

D = (D(Rex+ Rek. ) )(RE)(RCk+3)
avge 2 2
Rck "+ Rk g

Davgk I the diameter of a pore which would have a surface area that is the aver-
age of the areas for pores radius Rck and Rc,4, if its length was the mean of the
lengths at those radii.

The relative pressure corresponding to is calculated as follows:

“”K:'”4&1+EiEW%J

The thickness of the adsorbed layer at this pressure is calculated as follows:

HP3
W,y = le[ HP2 )J

In(Pang

The decrease in thickness of the wall layer by desorption from the walls of new
pores during the lower portion of the pressure interval is calculated as follows:

ATd = TWayg —TW, .

The cross-sectional area of the newly opened pores is calculated as follows:

2
CSAc, = [D""T"QK + ATd} (107 cm?/A?)
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C.

The length of the newly opened pores is calculated as follows:

_ _Vg
K CSAcy

Pore diameters and radii are adjusted for the change in thickness of the adsorbed wall
layer during this interval. If new pores were opened during this interval, the average
diameter is adjusted by the change in layer thickness during the second portion of the
desorption interval as follows:

=D +2(ATd)

aVOknew aVOkold

The layer thickness change during the whole interval is added to diameters of previ-
ously opened pores as follows:

= D, +2(ATw)

aVQjnew avgiold

(not including D,4x)

The layer thickness change desorbed during this interval also is added to the radii
corresponding to the ends of the pressure intervals as follows:

R(-"Jnew = R(-"Jold +ATw

for all except Rc ;.

Steps a to c are repeated for each pressure interval.

After the above calculations have been performed, the diameters corresponding to the
ends of the intervals are calculated as follows:

Dp; = 2(rcy)

for all Rc; including Rcy,;.

The remaining calculations are based on DP;), D,q), @nd LP,,. These calculations
are only done for D, values that fall between the Minimum BJH diameter and the

Maximum BJH diameter specified by the operator on the BJH Adsorption Report
Options dialog box or the BJH Desorption Report Options dialog box.

1) Incremental Pore Volume (Vp,, cm3/g):

DaV 2
Vp, = n(Lp,)[Tﬂ 10% cm?/A’
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2) Cumulative Pore Volume (Vpcywmy, €M*/Q):

VPcuw,, = Y Vp, for (J<1)
3) Incremental Surface Area (SA,, m?/g):
SA, = m(LP,)(107 m/cm)(D,,, )(107° m/A)
4) Cumulative Surface Area (SAcymgy, M?9):
SAcum,, = ZSAJ forJ<1

5) dV/dD pore volume (dV/dD,, cm3/g-A):

dv/dD, = __ VP
Dp,-Dpy+:
6) dV/dlog(D) pore volume (dV/dlog(D),, cm3g):

iDv/dlog(D), = vplllog(Dzi)
| +1

7) dA/dD pore area (dA/dD,, m?/g-A):

SA,

dA/dD, = —4m8M848—
! Dp,—-Dpy+1

8) dA/dlog(D) pore area [dA/dlog(D),, m?/g]:

dA/dlog(D), = SA,/log(D[;p' )
1+1

For fixed pore size tables (if selected), the following calculations are performed:

1) Average Fixed Pore Size (DF,q;, A):

Dpe +D
DFyy, = pFapru

calculated for all intervals in the fixed pore size table.
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2)

3)

4)

5)

6)

7)

For the intervals with between the Minimum BJH diameter and the Maximum
BJH diameter.

Cumulative Pore volume (VpFcm, cme/g):
VpFcyw, = INTERP(DpF,. ;)

where INTERP(x) is the value interpolated from the function X = Dp,,, and Y =
VPcyms using an AKIMA semi-spline interpolation.

Incremental Pore Volume (VpF,, cm3/g):
VpF, = VpFeym, — VPFeum, ,

where VpFcymo = 0.

Cumulative Surface Area (SAFc y, M?/9):
SAFcym, = INTERP(DpF, 1)

where INTERP(x) is the value interpolated from the function X = Dp,,; and Y =
SACUMJ'

Incremental Surface Area (SAF,, m?/g):
SAF| = SAFCUMI_ SAFCUMFI
where SAFc mo = 0.

dVv/dD pore volume (dV/dDpF,, cm3/g-A)):
dV/dDpF, = INTERP(DpF,,,)

where INTERP(x) is the value interpolated from the function X = D, q; and Y =
dVv/dD,.

dV/dlog(D) pore volume [dV/dlog(DpF),, cm3/g]:
dVv/dlog(DpF,) = INTERP(DpF,,,)

where INTERP(X) is the value interpolated from the function X = D,¢; and Y =
dVv/dlog(D),.
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8) dA/dD pore area (dA/dDpF,, m?/g-A):

9)

dA/dDpF, = INTERP(DpF,,,)

where INTERP(X) is the value interpolated from the function X = D,¢; and Y =
dA/dD;.

dA/dlog(D) pore area [dA/dlog(DpF,), m?/g]:

|A/dlog(DpF,) = INTERP(DpF,, ;)

where INTERP(x) is the value interpolated from the function X = D,,; and Y =
dA/dlog(D),.

Compendium of Variables

Va
VI
D

Pr
Dp
Rc
A
F

ATw
Tw

quantity adsorbed expressed as a volume (cm3/g STP)

liquid equivalent volume of volume adsorbed (cm?3/g)

density conversion factor from the Adsorptive Properties dialog box
(cm3/cm3 STP)

relative pressure

pore (or core) diameter (A)

Kelvin radius (A) of core

adsorbate property factor; from the BJH Adsorptive Options dialog box
fraction of pores open at both ends; from the BJH Adsorption Report
Options dialog box or the BJH Desorption Report Options dialog box
thickness of adsorbed layer desorbed during interval (A)

thickness of remaining adsorbed wall (A)

HP1, HP2, and HP3 are Halsey Parameters from the Halsey Thickness Equation dialog box.

HJ1, HJ2, and HJ3 are Harkins and Jura Parameters from the Harkins/Jura Thickness Equa-
tion dialog box.

vd
Davg
CSAa
CSAc
SAw
ATd
Ve
Lp

volume of gas desorbed from walls of previously opened pores (cm?/g)
average pore diameter (A)

= annular cross-sectional area of the desorbed layer (cm?)

cross-sectional area of opening of newly opened pores (cm?)

total surface area of walls exposed (cm?/g)

thickness of layer desorbed from walls of newly opened pores (A)
volume desorbed from cores of newly opened pores (cm3/g)
length of pore (cm/g)
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Horvath-Kawazoe

A relative pressure lower limit is determined such that L-d, never equals zero. All pressure
points less than this limit are discarded. For each collected relative pressure point, values of L
are chosen in an iterative manner, and the relative pressure (P/Po) determined by solving one
of the following equations:

» Slit Pore Geometry (original Horvath-Kawazoe)

* Cylinder Pore Geometry (Saito/Foley)
* Sphere Pore Geometry (Cheng/Yang)

Slit Pore Geometry (original HK)

When you use the original Horvath-Kawazoe® method, the following equation is solved for
each value of P. The value of L is determined when the solved-for relative pressure is within
0.1% of the collected absolute pressure.

n P - K 1Px10% IA' cm“){ ¢ e &, " }
Po RT  &*'x(L-2xdy) [3x(L-dy)® 9x(L-dy)° 3xd> 9xdg
where
K = Avogadro’s number (6.023 x 1023)
R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated
value on the Po and Temperature Options dialog box
. . . . Zs+Z,
c = gas solid nuclear separation at zero interaction energy (A), >
where:
Zs = sample equilibrium diameter at zero interaction energy (A) from the
Horvath-Kawazoe Physical Properties dialog box
Z, = zero interaction energy diameter from the Horvath-Kawazoe Physical
Properties dialog box
i = Da*tDy(A)
0 - 2
where:

D, = molecular diameter (A) from the Horvath-Kawazoe Physical
Properties dialog box

Ds = diameter of sample atom (A) from the Horvath-Kawazoe Physical
dialog box
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L = pore width (nucleus to nucleus) (A)

P = equilibrium pressure (mmHg)

Po = saturation pressure (mmHg)

IP = interaction parameter (10-43 ergs-cm*) from the Horvath-Kawazoe

Report Options dialog box

Cylinder Pore Geometry (Saito/Foley)

When you use the Saito-Foley!? method, the following equation is solved for each value of P.
The value of L is determined when the solved-for relative pressure is within 0.1% of the
collected absolute pressure.

n(F) - SR 18 [l

where
K = Avogadro’s number (6.023 x 1023)
R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated
value on the Po and Temperature Options dialog box
L = pore width (nucleus to nucleus) (A)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
IP = interaction parameter (10-43 ergs-cm*) from the Horvath-Kawazoe Report
Options dialog box
o - DatDi(A)
° 2
where:
D, = molecular diameter (A) from the Horvath-Kawazoe Physical
Properties dialog box
Dg = diameter of sample atom (A) from the Horvath-Kawazoe Physical
dialog box
2
Oy = (_ 4i — k) Ol _1,00= 1.0
-15-k\?
B = (P2 Beonhom 10
_ . —_ L
Mo = radius of the cylindrical pore, =

2
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Sphere Pore Geometry (Cheng/Yang)

When you use the Cheng/Yang!! method, the following equation is solved for each value of
P. The value of L is determined when the solved-for relative pressure is within 0.1% of the
collected absolute pressure.

In(ﬂ) _ B(Nge 1+ Nye )L’ x 107 J A3 cm®
RT(L-d,)’

(@ G+ () e am)]

where
R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated value on the Po
and Temperature Options dialog
_ Da+Ds(A)
do = =
where:
D, = molecular diameter (A) from the Horvath-Kawazoe Physical Properties
dialog
Dy = diameter of sample atom (A) from the Horvath-Kawazoe Physical
dialog
L = pore width (nucleus to nucleus) (A)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
N, = 4m L?Ng, where Ng = number of sample atoms/cm? at monolayer
N, = 4 (L - dy)? NA, where Ng = number of gas molecules/cm?
A 2
e*, = Se,whereAS=6X|\/IC X Xs X O
4ds %s 4 %a
Xs XA
A 2
g%y = — = where A, = 3xMC_x 0p x4
4D, ?
1 1
Ty = 3 3
(1-S)" (1+59)
_ 1 1
T - 2 2
(1+S)" (1-9)
T, _ 1 1

(1-5)° (1+5)°
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1 1

T = -
* (1+5)° (1-9)°

where S = L-d,

Cheng/Yang Correction

This factor corrects for the nonlinearity of the isotherm. It adds an additional term to the
equations for the different geometrics:

(&) = 6()- E ‘%'“(ﬁﬂ

where

G(L) one of the Horvath-Kawazoe equations given above

0 = degree of void filling; 0 is estimated by first computing the monolayer
capacity (V) with the Langmuir equation over the range of data points from
relative pressure 0.02 to 0.2 or the maximum relative pressure included in the
Horvath-Kawazoe analysis. 0 is computed as the volume adsorbed over V,,.

Interaction Parameter

The interaction parameter (IP) results from the following calculations:

The Kirkwood-Muller dispersion coefficients -

GXMCZXOLSX(XA

Ag =
%s . %a
Xs XA
A, = 3><MC2><0LA><XA

2

where

MC2 = kinetic energy of electron (0.8183 x 106 erg)

Og = polarizability of sample atoms (cm?3)
o = polarizability of gas molecule (cm?3)
As = diamagnetic susceptability of sample atom (cm?3)
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A diamagnetic susceptability of gas molecule (cm3)

IP = (Nax AL+ (NsxAs)

where:
Na = number of gas molecules/cm? at monolayer from the Horvath-Kawazoe
Physical Properties dialog
Ng = number of sample atoms/cm? from the Horvath-Kawazoe Physical Properties
dialog

Refer to Interaction Parameter Components later in this Appendix for recommended
values.

Additional Calculations

Based on the previous calculations, the following can be calculated:

Adjusted Pore Width (A):
(Shell to Shell)

AL, = L,-DS

Cumulative Pore Volume (cm?3/g):

where
D = density conversion factor (cm3 liquid/cm3 STP) on the Adsorptive Properties
dialog box

dVv/dD Pore Volume (cmd3/g-A):

d_V _ VCUM, - chml_1
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Median Pore Width (A):

\Y
ViaLr = C;MN

log(De) - |09(DL)}

Dyep = 10[Iog(DL)+ [log(VyaLe) — log(V,)] x log(Vg) - log(V,)

where
Veumn = total cumulative pore volume (V) for points designated for Horvath-
Kawazoe calculations
Vyae = 50% of total cumulative pore volume

vV, = cumulative pore volume (V) for first point less than Viya ¢

Vg = cumulative pore volume (V) for first point greater than V5 ¢
D, = pore width (L,) that corresponds to V|
Dg = pore width (L,) that corresponds to Vg
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Interaction Parameter Components

Table C-1. Interaction Parameters

Interaction
Bath Parameter
Temperature Calculated
Gas (K) Sample Type Value*
Argon 87.3 Carbon (Ross/Olivier value) 2.61
Carbon (Horvath/Kawazoe value) 5.89
Zeolite 3.19
Carbon 298.15 Carbon (Ross/Olivier value) 4.20
Dioxide Carbon (Horvath/Kawazoe value) 9.20
Zeolite 5.08
273.15 Carbon (Ross/Olivier value) 4.34
Carbon (Horvath/Kawazoe value) 9.35
Zeolite 5.22
194.65 Carbon (Ross/Olivier value) 4.72
Carbon (Horvath/Kawazoe value) 9.72
Zeolite 5.60
Nitrogen 77.15 Carbon (Ross/Olivier value) 2.84
Carbon (Horvath/Kawazoe value) 6.53
Zeolite 3.49
*The interaction parameter is entered in the Horvath-Kawazoe Report Options dialog in the
following field:
Interaction parameter: (calculated value) x 1043 ergs-cm#

The following values were used to calculate the values in Table C-1.

Carbon-Graphite Zeolite
Dy = 3.40 Dy = 3.04
Ng = 3.845x 10% Ng = 3.75x 10%
xs = 1.05x102%° (Ross/Olivier) xs = 1.94 x 1029

13.5x 10%° (Horvath/Kawazoe, implicit) ag = 0.85x 1024

ag = 1.02x 1024

Nitrogen Argon
D, = 3.00 Da = 2.95
N, = 6.71x 10% N, = 7.608 x 10%4
xa = 3.6x102° xa = 3.22x102°
as = 1.76 x 10 an = 1.63 x10%
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Carbon Dioxide
Dy =3.23

N, = 4.567 x 1014 (25 °C)
5.45 x 101 (0 °C)
7.697 x 1014 (-78 °C)

%a = 5.0x 102
op = 2.7 X102

D, values are from van der Waal’s constant.

N, values are from liquid densities.

¥ and o values are derived from data found in Ross and Olivierl2,

The physical parameters referenced in Saito/Foley are as follows:

Aluminophosphate

Ds
Ng
xs
Og

2.60

= 1.48 x 10%

1.3x 1028
2.5x 1024

Ds
NS
xs
Og

Aluminosilicate

2.76

1.31 x 1015
1.3x102°
2.5x 1024
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Dubinin-Radushkevich

The Dubinin-Radushkevichl3 equation is as follows:

2 2
log(V) = Iog(Vo)—% x [Io %J

V = volume adsorbed at equilibrium pressure (cm3/g STP)

the micropore capacity (cm3/g STP)

saturation vapor pressure of gas at temperature T (mmHg)
equilibrium pressure (mmHg)

a constant

the affinity coefficient of analysis gas relative to Po gas

(for this application (3 is taken to be 1)

analysis bath temperature (K), from the Po and Temperature
Options dialog box

S
I

For each point designated for Dubinin-Radushkevich calculations, the following calculations
are done:

LV =log (V)
LP = Iog(EPQ)2

The intercept, log(Vo) can be found by performing a least-squares fit on the (LP,LV) desig-
nated pairs where LP is the independent variable and LV is the dependent variable. Assuming
the adsorption of gas is restricted to a monolayer, Vo is the monolayer capacity. Based on this
assumption, the following are calculated:

a. Slope (S cm?/g STP)

b. Y-intercept (Y1 cm3/g STP)

c. Error of the slope (Sgrg cm®/g STP)

d. Error of the y-intercept (Ylggg cm3/g STP)

e. Correlation coefficient (Cc)
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Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):
Vo = 10"

Error of Monolayer Capacity (cm3/g STP):
VOgrg = VO X (10Y'err - 1.0)

Micropore surface area (m2/g):

o x Vo x (6.023 x 10%)

SDP =
22414 cm® x (10" nm?/m?)

where

c = molecular cross sectional area of gas (nm?2)from the Adsorptive Properties

dialog box
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Dubinin-Astakhov

The Dubinin-Astakhov equation is a follows:

RT " Po"
log(V) = log(Vo) - [BEJ X [Iog F}
where
Vv = volume adsorbed at equilibrium pressure (cm3/g STP)
Vo = the micropore capacity (cm3/g STP)
Po = saturation vapor pressure of gas at temperature T (mmHg)
P = equilibrium pressure (mmHg)
T = analysis bath temperature (K)
R = the gas constant (0.0083144 kJ/mol)
Eo = characteristic energy (kJ/mole)
N = Astakhov exponent, may be optimized or user entered from the Dubinin
Report Options dialog box
B = the affinity coefficient of the analysis gas relative to the Po gas, from the

Dubinin Adsorptive Options dialog box

For each point designated for Dubinin-Astakhov calculations, the following calculations are
done:

LV =log(V)
LP = [Iog-PﬁQ}N

A least-squares fit is performed on the (LP,LV) designated pairs where LP is the independent
variable and LV is the dependent variable. If the user selected yes for the Optimize Astakhov
Exponent prompt, a systematic search for the optimum value of N is conducted by recalcu-
lating the linear regression and selecting the value of N that gives the smallest standard error
of the y-intercept. The exponent N is optimized to within 10-4. If the optimum value for N is
not found in this range, an exponent of 2 is used. The following are calculated:

a. Slope (S cm3/g STP)

b. Y-intercept (Yl cm3/g STP)

c. Error of the slope (Sggg cm3/g STP)

d. Error of the y-intercept (Ylggg cm3/g STP)

e. Correlation coefficient (Cc)

f.  Optimized Astakhov exponent (N)
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Using the results of the above calculations, the following can be calculated:
Monolayer Capacity (cm3/g STP):
V, = 10"
Micropore Volume (cmd/g):
W, = (V,x D)
where

D = density conversion factor (cm? liquid/cm? STP) from the Adsorptive
Properties dialog box

Limiting Micropore Volume (cm?/g):
Wy = (Vo x D)
where

D = density conversion factor (cm? liquid/cm? STP) from the Adsorptive
Properties dialog box

Error of Limiting Micropore Volume (cm?3/g):
Characteristic Energy (KJ/mole):

2303xRxT

E =
B(2.303 x $)*™

Modal Equivalent Pore Width (nm):

3N 1N k 1/3
Wioce = zx“m”} ; [E—J}

where

k = the interaction constant for benzene, 8.969 kJ*nm3/mol
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Maximum Differential Pore Volume (cm3/g-nm):

This value is also known as frequency of the mode

1/3

dv
dWmode

1/3N E
Max = 0.5 x (3N + 1) x W, x [M} y [ﬂ

< emp( L
3N

3N

Mean Equivalent Pore Width (nm):

k 1/3
=

)

Wmean = 2 x

Micropore surface area (m2/g):
E 1/3 3N + 1
SDA = 1000 x 2.0 x W, x [ﬂ x F(W)

I' is calculated by a polynomial approximation over the domain 0 < x <1 as follows:

[(x+1) = 1+b;x + byx? + byx3 + byx* + bgx5 + bgx® + byx” + bgx® + g(x) | &(x) | <3 x 107

where
b, = -0.57719 1652
b, = 0.98820 5891
b, = -0.89705 6937
b, = 0.91820 6857
bs = -0.75670 4078
b = 0.48219 9394
b, = -0.19352 7818
bg = 0.03586 8343
and where
_ (3N + 1)
X+1 = ( aN
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Equivalent Pore Width (nm):

_(-Ek—Q)N 1/3N

In(W;) — In(Wo)

Wi:2><

dV/dw Pore Volume (cm3/g-nm):

dV _ _k_ N %)—(3N+1) _k_ N (Vi -3N
d_Wi —0.5><W0><3N><[EJ X(Z xexp[—(EO) X 2) }

MP-Method

For each point designated for MP-method!* calculations, the following calculations are done:

Thickness for the I point (A):

t, = HP1 x Ln'?gjh)rps (Halsey®)
or

t, = [HJPZliJIEgl(Preh)TJPS (Harkins and Jura’)
where:

=
|

= thickness for I point

HP1 = Halsey parameter #1

HP2 = Halsey parameter #2

HP3 = Halsey parameter #3

HJP1 = Harkins and Jura parameter #1

HJP2 = Harkins and Jura parameter #2

HJP3 = Harkins and Jura parameter #3

Pen = relative pressure for the 1M point (mmHg)
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With the (t,,V,) data pairs, the Akima semi-spline interpolation method is used to interpolate
volume adsorbed values based on thickness values that are evenly spaced 0.2 Angstrom apart
starting at the first outlier point. Outliers are defined as those points have the maximum
instantaneous slope within an iteratively shrinking subset of all points. The remaining pore
surface area calculation result is the slope of the line defined by two consecutive interpolated
points. The slopes of each pair of consecutive points from the origin to the last point must be
monotonically decreasing and non-negative. With the interpolated points set the following
can be calculated:

Average pore hydraulic radius (A):

R, = L+t
2
Remaining pore surface area for the I point (m2/g):

(V,=V,_;) x (D x 10° m*/cm®)
(t,—t,_,) x 107°m/A

where

D = density conversion factor (cm? liquid/cm3 STP) on the Adsorptive Properties
dialog box

Incremental pore surface area occluded for the I point (m2/g):
Sine, = Si-1—3

Cumulative pore surface area occluded for the 1t point (m2/g):
Scum, = Sing, tSing,_, t -+ + Sing,

dA/dR pore surface area for the It point (m%g-A):

Incremental pore volume occluded for the 1t point (cm3/g):

Ving, = (Sine, x 10° cm’/m?) x (R, x 107 cm/A)
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Cumulative pore volume occluded for the I point (cm?/g):

Veum, = Ving, * Vine, , + -+ * Vine,

dV/dR pore volume for the 1t point (cm3/g-A):

Freundlich Isotherm

The Freundlich isotherm has the form:

Q — CPllm
Qs
where
Q = quantity of gas adsorbed
Qs = quantity of gas in a monolayer
C = temperature-dependent constant
m = temperature-dependent constant

The pressure is absolute; typically, m > 1. In terms of quantity adsorbed,

Q = QsCP™"

Taking the log of both sides yields:

logQ = log Qg C+% log P
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Temkin Isotherm

The Temkin isotherm has the form,

Q - RT \hap)

Qs Qo
where
Q = quantity of gas adsorbed
Qs = quantity of gas in a monolayer
do = the differential heat of adsorption at zero surface coverage
Ag = ayexp {-0,/RT}, where a, and a, are adjustable constants

In terms of quantity adsorbed,

Q= Rq-l;gs [InA0+ In (%ﬂ

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight
line with slope RTQ¢/q, and intercept (In Ay) RTQg/qg0t.
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DFT (Density Functional Theory)

The adsorption isotherm is known to convey a great deal of information about the energetic
heterogeneity and geometric topology of the sample under study. The data of physical adsorp-
tion have been used for many years as the basis for methods to characterize the surface area
and porosity of adsorbents. Real solid surfaces rarely approach ideal uniformity of structure.
It is accepted that in general, the surface of even a nonporous material presents areas of
greater or lesser attraction for adsorbed molecules.

This energetic heterogeneity greatly affects the shape of the adsorption isotherm with the
result that simple theories such as the Langmuir and BET formulas can, at best, give only
approximate estimates of surface area. Porous solids virtually are never characterized by a
single pore dimension, but instead exhibit a more or less wide distribution of sizes. The
observed adsorption isotherm for a typical material is therefore the convolution of an adsorp-
tion process with the distribution of one or more properties which affect that process. This
was first stated mathematically by Ross and Olivierl2 for the case of surface energy distribu-
tion and has become known as the integral equation of adsorption.

The Integral Equation of Adsorption

In a general form for a single component adsorptive, the integral equation of adsorption can
be written as

Q(p) = [da db dc...q(p,a,b,c...) f(a,b,c...) (1)
where
Q(p) = the total quantity adsorbed per unit weight at pressure p,
a,b,c,... = aset of distributed properties,
f(a,b,c,...) = the distribution function of the properties, and
g(p,ab,c,...) = the kernel function describing the adsorption isotherm on unit

surface of material with fixed properties a,b,c,...

Equation (1), a Fredholm integral of the first kind, is a member of a class of problems known
as ill-posed, in that there are an infinite number of functional combinations inside the integral
that will provide solutions. Even when the kernel function is known, experimental error in the
data can make solving for even a single distribution function a difficult task. Solving for mul-
tiple distribution functions requires more data than provided by a single adsorption isotherm.
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Application to Surface Energy Distribution

Under certain conditions, an energetically heterogeneous surface may be characterized by a
distribution of adsorptive energies. The conditions are that the sample is not microporous, i.e.,
that adsorption is taking place on essentially a free surface with no pore filling processes at
least to about 0.2 relative pressure. Secondly, that each energetically distinct patch contributes
independently to the total adsorption isotherm in proportion to the fraction of the total surface
that it represents. This condition is satisfied if the patches are relatively large compared to an
adsorptive molecule, or if the energy gradient along the surface is not steep. In mathematical
terms, this concept is expressed by the integral equation of adsorption in the following form.

Q(p) = [de a(p, &) f(e) )
where
Q(p) = the experimental quantity adsorbed per gram at pressure p,
g(p,e) = the quantity adsorbed per unit area at the same pressure, p, on
an ideal free surface of energy e, and
f(e) = the total area of surface of energy e in the sample.

The exact form of the energy-dependent term depends on the form of the model isotherms
expressed in the kernel function and is provided in the model description (refer to Appendix
G for model descriptions).

Application to Pore Size Distribution

Similarly, a sample of porous material may be characterized by its distribution of pore sizes.
It is assumed in this case that each pore acts independently. Each pore size present then con-
tributes to the total adsorption isotherm in proportion to the fraction of the total area of the
sample that it represents. Mathematically, this relation is expressed by

Q(p) = [dH q(p, H) f(H) (3)
where
Q(p) = the experimental quantity adsorbed at pressure p,
q(p,H) = the quantity adsorbed per unit area at the same pressure, p, in
an ideal pore of size H, and
f(H) = the total area of pores of size H in the sample.

Numerical values for the kernel functions in the form of model isotherms can be derived from
modern statistical mechanics such as density functional theory or molecular simulations, or
can be calculated from one of various classical theories based on the Kelvin equation. Several
types are found in the models library.
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Performing the Deconvolution

The integrations in equations (2) and (3) are carried out over all surface energies or pore sizes
in the model. The functions q(p,e) and q(p,H), which we call the kernel functions, are con-
tained in numeric form as model isotherms. Because, in general, there is no analytic solution
for equation (1), the problem is best solved in a discrete form; the integral equation for any
distributed property Z becomes a summation:

Q(p) = > a(p. Z) f(Z) (4)

Given a set of model isotherms, q(p,Z), from a model chosen from the models library and an
experimental isotherm, Q(p), contained in a sample information file, the software determines
the set of positive values f(Z) that most nearly, in a least squares sense, solves equation (4).
The distributed property, surface energy or pore size, is then displayed on the Report Options
dialog box as a selection of tables or graphs.

Regularization

DFT allows a selectable regularization (also referred to as smoothing) constraint to be applied
during the deconvolution process to avoid over-fitting in the case of noisy data or ill-fitting
models. The method used is based on co-minimization of the second derivative of the distri-
bution. The relative weight given to this term is determined by the value of the regularization
parameter, which is set on the DFT Pore Size or Surface Energy dialog box and also is shown
in the header of reports. The value of the regularization parameter varies from zero (for no
second derivative constraint) to ten (indicating a weight equal to minimizing the residuals), or
even larger. When the distribution and residuals obtained change little with the value of the
regularization parameter, it indicates that the chosen model provides a good representation of
the data. Conversely, a large sensitivity to the regularization parameter might indicate inade-
guate data or a poor choice of model to represent the data.
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Summary Report

The following calculations and the results of previous calculations (as noted) are used to gen-
erate the summary report:

a.

BET Surface Area

See BET Surface Area Calculations
Langmuir Surface Area

See Langmuir Surface Area Calculations
Single Point Surface Area (m2/g)

_ [Vax(L=Pr)] x CSA x (6.023 x 10%)
Sipr = 3 18 2, 2
22414 cm” STP x 10™ nm“/m

where

Pr = pressure closest to 0.3 of the relative pressure points designated for surface area

calculations.
Va = volume corresponding to Pr
Micropore Area
See t-Plot calculations.
Micropore Volume
See t-Plot calculations.
Horvath-Kawazoe Maximum Pore Volume
See Horvath-Kawazoe Calculations
Horvath-Kawazoe Median Pore Diameter
See Horvath-Kawazoe Calculations
Dubinin-Radushkevich Micropore Surface Area
See Dubinin-Radushkevich Calculations
Dubinin-Radushkevich Monolayer Capacity

See Dubinin-Radushkevich Calculations
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J-

Dubinin-Astakhov Micropore Surface Area
See Dubinin-Astakhov Calculations
Dubinin-Astakhov Micropore Volume

See Dubinin-Astakhov Calculations
MP-Method Cumulative Surface Area of Pores

MPS+o7 = Scumi (see MP-method Calculations) for the last collected data point used

in the MP-method Calculations, and the range of hydraulic pore radii over which the
cumulative surface area was computed.

MP-Method Cumulative Pore Volume of Pores

MPV+o1 = Veumrn (see MP-method Calculations) for the last collected data point

used in the MP-method Calculations, and the range of hydraulic pore radii over
which the cumulative pore volume was computed.

Average Pore Hydraulic Radius (A)

_ MPVior

MPpaver = MPS o, x 10°m%/cm x 10 A/m
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SPC Report Variables

Regressions Chart Variables

The line of best fit for the Regression Chart is calculated by the usual Least Squares methd.
(Refer to BASIC Scientific Subroutines Vol 11, by F.R. Ruckdeschel, Copyright 1981 BYTE
Publications/McGraw Hill, p. 16.) If there is only a single point or all N points have the same
x-value, there can be no line of best fit in the standard form.

XAve = =X
N
YAve = Vi
N
Slope = % (X;— XAve)(y;— YAve)

T (X — XAve)®

The coefficient of Correlation for this line is also calculated in the usual way. (Refer to Math-
ematical Handbook for Scientists and Engineers, by Granino A. Korn and Theresa M. Korn,
Copyright 1961, 1968 McGraw Hill, Sec. 18.4.)

_ [ (x;— XAve)?
CTANTN
_ 2 (y;- YAve)®
Gy - —N

2 (X;— XAve)(y;— YAve)

Cov(x,y) = N

Correlation Coefficient = Cov(x.y)

OOy
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Control Chart Variables

Mean = &
N

2
StdDev = /2 —Mean
N-1

StdDev
Mean

CoefVar =

PlusNSig = Mean +n - StdDev

MinusNSig = Mean—n - StdDev
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D. TESTING FOR LEAKS

This appendix contains general instructions for testing the ASAP 2050 for leaks. If the ana-
lyzer successfully performs a blank tube analysis using nitrogen, you do not need to test for
leaks.

These procedures may be performed individually or sequentially. Record pressure readings on
the Valve Test Data Sheet included at the end of this appendix. After you finish testing for
leaks, replace any leaking valves.

You will need the following items to perform tests:

* Stopwatch
* Valve Test Data Sheet (included in this appendix)

Testing Individual Valves

Analysis Valves

This procedure removes differential pressure from all valves in the analysis system and estab-
lishes that there are no leaks in the analysis system. It should be performed before testing for
individual valves.

1.

2.

Ensure that the analyzer is idle.

Close the regulator outlet valve for each gas supply line to the analyzer.
Attach the Po tube to the Po port.

Insert a plug (or attach a clean, empty sample tube) into the analysis port.

Insert a plug into the vapor inlet (if the vapor option is not installed).
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6. Select Show Instrument Schematic, then Enable Manual Control from the Unit menu.
Table D-1 lists descriptions of the analysis valves.

Table D-1. Analysis Valve Descriptions

Valve Description
1 Unrestricted vacuum
2 Restricted vacuum
3 Helium inlet port valve
4 Highly restricted analysis gas
5 Partially restricted analysis gas
7 Lower manifold isolation
8 Vapor inlet port
9 Sample port
10 Restricted Psat tube port
11 Unrestricted Psat tube port
P1 through P6 | Gas inlet port valves
PS Supply valve for physisorption gases
PV Vacuum valve for physisorption gases

7. Openvalves 1, 2, 4,5, and 7; close all other manifold valves.

8. Open valve PS.

9. Open valve 3 and allow the pressure to drop below 1000 umHg (1 mmHg).

10. Repeat Step 9 for valves P1 through P6.

11. Open valve 9.

D-2
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12. Open valves 10 and 11.

13. Open valve 8.

14. Open valve PV.

15. Allow the system to evacuate for a minimum of one hour; a four-hour or overnight
evacuation is preferred.

16. Obtain the manifold outgassing rate using a vacuum gauge:

a.

b.

Close valves 3, 4, 5, 8, 9, 10, 11, and P1 through P6.

Evacuate manifold for another 30 minutes.

Take a pressure reading; record it as P1 for the manifold.

Close valves 1 and 2.

Wait 10 minutes and take another pressure reading; record it as P2 for the manifold.

Subtract P1 from P2 and divide the difference by 10 to obtain the outgassing rate per
minute;

Outgassing rate = %

Record this value as the outgassing rate for the manifold. This value should be less
than 0.5 umHg/min. for the lower manifold alone and less than 0.7 umHg/min. for
the upper and lower manifolds combined.

17. Obtain the gas inlet valve outgassing rate:

a.

b.

Open valves PS and 5; valve 7 should still be open.
Take a pressure reading; record it as P1 for the gas inlet valve.

Wait 10 minutes and take another pressure reading; record it as P2 for the gas inlet
valve.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgas-
sing rate for the gas inlet valve. This value should be less than 0.7 umHg/min.
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Valves 3 and P1 through P6

1.
2.

3.

Open the regulator outlet valve for the gas connected to port 3.

Take a pressure reading; record it as P1 for valve 3.
Wait 10 minutes and take another pressure reading; record it as P2 for valve 3.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for Valve 3. This value should be less than 0.7 umHg/min.

Repeat Steps 1 through 4 for valves P1 through P6 to which a gas is attached. Record the
values on the Valve Test Data Worksheet in the spaces provided.

Valves PS, 5, and 7

1.
2.

3.

10.

11.

12.

13.

14.

15.

16.

Close valve PS.

Open valve P1 for 60 seconds, then close it.
Take a pressure reading; store it as P1 for valve PS.
Wait 10 minutes and take another pressure reading; record it as P2 for valve PS.

Subtract P1 from P2 and divide the difference by 10; record the value as the outgassing
rate for Valve PS. This value should be less than 0.7 umHg/min.

Close valve 5 (close Valve 4 if open).

Open valve PS.

Open valve P1 for 30 seconds, then close it.

Take a pressure reading; record it as P1 for valve 5.

Wait 10 minutes and take another pressure reading; record it as P2 for valve 5.

Subtract P1 from P2 and divide the difference by 10.; record this value as the outgassing
rate for Valve 5. This value should be less than 0.7 pmHg/min.

Close valve 7; open valve 5.

Open valve P1 for 30 seconds, then close it.

Take a pressure reading; record it as P1 for valve 7.

Wait 10 minutes and take another pressure reading; record it as P2 for valve 7.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for Valve 7. This value should be less than 0.5 pmHg/min.

D-4
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Valves 1, 2, 8, 9, 10, 11, and PV

Valves 10 and 11

1.
2.

Open valve PV; wait 5 minutes (Valves PS and 5 should be open.).

Open valve 7; allow the system to evacuate to below vacuum setpoint (should be 10
umHg or less).

Close valves PV, PS, and 5.

Open valves 1 and 2; allow the system to evacuate for 30 minutes.

Valves 1, 2, and 7 should be the only valves open at this time.

Remove the Po tube.

Take a pressure reading; record it as P1 for valves 10 and 11.

Wait 10 minutes and take another pressure reading; record it as P2 for valves 10 and 11.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for Valves 10 and 11. This value should be less than 0.7 pmHg/min.

Valve 9

9.

10.

11.

12.

Remove the sample tube from the analysis port.
Take a pressure reading; record it as P1 for valve 9.
Wait 10 minutes and take another pressure reading; record it as P2 for valve 9.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for valve 9. This should be less than 0.7 pmHg/min.

Valve 8

13.

14.

15.

16.

17.

With valve 8 closed, remove the plug from the vapor inlet port on the side of the analyzer.
If the vapor accessory is installed, disconnect it from the analyzer.

Take a pressure reading; record it as P1 for valve 8.

Wait 10 minutes and take another pressure reading; record it as P2 for valve 8.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for valve 8. This value should be less than 0.7 umHg/min.

Before proceeding, reinstall the sample tube, the Po tube, and the plug from the vapor inlet
(or the vapor accessory).
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Valves 1, 2, and PV

18

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

. Open valves 1 and 2.

Open valves 4, 5, and PS.

Allow the system to evacuate for 15 minutes.

Close valves 1 and 2. Valve PV should be closed; if not, close it.

Take a pressure reading; record it as P1 for valves 1, 2, and PV.

Wait 10 minutes and take another pressure reading; record it as P2 for valves 1, 2, and PV.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for valves 1, 2, and PV. This value should be less than 0.7 umHg/min.

Fill the manifold to 800 mmHg with N,, then close the nitrogen port valve.
Close valve 4.

Take a pressure reading; record it as P1 for valve PV.

Wait 10 minutes and take another pressure reading; record it as P2 for valve PV.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for valve PV. This value should be less than 50 umHg/min.

If the pressure drops more than 50 umHg, close valve 5, the PV valve may be leaking.
Take another pressure reading; record it as P1 for valves 1 and 2.
Wait 10 minutes and take another pressure reading; record it as P2 for valves 1 and 2.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for valves 1 and 2. This value should be less than 50 umHg/min.

If the pressure drops more than 0.05 mmHg, close valve 7, valves 1 or 2 may be leaking.
Take another pressure reading; record it as P1 for valve 1.
Wait 10 minutes and take another pressure reading; record it as P2 for valve 1.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for valve 1. This value should be less than 50 pmHg/min.

If the pressure drops more than 50 umHg, valve 1 may be leaking.
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Degas Valves

Perform the following steps before testing the individual degassing valves.

1.
2.

10.

11.

Ensure that the analyzer is idle.

Close the regulator outlet valve for the backfill gas.
Insert a plug into (or attach a clean, empty sample tube) each degas port.

Select Degas, Show Degas Schematic, then Degas, Enable Manual Control from the
Unit menu. Table D-2 lists descriptions of the degas valves.

D5 760 mmHg

v [ ]
D1 D2
D7
Backfill —(D_

Curmrent = 298 K Curmrent = 298 K

Table D-2. Degas Valve Descriptions

Valve Description

D1 and D2 Degas port valves

D5 Vacuum valve
D6 Servo isolation valve
D7 Gas inlet port valve

Open Valves D5, D1, D2, and then D7.

Open Valve D6.

Allow the degas system to evacuate to the vacuum setpoint, then evacuate for 60 minutes.
Close Valves D1, D2, D5, D6, and D7.

Take a pressure reading and record it as P1 for the preliminary test.

Wait 10 minutes and take another reading; record it as P2 for the preliminary test.

Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing
rate for the preliminary test. This value should be less than 10 umHg/min.
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What To Do If You Detect a Leaking Valve

If you determine that a specific valve is leaking, remove differential pressure from the valve
and continue testing the remaining valves for leaks.

As an alternative, you may repair or replace the leaking valve after removing the
\ differential pressure on the valve. However, opening the analysis system to

replace or repair a valve exposes the analyzer manifold to atmospheric gases and
moisture. These gases and moisture greatly increase the time required to
evacuate the analyzer and prepare it for further testing or operation.

Removing Differential Pressure from a Leaking Valve

1. Select either of the following actions:

* Close the regulator outlet valve for the gas supply line to the valve.
* Reinstall the plug that was removed to test the valve.

2. Open the leaking valve.
3. Evacuate the analyzer until you obtain an outgas rate of less than 0.7 umHg per minute.

Refer to Testing Individual Valves on page D-1 for detailed instructions on determining
the outgas rate for specific valves.

Repairing or Replacing a Leaking Valve

Whether you repair or replace a valve depends on the type of valve that is leaking.

* Valves on the Analysis manifold should be repaired
« Valves on the Degas and inlet manifold should be replaced.

Repairing Valves on the Analysis Manifold

1. Backfill the manifold with nitrogen to approximately 800 mmHg.

* Close off the helium gas supply if you are repairing the helium inlet valve.
* Turn off the vacuum pump system if you are repairing a vacuum valve.

2. Remove and replace the plunger and gasket for the leaking valve.
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3. Closely inspect the valve seat area for any debris which may cause another leak.

4. Reassemble the valve.

* Reopen the helium supply if you are repairing the helium inlet valve.
* Turn on the vacuum pump system if you are repairing a vacuum valve.

5. Open and close the repaired valve approximately 20 to 30 times; this allows the valve to
seat properly.

6. Evacuate the analyzer until the outgas rate is less than 0.7 umHg per minute. Refer to
Testing Individual Valves on page D-1 for detailed instructions.
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Replacing Valves on the Degas and Gas Inlet Manifold

1.
2.

Backfill the manifold with nitrogen to approximately 800 mmHog.

Turn off the gas supply for the gas inlet valves.
Turn off the degas vacuum system for access to degas valves 5 or 6.
Disconnect the wiring from the valve.

Unscrew and remove the valve from the manifold.

Inlet Valve Degas Valve

Install the new valve, then reconnect the wiring.
Turn on the gas supply and vacuum pump system.

Evacuate the analyzer until the outgas rate is less than 0.7 umHg/min. for inlet valves or
10 umHg/min. for degas valves. Refer to Testing Individual Valves on page D-1 for
detailed instructions.
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Valve Data Test Sheet

Make a copy of this form to record pressure readings and outgassing rates when leak-testing
system valves.

VALVE(s)

P1

(1st pressure reading)

P2

(2nd pressure reading)

OUTGASSING RATE

Anal

ysis Valves

Manifold

Gas inlet valve

3

P1

P2

P3

P4

P5

P6

PS

5

7

10 and 11

9

8

1, 2, and PV

1, 2, and PV

land 2

1

Degas Valves

Manifold
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E. CALCULATING FREE-SPACE VALUES

Many microporous materials, such as zeolites and activated carbons, trap and hold helium in
their complex pore structures for many hours after being exposed to helium. Helium trapped
in micropores can interfere with the analysis at low pressures, causing an “S”-shaped curve at
the lower end of the isotherm. For this reason, it is recommended that you enter the ambient
and analysis free-space volumes when performing micropore analyses, therefore avoiding
exposure of the sample to helium. Two techniques can be used for determining ambient and
analysis free-space values.

The first method is to perform a short analysis on the sample after partial degassing (one pres-
sure point with no incremental dosing), but prior to final sample preparation. Measure the free
space during this analysis. The measured free-space values will be printed on the report and
may then be entered into the sample file after more thorough sample preparation.

The second method requires prior tests using empty tubes that will be employed later for the
sample analyses. The measured free-space data can be used thereafter on every analysis per-
formed using these sample tubes. This small initial investment of time will save considerable
time later. Perform an empty tube analysis on each sample tube you intend to use for
micropore analysis. Measure the free space of each sample tube, taking only one pressure
point. Four important things to remember are: 1) be consistent in using seal frits; for example,
use the same seal frits for the analysis as you did for the empty tube test; 2) since the analysis
free space is dependent on bath temperature, perform a test for each bath temperature to be
used; 3) the isothermal jacket must be in the same position for the sample analysis as it was
for the empty tube test; and 4) correct the free-space volumes obtained for the volume dis-
placed by the sample when you use them.

To make the correction, subtract the amount of gas displaced by the sample. The calculations
are simple and are given here with a brief explanation of their derivation. Remember to
employ the appropriate free-space values for each bath temperature used, stating all temper-
atures in Kelvin.

To correct ambient free space:

M, T
Vs = Vwm—(—jx-—gi)

e Ps Tamb
where
V,s = calculated ambient free space with sample present (in standard cm3)
V,m = ambient free space measured for the empty tube (in standard cm?3)
M = mass of sample to be analyzed (in grams)
rs = approximate sample true density (in grams/cm3)
T,mp = ambient temperature (in Kelvin)
Ted = standard temperature (273.15 Kelvin)
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To correct analysis free space:

where
Ve = calculated analysis free space with sample present (in standard cm?3)
V., = analysis free space measured for the empty tube (in standard cm?3)
M = mass of the sample to be analyzed (in grams)
rs = approximate sample true density (in grams/cm?3)
Toan = analysis bath temperature (in Kelvin)
T = standard temperature (273.15 Kelvin)
When you later analyze a sample, select Enter Free Space, and use the values calculated
above.
Example:

The sample is 0.2345 grams of activated carbon with a density of 2.0000 g/cm3. The room
temperature is 22 °C or 295.15 K. The analysis tube has been measured previously in an argon
bath. The measured ambient and analysis free spaces are 29.1234 and 89.4567 cm3 STP atm-1,
respectively. The analysis will be performed with argon at liquid argon temperature, 87.3 K.

With this information, enter the corrected ambient free space as follows:

023459  2732K
2.0000 g/cm® 2992 K

Vi = 291234 cm® STP - )= 20,0149 cm® STP atm ™"

and enter the corrected analysis free space as follows:

023459 2732K
2.0000 g/cm® 873K

Vg, = 89.4567 cm® STP - )= 89.0898 cm® STP atm™
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F. DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In
the experimental physical sciences, theories are often expressed in terms of a model that can
be visualized and described mathematically. Early models of physical adsorption were quite
simple, both conceptually and mathematically, for very practical reasons — hand computa-
tions were required. Today we can explore complex models that describe adsorption systems
on the atomic scale of size and sub-picosecond time frame. This is not because scientists are
smarter, but because of available tools. The DFT models are created by classical approaches
to adsorption as well as models based on modern statistical thermodynamics.

Models Based on Statistical Thermodynamics

Included in this group are methods that model the adsorption system in terms of forces acting
between individual molecules.

Theoretical Background

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an
isotherm equation containing a small number of parameters. At a minimum, these parameters
include the extent of the surface, such as the monolayer capacity (Vm), and the molar inten-
sity of the gas-surface interaction, such as the Langmuir “K” constant or the BET “C”
constant. In some equations, additional parameters take into account the lateral interaction of
adsorbed molecules with each other. Other theories, such as the Dubinin-Astakhov approach,
also include parameters for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the micro-
scopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters,
the pore size, the pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed.

A clean sample of a solid material containing slit-shaped pores of a single width is placed in
an evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded
over time. In this situation, the pressure falls rapidly from its initial value and gradually
approaches a steady reading, called the equilibrium pressure. The amount adsorbed corre-
sponds to the quantity of gas effectively removed from the gas phase by the solid surface. A
graph that plots amount adsorbed versus equilibrium pressure is called an adsorption
isotherm.

Under such conditions, the argon atoms that randomly enter the pore space feel the presence
of the solid surface as the action of an external attractive force (the dispersion forces or Van
der Waal’s forces) and spend more time near the surface. As a result, the space near the sur-
face acquires a greater average density of argon atoms than regions farther removed.
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If the equilibrium distribution of the gas atoms near the surface could be described as a func-
tion of pressure and the molecular properties of the components of the system, then a model
could be constructed for the adsorption isotherm for the system. Modern physical chemistry
provides several ways to calculate this distribution. All these methods are based on the fun-
damental thermodynamic law that such a system adopts a configuration of minimum free
energy at equilibrium. Also needed is a description of the pairwise interaction energy between
atoms, U(s), commonly given by a Lennard-Jones potential:

oo = (92

where
€ = acharacteristic energy of the adsorptive,
c = the diameter of the adsorptive molecule, and
S = the separation distance.

Molecular Simulation Methods

Two simulation techniques are commonly used to determine the distribution of gas molecules
in a system in equilibrium: the molecular dynamics method and the Monte Carlo method.
Both of these are used as reference methods because their results are considered exact.

Molecular Dynamics Method

In the molecular dynamics method, the position and velocity of individual gas particles are
calculated over time at very short intervals. This method takes into account both the forces
acting between the gas particles themselves and those acting between the gas particles and the
atoms of the simulated surface. As the simulated particles collide with each other and with the
surface, the average concentration of particles in the space near the surface is calculated; this
calculation yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the move-
ment of each particle in the system using time steps of 10-14 seconds. Although the
mathematics are simple, the number of calculations required for a system of even a few hun-
dred particles is astronomical and challenges even the fastest computers.

Monte Carlo Method

In the Monte Carlo method, determination of the system equilibrium distribution begins with
an assumption (which may be only approximate) about the initial configuration of particles in
the system. The system is “equilibrated” through a process of randomly selecting one particle
and conditionally moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and
another particle is randomly selected to be moved.
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If the move results in a configuration of higher energy, a probability for that event is calcu-
lated, and a random number between zero and one is generated. If the generated number is
smaller than the probability of the event, then the move is accepted; otherwise, another par-
ticle is selected and the process is repeated. This process continues until the average total
energy of the system no longer decreases; at this point, average configuration data are accu-
mulated to yield the mean density distribution of particles in the system.

Monte Carlo simulations require considerable less computation time than molecular dynamic
simulations and can yield the same results; however, neither method provides a really prac-
tical way to calculate complete isotherms.

Density Functional Formulation

Density functional theory offers a practical alternative to both molecular dynamic and Monte
Carlo simulations. When compared to reference methods based on molecular simulation, this
theory provides an accurate method of describing inhomogeneous systems yet requires fewer
calculations. Because the density functional theory provides accuracy and a reduced number
of calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls sepa-
rated by a distance H. The pore is open and immersed in a single component fluid
(adsorptive) at a fixed temperature and pressure. Under such conditions, the fluid responds to
the walls and reaches an equilibrium distribution. In this condition (by the definition of equi-
librium), the chemical potential at every point equals the chemical potential of the bulk fluid.
The bulk fluid is a homogenous system of constant density; its chemical potential” is deter-
mined by the pressure of the system using well-known equations. The fluid near the walls is
not of constant density; its chemical potential is composed of several position-dependent con-
tributions that must total at every point to the same value as the chemical potential of the bulk
fluid.

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free
energy, known thermodynamically as the grand potential energy (GPE). Density functional
theory describes the thermodynamic grand potential as a functional of the single-particle den-
sity distribution; therefore, calculating the density profile that minimizes the GPE yields the
equilibrium density profile. The calculation method requires the solution of a system of com-
plex integral equations that are implicit functions of the density vector. Since analytic
solutions are not possible, the problem must be solved using iterative numerical methods.
Although calculation using these methods still requires supercomputing speed, the calculation
of many isotherm pressure points for a wide range of pore sizes is a feasible task. The com-
plete details of the theory and the mathematics can be found in the papers listed under
References at the end of this appendix.

The following graphs and accompanying text illustrate the results of using density functional
theory to predict the behavior of a model system.

*Chemical potential may be thought of as the energy change felt by a probe particle when it is inserted
into the system from a reference point outside the system. It can also be defined as the partial derivative
of the grand potential energy with respect to density (or concentration).
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Figure F-1 shows the density profile for argon at a carbon surface as calculated by density
functional theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Density (particle A-3)

0.15

0.1

0.05

o
ot
—
o

15 20

Distance from wall in A

Figure F-1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise dis-
tribution of adsorbate; the first monolayer is sharply defined and a third layer can be
distinguished. The area under the profile curve represents the amount adsorbed per unit area
at this pressure. The positions of the maxima are separated by a distance determined by the
size of the adsorptive atom.

Given the density profile, the amount adsorbed at the stated pressure can be easily calculated
as the integral over the profile. Repeating this calculation over a range of pressures yields the
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained cor-
responds to that of an external, or free, surface. If H is smaller, a range of pressures is reached
where two minima exist for the grand potential, showing the presence of two metastable
phases having different density distributions but the same chemical potential. The phase with
the lower GPE is the stable one. As the pressure is increased, a point is reached where the
other phase becomes the stable one. This phase transition reflects condensation of adsorbate
in the pore; the pressure at which it occurs is called the critical pore-filling pressure. This
pressure is analogous to the condensation pressure predicted by the Kelvin equation in the
classical model of pore filling.
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Figure F-2 shows how the profiles change with pressure for a model pore with H = 40 Ang-
stroms. The insets show the density profiles for the corresponding points of the isotherm.

Volume Adsorbed ( ¢cm3 STP m?2)

— d cr/a/
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1 U\A/\-mm
1.0 c
0.5
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|
0.01 0.1 1 10 100 1000

Pressure in Torr

Figure F-2. Model Isotherm for Argon at 87.3 K in a 40 A Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half
of the distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position
close to the surface.

* Inset a shows the profile corresponding to point a on the isotherm where the surface is
about half covered.

* At point b, the first layer is so full that it is more favorable for atoms to start a new layer.
* At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling
pressure. In inset c, the profile shows the density decreasing to near zero (actually the

bulk gas density) at 4 or 5 molecular diameters from the surface.

* Inset d shows the profile converging on a density similar to that of bulk liquid argon in
the center of the pore, indicating a phase transition.
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Note that the adsorption isotherms for pores larger than the one shown in Figure 4-2 is iden-
tical up to point c. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in Figure F-3, where isotherms for some larger size pores
are shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-
filling pressure. At large pore sizes, density functional theory produces results for the critical
filling pressures that are in good agreement with those produced by the Kelvin equation.

Volume Adsorbed ( ¢m3® STP m?)

50 543.7 A
15
10 - 252.4A |
5 117.14
il 54.3A
25.2 A ] L
0 [ T S l ...................... o l ...................... o l ...................... Lo
0 100 200 300 400 500 600 700

Pressure in Torr

Figure F-3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K
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Figure F-4 shows model isotherms for pores in the micropore size range. Note the logarithmic
scale for pressure.
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Figure F-4. Model Isotherms in the Micropore Size Range of Pore Width
Argon on Carbon at 87.3 K

Pores of 4 A width, barely larger than the argon atom (3.38 A), fill at pressures below 1 mil-
litorr. Pores below 15 A fill before a monolayer is completed on the surface of the larger
pores. In the micropore size range, the pore volume fills more gradually with pressure and the
total shape of the isotherm is important in characterizing the pore size.
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Models Included

Non-Local Density Functional Theory with Density Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit

Substrate: Carbon (graphite)

Category: Porosity

Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been
calculated to serve as kernel functions for the characterization of porous solids from adsorp-
tion data. The model isotherms are stored in binary format files. These models assume a slit-
like pore geometry. The pore size range from 4.0 to 4000 A is covered in 91 classes in a geo-
metric progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A
model for the free or external surface is included to account for unfilled pores. Each of the 92
model isotherms has been calculated at 181 pressure points from near 1x10 to near 1.00 rel-
ative pressure.

These models are identical to those supplied with the original DOS version of DFT software.
Some slight difference from the DOS results may be noted when they are applied to the same
data due to improvements in the deconvolution algorithm and better regularization of the cur-
rent software.

Modified Non-Local Density Functional Theory with Density-Dependent
Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K

Using the modified Tarazona prescription described by Olivier (refer to references 3 and 4 on
page F-15), model isotherms were calculated for a wide range of adsorptive energies to a rel-
ative pressure of 0.6. The model makes no provision for pore filling in the micropore region.
If the sample solid contains small mesopores, the isotherm data should be truncated (using the
Select Data Points dialog box) to a suitably low relative pressure to avoid trying to fit this
region; mesopore filling reports as a large area of low energy in the calculated distribution of
adsorptive potential.

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter,
e, for the adsorptive/adsorbent pair divided by Boltzmann’s constant. The units are therefore
degrees Kelvin.

F-8
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N2 - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide

Category: Porosity
Method: Nitrogen at 77 K

Model isotherms were calculated using a combination of statistical mechanical calculations
and experimental observations for macroporous silicas and MCM-41 mesoporous silicas as
well as zeolites. The pore-filling pressures were determined as a function of the pore size
from adsorption isotherms on MCM-41 materials characterized by X-ray and other tech-
niques. The variation of the pore fluid density with pressure and pore size has been accounted
for by density functional theory calculations. This model reports pore sizes ranging from 3.8
to 387 Angstroms.

Reference: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the

Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Mesoporous
Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999)

N2 — Cylindrical Pores — Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder

Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77 K

Model isotherms were calculated using a combination of statistical thermodynamic Non-
Local Density Functional Theory (NLDFT) calculations and experimental isotherms for ref-
erence samples of montmorillionite. The construction method for the hybrid models was
analogous to that described in the first reference below (Jaroniec et al,1999). The additional
references add additional theoretical details as well as examples of the application of the
model to pillared clay catalysts. This model reports pore widths from 3.8 to 387 Angstroms.

References:  Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occell, “Surface Area and Microporosity of a
Pillared Interlayered Clay (PILC) from a Hybrid Density Functional Theory
(DFT) Method,” The Journal of Physical Chemistry B; 2001, 105(3),
623-629.
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References: M. L. Ocecelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded Clay
Catalysts from Hybrid Density Functional Theory (DFT) and Adsorption
Microcalorimetry Methods,” Langmuir 2002, 18, 9816-9823.

James P. Olivier, “The Importance of Surface Heterogeneity in Developing
Characterization Methods.” 6! International Symposium on the Character-
ization Of Porous Solids, Studies in Surface Science and Catalysis 144,
Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface area and microporosity of pil-

lared rectorite catalysts from a hybrid density functional theory method,”
Microporous and Mesoporous Materials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit

Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isotherms were calculated, using the non-local prescription of Tarazona, employing
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional

Geometry: Free Surface
Substrate: Any
Category: Surface energy
Method: Argon at 87 K

This model was produced in the same manner as the N2 Modified Density Functional model
listed earlier, except applicable to argon adsorbed at 87.3 K.
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N2 - Tarazona NLDFT, Esf = 30.0K

Geometry: Cylinder
Substrate: Oxide

Category: Porosity
Method: Nitrogen at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is /k = 30 K,
typical for a silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that
have substantial micropore volume. The reported pore size range is 3.8 to 387 Angstroms.

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).
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Models Based on Classical Theories

Both surface energy distribution and pore size distribution may be evaluated using classical
approaches to model kernel functions

Surface Energy

The use of classical theories to extract adsorptive potential distribution is mostly of historical
interest. At a minimum, the equation must contain a parameter dependent on adsorption
energy and another dependent on monolayer capacity, or surface area. This is sufficient to
permit the calculation of the set of model isotherms that is used to create a library model. The
Langmuir equation has been used in the past, as have the Hill-deBoer equation and the
Fowler-Guggenheim equation. All of these suffer from the fact that they only describe mono-
layer adsorption, whereas the data may include contributions from multilayer formation.

Pore Size

It is well established that the pore space of a mesoporous solid fills with condensed adsorbate
at pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pres-
sure, this knowledge can be used to characterize the mesopore size distribution of the
adsorbent. The correlating function most commonly used is the Kelvin equation. Refinements
make allowance for the reduction of the physical pore size by the thickness of the adsorbed
film existing at the critical condensation pressure. Still further refinements adjust the film
thickness for the curvature of the pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm
data using Kelvin-based theories, such as the BJH method, were for the most part developed
decades ago and were designed for hand computation using relatively few experimental
points. In general, these methods visualize the incremental decomposition of an experimental
isotherm, starting at the highest relative pressure or pore size. At each step, the quantity of
adsorptive involved is divided between pore emptying and film thinning processes and
exactly is accounted for. This computational algorithm frequently leads to inconsistencies
when carried to small mesopore sizes. If the thickness curve used is too steep, it finally will
predict a larger increment of adsorptive for a given pressure increment than is actually
observed; since a negative pore volume is non-physical, the algorithm must stop. Conversely,
if the thickness curve used underestimates film thinning, accumulated error results in the cal-
culation of an overly large volume of (possibly nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel
functions corresponding to various classical Kelvin-based methods have been calculated for
differing geometries and included in the list of models.
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Models Included

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit

Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

~5.00 )1/3

t= 3'54(In(P/P0)

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm!
Molar density 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder

Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948)
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Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit

Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The kernel function is calculated using the Harkins and Jura equation with standard

parameters:

(= ( 13.99 12
0.034 - log(P/Po

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm1
Molar density 0.02887 g cm-3

N2 - Harkins and Jura Thickness Curve

Geometry: Cylinder

Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: ~ W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944)
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966)

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Slit

Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard

parameters:
The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm1
Molar density 0.02887 g cm-3

F-14
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N2 - Broekhoff-de Boer Model
Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K
The calculation is similar to the above except that cylindrical geometry is assumed, and the
film thickness depends on pore size (see reference).
Reference: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer, “The
Surface Area in Intermediate Pores,” Proceedings of the International Sym-
posium on Surface Area Determination, D.H. Everett, R.H. Ottwill, eds., U.K.
(1969)
References

The papers listed below provide additional information on DFT models:

1.

“Determination of Pore Size Distribution from Density Functional Theoretic Models of
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin,
Micromeritics Instrument Corp; presented at the International Symposium on the Effects
of Surface Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland
(July 1992).

“Classification of Adsorption Behavior: Siimple Fluids in Pores of Slit-shaped
Geometry,” Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35,
Elsevier Science Publishers, B.V., Amsterdam (1992).

“Modeling Physical Adsorption on Porous and Nonporous solids Using Density
Functional Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

“The Determination of Surface Energetic Heterogeneity Using Model Isotherms
Calculated by Density Functional Theory,” J.P. Olivier; presented at the Fifth International
Conference on the Fundamentals of Adsorption, Pacific Grove, CA (1995).

Jul 07

F-15



ASAP 2050 Operator’'s Manual Appendix F

F-16 Jul 07



ASAP 2050 Operator’'s Manual

Index

INDEX

Symbols
$ symbol, 3-3, 8-5, 8-8

A

AJD calibration, 6-15
Absolute pressure dosing, 3-11, 3-12, 5-16
Absolute pressure tolerance, 5-23
Adding an analyzer, 4-6
Adsorbate Molecular Weight, 5-34
Adsorption isotherm, F-1
Adsorptive Properties dialog, 5-25
Adsorptive properties file, 5-25
defining, 3-12
listing file statistics, 3-40, 5-85
printing contents, 3-39
Advanced format, 8-2
creating sample file, 3-6
establishing sample defaults, 3-4
sample information file, 5-4
Advanced Sample Defaults dialog, 3-4
Alpha-S curve, saving, 5-82
Alpha-S Method dialog, 5-46
Alpha-S report, 5-46
Alumina, replacing in oil vapor traps, 9-15
Ambient free space, 3-10, 5-10, 5-19, 5-80, 6-5, E-1
Analysis
canceling, 6-6
details, 6-12
Dewar, checking and cleaning, 9-5
performing, 3-37, 6-3
reference, 9-39
resuming, 6-6
skipping a step, 6-6
status, 6-12
suspending, 6-6
viewing options, 6-3
Analysis bath fluid, 1-14, 3-25
Analysis conditions
defining, 3-11
Analysis Conditions dialog, 5-13
Analysis conditions file, 5-13
creating, 3-11
identification, 5-13
listing file statistics, 3-40, 5-85
printing contents, 3-39
Analysis dialog, 3-37, 6-3
Analysis free space, 3-10, 5-10, 5-19, 5-80, 6-5

Analysis port, 2-3

replacing filter, 9-5
Analysis Preparation dialog, 5-17
Analysis program, 1-12, 2-7

error messages, B-1

exiting, 5-88

installing, 4-1

installing upgrade, 4-5

subsequent installation, 4-5

uninstalling, 4-12

version number, 6-16
Analyzer

adding another, 4-6

changing setup, 4-10

cleaning, 9-8

description, 1-11

front panel, 2-1

lower side panel, 2-5

maintaining, 9-4

moving to a different computer, 4-6

rear panel, 2-6

removing, 4-9

troubleshooting, 9-1

turning off, 2-6

turning on, 2-6

upper side panel, 2-4
AR DFT model, F-8
AR Modified Density Functional model, F-10
ASCII text, 3-41

saving reports, 7-19
Automatic Degas dialog, 6-7
Autoscale x- and y-axis, 5-38
Avogadro's number, C-20
AXis

coordinates, viewing, 7-25

editing, 7-24

properties, editing, 7-24
AXis Properties dialog, 7-24

B

Backfill, 3-12
gas, 5-25
options, 5-24
selecting options, 3-12
Basic format, 8-2, 8-3
creating sample file, 3-8
sample information file, 5-6
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specifying sample defaults, 3-2, 8-4
Basic Sample Information dialog, 3-2
Bath temperature, 6-5
BET Surface Area report, 5-35
calculations, C-6, C-7
BJH Adsorption Cumulative Pore VVolume report, 7-28
BJH Adsorption/Desorption plot options dialog, 5-56
BJH Adsorption/Desorption report, 5-50
calculations, C-11
plot, 5-56
tabular, 5-54
BJH Adsorption/Desorption Report Options dialog, 5-50
BJH Adsorptive Options dialog, 5-52
BJH correction, 5-53
Board ID dialog, 6-16
Boltzmann’s constant, F-8
Bookmarks tab, 1-4
Breaker
See Circuit Breaker
Broekhoff-de Boer equation, 5-44

C

Calculated free space, 5-20
Calculation assignments, 5-17
Calibrate Manifold Temperature dialog, 9-29
Calibrate Pressure Offset dialog, 6-17
Calibrate Pressure Scale dialog, 6-18
Calibrate Servo Valve dialog, 6-26
Calibrate System Volume dialog, 6-19, 6-20
Calibration

analysis pressure scale, 6-18

degas pressure scale, 6-25

degas vacuum gauge, 6-26

details, 6-15

file, loading, 6-21

files, reinstalling, 4-11

Load from File, 6-21

pressure gauge, 6-17, 9-27

pressure scale, 9-28

servo valve, 6-26

settings, saving, 6-21

temperature, 6-18, 9-29

vacuum gauge, 6-17

volume, 6-19

zero pressure transducer, 6-25
Calibration command, 6-17
Calibration File dialog, 6-21
Calibration Manifold Temperature dialog, 6-18
Calibration Vacuum Gauge dialog, 6-17
Cancel push button, 2-10
Carbon Black STSA equation, 5-44

Check box, 2-9
Chemical potential, F-3
Cheng/Yang
calculations, C-23
Pore Geometry, C-22
Cheng/Yang correction, 5-58
Circuit boards, 6-16
Circuit breaker
heating mantle, 2-3
valve, 2-5
Cleaning
analyzer, 9-8
Dewars, 9-5
Close All command, 5-83
Close command, 5-83
Close push button, 2-10
Close Reports command, 7-4
CO2 DFT Model, F-10
Cold free space, E-2
Cold trap, 1-11
location, 2-3
tubes, cleaning, 9-21
when to use, 3-14
Collected Data dialog, 5-78
Columns, editing on onscreen reports, 7-21
Comments, 3-7, 5-5, 8-9
Compressibility factor, 5-27
Computer
requirements, 1-15
Control Chart command, 7-10
Control Chart Graph Options dialog, 7-11
Control Chart Options dialog, 7-10
Control Chart report, 7-10
defining the Y-axis, 7-11
recalculating archived results, 7-11
Control Chart Sample Selection dialog, 7-12
Controls, indicators, and connectors, 2-1
front panel, 2-1
rear panel, 2-6
side panel, 2-4
Conventions
operator’s manual, 1-3
Cross-hair, axis, 7-25
Cross-references, 1-7
Cryogen
See Analysis bath fluid
Curve Properties dialog, 7-23
Curves
editing, 7-23
showing and hiding, 7-22

Cascade windows, 2-15 D
Cautions, 1-3 Data
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Index

isotherm, exporting, 5-86
selecting display options, 8-10
smoothing, 5-65
type, 5-5
Data entry field, 2-9
Date Range push button, 2-11
Dates push button, 5-3
Default Basic Sample Information dialog, 8-4
Default files, 3-2
Default Style dialog, 7-19
Defaults
entering sample, 8-4
Degas
Calibrate pressure zero, 6-25
Calibrate servo, 6-26
Calibrate vacuum gauge, 6-26
canceling, 6-25
dialog, 6-7
Enable manual control, 6-22
monitoring, 6-24
sample on analysis port, 3-31
sample on degas port, 3-20
Show instrument schematic, 6-23
Show status, 6-24
skipping a step, 6-24
starting, 6-7
Degas backfill port, 2-4
Degas command, 6-22
Degas Conditions dialog, 3-10
Degas conditions file, 5-11
creating, 3-10
listing file statistics, 3-40
printing contents, 3-39
Degas port
location, 2-3
preparing samples, 3-20
replacing filter, 9-7
Degas Schematic, 3-33

Density
entering, 3-3, 3-5, 8-6
sample, 5-5

Density conversion factor, 5-26
Density Functional theory, F-3
Destination, 5-84
Dewar
adding bath fluid, 3-25
analysis, 2-2, 3-29, 3-35
checking, 9-5
cleaning, 9-5
cover, 3-15, 3-30, 3-35
precautions, 3-24
raising and lowering, 6-9
safety shield, 1-11, 3-30, 3-36
DFT models, F-1

see also Models
DFT Pore Size Report Options dialog, 5-64
DFT report
pore size, 5-64
surface energy, 5-67
DFT Surface Energy Report Options dialog, 5-67
Dialog box, 2-9
closing, 2-10
Differential calculations, smoothing, 5-52, 5-58
Dipstick
for measuring analysis bath fluid level, 3-25
Directories list box, 2-12
Directory, 5-3
disposing, 9-5
Dosing method, 5-26
Dosing options, 3-11
Dosing Options dialog, 5-22
Drop-down list, 2-10
Dubinin report, 5-68
pore volume, 5-71
tabular, 5-70
transformed isotherm, 5-70
Dubinin Report Options dialog, 5-68

Dubinin Transformed Isotherm Plot Options dialog, 5-70

Dubinin-Astakhov
calculations, C-30, C-32, C-33
Dubinin-Radushkevich
calculations, C-28

E

Elevator, 2-2, 3-38, 6-9
lubricating screws, 9-24
raising and lowering, 6-8
Enable Manual Control command
analysis system, 6-8
degas system, 6-22
Equilibration, 5-24
calculations, C-4
entering interval and delay time, 3-12
Equilibration dialog, 5-24
Equipment
analyzer, 1-11
description, 1-11
Error messages, B-1
Evacuation, 5-17
Evacuation rate, 5-12
Evacuation time, 5-12, 5-17
Exit command, 5-88
Exiting the analysis program, 2-8, 5-88
Export command, 5-86
Export Sample Information dialog, 3-41
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F
File
displaying, 2-15
listing statistics, 2-8
name, including with file identification, 8-5, 8-8
opening, 2-8
printing to, 7-3
status, 2-12, 5-3
File menu, 5-1
Close All command, 5-83
Close command, 5-83
description, 5-1
Exit command, 5-88
Export command, 5-86
List command, 5-85
Open command, 5-2
Print command, 5-84
Save All command, 5-83
Save As command, 5-81
Save command, 5-81
File name default extensions, 2-13
File name field, 3-3, 3-6, 3-8
Filter
port, 9-5
vacuum pump exhaust, 9-25
Find command, 1-8
Folder, 3-1
f-Ratio Method dialog, 5-49
f-Ratio report, 5-49
Free space, 3-3, 3-5, 5-10, 5-19, 5-80, 6-5
ambient, 3-10
analysis, 3-10
calculated, 5-5, 5-20
calculating, E-1
calculations, C-2
selecting measurement method, 3-11, 5-18
Free Space dialog, 5-18, 5-80
Freespace helium port, 2-4
Freundlich report, 5-37
calculations, C-35
Freundlich Report Options dialog, 5-37
Front panel description, 2-1
Fume hood, 9-25
Function keys
See Shortcut keys

G

Gas
absolute pressure dosing, 5-16
adsorptive, 5-26
backfill, 5-25
changing, 9-30

connecting a regulator, 9-31
connecting to the analyzer, 9-38
connection ports, 2-4
dosing, 5-22
entering dosing method, 5-26
guidelines for connecting to analyzer, 9-30
inlet ports, 2-4
ports, 9-38
regulator pressure, 3-37
requirements, 1-12
Gas Configuration dialog, 6-16, 9-38
Graph
copying as metafile, 7-24
copying report data as text, 7-24
editing onscreen, 7-22
grid lines, 8-10
legend, editing, 7-24
shortcut menu, 7-22
Graph Grid Lines command, 8-10
Graph Grid Lines dialog, 8-10
Graph Overlay Samples, 5-30
Graph Overlay Samples dialog, 3-44
Graph overlays
See Overlays
Graphic
showing in report title, 5-30
Grid lines, 8-10

H

Halsey Thickness Equation, 5-43
Halsey Thickness Equation dialog, 5-73
Hardware code, 6-15
Harkins and Jura Thickness Equation, 5-43
Harkins and Jura Thickness Equation dialog, 5-73
Heat of Adsorption dialog, 7-13
Heat of Adsorption report, 7-13
Heater Settings dialog, 3-33
Heating mantle
attaching to sample tube, 3-22, 3-32
breaker, 2-3
connector, 2-3
cooling, 3-23, 3-34
power plug, 3-20, 3-32
thermocouple, 2-3
Heating mantle clip, 3-22, 3-32, 3-34
Help menu, 2-15
Histogram, 7-23
Horvath-Kawazoe calculations
Cylinder pore geometry (Saito/Foley), C-21
Slit pore geometry (original HK), C-20
Sphere pore geometry (Cheng/Yang), C-22
Horvath-Kawazoe Physical Properties dialog, 5-59
Horvath-Kawazoe Plot Options dialog, 5-62
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Horvath-Kawazoe report, 5-58
calculations, C-20
plot, 5-62
tabular, 5-61
Horvath-Kawazoe Report Options dialog, 5-58

Icons
arranging, 2-15
Index, online, 1-7
Indicators
See Controls, indicators, and connectors
Information bar, 2-9
Instrument log, 6-13
adding entries, 5-6, 6-13
Instrument schematic
analysis system, 6-11
degas system, 6-23
Interaction parameter, C-23
Isosteric heat of adsorption, 7-13
Isotherm, F-1
Isotherm data
exporting, 3-41, 5-86
Isotherm Linear Absolute Plot, 7-30
Isotherm Pressure Composition report, 7-29
Isotherm report, 5-32
Isotherm Report Options dialog, 5-32
Isothermal jacket, 1-11, 1-14, 3-16, 3-28, 3-34

K

Kernel function, F-12, F-13, F-14
Kruk-Jaroniec-Sayari Thickness Equation, 5-43

L

Langmuir Surface Area report, 5-35
calculations, C-7
Leak test
blank tube analysis (nitrogen), D-1
Data sheet for recording values, D-11
removing differential pressure, D-8
Valve 9, D-5
Valves 10 and 11, D-5
Valves P1 through P6, D-4
Valves PS, 5, and 7, D-4
Legend Properties dialog, 7-24
Lennard-Jones interaction parameter, F-8
Lennard-Jones potential, F-2
Links, 1-6
Liquid nitrogen, 9-5
List command, 5-85

Listing file statistics, 5-85
Live Graph command, 8-11
Load from File command, 6-21
Log

See Instrument log
Log Report Settings dialog, 6-14

M

Main Menu bar, 2-14
Maintenance
preventive, 9-4
routine, 9-30
Manifold temperature
calibrating, 6-18, 9-29
transducer, 1-14
Manual control, 6-8
enabling for analysis system, 6-8
enabling for degas system, 6-22
Mass
determining, 3-18, 3-19
entering, 3-5, 3-7, 3-8, 3-27, 5-5, 5-7, 8-6, 8-9
MCM-41 materials, F-9
Menu
shortcut, 2-7
structure, 2-14
Metafile, copying graph as, 7-24
Models, F-1
AR DFT model, F-8
AR Modified Density Functional model, F-10
based on classical theories, F-12
based on statistical thermodynamics, F-1
CO2 DFT model, F-10
N2 Broekhoff-de Boer model, F-14, F-15
N2 Cylindrical Pores - Oxide Surface, F-9
N2 Cylindrical Pores - Pillared Clay Surface, F-9
N2 DFT model, F-8
N2 Halsey Thickness Curve, F-13
N2 Harkins and Jura Thickness Curve, F-14
N2 Harkins and Jura Thickness Curve model, F-14
N2 Modified Density Functional model, F-8
N2 Tarazona NLDFT, Esf = 30.0K, F-11
Molecular cross-sectional area, 5-26
Molecular dynamics, F-2
Molecular simulation methods, F-2
Monolayer capacity, 5-37
Monte Carlo, F-2
Montmorillionite, F-9
MP-Method
Calculations, C-35
MP-Method Plot Options dialog, 5-75
MP-Method report, 5-72
plot, 5-75
tabular, 5-75
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MP-Method Report Options dialog, 5-72
MP-Method Tabular Report Column Options dialog,
5-75

N

N2 Broekhoff-de Boer model, F-14, F-15

N2 Cylindrical Pores - Oxide Surface model, F-9

N2 Cylindrical Pores - Pillared Clay Surface model, F-9
N2 DFT model, F-8

N2 Halsey Thickness Curve model, F-13

N2 Harkins and Jura Thickness Curve model, F-14

N2 Modified Density Functional model, F-8

N2 Tarazona NLDFT, Esf = 30.0K model, F-11
Non-condensity Adsorptive, 5-26

Notes, 1-3

o

Oil vapor traps
replacing alumina, 9-15
On/Off switch, 2-5
Online manual
cross references, 1-7
index, 1-7
printing options, 1-9
using, 1-4
See also Operator’s manual
Open Adsorptive Properties File dialog, 3-12
Open Analysis Conditions File dialog, 3-11
Open command, 5-2
Open Compressibility Factor Table dialog, 5-27
Open report command, 7-4
Open Report Options File dialog, 3-13
Open Sample Information File dialog, 3-6, 3-8
Operator, 8-9
Operator field
omitting, 3-5
Operator’s manual
conventions, 1-3
displaying online, 2-15
online, 1-4
organization, 1-1
Option Presentation command, 8-2
Options menu
Graph Grid Lines command, 8-10
Option Presentation command, 8-2
Parameter Files Directory, 8-11
Sample Defaults command, 8-4
Service Test Mode command, 8-12
Units command, 8-10
Options report, 5-77
Ordering information, 10-1
Outgassing rate, 6-24, 9-24

Overlays, 3-14, 5-30
for multiple samples, 3-42
generating, 3-42
multiple graph, 3-45
oxygen-compatible vacuum pump, 9-9, 9-31

P

Parameter files, 3-9
Adsorptive properties, 3-12, 5-25
Analysis conditions, 3-11, 5-13
Degas conditions, 3-10, 5-11
listing file statistics, 3-40, 5-85
printing contents, 3-39, 5-84
Report options, 3-13, 5-29
Sample tube, 3-9, 5-9
saving, 5-82
Parameter files directory, 8-11
Parts, ordering, 10-1
Password, for restricted format, 8-3
Plot Options dialog, 5-33
Plot Overlay Sample Selection dialog, 3-44
Po and T dialog, 5-80
Po and Temperature
selecting method of measuring, 3-11
Po and Temperature Options dialog, 5-20
Po port, 2-3
Pore filling pressure, F-4
Pore Geometry
cylinder (Saito-Foley), C-21
slit (original Horvath-Kawazoe), C-20
sphere (Cheng/Yang), C-22
Pore size, F-12
Port filter
replacing analysis, 9-6
replacing degas, 9-7
Ports
gas connecting, 9-38
gas connection, 2-4
specifying gas, 9-38
See also Analysis port
See also Degas port
Power
heating mantle, 3-20, 3-32
On/Off switch, 2-5
Power connector, 2-5
Power indicator light, 2-1
Preparing samples, 3-16
Pressure
entering predefined points, 5-16
hold, 5-12
maximum manifold, 5-26
measurement, 1-13
relative, calculations, C-1, C-2
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table, 5-14 samples, 7-26
Pressure gauge saving in other formats, 7-19
calibrating, 6-17, 9-27 selecting, 7-4
Pressure scale starting, 2-8, 3-44
calibrating, 9-28 Statistical Process Control (SPC), 7-5
calibrating analysis system, 6-18 title, 5-30
calibrating degas system, 6-25 viewing onscreen, 7-16
Pressure zero zoom feature, 7-25
calibrating, 6-25 Report button, 7-9
Preventive maintenance schedule, 9-4 Report Options dialog, 3-13, 3-45, 3-46, 5-29
Print command, 5-84 Report options file, 5-29
Printing file contents, 3-39 creating, 3-13
Psat vs Temperature table, 3-12 listing file statistics, 3-40, 5-85
Psat vs. Temperature Table dialog, 5-28 printing contents, 3-39
Push buttons, 2-10 Report Pressure Table dialog, 5-36
Report Relative Pressure Range dialog, 5-45, 5-53
Report system, 1-12
R Report title
Radio button, 2-9 including graphic, 3-14
Reference material, 9-39 showing, 3-14
Regression report, 7-6 Reports menu, 7-1
recalculating SPC values, 7-7 Close Reports command, 7-4
selecting X- and Y-Axes variables, 7-7 Control Chart command, 7-10
Regression Report command, 7-6 description, 7-1
Regression Report Options dialog, 7-6 Heat of Adsorption command, 7-13
Regression Report Sample Selection dialog, 7-7 Open Report command, 7-4
Regularization, 5-65 Regression Report command, 7-6
Regulators SPC Report Options command, 7-5
attaching to gas supply, 9-31 Start Report command, 7-2
gas, 1-12 Reports to Generate dialog, 7-3
Relative pressure tolerance, 5-23 Restricted format, 3-8, 8-2, 8-3
Removing an analyzer, 4-9 creating sample file, 3-8
Replace All command, 3-7, 5-6, 5-8, 8-6, 8-9 password, 8-3
Replace command, 3-9 sample information file, 5-8
Replace push button, 2-10, 5-13 specifying sample defaults, 8-4
Report RS232 port, 2-5
closing, 2-8, 7-4
Control Chart, 7-10
displaying company logo in title, 5-30 S
editing axis, 7-24 Safety shield, 3-36
editing legend, 7-24 attaching, 3-30
editing style, 7-19 Saito-Foley
editing title, 7-24 calculations, C-21
generating, 7-2 Pore Geometry, C-21
generating automatically after analysis, 3-38, 6-5 Sample
graphs, editing onscreen, 7-22 degassing, 6-7
header, 7-16 degassing on analysis port, 3-31
Heat of Adsorption, 7-13 degassing on degas port, 3-20
legend, editing, 7-24 entering mass, 3-3
onscreen tool bar, 7-17 information, defining, 3-6
onscreen, shortcut menus for, 7-21 inserting in sample tube, 3-19
printed, 7-16 mass, determining, 3-18
printing, 7-18 preparing, 3-16
Regression, 7-6 Sample Analysis command, 6-3
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Sample Backfill Options, 5-24
Sample Data Worksheet, A-1
Sample defaults, 8-4
establishing for Advanced format, 8-7
establishing for Basic format, 8-4
Sample field, 3-7
Sample identification, 8-5, 8-8
Sample information file
automatic numbering, 3-3
contents, 3-1
creating, 3-6
default values, 3-2
exporting isotherm data, 3-41
listing file statistics, 3-40, 5-85
printing contents, 3-39, 5-84
specifying defaults, 3-2
Sample Log report, 5-78
Sample tube
cleaning, 3-16
cooling, 3-23, 3-26, 3-34
displayed on schematic, 6-10
installed, 3-30
installing on sample port, 3-26
replacing O-ring, 9-8
seal frit, 3-17, 3-19, 3-26
stopper, 3-17, 3-19, 3-26
transferring from degas port to analysis port, 3-26
Sample Tube dialog, 3-9, 5-9
Sample tube file, 5-9
creating, 3-9
listing file statistics, 3-40
printing contents, 3-39
Saturation pressure
calculations, C-1
tube, 1-11, 3-34
Save All command, 5-83
Save As command, 5-81
Save as Default button, 7-12
Save command, 5-81
Save push button, 2-10
Save to File command, 6-21
Schematic
analysis system, 6-11
degas system, 6-22
Seal frit
See Sample tube
Select Dates dialog, 2-11, 5-3
Select Reports dialog, 3-45
Selected Reports list, 3-14, 3-46
Sequence field, 3-3, 3-4
Service Test command, 6-27
Service Test Mode, 8-12
Servo Value Settings dialog, 6-23
Servo valve, 6-23

calibrating, 6-26
Setup Program, 4-1
Setup program
adding an analyzer, 4-6
changing an analyzer setup, 4-10
moving an analyzer to a different computer, 4-6
reinstalling analysis program, 4-5
reinstalling calibration files, 4-11
removing an analyzer from the computer, 4-9
uninstalling the software, 4-12
using for other functions, 4-4
Shortcut keys, 2-7, 2-12
list of, 2-8
Shortcut menu, 2-7
for graphs, 7-22
for tabular reports, 7-21
Show Instrument Log command, 6-13
Show Instrument Schematic command
analysis system, 6-11
degas system, 6-23
Show Status command
analysis system, 6-12
degasser, 6-24
Software
See Analysis program
SPC Report Options command, 7-5
SPC Report Options dialog, 7-5
Specifications
ASAP 2050, 1-13
Degas system, 1-14
Spreadsheet format
saving reports in, 7-19
Start Analysis dialog, 3-37
Start Degas command, 6-7
Start Degas dialog, 3-23
Start Report command, 7-2
Start Report dialog, 3-44, 7-2
Status
analysis system, 6-12
degas system, 6-24
Status list, 2-12, 7-2
Stopper
See Sample tube
STSA Thickness equation, 5-44
Submenu, 2-14
Submitter, 8-9
omitting, 3-5
Summary report, 5-77, 7-27
calculations, C-40
Summary Report Options dialog, 5-77
Surface Energy, F-12
Surface Energy report, 5-67
System volume
calibrating, 6-19
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T Sample Analysis command, 6-3
Table of Contents, online, 1-6 Service Test command, 6-27
Tabular report shortcut menu, 7-21 Show Instrument Log command, 6-13
Tarazona, F-8 Show Instrument Schematic command, 6-11
t-Curve Show Status command, 6-12
entered, 5-42 Start Degas command, 6-7
t-Curve, saving, 5-82 _Unit configuration commfand, 6-15
Temkim Report Options dialog, 5-39 Un!ts of mea}surement, selecting, 8-10
Temkin report, 5-39 Units Selections dialog, 8-10
calculations, C-36
Temperature Vv
analysis bath, 5-20
calibrating, 6-18, 9-29 Vacuum gauge
calibration details, 6-15 calibrating, 6-17
displayed on schematic, 6-10 calibrating, degas system, 6-26
hold temperature and time, 5-12 calibration details, 6-15
ramp rate, 5-11, 5-12 pressure, 6-10
saturation pressure, 5-20 Vacuum pump
target, 5-11 cha.nglng fluid, 9-11
Text, copy graph data as, 7-24 draining, 9-11 _
Thermal transpiration exhaust filter, replacing, 9-25
hard-sphere diameter, 5-26 fluid fo.r use vyith oxygen, 1-12, 9-9, 9-31
Thermal transpiration correction, 3-14 inspecting fluid, 9-9
calculations, C-5 oxygen-compatible, 1-12, 9-9, 9-31
choosing, 5-31 panel, 2-1
Thermocouple placement, 2-6
plug, 3-20, 3-32 rgplaleng al_umlna in oil vapor trap, 9-15
Thermodynamic law, F-2 viewing fluid level, 9-9
Thickness curve, 5-53, 5-72 Vacuum seal, 3-10
types, 5-51 Vacuum setpoint, 5-12, 5-17
Thumbnails tab, 1-9 Vacuum system, 1-13
Tile windows, 2-15 Valves
Title Properties dialog, 7-24 degas system, 6-23
t-Plot report, 5-41 description, D-2
calculations, C-9 opening and closing, 6-8
T-Plot Report Options dialog, 5-41 system, 6-9
Transducer testing for leaks, D-1
adjusting scale, 6-18 Van der Waal force, F-1
calibration details, 6-15 Vapor gas port, 2-4
displayed on schematic, 6-10 Viewing options, 6-3
Transformed Isotherm report, 5-70 Voltage
Troubleshooting, 9-1 selecting, 2-5
Volume
calibrating, 6-19
U calibration details, 6-15
Ultrasonic cleaning unit, 3-16 Volume adsorbed, 5-34
Unit Configuration command, 6-15 calculations, C-3
Unit menu, 6-1
Calibration command, 6-17 W
Degas command, 6-22 .
description, 6-1 Wall potentlal, F-11
Enable Manual Control command, 6-8 Warnings, 1-3
Live Graph command, 8-11 Windows
Cascade, 2-15
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tile, 2-15
Windows menu, 2-15

X

X-axis, choose variable, 8-11

Z

Zoom feature, 7-25
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